When exported from Japan, this manual does not require application to the Ministry of International Trade and Industry for service transaction permission.

HEAD OFFICE : MITSUBISHI DENKI BLDG MARUNOUCHI TOKYO 100-8310 TELEX : J24532 CABLE MELCO TOKYO

NAGOYA WORKS : 1-14, YADA-MINAMI 5, HIGASHI-KU, NAGOYA, JAPAN

MODEL

MODEL CODE

SW2-A8GOTP Graphic Settings Software Package Operating Manual (Monitor Screen Creation Manual)

MITSUBISHI ELECTRIC CORPORATION

Mitsubishi Graphic Operation Terminal

GOT

Series

GRAPHIC OPERATION TERMINAL

MITSUBISHI

SW2NIW-A8GOTP Graphic Settings Software Package Operating Manual (Monitor Screen Creation Manual)
Revisions

* The manual number is noted at the lower left of the back cover.

<table>
<thead>
<tr>
<th>Print Date</th>
<th>*Manual Number</th>
<th>Revision</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jul. 1996</td>
<td>IB (NA)-66681-A</td>
<td>First printing</td>
</tr>
</tbody>
</table>

This manual confers no industrial property rights or any rights of any other kind, nor does it confer any patent licenses. Mitsubishi Electric Corporation cannot be held responsible for any problems involving industrial property rights which may occur as a result of using the contents noted in this manual.

© 1996 Mitsubishi Electric Corporation
Introduction

Thank you for purchasing the Mitsubishi Graphic Operation Terminal.

Before using the equipment, please read this manual carefully to develop full familiarity with the functions and performance of the graphic operation terminal you have purchased, so as to ensure correct use.

Please forward a copy of this manual to the end user.

Contents

1. Overview .................................................. 1-1 ~ 1-10
   1.1 Differences between the A870GOT and the A85□GOT .............................................. 1- 2
   1.2 Structure and Guide to the Use of This Manual ...................................................... 1- 3
   1.3 Configuration of This Manual ..................................................................................... 1- 5
   1.4 Abbreviations and Symbols Used in This Manual ..................................................... 1- 7
   1.5 Similarities and Differences with the SW1NIW-A8GOTP ........................................... 1- 9

2. Where to Start .................................................. 2-1 ~ 2-9
   2.1 Getting Ready to Start Monitoring with the GOT .................................................... 2- 1
   2.2 Using the Panel Kit to Shorten Data Creation Time .................................................. 2- 4
   2.3 Checking the Volume of Data While Creating Screen Data ....................................... 2- 5
   2.4 Creating Data as a Team ............................................................................................. 2- 7
   2.5 Using Previously Created GOT Data ........................................................................... 2- 8

3. Creating Data ..................................................... 3-1 ~ 3-15
   3.1 Creating the First Screen ............................................................................................. 3- 1
   3.2 Creating the Next Screen/Opening a Screen to Edit .................................................. 3- 2
   3.3 Overlapping/Lining Up Open Screen Windows ......................................................... 3- 3
   3.4 Making the Screen Window to be Edited the Active Window ..................................... 3- 5
   3.5 Closing the Screen Window from the Application Window ....................................... 3- 6
   3.6 Storing Project Data on a Hard Disk or Floppy Disk ................................................ 3- 8
   3.7 Exiting the Graphics Software Program .................................................................... 3-11
   3.8 Opening Project Data Stored on a Hard Disk or Floppy Disk .................................... 3-12
   3.9 Opening Previously Created GOT Data .................................................................... 3-14

4. What to Do First .................................................. 4-1 ~ 4-15
   4.1 Setting the GOT Type ................................................................................................. 4- 1
   4.2 Specifying the PC Type ............................................................................................... 4- 2
   4.3 Setting Screen Switching Devices .............................................................................. 4- 3
   4.4 Setting the Operation Environment for the Graphics Software .................................. 4- 6
   4.5 Setting Devices to Check GOT Operation (System Information) ................................ 4- 8
   4.6 Registering a Password for the Project Data .............................................................. 4-14
   4.7 Registering a Title and ID Number for the Project Data ........................................... 4-15

5. Drawing Canvas Graphics and Preparing to Enter Sprite Settings .................................. 5-1 ~ 5-5
   5.1 Displaying a Grid on the Screen Window ................................................................... 5- 1
   5.2 Deleting the Tool Bar and Status Bar from the Application Window ......................... 5- 2
6. Drawing Canvas Graphics

6.1 Figures and Text Characters That Can Be Drawn ........................................ 6-1
6.2 Memory Required for Figures and Text Characters ...................................... 6-4
6.3 Overlapping Graphics ................................................................................. 6-5
6.4 Setting Attributes for Graphics .................................................................. 6-6
6.5 Items to Know before Starting to Draw ...................................................... 6-8
6.6 Drawing Figures and Text Characters ......................................................... 6-10
6.6.1 Drawing Straight Lines ............................................................................ 6-10
6.6.2 Drawing Continuous Lines ....................................................................... 6-11
6.6.3 Drawing Rectangles ................................................................................ 6-12
6.6.4 Drawing Polygons ................................................................................... 6-13
6.6.5 Drawing Circles ....................................................................................... 6-14
6.6.6 Drawing Ovals and Painted Ovals ............................................................. 6-15
6.6.7 Drawing Circular Arcs ............................................................................... 6-16
6.6.8 Drawing Oval Arcs ................................................................................... 6-17
6.6.9 Painting Areas within a Line and Polygons .............................................. 6-18
6.6.10 Entering Text .......................................................................................... 6-21
6.7 Pasting Graphics Data in Other Formats (BMP File Format) ....................... 6-24

7. Editing Canvas Graphics after Drawing Them

7.1 Changing the Cursor to the Graphic Editing Cursor ...................................... 7-1
7.2 Selecting the Graphic or Text to Edit ........................................................... 7-2
7.2.1 Selecting a Single Graphic or Character .................................................. 7-2
7.2.2 Selecting a Single Graphic or Character from Overlapped Graphics .......... 7-3
7.2.3 Selecting Multiple Graphics or Characters from a Group in a Screen Window ......................................................................................... 7-4
7.2.4 Selecting Disparate Multiple Graphics or Characters in a Screen Window .......................................................................... 7-6
7.2.5 Deleting One or More Selected Graphics ................................................. 7-7
7.2.6 Deleting One of Several Selected Graphics .............................................. 7-8
7.3 Correcting Graphics or Characters ................................................................ 7-9
7.3.1 Changing the Attributes of a Graphic ...................................................... 7-9
7.3.2 Changing the Attributes of a Character .................................................... 7-10
7.3.3 Changing Graphic and Character Attributes Simultaneously ................... 7-10
7.3.4 Changing the Size of a Straight Line or Circular Arc after Drawing It ........ 7-11
7.3.5 Changing the Length of a Specified Segment of a Continuous Line or Polygon ..................................................................................... 7-12
7.3.6 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction ..................................................... 7-14
7.3.7 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Corner Axis .......... 7-15
7.3.8 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Center Axis .......... 7-16
7.3.9 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle without Changing the Horizontal to Vertical Proportion .................. 7-17
7.3.10 Deleting Graphics and Characters ........................................................... 7-18
7.3.11 Cutting Graphics and Characters and Storing Them on the Clipboard .... 7-19
7.3.12 Flipping, Reversing, and Rotating Graphics 90° ..................................... 7-20
7.3.13 Rotating text ............................................................................................ 7-20
7.4 Editing Graphics and Characters ................................................................. 7-21
7.4.1 Moving Graphics and Characters ......................................................... 7-21
7.4.2 Copying Graphics and Characters ......................................................... 7-22
7.4.3 Pasting Graphics and Characters Stored on the Clipboard ..................... 7-23
7.4.4 Changing the Order of Overlapped Graphics or Characters .................... 7-23
7.4.5 Copying and Pasting Figures and Texts as a Group ............................... 7-24
7.4.6 Undoing the Previous Operation ........................................................... 7-26
7.5 Editing Several Graphics ............................................................................. 7-26
7.5.1 Grouping Several Graphics and Characters ............................................ 7-26
7.5.2 Ungrouping Graphics and Characters .................................................... 7-27
7.5.3 Centering Several Graphics .................................................................... 7-28
7.5.4 Aligning Several Graphics along the Top or Bottom ............................... 7-28
7.5.5 Aligning Several Graphics along the Left or Right ................................. 7-29
7.5.6 Aligning Several Graphics along the Left or Top at Even Intervals ............ 7-30
7.6 Editing Graphics and Sprites Simultaneously .......................................... 7-31

8. Before Entering Sprite Settings ................................................................. 8-1 ~ 8-7

8.1 Types of Sprite Functions ........................................................................... 8-1
8.2 Memory Required for Sprites and Maximum Settings ................................. 8-5
8.3 Overlapping Canvas Graphics and Sprites .................................................. 8-6
8.4 Entering Settings for Overlapped Sprites ................................................... 8-6
8.5 Types of Attributes That Can be Set with Sprites ....................................... 8-7

9. Devices That Can be Set with Sprites and Their Access Ranges ............... 9-1 ~ 9-18

9.1 Names of Devices That Can be Monitored ................................................ 9-1
9.2 Monitoring Special Function Units ............................................................ 9-4
9.3 Access Ranges for Data Link Systems That Can be Monitored When Using the MELSEC-ACPU and QnACPU ........................................ 9-5
9.4 Access Ranges for Network Systems That Can be Monitored When Using the MELSEC-ACPU and QnACPU ........................................ 9-7
9.5 Access Ranges Which Can Be Monitored When Using the MELSEC-FXCPU ......................................................... 9-18
9.6 Access Ranges Which Can Be Monitored When Using the Omron PLC .......... 9-18

10. Common Operations Used in Setting Sprites ............................................. 10-1 ~ 10-16

10.1 Setting Devices for Monitoring .................................................................. 10-1
10.1.1 Ranges for Device Names and Device Numbers to be Set ....................... 10-2
10.2 Setting Data Expressions (Other Than Numeric Input Function) ................. 10-3
10.2.1 Items to Know before Setting Data Expressions ...................................... 10-3
10.2.2 Types of Expression Procedures That Can be Set .................................. 10-3
10.2.3 Setting Data Expressions (Other Than Numeric Input Function) .......... 10-6
10.3 Setting Data Expressions (Numeric Input Function) ................................... 10-8
10.3.1 Types of Expression Procedures That Can be Set with the Numeric Input Function ........................................................................... 10-8
10.3.2 Setting Data Expressions (Numeric Input Function) ............................... 10-10
10.4 Setting Display Conditions ....................................................................... 10-12
10.4.1 Items to Know before Setting Display Conditions .................................. 10-12
10.4.2 Setting Up Displays When Setting Several Sprites on One Screen .......... 10-13
10.4.3 Setting Display Conditions .................................................................... 10-14
10.5 Setting Display Ranges (Comparative Equations) ...................................... 10-15
11. Setting Data Display Functions 11-1 ~ 11-15

11.1 Setting the Numeric Value Display Function ........................................ 11-1
11.2 Setting the ASCII Display Function ..................................................... 11-8
11.3 Setting the Clock Display Function ..................................................... 11-12

12. Setting the Message Display Function 12-1 ~ 12-36

12.1 Registering Comments to Display with the Comment Display Function .......... 12-1
12.1.1 Registering Comments ................................................................. 12-1
12.1.2 Deleting Registered Comments ................................................... 12-4
12.1.3 Copying a Registered Comment to Another Comment Number ................. 12-5
12.1.4 Using Data in Text File Format as Comment Data ................................ 12-6
12.2 Setting the Comment Display (Bit) Function ....................................... 12-9
12.3 Setting the Comment Display (Word) Function .................................. 12-15
12.4 Setting the Alarm List Display (System Alarms) Function ....................... 12-23
12.5 Setting the Alarm List Display (User Alarms) Function ............................ 12-27

13. Setting Moving Screen Display Functions 13-1 ~ 13-53

13.1 Registering Parts (Graphics) Displayed in the Parts Display and Parts Movement Display .... 13-1
13.1.1 Useful Information When Utilizing and Registering Parts ...................... 13-1
13.1.2 Registering Parts ........................................................................... 13-2
13.1.3 Reading Out Registered Parts ....................................................... 13-3
13.1.4 Deleting Registered Parts ............................................................ 13-4
13.1.5 Changing a Part Name Assigned When a Part was Registered ............... 13-5
13.2 Setting the Parts Display (Bit) Function ............................................. 13-6
13.3 Setting the Parts Display (Word) Function .......................................... 13-14
13.4 Setting the Parts Movement Display Function .................................... 13-24
13.5 Setting the Lamp Display (Bit) Function ............................................ 13-30
13.6 Setting the Lamp Display (Word) Function ........................................ 13-36
13.7 Setting the Panel Meter Display Function .......................................... 13-43

14. Setting Graph Display Functions 14-1 ~ 14-30

14.1 Setting the Trend Graph Display Function ........................................... 14-1
14.2 Setting the Line Graph Display Function ............................................. 14-10
14.3 Setting the Bar Graph Display Function ............................................. 14-16
14.4 Setting the Level Display Function ..................................................... 14-23

15. Setting the Touch Key Functions 15-1 ~ 15-53

15.1 Items to Know before Setting the Touch Key Functions ......................... 15-1
15.2 Common Settings for Touch Key Functions ......................................... 15-4
15.2.1 Setting Key Graphics .................................................................... 15-4
15.2.2 Setting the Run Timing for Specified Movements .............................. 15-8
15.2.3 Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics .... 15-10
15.3 Setting Touch Key (Bit) Functions ..................................................... 15-12
15.4 Setting Touch Key (Word) Functions ................................................ 15-17
15.5 Setting Touch Key (Base Switching) Functions ................................... 15-22
15.5.1 Switching to the Screen of the Previously Displayed Base Screen Number .......................... 15-22
15.5.2 Switching to the Screen of the Specified Base Screen Number ........................................ 15-26
15.5.3 Switching to the Screen of a Base Screen Number
   by Turning the Specified Bit Device ON/OFF ............................................................................ 15-29
15.5.4 Switching to the Screen of a Base Screen Number Using the Current Value
   of the Specified Word Device ................................................................................................. 15-34
15.5.5 Switching the Base Screen Using a Sequence Program ...................................................... 15-40
15.6 Setting the Touch Key (Window Switching) Functions ........................................................... 15-41
15.6.1 Changing to the Screen of the Specified Window Number ................................................. 15-41
15.6.2 Changing to the Screen of a Window Screen Number by Turning the
   Specified Bit Device ON/OFF ............................................................................................... 15-43
15.6.3 Changing to the Screen of a Window Screen Number Using the Current
   Value of the Specified Word Device ...................................................................................... 15-45
15.6.4 Changing the Window Screen Using a Sequence Program ................................................. 15-47
15.7 Setting the Touch Key (Expansion) Functions ........................................................................ 15-48
15.8 Inhibiting Simultaneous Pressing of Touch Keys
   When Creating Keys for Numeric and ASCII Input ............................................................... 15-51

16. Setting Data Input Functions 16-1 ~ 16-20

16.1 Setting the Numeric Input Function ....................................................................................... 16- 1
16.2 Key Window Operations ....................................................................................................... 16-10
16.3 Setting the ASCII Input Function ......................................................................................... 16-14
16.4 Creating Keys to be Input ..................................................................................................... 16-20

17. Displaying Window Screens 17-1 ~ 17-5

17.1 Window Screen Operations ................................................................................................. 17- 1
17.2 Setting the Initial Display Position for the Window Screen .................................................. 17- 3
17.3 Precautions When Base Screens Touch Keys, and Window Screens are Overlapped ........ 17- 4

18. Operations Using the Panel Kit 18-1 ~ 18-6

18.1 Items to Know When Using the Panel Kit ............................................................................. 18- 1
18.2 Registering Drawn Graphics and Sprite Settings in a Panel Kit .............................................. 18- 2
18.3 Reading a Registered Panel Kit ........................................................................................... 18- 4
18.4 Deleting a Registered Panel Kit ........................................................................................... 18- 5
18.5 Changing the Registered Library Name or Panel Kit Name ................................................... 18- 6

19. Editing Set Sprites 19-1 ~ 19-26

19.1 Changing the Cursor to the Sprite Editing Cursor ............................................................... 19- 1
19.2 Selecting the Sprite to Edit .................................................................................................... 19- 2
19.2.1 Selecting a Single Sprite .................................................................................................. 19- 2
19.2.2 Selecting Several Overlapped Sprites in a Screen Window .............................................. 19- 3
19.2.3 Selecting Disparate Several Sprites in a Screen Window ................................................. 19- 5
19.2.4 Deleting One or More Selected Sprites ........................................................................... 19- 6
19.2.5 Deleting One of Several Selected Sprites ....................................................................... 19- 7
19.3 Editing a Sprite Using the Same Procedures as Graphic Editing ......................................... 19- 8
19.3.1 Correcting the Data of a Set Sprite .................................................19- 8
19.3.2 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction ... 19- 9
19.3.3 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis) .............................................19-10
19.3.4 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis) .............................................19-11
19.3.5 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction without Changing the Proportion .............................................19-12
19.3.6 Deleting a Set Sprite ........................................................................19-13
19.3.7 Cutting the Set Sprite and Storing it on the Clipboard .......................19-14
19.3.8 Changing (Moving) the Display Position of the Set Sprite .....................19-15
19.3.9 Copying a Set Sprite ........................................................................19-16
19.3.10 Pasting a Sprite Stored on the Clipboard ........................................19-17
19.3.11 Copying and Pasting Sprites as a Batch ...........................................19-18
19.3.12 Grouping Several Sprites in One Group ...........................................19-21
19.3.13 Ungrouping Sprites ........................................................................19-21
19.3.14 Aligning Several Sprites along the Top or Bottom ...............................19-22
19.3.15 Aligning Several Sprites along the Left or Right ................................19-22
19.3.16 Aligning Several Sprites along the Left or Top at Even Intervals ..........19-23
19.3.17 Displaying Numeric or ASCII Displays in Block Format ......................19-23
19.4 Selecting Several Sprites and Correcting Sprites from a List ......................19-24
19.5 Correcting, Utilizing, and Deleting Set Sprites from a List .......................19-25
19.6 Batch Changes to Monitor Devices Set Using Sprites .............................19-26

20. Operations Subsequent to Screen Creation .................................20-1 ~ 20-11

20.1 Assigning a Title to the Screen Data ..................................................20- 1
20.2 Viewing an Image of the Created Screen Data ......................................20- 2
20.3 Viewing the Monitor Device Specified by a Sprite ...............................20- 4
20.4 Viewing the Image and Device for the Created Screen Data ..................20- 6
20.5 Viewing an Image for a Still Screen (Canvas Screen) ............................20- 8
20.6 Viewing Sprite ID Numbers Set Using Sprites ....................................20-10

21. Editing in Screen Units/Single-Project Units .................................21-1 ~ 21-12

21.1 Copying Other Screen Data to the Project Data being Edited ..................21- 1
21.2 Combining Data Created by More Than One Person ............................21- 4
21.2.1 Items to Know before Creating Data as a Team ..............................21- 4
21.2.2 Combining Data Created by More Than One Person .......................21- 6
21.2.3 Combining Parts Data ..................................................................21- 6
21.2.4 Combining Comment Data .............................................................21- 8
21.3 Copying the Created Screen Data to Another Screen Number ..................21-10
21.4 Deleting the Created Screen Data in Screen Number Units ....................21-11
21.5 Changing the Screen Number of the Created Screen Data .....................21-12

22. Setting Sprite Functions Added to the SW2 and Subsequent Versions 22-1 ~ 22-21

22.1 Precautions When Using Functions Described in This Chapter ...............22- 1
22.2 Specifying the Data List Display Function ...........................................22- 2
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>22.3 Setting the Hard Copy Function</td>
<td>22-12</td>
</tr>
<tr>
<td>22.4 Setting the Circuit Startup Function</td>
<td>22-15</td>
</tr>
<tr>
<td>22.5 Setting the Status Monitor Function</td>
<td>22-16</td>
</tr>
</tbody>
</table>

**Appendices**

<table>
<thead>
<tr>
<th>Appendix 1. Key Code Table</th>
<th>A-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix 2. Screen Creation Form</td>
<td>A-2</td>
</tr>
<tr>
<td>Appendix 3. Display Speeds for Sprites</td>
<td>A-6</td>
</tr>
</tbody>
</table>
# About the Manuals

The following product manuals are available. Please use this table as a reference to request the appropriate manual as necessary.

## Related Manuals

<table>
<thead>
<tr>
<th>Manual Name</th>
<th>Manual No.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A870GOT Graphic Operation Terminal User's Manual</strong></td>
<td>IB-66628</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A870GOT main unit,</td>
<td>(13J830)</td>
</tr>
<tr>
<td>as well as the hardware configuration, procedures for installing optional units,</td>
<td></td>
</tr>
<tr>
<td>operation in on-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td><strong>A850GOT Graphic Operation Terminal User's Manual</strong></td>
<td>IB-66659</td>
</tr>
<tr>
<td>This describes the specifications and performance of the A850GOT main unit,</td>
<td>(13JF33)</td>
</tr>
<tr>
<td>as well as the hardware configuration, procedures for installing optional units,</td>
<td></td>
</tr>
<tr>
<td>operation in on-line mode, error codes, and troubleshooting guidelines.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td><strong>SW2NIW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66679</td>
</tr>
<tr>
<td><em>(Introductory Manual)</em></td>
<td>(13J900)</td>
</tr>
<tr>
<td>This manual is designed for the first-time user of the GOT. It describes how</td>
<td></td>
</tr>
<tr>
<td>to create monitor screens with the A8GOTP, how to send monitor data to the</td>
<td></td>
</tr>
<tr>
<td>GOT, and what the various screen displays mean.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td><strong>SW2NIW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66680</td>
</tr>
<tr>
<td><em>(Startup Manual)</em></td>
<td>(13J901)</td>
</tr>
<tr>
<td>This describes the configuration of the A8GOTP system, precautions regarding the configuration, and the specifications of the various functions, as well as the installation procedures, startup procedures, screen configurations, and basic operation procedures.</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td><strong>SW2NIW-A8GOTP Graphic Settings Software Package Operating Manual</strong></td>
<td>IB-66682</td>
</tr>
<tr>
<td><em>(Data Transmission/Debugging/Document Creation Manual)</em></td>
<td>(13J903)</td>
</tr>
<tr>
<td>This manual describes the following items.</td>
<td></td>
</tr>
<tr>
<td>(1) Procedures for downloading project data to the GOT and uploading data from the GOT</td>
<td></td>
</tr>
<tr>
<td>(2) Procedures for installing the operating system in the GOT</td>
<td></td>
</tr>
<tr>
<td>(3) Procedures for using the A8GOTP as a virtual sequencer and for debugging the GOT</td>
<td></td>
</tr>
<tr>
<td>(4) Procedures for outputting created monitor data as a completed document</td>
<td></td>
</tr>
<tr>
<td><em>(Sold separately)</em></td>
<td></td>
</tr>
<tr>
<td>Manual Name</td>
<td>Manual No. (Model Code)</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>A870/A850/A851GOT Graphic Operation Terminal Operating Manual (Expanded</td>
<td>IB-66652 (13JF32)</td>
</tr>
<tr>
<td>Functions Manual)</td>
<td></td>
</tr>
<tr>
<td>This manual describes the operation procedures for using system monitor</td>
<td></td>
</tr>
<tr>
<td>functions, monitor functions for special function units, and the</td>
<td></td>
</tr>
<tr>
<td>dedicated monitor screens used with the circuit monitor functions.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>A7GT-J71LP23/BR13 Network Unit User’s Manual</td>
<td>IB-66558 (13JE94)</td>
</tr>
<tr>
<td>This manual contains the specifications for the MELSECNET/10 Optical Loop</td>
<td></td>
</tr>
<tr>
<td>Network Unit/MELSECNET/10 Coaxial Bus Network Unit, as well as the</td>
<td></td>
</tr>
<tr>
<td>names and settings for the various parts.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>MELSECNET, MELSECNET/B Data Link System Reference Manual</td>
<td>IB-66350 (13JF70)</td>
</tr>
<tr>
<td>This manual contains an overview of the MELSECNET (II) and MELSECNET/</td>
<td></td>
</tr>
<tr>
<td>B, as well as the specifications, names of parts, and the various</td>
<td></td>
</tr>
<tr>
<td>settings.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>MELSECNET/10 Network System Reference Manual (For PC Networks)</td>
<td>IB-66440 (13JE33)</td>
</tr>
<tr>
<td>This manual contains an overview of the MELSECNET/10, along with the</td>
<td></td>
</tr>
<tr>
<td>specifications, names of parts, and the settings.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
<tr>
<td>A8GT-70PRF Printer Interface Unit User’s Manual</td>
<td></td>
</tr>
<tr>
<td>This manual contains the specifications and the settings of the A8GT-70PH-</td>
<td></td>
</tr>
<tr>
<td>Printer Interface Unit.</td>
<td></td>
</tr>
<tr>
<td>(Sold separately)</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 1

Overview
1. Overview

This manual explains the following procedures:

- How to create monitor screens
- How to draw canvas graphics (still images) and how to enter settings for sprites (moving images)
- How to actually display these screens and images on the GOT

- How to create the screen
- What to do first
- Editing the created data

- Drawing and editing canvas graphics
- Setting and editing sprites
- Window screens
- Displaying data created with sprite settings on the GOT

Creating the first screen

Creating screens to be displayed on the GOT
### Differences between the A870GOT and the A85□GOT

<table>
<thead>
<tr>
<th>Screen size</th>
<th>A870GOT</th>
<th>A85□GOT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base screen</td>
<td>EL model: 480 (vertical) x 640 (horizontal) dots&lt;br&gt;STN and TFT models: 480 (vertical) x 640 (horizontal) dots</td>
<td>STN and L model: 240 (vertical) x 320 (horizontal) dots</td>
</tr>
<tr>
<td>Window screen</td>
<td>195 (vertical) x 319 (horizontal) dots&lt;br&gt;(Screen creation size: 176 (vertical) x 316 (horizontal) dots)</td>
<td>144 (vertical) x 192 (horizontal) dots&lt;br&gt;(Screen creation size: 127 (vertical) x 191 (horizontal) dots)</td>
</tr>
<tr>
<td>No. of screens</td>
<td>Base and window screens: 1,024 screens max.</td>
<td></td>
</tr>
<tr>
<td>No. of touch switches</td>
<td>256 points max.</td>
<td>77 points max.</td>
</tr>
<tr>
<td>Sprite functions that can be displayed</td>
<td>Same (see Chapter 8)</td>
<td></td>
</tr>
<tr>
<td>Expansion functions</td>
<td>Circuit monitor function&lt;br&gt;System monitor function&lt;br&gt;Special function unit monitor function</td>
<td>System monitor function</td>
</tr>
<tr>
<td>Applicable software packages</td>
<td>SW0NIW-GOT800PSET (Does not accommodate TFT type.)&lt;br&gt;SW1NIW-GOT800PSET&lt;br&gt;SW2NIW-GOT800PSET</td>
<td>SW1NIW-GOT800PSET&lt;br&gt;SW2NIW-GOT800PSET</td>
</tr>
</tbody>
</table>

With the A870GOT and A85□GOT, the base screens and window screens are different sizes, but there are no differences in terms of the graphics and sprite functions that can be displayed.

GOT display examples used in this manual show A870GOT display screens.
1.2 Structure and Guide to the Use of This Manual

When this graphics software is purchased, it comes with five operating manuals. Manuals are categorized according to the purpose for which they are used. Please read the manual that corresponds to your particular objective in order to become familiar with the operations and functions of the software.

---

**SW2NIW-A8GOTP Operating Manual**

- Install the graphics software in the computer.
- Start up the graphics software.
- Learn fundamental information and basic operations for the graphics software.

---

- Create simple graphics, monitor using the GOT, and learn the flow of a series of operations.

---

- Actually create screens for monitoring using the GOT.
  - Drawing graphics
  - Sprite settings
- Edit the data which has been created.
1. Overview

- Install the OS program and communications driver in the GOT.
- Download created graphics to the GOT.
- Debug graphics between the computer and GOT.
- Create data documents.

- Monitor circuits.
- Monitor the system.
- Monitor the special unit.

---


- Install optional units in the GOT.
- Connect the GOT and PC CPU.
- Find out how to attach the GOT and its external dimensions.
1.3 Configuration of This Manual

Chapter 1. Overview
• Describes the contents of the manual and the terms and abbreviations used in the manual.

Chapter 2. Where to Start
• Describes the procedures for creating screens to be monitored, and convenient functions which you should know about before creating monitor screens.

Chapter 3. Creating Data
• Describes how to create new data, open and close screen windows, save project data, and exit the graphics software program.

Chapter 4. What to Do First
• Describes how to enter settings for the operation environment and for the data common to all of the screens, which have to be entered before creating the monitor screen data.

Chapter 5. Drawing Canvas Graphics and Preparing to Enter Sprite Settings
• Describes functions which make it easier to draw canvas graphics and enter sprite settings.

Chapter 6. Drawing Canvas Graphics
• Describes the various types of graphics which can be drawn, and how to draw them.

Chapter 7. Editing Canvas Graphics After Drawing Them
• Describes methods for correcting and editing graphics after you have drawn them.

Chapter 8. Before Entering Sprite Settings
• Describes the types of sprites that can be set, and explains items that you should know before entering sprite settings.
Chapter 9. Devices That Can be Set With Sprites and Their Access Ranges
- Describes devices that can be monitored using sprites, and the access ranges for monitoring based on the type of connection being used with the GOT.

Chapter 10. Common Operations Used in Setting Sprites
- Describes how to enter settings that are requisite for sprites, and how to enter settings for data operation functions.

Chapter 11. Setting Data Display Functions
Chapter 12. Setting the Message Display Function
Chapter 13. Setting Moving Screen Display Functions
Chapter 14. Setting Graph Display Functions

Chapter 15. Setting the Touch Switch Functions
Chapter 16. Setting Data Input Functions
- Explain how the various displays are produced on the GOT by entering settings for the sprites, as well as the various items that are set using the sprites.

Chapter 17. Displaying Window Screens
- Describes how to display window screens and how to move the position at which a window screen is displayed.

Chapter 18. Operations Using the Panel Kit
- Describes how to use the panel kit provided with the graphics software.

Chapter 19. Editing Set Sprites
- Describes how to correct and edit sprites for which settings have been entered.

Chapter 20. Operations Subsequent to Screen Creation
- Describes how to assign a name (title) to a screen which has been created, and how to view images in order to check how the screen data which has been created will actually appear on the GOT.

Chapter 21. Editing in Screen Unite/Single-Project Unite
- Describes how to edit project data which has been created, and how to change the order of the numbers of the screens which have been created.

Chapter 22. Setting Sprite Functions Added to the SW2 and Subsequent Versions
- Describes functions which have been added starting with the SW2 version (data list display, hard copy function, circuit startup function, and status monitor function).
### 1.4 Abbreviations and Symbols Used in This Manual

The following abbreviations and symbols are used in this manual.

<table>
<thead>
<tr>
<th>Abbreviation/Terminology</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics software</td>
<td>This refers to the SW2NIW-A8GOTP.</td>
</tr>
<tr>
<td>Computer</td>
<td>This refers to a peripheral device in which the graphics software has been installed.</td>
</tr>
<tr>
<td>A870GOT</td>
<td>This indicates the A870 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A850GOT</td>
<td>This indicates the A850 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A851GOT</td>
<td>This indicates the A851 Graphic Operation Terminal.</td>
</tr>
<tr>
<td>A85□</td>
<td>This refers to the A850GOT/A851GOT.</td>
</tr>
<tr>
<td>GOT</td>
<td>This indicates the abbreviation for the A870GOT/A850GOT/A851GOT.</td>
</tr>
<tr>
<td>Conventional GOT</td>
<td>This indicates the A77GOT (S3/S5)/A64GOT.</td>
</tr>
<tr>
<td>Canvas graphics</td>
<td>This indicates graphics and text data for still images.</td>
</tr>
<tr>
<td>Sprite</td>
<td>This refers to setting data used for moving images.</td>
</tr>
<tr>
<td>Screen data</td>
<td>This is the data specified for graphics and sprites, in units of one screen.</td>
</tr>
<tr>
<td>Common screen data</td>
<td>This is the data for the specified GOT type and screen switching device.</td>
</tr>
<tr>
<td>Comment data</td>
<td>This is character string data created in order to display comments with the message display function.</td>
</tr>
<tr>
<td>Parts data</td>
<td>This is graphic data registered in order to display graphics with the part display function.</td>
</tr>
<tr>
<td>Title data</td>
<td>This is title data that comes with each of the various screens.</td>
</tr>
<tr>
<td>Project data</td>
<td>This refers to all of the data that has been created, and all of the data saved in the specified directory.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Contents</td>
</tr>
<tr>
<td>--------</td>
<td>----------</td>
</tr>
<tr>
<td><img src="symbol1.png" alt="image" /></td>
<td>This indicates a command on a menu.</td>
</tr>
<tr>
<td><img src="symbol2.png" alt="image" /></td>
<td>This is the icon for the Tool Bar 1.</td>
</tr>
<tr>
<td><img src="symbol3.png" alt="image" /></td>
<td>This indicates a dialog box tab.</td>
</tr>
<tr>
<td><img src="symbol4.png" alt="image" /></td>
<td>This indicates a command name in a dialog box.</td>
</tr>
<tr>
<td><img src="symbol5.png" alt="image" /></td>
<td>This indicates a displayed dialog box.</td>
</tr>
<tr>
<td><img src="symbol6.png" alt="image" /></td>
<td>This indicates an item in a dialog box for which a setting can be entered.</td>
</tr>
<tr>
<td><img src="symbol7.png" alt="image" /></td>
<td>This indicates a command button in a dialog box.</td>
</tr>
<tr>
<td><img src="symbol8.png" alt="image" /></td>
<td>These indicate keys on the computer keyboard.</td>
</tr>
<tr>
<td><img src="symbol9.png" alt="image" /></td>
<td>This indicates that the information is particularly important.</td>
</tr>
<tr>
<td><img src="symbol10.png" alt="image" /></td>
<td>This indicates an item which can be referenced in this manual.</td>
</tr>
<tr>
<td><img src="symbol11.png" alt="image" /></td>
<td>Refer to other related manuals.</td>
</tr>
</tbody>
</table>
1.5 Similarities and Differences with the SW1NIW-A8GOTP

Contents which have been added to the upgraded model, and which differ from the SW1NIW-A8GOTP, are listed below.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Command</th>
<th>Contents</th>
<th>Ref. Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Option ▶ File</td>
<td>It is no longer necessary to specify the name of the drive or path containing the special unit monitor data installed in the computer.</td>
<td>Section 4.4</td>
</tr>
<tr>
<td></td>
<td>Option ▶ View</td>
<td>A screen window reduction (50%, 75%) function has been added.</td>
<td>Section 5.4</td>
</tr>
<tr>
<td></td>
<td>Copy and Paste</td>
<td>A function has been added which allows figure and sprite data to be copied and pasted as a batch.</td>
<td>Section 7.4.5, 19.3.11</td>
</tr>
<tr>
<td></td>
<td>Rotate/Flip ▶ Rotate Left</td>
<td>A function has been added which allows text to be rotated 90°.</td>
<td>Section 7.3.13</td>
</tr>
<tr>
<td></td>
<td>Attribute</td>
<td>The color selection for the &quot;Change Attribute&quot; dialog box has been improved, and has been changed to a list box.</td>
<td>Section 7.3.3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The size of data in BMP format files can now be changed (enlarged/reduced) on the screen window.</td>
<td>Section 6.7</td>
</tr>
<tr>
<td></td>
<td>Replace Devices</td>
<td>The bit specified by Bit Device ↔ Word Device can now be changed.</td>
<td>Section 19.6</td>
</tr>
<tr>
<td></td>
<td>Panelkit</td>
<td>A function has been added which allows confirmation of the ON and OFF figures in a panel kit with a sprite function, in the &quot;Select Image&quot; dialog box.</td>
<td>Section 18.3</td>
</tr>
<tr>
<td></td>
<td>Draw Figure ▶ Text</td>
<td>Bold, outline, and vertical text have been added as text types.</td>
<td>Section 6.6.10</td>
</tr>
<tr>
<td></td>
<td>Data Display ▶ Data List</td>
<td>A data list display function has been added.</td>
<td>Section 22.2</td>
</tr>
<tr>
<td></td>
<td>Message Display ▶ Comment</td>
<td>Operation has been improved when specifying the Comment Display (Bit) function, and the setting for the display method has been changed.</td>
<td>Section 12.2</td>
</tr>
<tr>
<td></td>
<td>Message Display ▶ Alarm List</td>
<td>In the Alarm List (User Alarms) Display function, Display Time and Save in Memory functions have been added. Random settings of bit devices as monitor devices can now be entered. Along with improved operation, the dialog box has been changed so that multiple bit devices can be specified.</td>
<td>Section 12.5</td>
</tr>
<tr>
<td>Draw</td>
<td>Animated Display ▶ Parts Display</td>
<td>Along with improved operation when the Part (Bit) Display function is specified, the setting for the display method has been changed.</td>
<td>Section 13.2</td>
</tr>
<tr>
<td></td>
<td>Animated Display ▶ Lamp</td>
<td>New types of lamp figures have been added which can be displayed. Along with improved operation when the Lamp (Bit) Display function is specified, the setting for the display method has been changed. The size of lamp figures can now be changed (in 1-dot units) on the screen window.</td>
<td>Section 13.5, 13.6</td>
</tr>
<tr>
<td></td>
<td>Animated Display ▶ Panel meter</td>
<td>The line width of the meter indicator displayed on the GOT has been changed to 3 dots. The current values of the specified device have been added as the upper and lower limit values of the panel meter display.</td>
<td>Section 13.7</td>
</tr>
<tr>
<td>Menu</td>
<td>Command</td>
<td>Contents</td>
<td>Ref. Section</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Draw</td>
<td>Trend</td>
<td>A memory store function has been added to the Display Trend Graph function. The current values of the specified device have been added as the upper and lower limit values of the graph display. Along with improved operation, the dialog box has been changed so that multiple word devices can be specified.</td>
<td>Section 14.1</td>
</tr>
<tr>
<td></td>
<td>Linc</td>
<td>The current values of the specified device have been added as the upper and lower limit values of the graph display. Along with improved operation, the dialog box has been changed so that multiple word devices can be specified.</td>
<td>Section 14.2</td>
</tr>
<tr>
<td></td>
<td>Ref</td>
<td>The current values of the specified device have been added as the reference, upper and lower limit values of the graph display. Along with improved operation, the dialog box has been changed so that multiple word devices can be specified.</td>
<td>Section 14.3</td>
</tr>
<tr>
<td></td>
<td>Level</td>
<td>The current values of the specified device have been added as the upper and lower limit values of the graph display.</td>
<td>Section 14.4</td>
</tr>
<tr>
<td>Touch Key</td>
<td></td>
<td>New types of basic figures have been added for touch keys.</td>
<td>Section 15.2.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Along with improved operation, the dialog box for the attributes of touch key figures and text settings has been changed.</td>
<td>Section 15.2.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A word device range specification has been added to the action conditions for the touch key function.</td>
<td>Section 15.2.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Hard Copy Start and Hard Copy Cancel commands have been added to the touch key (expanded) function.</td>
<td>Section 15.7</td>
</tr>
<tr>
<td>Data Input</td>
<td>Numeric Input</td>
<td>A word device range specification has been added to the action conditions for the numeric input function.</td>
<td>Section 16.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Monitoring of PLCs made by other companies is now possible, and settings can be entered for FxCPU and Omron PLC devices.</td>
<td>Section 9.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The internal GOT devices GD0 ~ GD1023 (word devices) and GB0 ~ 1023 (bit devices) have been added as monitor devices.</td>
<td>Section 9.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The current values of up to two types of specified devices can now be specified as calculation equations for the data expression function.</td>
<td>Section 10.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Section 10.3</td>
</tr>
<tr>
<td>Download</td>
<td>Special Func</td>
<td>Along with improved operation, the names of the drive and path containing the special unit monitor data can be now specified.</td>
<td>See Data Transmis-</td>
</tr>
<tr>
<td></td>
<td>Data Download</td>
<td></td>
<td>sion Manual</td>
</tr>
<tr>
<td>Install</td>
<td>OS</td>
<td>A function has been added which allows installation of an option driver (printer). Along with improved operation, the &quot;Install OS&quot; dialog box has been changed.</td>
<td>See Data Transmis-</td>
</tr>
<tr>
<td></td>
<td>ROM BIOS</td>
<td>A function has been added which allows a ROM BIOS to be installed.</td>
<td>sion Manual</td>
</tr>
<tr>
<td>Common</td>
<td>Hard Copy</td>
<td>Settings have been added for the hard copy function.</td>
<td>Section 22.3</td>
</tr>
<tr>
<td></td>
<td>Observe Stat</td>
<td>Settings have been added for the status monitor function.</td>
<td>Section 22.4</td>
</tr>
<tr>
<td></td>
<td>GOT Type</td>
<td>The A861GOT has been added.</td>
<td>Section 4.1</td>
</tr>
<tr>
<td></td>
<td>PC Type</td>
<td>Connections to the FxCPU and Omron PLC are now possible, and a PC type setting has been added.</td>
<td>Section 4.2</td>
</tr>
<tr>
<td>Screen</td>
<td>Scr. Utilize/</td>
<td>The number of units specified for utilization can now be used for a destination screen.</td>
<td>Section 21.3</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Chapter 2

Where to Start
2. Where to Start

2.1 Getting Ready to Start Monitoring with the GOT

This section explains the procedure up to the point where you can start monitoring with the GOT.

1. First, design the screen.

- To design the layout of the screen you want to create, use the graphics paper provided in Appendix 2.

2. Install the graphics software and boot it.

- Install the graphics software in the computer you’re using, and boot the software program.
3. Enter settings for common screen data.

- Enter settings for the operation environment in which the graphics software is to be used, and then for the GOT type for the project data to be created, and the screen switching device.

See Chapter 4, What To Do First.

4. Draw the canvas graphics on the screen, and enter sprite settings.

- Draw the canvas graphics and enter the sprite settings, based on the screen design.

See Chapters 5 to 21.
5. Install the OS program and the communications driver in the GOT, and download the project data.

- Install the operating system program and the communications driver, which are necessary in order to use the GOT for monitoring. Then download the project data you have created.

6. Begin monitoring with the GOT.

- Connect the PC CPU and the GOT, and begin monitoring.
2.2 Using the Panel Kit to Shorten Data Creation Time

- The panel kit can be used to create three-dimensional switch graphics and graph display boxes. The panel kit contains these and many other forms. The graphic to be used can be selected and pasted on the screen, which greatly reduces the amount of time required to create data.

  See Section 18.3, Reading Out a Registered Panel Kit.

- The panel kit makes it easy to enter sprite settings. It contains all of the various types of sprite data with the settings for required items (including graphics). The sprite for which a setting is to be entered is selected and settings entered for monitor devices and the display position.

  See Section 18.3, Reading Out a Registered Panel Kit.
2.3 Checking the Volume of Data While Creating Screen Data

The amount of data that can be downloaded to the GOT is limited to the values noted below.

A maximum of 768 KB of screen data can be stored, but if the expanded function OS is installed, please be aware that the amount of data which can be stored changes as shown below.

(a) With the A870GOT

1. When an option driver (hard copy function) has been installed in the GOT
   - If the expanded function operating systems are not installed ....................... 768 KB
   - If any one expanded function operating system is installed ....................... 512 KB
   - If any two expanded function operating systems are installed ................... 384 KB

2. If no option driver (hard copy function) has been installed in the GOT
   - If the expanded function operating systems are not installed ....................... 768 KB
   - If any one expanded function operating system is installed ....................... 768 KB
   - If any two expanded function operating systems are installed ................... 512 KB
   - If three expanded function operating systems are installed ..................... 384 KB

(b) With the A85□GOT

If no expanded function operating systems have been installed ....................... 768 KB
If the system monitor function operating system has been installed ................ 768 KB
(The circuit monitor function, special unit monitor function, and hard copy function cannot be used.)
With the graphics software, the current volume of data can be checked using the process shown below.

1. On the Communication menu, select [Download] and then [Monitor Data].

2. The "Monitor Data Download" dialog box is displayed.

The total amount of data can be checked here.
2.4 Creating Data as a Team

Project data can be created by dividing up the work among a number of people. The graphics software supports the method of data creation shown below, which enables data created by a number of people to be assembled into a single element of project data afterwards. This is an extremely convenient feature.

See Section 21.2, Combining Data Created by More Than One Person.
2.5 Using Previously Created GOT Data

Previously created GOT data with the SW□□□□-AGOTP can be read using the graphics software, and used as GOT data.

See Section 3.9, Opening Previously Created GOT Data.

(1) Data interchangeability

The following symbols apply to data read with the graphics software:

○ : Previously created GOT data can be read and used just as it is
△ : Some of the data will be different from the data previously created with the GOT
× : This function does not exist on the GOT, so the data will be deleted.

<table>
<thead>
<tr>
<th>Previously created GOT data</th>
<th>Status after conversion</th>
<th>Differences with previously created GOT data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch key function</td>
<td>Switch function</td>
<td>△ Data written to the device using key code settings is deleted.</td>
</tr>
<tr>
<td>Device reading</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key code setting</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device writing with operation panel</td>
<td>Switch function</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Device writing</td>
<td></td>
</tr>
<tr>
<td>Numeric input function</td>
<td>Numeric values</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>Numeric display</td>
<td>Numeric values</td>
<td>△ Character size: 1/4 angle converted to standard character</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>Block data display</td>
<td>Numeric values</td>
<td>△ Divided into individual numeric value displays, Character size: 1/4 angle converted to standard character</td>
</tr>
<tr>
<td></td>
<td>ASCII</td>
<td>Divided into individual ASCII displays, Character size: 1/4 angle converted to standard character</td>
</tr>
<tr>
<td>Clock display</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Character string display</td>
<td>Bit devices</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Word devices</td>
<td></td>
</tr>
<tr>
<td>Alarm list display *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error warning display</td>
<td></td>
<td>× Part display switching: Fixed data is deleted</td>
</tr>
<tr>
<td>Part display</td>
<td>Display</td>
<td>△</td>
</tr>
<tr>
<td></td>
<td>Move</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Trace</td>
<td></td>
</tr>
<tr>
<td>Level display</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Trend graph display</td>
<td>Scroll</td>
<td>△ No. of graphs: More than 9 are invalid</td>
</tr>
<tr>
<td></td>
<td>Overlap</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td>Batch display</td>
<td></td>
</tr>
<tr>
<td>Bar graph display</td>
<td>Normal</td>
<td>○</td>
</tr>
<tr>
<td></td>
<td>Accumulated</td>
<td>×</td>
</tr>
<tr>
<td>Curve graph display</td>
<td></td>
<td>○</td>
</tr>
<tr>
<td>Spline graph display *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scatter graph display</td>
<td>Sample batch display</td>
<td>×</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circle (Column) graph display</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station no. switching function *1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*1. This function is not supplied with the A64GOT.
<table>
<thead>
<tr>
<th>Previously created GOT data</th>
<th>Status after conversion</th>
<th>Differences with previously created GOT data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Straight line</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>Continuous line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rectangle</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filled rectangle</td>
<td>△</td>
<td>Converted to fill pattern in graphics software</td>
</tr>
<tr>
<td>Polygon</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Circle</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>Circular arc</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elliptical arc</td>
<td>△</td>
<td>Elliptical circles with 16 horizontal/vertical dots or less cannot be displayed with the GOT</td>
</tr>
<tr>
<td>Painting</td>
<td>△</td>
<td>Converted to fill pattern in graphics software</td>
</tr>
<tr>
<td>Characters</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphic</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td>△</td>
<td>Attribute: Backward rotation is converted to forward rotation, and becomes graphic character</td>
</tr>
<tr>
<td>Part</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>○</td>
<td>Comment No. 0 is deleted</td>
</tr>
<tr>
<td>Title</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Screen/station no. switching device</td>
<td>△</td>
<td>Station no. switching device is deleted</td>
</tr>
<tr>
<td>Report *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Announce *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timed action *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Snapshot *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special key *1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operation panel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>System information *1</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>Printer type *1</td>
<td>×</td>
<td></td>
</tr>
<tr>
<td>Backlight off time *1</td>
<td>×</td>
<td>Deleted, because it is set by the GOT main unit</td>
</tr>
<tr>
<td>Password</td>
<td>○</td>
<td></td>
</tr>
<tr>
<td>GOT type</td>
<td>△</td>
<td>The GOT types have been changed as shown A77GOT (S3, S5) → A870GOT-TFT, STN A64GOT → A85□GOT-STN, L</td>
</tr>
</tbody>
</table>

*1. This function is not supplied with the A64GOT.

(2) Restrictions on GOT data created with conventional software packages

Data created with the following software programs cannot be read with the graphics software.

![SWC□□□-AD67GP](SWC□□□-AD67GP) ![SWC□□□-GOTP](SWC□□□-GOTP)

(3) Precautions regarding display colors when using data previously created with the GOT

If canvas graphics or sprites drawn or set in previously created GOT data are displayed in gray, this will be converted to beige when opened using the graphics software.
Chapter 3

Creating Data
3. Creating Data

3.1 Creating the First Screen

**When is this function used?**

- When creating a new screen
- When closing the project data currently being created and creating different project data

**POINT**

Only one project can be created and edited with the graphics software.

When the graphics software is booted, one new screen is created as a base screen, so the first screen can be created just as it is.

The procedure below is used to close the current project data which is open, and create new project data.

1. On the Project menu, select [New] and then [Close].

2. A message dialog box is displayed. Follow the guide messages in the dialog box. If the already open project data has not been saved to a hard disk or floppy disk, the data is first saved, before the new data can be created.

   If no file name has been assigned to the already open project data, a name must be assigned and the data saved.

   If a file name has already been assigned to the open project data, the previous data will be overwritten.

3. The project data which is already open will be closed, enabling a new first base screen to be created.
3.2 Creating the Next Screen/Opening a Screen to Edit

- When is this function used?
  
  - To create the next new screen
  - To open the editing screen window in order to edit a screen

1. Select [Load] on the Screen menu.
2. The "Load Screen" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to set</th>
<th>Contents of setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Screen type&quot;</td>
<td>Using the radio button, select the type of screen to be opened.</td>
</tr>
<tr>
<td>&quot;Load No.&quot;</td>
<td>To create the next new screen, or edit a screen, use the spin box to specify the screen number.</td>
</tr>
<tr>
<td>&quot;Screen title list&quot;</td>
<td>To open the screen to be edited, select the screen number with the text box.</td>
</tr>
<tr>
<td>Set title</td>
<td>To specify a title, click on [Set title].</td>
</tr>
<tr>
<td></td>
<td>See Section 20.1, Assigning a Title to the Screen Data.</td>
</tr>
</tbody>
</table>

3. The application window for the selected screen number opens, so you are ready to create or edit the screen.

**POINT**

Up to ten screens (base screens + window screens) can be opened in the application window.
3.3 Overlapping/Lining Up Open Screen Windows

When is this function used?
- To change the order in which windows open in the application window are displayed

1. On the Screen menu, select [Cascade] / [Tile].

2. The screen windows are displayed either superimposed on each other, or lined up next to each other.

Overlapping display

Screen windows are displayed stepwise, from the upper left to the lower right of the screen.
Lined up display

Please select figures or sprites. [No title] X=482, Y=106

Screen windows are displayed next to each other, without overlapping.
3.4 Making the Screen Window to be Edited the Active Window

- When is this function used?
  - When you want to make one of the screen windows open in the application window active

Up to ten screen windows can be opened in the application window, but only one screen at a time can be edited. There are two ways to make a window active:

- Select the screen to be made active from the Screen menu commands.
- Click anywhere on the window to be made active.

1. **Selecting the screen from the Screen menu commands**

1. On the Screen menu, the screen number and title of the window currently open in the application window are displayed as commands. Select the command for the name of the screen to be made active.

<table>
<thead>
<tr>
<th>Screen</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear (L)</td>
<td>B-1 MONITOR Screen 1</td>
</tr>
<tr>
<td>Clear and Load (N)</td>
<td></td>
</tr>
<tr>
<td>Store (S)</td>
<td>B-2 MONITOR Screen 2</td>
</tr>
<tr>
<td>Store As (A)</td>
<td></td>
</tr>
<tr>
<td>Scr. Utilize/Delete (U)</td>
<td>W-1 MONITOR Screen 3</td>
</tr>
<tr>
<td>Preview (V)</td>
<td></td>
</tr>
<tr>
<td>Redisplay (D)</td>
<td></td>
</tr>
<tr>
<td>Cascade (C)</td>
<td></td>
</tr>
<tr>
<td>Tile (T)</td>
<td></td>
</tr>
</tbody>
</table>

Indicates the currently active window

2. The selected screen becomes active.

2. **Click anywhere on the screen window.**

1. Clicking anywhere on a screen window makes it the active screen. If the window to be made active is hidden behind another window, use the overlap/line up function to overlap windows or line them up next to each other.

2. The clicked window becomes the active window.
3.5 Closing the Screen Window from the Application Window

When is this function used?

- To close a screen window from the application window (when more than one screen window is open in the application window)

1. Make the screen window to be closed the active window, and then select [Clear] / [Clear and Load] on the Screen menu.

2. If [Clear] is selected, the specified window is closed, and the foremost window becomes active.

   If [Clear and Load] is selected, the “Open Edit Screen” dialog box is displayed.

   See Section 3.2, Creating the Next Screen/Opening a Screen to Edit.

The screen data in the screen window that is closed is saved in a temporary area.

- To save screen data that has been created or edited to the temporary area without closing the screen window, select [Store].
• What is the temporary area?

This is an area where the screen data from a screen window that has been closed is stored temporarily. The location where the data is to be saved (drive and file name) can be freely selected by the user before the screen data is created.

See Section 4.3, Setting the Operation Environment for the Graphics Software.

The screen data is only stored in the temporary area if the screen window is closed from the application window. All of the data created and/or edited in the application window is stored in the main memory of the computer.

Data in the temporary area should be handled this way:

• In the application window, open the screen window for the screen data stored in the temporary area, and make any necessary corrections.

• After correcting the data, suppose you want to return it to its original status.

• The original data has been stored in the temporary area, so opening that screen window again returns the data to its original status.
3.6 Storing Project Data on a Hard Disk or Floppy Disk

- When is this function used?
  - To store project data that has been created or edited on a hard disk or floppy disk

When project data is stored, the possibilities noted below may apply.

Select the appropriate command on the Project menu, and save the project data to the hard disk or floppy disk.

<table>
<thead>
<tr>
<th>Situation</th>
<th>Command to select</th>
</tr>
</thead>
<tbody>
<tr>
<td>The created project data is being saved to a hard disk or floppy disk for the first time.</td>
<td></td>
</tr>
<tr>
<td>Project data already stored on a hard disk or floppy disk is opened and edited, and the edited project data is saved under a different file name.</td>
<td>![Save As] on the Project menu</td>
</tr>
<tr>
<td>Project data already stored on a hard disk or floppy disk is opened and edited, and is backed up under a different file name.</td>
<td></td>
</tr>
<tr>
<td>Project data already stored on a hard disk or floppy disk is opened and edited, and the edited project data is saved under the current file name.</td>
<td>![Save] on the Project menu</td>
</tr>
</tbody>
</table>

In order to minimize the chances of losing data if a power failure or a system error occurs, project data should be saved periodically.

1. **Save As**

   1. Select ![Save As] on the Project menu.
2. The “Save As” dialog box is displayed.

In the “Drives” list box, select the drive to which the data is to be saved.

In the “Directories” list box, specify the directory containing the file name under which the data is to be saved. If a new directory name is being created, click on [MkDir M]. This displays the “Make Directory” dialog box.

Using the “Name” text box, input the directory name.
(Example) \MONIMA

Click on [OK] in the “Make Directory” dialog box.

The “Save As” dialog box is displayed.

Click on [OK] in the “Save As” dialog box.

3. The project data is saved to the specified directory, so that it is available once more for editing.

The file extension is fixed as “a8gotp.got”.

The directory name and file name must conform to the rules for making such names under MS-DOS.
2. Save

1. Select [Save] on the Project menu.
2. Follow the instructions in the message dialog box which appears.
3. The project data overwrites any previous data stored under that file name, and the data is available once more for editing.

- How is data saved to a hard disk or floppy disk?

When data is saved to a hard disk or floppy disk, the graphics software saves the data as described below.

1. Screen data stored in the temporary area is saved to the hard disk or floppy disk.

2. Screen data in the main memory of the computer (screen data for which the screen window has not been closed from the application window) is saved to a hard disk or floppy disk.

If there is screen data in the internal memory that has the same screen number as that in the temporary area (even though the data itself may be different), the screen data in the internal memory is saved to the hard disk or floppy disk.
3.7 Exiting the Graphics Software Program

When is this function used?

- When exiting the graphics software

1. Select [Exit] on the Project menu.

2. When the message dialog box is displayed, follow the instructions in the box. If the project data in the open window has not been saved to a hard disk or floppy disk, it will be saved at this point. After the data has been saved, the graphics software is exited.

   If no file name has been assigned to the project data in the open window, assign a file name under which the data is to be saved.

   If a file name has been assigned to the project data in the open window, saving the data overwrites any data previously stored under that file name.

3. The graphics software is exited.
3.8 Opening Project Data Stored on a Hard Disk or Floppy Disk

When is this function used?
- To open project data stored on a hard disk or floppy disk, so that it can be edited using the graphics software

1. Select [Open] on the Project menu.

2. When the message dialog box is displayed, follow the instructions in the box. If the project data in the currently open window has not been saved to a hard disk or floppy disk, it will be saved at this point. After the data has been saved, the "Open" dialog box is displayed.

   If no file name has been assigned to the project data in the open window, assign a file name under which the data is to be saved.

   If a file name has been assigned to the project data in the open window, saving the data overwrites any data previously stored under that file name.

3. The "Open" dialog box is displayed.
In the “Drives” list box, select the drive containing the project data.

In the “Directories” list box, specify the name of the directory containing the project data to be opened.

Click on [OK].

4. The specified project data is opened, so that the data in the first base screen can be edited.
3.9 Opening Previously Created GOT Data

When is this function used?

- To open previously created GOT data in the graphics software program

1. On the Project menu, select [Import File] and then [AGOTP Data].

2. When the message dialog box is displayed, follow the instructions in the box. If the project data in the currently open window has not been saved to a hard disk or floppy disk, it will be saved at this point. After the data has been saved, the "Open" dialog box is displayed.

   If no file name has been assigned to the project data in the open window, assign a file name under which the data is to be saved.

   If a file name has been assigned to the project data in the open window, saving the data overwrites any data previously stored under that file name.

3. The "Open" dialog box is displayed.

![Read AGOTP File dialog box]

In the "Drives" list box, select the drive containing the previously created GOT data.

In the "Directories" list box, specify the name of the directory containing the previously created GOT data to be opened.

Click on [OK].
4. The specified previously created GOT data is opened, so that the first base screen can be edited. (The graphics software automatically converts the data to GOT data.)

• Doesn't the parts file have to be opened?

Parts data in the parts file is automatically read by the graphics software, so there is no need to specify the name of the parts file.

However, please be aware that if no parts data was saved with the previously created GOT data opened using the graphics software when the data was saved with the SW□□□□-AGOTP (if the parts file was changed to another drive or the directory of the parts file was changed), the parts data will not be read.

If the parts file was changed to another drive or the directory of the parts file was changed, follow the procedure below, using the SW□□□□-AGOTP.

1. Read out the previously created GOT data opened with the graphics software.
2. Read out the parts file.
3. Save the data.
4. Specify the saved conventional parts data using this procedure.
Chapter 4

What to Do First
4. What to Do First

4.1 Setting the GOT Type

What do I need to set?

- Set the screen size (GOT type) for the project data you are about to create.

**POINT**
This setting is used to determine the screen size, so, for example, even if EL data is used as STN data, the operation will be carried out normally even though the two types of data are displayed in different colors.

1. Select [GOT Type] on the Common menu.
2. The "GOT Type" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;GOT Type&quot;</td>
<td>Using the radio button, select the GOT type for the project data you are about to create.</td>
</tr>
</tbody>
</table>

- What happens if the GOT type is changed partway through the process?

TFT, STN, and EL data have different base screen sizes (areas), so please be aware that if you are creating data, or you open GOT data that has already been saved and change the GOT type, the following results occur.
4.2 Specifying the PC Type

What is this function used?

- This function is used when you want to specify the type of PC for the project data you are about to create.

1. Select [PC Type] on the Common menu.
2. The "PC Type" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;PC Type&quot;</td>
<td>Using the radio button, select the type of CPU to be monitored.</td>
</tr>
</tbody>
</table>

- What happens if I change the PC type while I'm still creating data?

Devices which can be accommodated differ for the MELSEC-A, QnACPU, MELSEC-FxCPU, and OMRON PLC, so please be aware that if the PC type is changed while the data is still being created, or project data which has been stored is opened and the PC type changed, the device will be changed. Check the individual sprite function to see if devices have been changed. If there is no device which corresponds to the updated PC type, the PC type set earlier will be deleted, so the monitor device has to be specified once again. The notation "??" will be displayed for the "Display Device" entry.
4.3 Setting Screen Switching Devices

What do I need to set?

- Set the device used to switch the base screen displayed on the GOT.
- Set the device used to switch the window screen displayed on the base screen.

2. The "Switching Screen Device" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Device to switch base&quot;</td>
<td>Click on [Dev.]. This displays the &quot;Device Set&quot; dialog box, where you can specify the</td>
</tr>
<tr>
<td>&quot;Device to switch window screen&quot;</td>
<td>NW number, the station number, the device name, and the device number.</td>
</tr>
<tr>
<td></td>
<td>See Section 10.1, Setting the Device to be Monitored.</td>
</tr>
</tbody>
</table>

**POINT**

To avoid using the PC CPU device to switch the screen, the GOT has two screen switching devices of its own, GD0 and GD1 (GOT data registers).

If you are not using the PC CPU device, set GD0 and GD1 as the screen switching devices. If you use these, however, please be aware that screens cannot be switched from the PC CPU.

If you do not want to use the PC CPU device to switch the screen, use GD0 – 1023 (GOT data registers).
• Why do screen switching devices need to be set?

The GOT is designed to display the screen that corresponds to the value stored in the specified device, so a device needs to be specified.

Since the value of the base screen switching device is 10, the base screen with a screen number of 10 will be displayed.

Screens are switched by changing the value of the PC CPU screen switching device.

• Using touch switches to change screens

See Section 15.7, Setting the Touch Switch (Base Switching) Function
See Section 15.5, Setting the Touch Switch (Window Switching) Function
Does a value have to be stored for the base screen switching device when the power to the GOT is turned on?

- When the value for the base screen switching device is 0, the GOT forcibly displays the No. 1 base screen. Therefore, no value has to be stored in the sequence program for base screen switching when the power is turned on.

- When the power to the GOT is turned on, if the value for the base screen switching device is a value from 1 to 1024 but there is no screen number which corresponds to the set value, nothing will be displayed. Make sure the set value corresponds to an actual screen number.

- If an attempt is made to change from the currently displayed screen to a screen number which has not been downloaded, or if the number specified for the base screen switching device is 1025 or higher, the screen switching command will be ignored, and the current screen will continue to be displayed.
4.4 Setting the Operation Environment for the Graphics Software

**What do I need to set?**

- Set the temporary area where the screen data is to be stored temporarily, using the “Work area” parameter.
- Specify whether the specified project data is to be opened the next time that the graphics software is run, or whether new data is to be created when the program is booted, using the “Project of edit” parameter.
- Select [Store] on the File menu or Screen menu, and specify whether or not a message dialog box is to be displayed when project data or screen data is saved, using the “Overwrite message” parameter.

**POINT**

When the graphics software is run the next time, it will boot under the operation environment parameters set here.

2. The “File Option” dialog box is displayed.

![File Option dialog box](image)
<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Work area&quot;</td>
<td>Click on [Browse] . The &quot;Browse&quot; dialog box is displayed, so the drive and directory containing the temporary area can be specified.</td>
</tr>
<tr>
<td>&quot;Project of edit&quot;</td>
<td>Using the radio buttons, select the status for the next time that the graphics software is booted. &quot;Select every time&quot; ..... The system will be ready for new data to be created the next time the software is booted. &quot;Fixed&quot; ..................... The specified project data will be opened the next time that the software is booted. If &quot;Fixed&quot; is selected, click on [Browse] . This displays the &quot;Browse&quot; dialog box, where the drive and directory containing the project data can be specified.</td>
</tr>
</tbody>
</table>
| "Overwrite message" | To turn off the "Overwrite message" confirmation dialog box so it is not displayed, select the check box and delete the "X" mark in it.  

Select  

![Overwrite message](image)

Replace existing file?  

Yes  

No  

Overwrite message  

Data is overwritten and new data saved. |
4.5 Setting Devices to Check GOT Operation (System Information)

What do I need to set?
- Set the device used to check GOT operation with the PC CPU.

1. Select [System Information] on the Common menu.
2. The "System Information" dialog box is displayed.

![System Information Dialog Box]

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Read device&quot; &quot;Write device&quot;</td>
<td>Click on [Dev]. The &quot;Device Set&quot; dialog box is displayed. Specify the NI number, station number, device name, and device number.</td>
</tr>
</tbody>
</table>

See Section 10.1, Setting the Device to be Monitored.

**POINT**
- One word is assigned as system information for the reading device. For the writing device, 15 words starting from the first device are assigned as system information.
- Settings should be entered in such a way that the system information devices do not overlap the screen switching devices.
- Special registers should not be used as system information devices.
• What kind of information is stored in the specified devices?
  - Reading device .............. The GOT operation status is written to the device.
    The GOT scans the written information every 5 seconds.
  - Writing device .............. This writes the current operating status from the GOT to the device.
    Each time the operation status is changed, the GOT writes the updated information to the device. Information should not be written to the writing device from the PC CPU.

<table>
<thead>
<tr>
<th>Reading device/Writing device</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reading device</td>
<td>System signal 1 area</td>
</tr>
<tr>
<td>+0</td>
<td>System signal 2 area</td>
</tr>
<tr>
<td>+1</td>
<td>GOT error code storage area</td>
</tr>
<tr>
<td>+2</td>
<td>Storage area for base screen number during display</td>
</tr>
<tr>
<td>+3</td>
<td>Storage area for window screen number during display</td>
</tr>
<tr>
<td>Writing device</td>
<td>+4 Not used</td>
</tr>
<tr>
<td>+5</td>
<td>Storage area for current cursor position</td>
</tr>
<tr>
<td>+6</td>
<td>Storage area for previous cursor position</td>
</tr>
<tr>
<td>+7</td>
<td>Storage area for input key code</td>
</tr>
<tr>
<td>+8</td>
<td>Not used</td>
</tr>
<tr>
<td>+14</td>
<td></td>
</tr>
</tbody>
</table>

(1) Contents of system signal 1 area

- Automatic screen saver invalid signal
- Forced screen saver signal
- Input key readout completed signal
- GOT error reset signal

Use prohibited
• Automatic screen saver invalid signal (Bit 0)

If the screen has currently been turned off by the screen saver function, turning this bit on displays the screen. Turning it off turns off the display.

If the screen saver timing is specified with the screen displayed, turning this bit on renders the specified timing invalid and keeps the screen displayed all the time.

Turning this bit off makes the specified screen saver timing effective.

• Forced screen saver signal (Bit 1)

Turning this bit on causes the display to be forcibly turned off. While this bit is on, the screen will not be displayed even if the GOT screen is touched. Turning this bit off displays the screen.

Please be aware that, even if the bit of the forced screen saver signal is on, if the bit of the automatic screen saver invalid signal is on, the screen display will not be turned off.
• Input key readout completed signal (Bit 3)
  See (8) Contents of the input key code storage area.

• GOT error reset signal (Bit 13)
  See (3) Contents of the GOT error code storage area.

(2) Contents of the system signal 2 area

- GOT ready signal (Bit 1)
  When the power supply is turned on, this bit is turned on if the GOT is operating normally.
  If this bit remains off, there may be a problem with the hardware, and the unit should be replaced.

- Input key signal (Bit 3)
  See (8) Contents of the input key code storage area.

- GOT error detection signal (Bit 13)
  See (3) Contents of the GOT error code storage area.
4. What to Do First

(3) Contents of the GOT error code storage area

If an error occurs in the GOT, the error code is stored here, and the system signal 2, which is the GOT error detection signal (Bit 13), is turn on.

If several error codes are produced at the same time, the last error code to be produced is stored here.

Checking the error code and eliminating the cause of the problem does not clear the GOT error code storage error or the GOT error detection signal.

To clear these, turn on the system signal 1, which is the GOT error reset signal (Bit 13).

(4) Storage area for base screen number during display

The number of the screen currently displayed on the GOT is displayed here.

If -1 is stored here : A utility function screen is displayed
If 0 is stored here : Nothing is displayed, or the screen is being switched
If 1~1024 is displayed : The base screen with the screen number corresponding to the numeric value stored here is displayed

(5) Storage area for window screen number during display

If 0 is stored here : Nothing is displayed, or the window screen is being switched
If 1~1024 is displayed : The window screen with the screen number corresponding to the numeric value stored here is displayed

(6) Contents of the current cursor position storage area

This contains the sprite ID number of the currently displayed cursor for input. When sprites are being set, the graphics software assigns sprite ID numbers automatically. To confirm the sprite ID number, select [Print] on the Project menu, and print out the sprite ID number.

The sprite ID number can be confirmed by selecting "Preview" and then "Sprite ID" on the Screen menu.
(7) Contents of the previous cursor position storage area

This contains the sprite ID number of the previously displayed cursor for input. When sprites are being set, the graphics software assigns sprite ID numbers automatically. To confirm the sprite ID number, select [Print] on the Project menu, and print out the sprite ID number.

The sprite ID number can be confirmed by selecting "Preview" and then "Sprite ID" on the Screen menu.

(8) Contents of the input key code storage area

When the touch switch specified by the key code is input, the key code is stored here, and the system signal 2, which is the key input signal (Bit 3) is turned on.

The timing at which the touch switch is input can be confirmed by checking the system signal 2, which is the key input signal (Bit 3).

The input key code storage area and input key signal are not cleared by concluding the touch switch input. To clear these, turn on the system signal 1 input key readout completed signal (Bit 3).
4.6 Registering a Password for the Project Data

- What do I need to set?
  - Register a password for the project data.

POINT
When a password has been registered, the matching password must be entered before data can be uploaded. If no password is necessary, this step can be skipped.

2. The "Password" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Password&quot;</td>
<td>Click on [Register].</td>
</tr>
<tr>
<td></td>
<td>This displays the &quot;Input Password&quot; dialog box, where the password can be input.</td>
</tr>
<tr>
<td></td>
<td>Passwords can consist of 1 ~ 8 characters.</td>
</tr>
<tr>
<td></td>
<td>If you forget your password, you will not be able to upload data or change the password, so make sure you remember the registered password.</td>
</tr>
</tbody>
</table>

- Changing or deleting the registered password once
  - Changing the registered password
    Clicking on [Register] in the "Password" dialog box displays the "Verify Password" dialog box. Input the registered password and then the new password. Passwords can only be changed if the input password matches the one already registered.
  - Deleting the registered password
    Clicking on [Delete] in the "Password" dialog box displays the "Verify Password" dialog box. Input the registered password and then delete it. Passwords can only be deleted if the input password matches the one already registered.
4.7 Registering a Title and ID Number for the Project Data

What do I need to set?

- Assign a title for the project data you are about to create.
- Register an ID number for the project data.

**POINT**
If no title or ID number is necessary, this step can be skipped.

1. On the Common menu, select [Title] and then [Project].
2. The “Project Title” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Project title&quot;</td>
<td>Enter a title for the project data in the text box. Titles can consist of up to 32 characters.</td>
</tr>
<tr>
<td>&quot;Project ID&quot;</td>
<td>Using the spin box, specify an ID number for the project. The number is input in half-width characters. (1~4294967295)</td>
</tr>
<tr>
<td>&quot;Detailed explanation&quot;</td>
<td>If necessary, an explanation of the project data can be input in the text box. The explanation can consist of up to 512 characters.</td>
</tr>
<tr>
<td>&quot;Author&quot;</td>
<td>If necessary, input the name of the person creating the data.</td>
</tr>
</tbody>
</table>

- Why does a project ID number have to be registered?

This is to make sure that the downloaded project data is kept separate from other project data. If any of the data from another project is downloaded along with the data for the pertinent project, the ID numbers are verified to make sure the data from the two projects is not mixed together.
Chapter 5

Drawing Canvas Graphics and Preparing to Enter Sprite Settings
5. Drawing Canvas Graphics and Preparing to Enter Sprite Settings

5.1 Displaying a Grid on the Screen Window

Why does this need to be done?

- This makes it easier to draw canvas figures and enter settings for sprites.

1. On the Project menu, select [Option] and then [View].
2. The "View Option" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Grid&quot;</td>
<td>Using the radio button, select whether or not a grid is to be displayed on the screen window. &quot;Front&quot; Displays a grid on the foremost screen. (The grid spacing is fixed at 16 dots.) The grid display is not hidden if you use drawing elements such as painted figures. &quot;Back&quot; Displays a grid on the screen at the back. (The grid spacing is fixed at 16 dots.) The grid display is hidden if you use drawing elements such as painted figures. &quot;None&quot; No grid is displayed.</td>
</tr>
<tr>
<td>&quot;Item&quot;</td>
<td>See Section 5.2, Deleting the Tool Bar and Status Bar From the Application Window.</td>
</tr>
<tr>
<td>&quot;Cursor move&quot;</td>
<td>See Section 5.3, Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set.</td>
</tr>
<tr>
<td>&quot;Zoom&quot;</td>
<td>See Section 5.4, Enlarging the Screen Window to Draw Small Graphics.</td>
</tr>
<tr>
<td>&quot;Display paint&quot;</td>
<td>See Section 6.6.9, Painting Areas Within a Line and Polygons.</td>
</tr>
</tbody>
</table>
### 5.2 Deleting the Tool Bar and Status Bar from the Application Window

**Why does this need to be done?**

- This is to broaden the work area of the screen window when the tool bars and status bar are not being used.

1. On the Project menu, select [Option] and then [View].
2. The “View Option” dialog box is displayed.

![View Option dialog box](Image)

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Item”</td>
<td>Select the check box for Tool Bar 1 or Tool Bar 2, whichever is to be deleted, and delete the “X” mark. Deleting Tool Bar 1 and Tool Bar 2 extends the display range of the screen window.</td>
</tr>
<tr>
<td>“Grid”</td>
<td>See Section 5.1, Displaying a Grid on the Screen Window.</td>
</tr>
<tr>
<td>“Cursor move”</td>
<td>See Section 5.3, Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set.</td>
</tr>
<tr>
<td>“Zoom”</td>
<td>See Section 5.4, Enlarging the Screen Window to Draw Small Graphics.</td>
</tr>
<tr>
<td>“Display paint”</td>
<td>See Section 6.6.9, Painting Areas Within a Line and Polygons.</td>
</tr>
</tbody>
</table>

![Tool bars deleted](Image)
5.3 Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set

Why does this need to be done?
- This makes it easier to position the figures which are drawn and/or moved, and sprites which are set and/or moved.

1. On the Project menu, select [Option] and then [View].
2. The "View Option" dialog box is displayed.

Settings for automatic positioning can also be entered using the list box for the "Cursor move" command on Tool Bar 2.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Cursor move&quot;</td>
<td>Using the list box, select the dot unit in which automatic positioning is to be carried out.</td>
</tr>
<tr>
<td>&quot;Grid&quot;</td>
<td>See Section 5.1, Displaying a Grid on the Screen Window.</td>
</tr>
<tr>
<td>&quot;Item&quot;</td>
<td>See Section 5.2, Deleting the Tool Bar and Status Bar From the Application Window.</td>
</tr>
<tr>
<td>&quot;Zoom&quot;</td>
<td>See Section 5.4, Enlarging the Screen Window to Draw Small Graphics.</td>
</tr>
<tr>
<td>&quot;Display paint&quot;</td>
<td>See Section 6.6.9, Painting Areas Within a Line and Polygons.</td>
</tr>
</tbody>
</table>
• What happens when a figure is drawn or moved?

(Example) If a rectangle is drawn using 16 dots, the following results:

The current cursor position is (X = 10, Y = 12). To set this as the starting point, press the left button of the mouse. This positions the starting point at the coordinates closest to the position 16 times the current cursor position (X = 16, Y = 16).

![Diagram of cursor movement](image)

Current cursor position (X = 10, Y = 12)  

Positioned at location nearest to 16 x coordinates (X = 16, Y = 16)

When the cursor is moved to determine the ending point, the cursor moves only to the position nearest that which is 16 times the coordinates. The cursor cannot move to any position which is not a multiple of 16 times the coordinates.

![Diagram of cursor movement](image)

Cursor movement

Cursor movement

Entering an **↑↓←→** on the keyboard at this point moves 16 dots.

**POINT**

If "Cursor move" is set to 1 dot, each time the arrow key on the keyboard is entered, the cursor moves one dot. This makes it easier to position the cursor on finely detailed graphics.

![Diagram of cursor movement](image)

The same process as that shown above is used to determine the position at which a sprite is displayed and to move a figure: the cursor moves in the dot unit specified by the "Cursor move" parameter, and moves by the specified dot unit each time an arrow key on the keyboard is entered.
5.4 Enlarging / Reducing the Screen Window

**What's the purpose of this function?**

- To make it easier to draw graphics on the screen window.

1. Using the scroll bars, display the section of the screen window to be enlarged.
2. Select [Option] and then [View] on the Project menu.
3. The "View Option" dialog box is displayed.

Enlarging the screen window can also be entered using the list box on Tool Bar 2.

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Zoom&quot;</td>
<td>Using the radio button, select the magnification to be used for enlargement or reduction.</td>
</tr>
<tr>
<td>&quot;Grid&quot;</td>
<td>See Section 5.1, Displaying a Grid on the Screen Window.</td>
</tr>
<tr>
<td>&quot;Item&quot;</td>
<td>See Section 5.2, Deleting the Tool Bar and Status Bar From the Application Window.</td>
</tr>
<tr>
<td>&quot;Cursor move&quot;</td>
<td>See Section 5.3, Graphics Drawn in Specified Dot Units/Automatic Positioning of Sprites to be Set.</td>
</tr>
<tr>
<td>&quot;Display paint&quot;</td>
<td>See Section 6.6.9, Painting Areas Within a Line and Polygons.</td>
</tr>
</tbody>
</table>
Chapter 6

Drawing Canvas Graphics
6. Drawing Canvas Graphics

6.1 Figures and Text Characters That Can Be Drawn

(1) Types of figures

The types of figures and text characters that can be drawn are shown below.

<table>
<thead>
<tr>
<th>Figure</th>
<th>Example</th>
<th>Selectable Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Straight line</td>
<td><img src="image" alt="Straight line" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Continuous line</td>
<td><img src="image" alt="Continuous line" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="image" alt="Rectangle" /></td>
<td>Line type, line width, display color, painting pattern, pattern color</td>
</tr>
<tr>
<td>Polygon</td>
<td><img src="image" alt="Polygon" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Circle (oval)</td>
<td><img src="image" alt="Circle (oval)" /></td>
<td>Line type, line width, display color, painting pattern, pattern color</td>
</tr>
<tr>
<td>Circular arc (elliptical arc)</td>
<td><img src="image" alt="Circular arc" /></td>
<td>Line type, line width, display color</td>
</tr>
<tr>
<td>Painted closed area Painted polygon</td>
<td><img src="image" alt="Painted closed area" /></td>
<td>Painting pattern, pattern color</td>
</tr>
<tr>
<td>Graphics data in bitmap file format</td>
<td><img src="image" alt="Graphics data in bitmap file format" /></td>
<td></td>
</tr>
<tr>
<td>Text</td>
<td><img src="image" alt="Text" /></td>
<td>Display color, text enlargement</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Text" /></td>
<td>Text ornamentation, outline color, direction in which text is displayed</td>
</tr>
</tbody>
</table>
(2) Types of attributes that can be selected

The types of attributes that can be selected are shown below.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line type</td>
<td>Solid line, Broken line, Dotted line, Alternate dots and dashes, Alternate double dots and dashes</td>
</tr>
<tr>
<td>Line width</td>
<td>1dot, 2dots, 3dots, 4dots</td>
</tr>
<tr>
<td>Selectable display colors</td>
<td>White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple</td>
</tr>
<tr>
<td>How attribute is</td>
<td>With the A870GOT-EL: All display colors other than black are displayed in the same color (orange).</td>
</tr>
<tr>
<td>displayed on GOT</td>
<td>With the A870GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-TFT: Selected display colors are displayed.</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-L: All display colors other than black are displayed in the same color (black).</td>
</tr>
<tr>
<td>Painting pattern</td>
<td><img src="image" alt="Painting pattern" /></td>
</tr>
<tr>
<td>Selectable pattern colors</td>
<td>White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple</td>
</tr>
<tr>
<td>How attribute is</td>
<td>With the A870GOT EL: All display colors other than black are displayed in the same color (orange).</td>
</tr>
<tr>
<td>displayed on GOT</td>
<td>With the A870GOT-STN: All dark colors are displayed as the original color</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-TFT: Selected display colors are displayed.</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-L: All display colors other than black are displayed in the same color (black).</td>
</tr>
<tr>
<td></td>
<td>With the A85□GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
</tbody>
</table>

• Graphics in bitmap file format

The only graphics in the BMP file format which can be displayed on the GOT are parts graphics.

If the GOT is an EL model, the only graphic data which can be displayed is BMP file format graphic data which has been converted to two-tone (monochrome) data.
- How much are characters enlarged at the various magnifications?

  - Full-width characters (16 dots vertical) x 16 dots (horizontal)

<table>
<thead>
<tr>
<th>Vertical magnification</th>
<th>0.5 times</th>
<th>1 time</th>
<th>2 times</th>
<th>4 times</th>
<th>8 times</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
<td>Horizontal: 128 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
<td>Horizontal: 128 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
<td>Horizontal: 128 dots</td>
</tr>
<tr>
<td>4 times</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
<td>Horizontal: 128 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
<td>Horizontal: 128 dots</td>
</tr>
</tbody>
</table>

- Half-width characters (16 dots vertical) x 8 dots (horizontal)

<table>
<thead>
<tr>
<th>Vertical magnification</th>
<th>0.5 times</th>
<th>1 time</th>
<th>2 times</th>
<th>4 times</th>
<th>8 times</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
<td>Vertical: 8 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 4 dots</td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 4 dots</td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 4 dots</td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
</tr>
<tr>
<td>4 times</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
<td>Vertical: 64 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 4 dots</td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 4 dots</td>
<td>Horizontal: 8 dots</td>
<td>Horizontal: 16 dots</td>
<td>Horizontal: 32 dots</td>
<td>Horizontal: 64 dots</td>
</tr>
</tbody>
</table>
### 6.2 Memory Required for Figures and Text Characters

The amount of memory required to draw figures and characters is shown below. Figures require the amount of memory stated below, regardless of the type of attributes and size.

<table>
<thead>
<tr>
<th>Figure</th>
<th>Amount of memory (bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Straight line</td>
<td>36</td>
</tr>
<tr>
<td>Continuous line</td>
<td>(32 + 4 \times n) (n = \text{no. of vertices})</td>
</tr>
<tr>
<td>Rectangle</td>
<td>28</td>
</tr>
<tr>
<td>Polygon</td>
<td>(32 + 4 \times n) (n = \text{no. of vertices}) (starting point and ending point are also each counted as 1 vertex)</td>
</tr>
<tr>
<td>Circle (oval)</td>
<td>28</td>
</tr>
<tr>
<td>Circular arc (elliptical arc)</td>
<td>40</td>
</tr>
<tr>
<td>Painted polygon</td>
<td></td>
</tr>
<tr>
<td>Painted closed area</td>
<td>28</td>
</tr>
<tr>
<td>Graphic data in bitmap file format</td>
<td>This should be checked for the application used to create the graphic data in the bitmap file format.</td>
</tr>
<tr>
<td>Characters</td>
<td>(36 + 2 \times n) (n = \text{no. of characters}) (memory amount is that stated at left, regardless of whether characters are full- or half-width)</td>
</tr>
</tbody>
</table>
6.3 Overlapping Graphics

When you draw canvas graphics on base screens and window screens, there may be times when two figures overlap each other, or when characters and a figure overlap.

When drawing with the graphics software and displaying overlapping figures on the GOT, there are no particular restrictions which apply.

Any graphics which can be drawn with the graphics software and displayed on the computer can also be displayed on the GOT, without requiring any modification.

The order in which figures are overlapped can be changed.

See Section 7.4.4, Changing the Order of Overlapped Graphics or Characters.
6.4 Setting Attributes for Graphics

At this step, let's determine the attributes for the graphic we are about to draw. The figure can be drawn once the attributes have been decided.

There are two ways to specify attributes:

- Selecting them from Tool Bar 2
- Selecting them from the "Change Attribute" dialog box

1. Selecting attributes from Tool Bar 2

The attributes of the figure to be drawn are selected by opening the appropriate list box.

The attributes selected in the various list boxes are displayed on Tool Bar 2. After drawing the figure, the attributes can be changed by using the corresponding list boxes on Tool Bar 2.

**POINT**

If an area enclosed by a line is painted, when inputting text in that area, attributes can be decided after the icon or command has been selected.
Selecting attributes from the "Change Attribute" dialog box

1. Move the cursor to a position in the screen window where there is no figure or sprite, and double-click the mouse button to select [Attribute] on the Edit menu.

2. The "Change Attribute" dialog box is displayed.

```
<table>
<thead>
<tr>
<th>Tab name</th>
<th>Item to set</th>
<th>Description of item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>&quot;Style&quot;</td>
<td>Select the line style for the figure from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Width&quot;</td>
<td>Select the line width for the figure from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which lines of the figure are to be displayed.</td>
</tr>
<tr>
<td>Pattern</td>
<td>&quot;Type&quot;</td>
<td>Select the painting pattern to be used for painted figures from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which the painting pattern is to be displayed.</td>
</tr>
<tr>
<td>Text</td>
<td>&quot;Horizontal&quot;</td>
<td>Select the horizontal magnification of the text from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Vertical&quot;</td>
<td>Select the vertical magnification of the text from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which text is to be displayed.</td>
</tr>
</tbody>
</table>
6.5 Items to Know before Starting to Draw

(1) The same figure, with the same attributes, can be drawn more than once in succession.

(2) Once the starting point of the figure has been decided, ESC can be used to interrupt the process.

(3) Lines with a width of 2 - 4 dots are positioned as shown below, in relation to the starting point position.
(4) If another figure is being drawn after drawing a straight-line figure, the same attributes will continue to be effective even if another icon or command is selected.

(5) If the figure is being drawn from the keyboard, use the following keys for input.

**Straight lines, rectangles, and circular arcs**

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine starting point</td>
<td>Enter</td>
</tr>
<tr>
<td>Move cursor</td>
<td>↑, ↓, ←, →</td>
</tr>
<tr>
<td>Determine ending point</td>
<td>Enter</td>
</tr>
<tr>
<td>Interrupt after starting point has been determined</td>
<td>ESC</td>
</tr>
</tbody>
</table>

**Continuous lines and polygons**

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Determine starting point</td>
<td>Enter</td>
</tr>
<tr>
<td>Move cursor</td>
<td>↑, ↓, ←, →</td>
</tr>
<tr>
<td>Determine edge</td>
<td>Enter</td>
</tr>
<tr>
<td>Determine ending point</td>
<td>Enter → Enter</td>
</tr>
<tr>
<td>Interrupt after starting point has been determined</td>
<td>ESC</td>
</tr>
<tr>
<td>Delete previously determined edge</td>
<td>BS / Back Space</td>
</tr>
</tbody>
</table>

(6) When drawing circles and circular arcs, the circle or circular arc will be drawn with a line width of 1 dot even if a line width of 2 or more dots has been selected.

(7) If a figure is drawn using a line style other than a solid line (broken, dotted, two dots with a dash) and the line width is 2 or more dots, there may be times when the figure cannot be displayed properly by the graphics software. (This problem occurs when the screen window has been enlarged.) The figure will be displayed with the line attributes selected with the GOT, however.
6.6 Drawing Figures and Text Characters

There are two ways to draw figures: by selecting an icon on Tool Bar 1, or by selecting a command on the Draw menu.

6.6.1 Drawing Straight Lines

<table>
<thead>
<tr>
<th>Tool Bar 1</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
<tr>
<td>![Drawing Icon]</td>
<td>On Draw menu:</td>
</tr>
<tr>
<td></td>
<td>[Draw Figure] ➔ Line</td>
</tr>
</tbody>
</table>

1. Decide the attributes of the straight line.

2. Move the cursor to the starting point of the line.

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse.

4. At the ending point, release the left button of the mouse.
### 6.6.2 Drawing Continuous Lines

<table>
<thead>
<tr>
<th>Tool Bar 1</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
</tbody>
</table>

- ![Diagram](image)

1. Decide the attributes of the continuous line.
2. Move the cursor to the starting point of the line.
3. Press the left button of the mouse on the starting point, and move the cursor to the first edge position by dragging it with the mouse.

- ![Diagram](image)

4. At the first edge position, release the left button of the mouse.

- ![Diagram](image)

5. Move the cursor to the next edge position, and click there.

- ![Diagram](image)

6. Repeat the above step until all of the edges have been added, and then double-click at the ending point.

- ![Diagram](image)
6.6.3 Drawing Rectangles

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:
Draw Figure → Rectangle

1. Decide the attributes of the rectangle.

2. Move the cursor to the starting point of the rectangle.

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse. To draw a square, hold down Shift while dragging the mouse.

4. At the ending point, release the left button of the mouse.
6.4 Drawing Polygons

<table>
<thead>
<tr>
<th>Tool Bar 1</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
<tr>
<td><img src="triangle.png" alt="Triangle Icon" /></td>
<td>On Draw menu: [Draw Figure] → [Polygon]</td>
</tr>
</tbody>
</table>

1. Decide the attributes of the polygon.
2. Move the cursor to the starting point of the polygon.
3. Press the left button of the mouse on the starting point, and move the cursor to the first edge position by dragging it with the mouse.

![First Edge Position](first_edge.png)

4. At the first edge position, release the left button of the mouse.

![Release Position](release_position.png)

5. Move the cursor to the next edge position, and click there.

![Next Edge Position](next_edge.png)

6. Repeat the above step until all of the edges have been added, and then double-click at the ending point.

![Completed Polygon](completed_polygon.png)
### 6.6.5 Drawing Circles

<table>
<thead>
<tr>
<th>Tool Bar 1</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
<tr>
<td><img src="image" alt="Circle Icon" /></td>
<td>On Draw menu:</td>
</tr>
<tr>
<td></td>
<td>Draw Figure → Circle</td>
</tr>
</tbody>
</table>

1. Decide the attributes of the circle.
2. Move the cursor to the starting point of the circle.

![Starting Point](image)

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse.

![Dragging](image)

4. At the ending point, release the left button of the mouse.

![Completed Circle](image)
6.6.6 Drawing Ovals and Painted Ovals

There are no icons or commands for drawing an ellipsis or oval. Use the method below for this figure.

1. Decide the attributes of the oval.
2. Follow the steps in Section 6.6.5 above to draw a circle.

3. Switch the cursor to the graphic editing cursor.

See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.

4. Move the cursor to a handle which is not positioned on the four sides around the circle.

5. Press the left button of the mouse at the handle position, and drag the mouse until the circle changes to the desired oval shape.

6. Release the left button of the mouse.
6.6.7 Drawing Circular Arcs

<table>
<thead>
<tr>
<th>Tool Bar 1</th>
<th>Menu Bar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected icon</td>
<td>Selected command</td>
</tr>
<tr>
<td><img src="image" alt="Arc icon" /></td>
<td>On Draw menu:</td>
</tr>
<tr>
<td></td>
<td>Draw Figure (\rightarrow) Arc</td>
</tr>
</tbody>
</table>

1. Decide the attributes of the circular arc.
2. Move the cursor to the starting point of the arc.

![Cursor at starting point](image)

3. Press the left button of the mouse on the starting point, and move the cursor to the ending point by dragging it with the mouse.

![Arc being drawn](image)

4. At the ending point, release the left button of the mouse.

![Completed arc](image)
6.6.8 Drawing Oval Arcs

There are no icons or commands for drawing an oval arc. Use the method below for this figure.

1. Decide the attributes of the oval arc.

2. Follow the steps in Section 6.0.7 above to draw a circular arc.

3. Switch the cursor to the graphic editing cursor.

   See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.

4. Move the cursor to a handle which is not positioned on the four sides around the figure.

5. Press the left button of the mouse at the handle position, and drag the mouse until the figure changes to the desired oval arc.

6. Release the left button of the mouse.
6.6.9 Painting Areas within a Line and Polygons

Before painting a figure, keep the following points in mind.

- The borders of the area to be painted should be solid lines.

![Solid line](Solid line)

- The lines bordering the painted area should be the same color.

- If there is even a slight gap in the painted area, the paint will leak to other areas. Be sure the painted area is solidly closed.

![Solid line](Solid line)
1. The "Change Attribute" dialog box is displayed. Decide the paint attributes.

<table>
<thead>
<tr>
<th>Tab name</th>
<th>Item to set</th>
<th>Description of setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line</td>
<td>&quot;Color&quot;</td>
<td>Select the color in which the border lines around the area to be painted are to be displayed.</td>
</tr>
<tr>
<td>Pattern</td>
<td>&quot;Style&quot;</td>
<td>Select the pattern to be used for painting from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Color&quot;</td>
<td>Select the color in which the painting pattern is to be displayed.</td>
</tr>
</tbody>
</table>

2. Move the cursor to the area to be painted.
3. Click on the area to be painted.

A paint mark is displayed at the clicked position. This is displayed only in the graphics software, and not on the GOT. To edit the painting, select this mark. (This serves the same function as the handles on a figure.)

- Deleting the display of paint from the screen window in the software graphics

With the graphics software, the display of paint can be deleted from the screen window. (The paint remains displayed on the GOT.) To do this, select [View] under [Option] on the Project menu, and in the "View Option" dialog box, select the check box next to "Display paint", and delete the "X" mark.

The paint disappears, leaving only the paint mark. The painted areas of squares and other figures are not deleted.
6.6.10 Entering Text

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:
Draw Figure \[\rightarrow\] Text

1. The "Text" dialog box is displayed.

![Text dialog box]

2. Enter the text in the text input text box. Up to 80 characters can be input using half-width characters.

   (Example) Line Monitor

   **POINT**

   One line on the GOT can display up to 80 half-width characters on a base screen, and up to 40 half-width characters on a window screen.

3. Click on [Change attribute].

4. The "Change Attribute" dialog box is displayed.

   ![Change Attribute dialog box]
<table>
<thead>
<tr>
<th>Tab name</th>
<th>Item to set</th>
<th>Description of setting</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&quot;Style&quot;</td>
<td>Using the list box, select the display format for the text.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Regular .... Text is displayed in the standard style.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bold ........ Text is displayed in the bold type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Solid ........ Text is displayed in outline style.</td>
</tr>
<tr>
<td>Text</td>
<td>&quot;Solid&quot;</td>
<td>If &quot;Text ornamentation&quot; was set to &quot;Solid&quot;, select the outline color from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Text&quot;</td>
<td>Select the color in which text is to be displayed, from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Horizontal&quot;</td>
<td>Select the horizontal magnification of the text from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Vertical&quot;</td>
<td>Select the vertical magnification of the text from the list box.</td>
</tr>
<tr>
<td></td>
<td>&quot;Direction&quot;</td>
<td>Using the radio button, select the direction (horizontal or vertical) in which character strings are to be displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ABCDE</td>
</tr>
</tbody>
</table>

5. Click on [OK] .

6. The “Text” dialog box is displayed once again. Click on [OK]  .

7. A text frame indicating the size of the displayed text is displayed at the upper left of the screen window.

8. Move the cursor to the position at which the text is to be displayed.

9. Click at that position.
- Precautions when displaying text in the vertical direction

Please be aware that characters such as "-", "-", and "0" will be displayed as shown below if the vertical orientation is used.

(Example)

<table>
<thead>
<tr>
<th>Horizontal direction</th>
<th>Vertical direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>A7GT-BUS</td>
<td>A7GT-BUS</td>
</tr>
<tr>
<td>10 - 20</td>
<td>10 - 20</td>
</tr>
</tbody>
</table>

- Text that can be displayed on the GOT

- The following types of text can be displayed on the GOT. All styles of text that can be displayed in the screen window of the graphics software can be displayed on the GOT.

Please be aware that until the input text is actually entered, however, even though the characters have been input, there may be characters which cannot be displayed with the graphics software or whose size changes. This is not a problem once the text has actually been entered.

- For instructions on inputting Japanese text, please refer to the instruction manual that comes with the Japanese FEP being used.

- The GOT can display languages from all over the world, using the Unicode system. Languages that can be displayed include Japanese, Korean, Chinese (Mandarin), English, German, French, and many others.

If text is being entered in different languages (Korean, Chinese, etc.) using the graphic settings software, the graphic settings software should be installed on a DOS/V computer running Windows 3.1 or Windows 95, which are designed to accommodate characters for various languages.
6.7 Pasting Graphics Data in Other Formats (BMP File Format)

Image data that has been read using a scanner, and graphics data in the BMP file format that was created using another application, can be pasted to the screen window and displayed on the GOT.

![Image of graphics pasting]

The following points should be noted before pasting graphics data in the BMP file format to the screen window.

- Graphics data in the BMP file format that can be pasted to the screen window is limited to 16-color bitmap format data. Please be aware that no other types of graphics data can be pasted to the screen window.

- Graphics data in the BMP file format that can be pasted to the screen window can be enlarged or reduced, so use another application to adjust the size, color, and other attributes of the text before pasting it to the screen window.

See Section 7.3.6, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction.

See Section 7.3.7, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Corner Axis.

See Section 7.3.8, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Center Axis.

See Section 7.3.9, Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle without Changing the Horizontal or Vertical Proportion.
1. The "Read Other Form" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to set</th>
<th>Description of setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Drives&quot;</td>
<td>Select the drive containing the graphics data in BMP file format to be pasted on the screen from the list box.</td>
</tr>
<tr>
<td>&quot;Directories&quot;</td>
<td>Select the directory containing the graphics data in BMP file format to be pasted on the screen from the directory box.</td>
</tr>
<tr>
<td>&quot;File Name&quot;</td>
<td>Specify the name of the file containing the graphics data in BMP file format to be pasted on the screen from the file box.</td>
</tr>
</tbody>
</table>

2. Click on OK.
3. The specified graphic in BMP file format is displayed at the upper left of the screen window.

4. Move the cursor to the position where the graphic is to be placed.

5. Click at that position.
Chapter 7

Editing Canvas Graphics after Drawing Them
7. Editing Canvas Graphics after Drawing Them

7.1 Changing the Cursor to the Graphic Editing Cursor

To edit figures and text, first the cursor has to be changed to the graphic editing cursor, and then the figure or text to be edited is selected.

1. On the Edit menu, select [Object of Selection] and then [Figure].

- [Object of Selection] and then [Sprite] are selected to edit a sprite.

- [Object of Selection] and then [Figure and Sprite] are selected when a figure and a sprite are to be edited at the same time.

2. The cursor changes to the graphic editing cursor. Select the figure or text to be edited.

- What happens when [ ] is selected on Tool Bar 1?

  Selecting [ ] on Tool Bar 1 returns the cursor to the status it was in the last time that [Object of Selection] was selected on the Edit menu (the graphic editing cursor, sprite editing cursor, or graphic + sprite editing cursor).

  (Examples)
  - If [Object of Selection] and then [Figure and Sprite] were selected previously, selecting [ ] changes the cursor to the graphic + sprite editing cursor.
  - If [Object of Selection] and then [Figure] were selected previously, selecting [ ] changes the cursor to the graphic editing cursor.
7.2 Selecting the Graphic or Text to Edit

When editing figures or text, handles are first attached to the figure or text to be edited, and then changes are made to the attributes, position, size, or other elements.

After the figure has been drawn, handles are attached to the figure or text.

![Diagram of handles on figure]

7.2.1 Selecting a Single Graphic or Character

1. Using the mouse
   - Change the cursor to the graphic editing cursor.
   - Move the cursor onto a line of the figure or text to be edited, or within the figure.

   **POINT**
   - To edit painting, move the cursor onto one of the lines forming the paint mark (+).

   ![Diagram of single graphic]

   - Click at that point.

2. Using the keyboard
   - Change the cursor to the graphic editing cursor.
   - Using up, down, left, right, move the cursor onto a line of the figure or text to be edited, or within the figure.
   - Press enter twice.
7.2.2 Selecting a Single Graphic or Character from Overlapped Graphics

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Move the cursor onto the overlapping figure or text.

   ![Monitor 1](image1)

   3. Holding down **CTRL** on the keyboard, click at that point.

   ![Monitor 2](image2)

   4. Repeat step 3) above and attach handles to the figure or text to be edited.

   ![Monitor 3](image3)

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Using **↑↓←→**, move the cursor onto the overlapping figure or text.
   3. Holding down **CTRL**, press **Enter** twice.
   4. Repeat step 3) above and attach handles to the figure or text to be edited.
7.2.3  Selecting Multiple Graphics or Characters from a Group in a Screen Window

This function is used when a number of figures are to be included within a square.

There may be times when selecting a number of overlapping figures does not display handles. To avoid this, the figures to be edited should be separated out from the others ahead of time.

1] Using the mouse
1. Change the cursor to the graphic editing cursor.
2. Move the cursor to the position which will serve as the starting point.

3. Press the left button of the mouse at the starting point, and drag the mouse to draw a square that includes all of the figures to be selected.

4. Release the left button of the mouse.

2] Using the keyboard
1. Change the cursor to the graphic editing cursor.
2. Using \[\uparrow, \downarrow, \leftarrow, \rightarrow\], move the cursor to the starting point.
3. Press \[\text{Enter}\] at the starting point, and then move the cursor to draw a square that includes all of the figures to be selected.
4. Press \[\text{Enter}\].
• What happens if the square includes a sprite?

If the cursor has been changed to the graphic editing cursor, handles will not be attached to a sprite even if it is included in the square.

• This function can be used to select all of the graphics on the screen window.
  - Drawing a square that extends from the upper left corner of the screen window to the lower right corner will display handles on all of the graphics on the screen.
  - If no sprites have been specified in the screen window, the [Select All] command on the Edit menu can be used to display handles on all of the figures and text.
  - The [Select All] command on the Edit window can be used to display handles on all of the graphics and sprites in the screen window.
7.2.4 Selecting Disparate Multiple Graphics or Characters in a Screen Window

1. Using the mouse

1. Change the cursor to the graphic editing cursor.
2. Move the cursor onto a line of the figure or text to be selected first.

3. Click at that position.

4. Move the cursor onto a line of the figure or text to be selected next, and hold down \text{SHIFT} on the keyboard while clicking at that position.

Repeat this procedure to display handles on all of the figures and text to be edited.

\textbf{POINT}

To edit painting, move the cursor onto one of the lines forming the paint mark (+).

2. Using the keyboard

1. Change the cursor to the graphic editing cursor.
2. Using \boxed{\text{arrow}}, move the cursor onto the first figure or text to be edited.
3. Press \boxed{\text{Enter}}.
4. Using \boxed{\text{arrow}}, move the cursor onto a line of the figure or text to be selected next, and press \boxed{\text{Enter}} while holding down \boxed{\text{SHIFT}}.

Repeat this procedure to display handles on all of the figures and text to be edited.
### 7.2.5 Deleting One or More Selected Graphics

1. **Using the mouse**
   
   1. Move the cursor to a position on the screen window where there is no setting frame for a figure or sprite.

   ![Diagram 1]

   2. Click at that position.

   ![Diagram 2]

2. **Using the keyboard**

   1. Using the arrow keys, move the cursor to a position on the screen window where there is no setting frame for a figure or sprite.

   2. Press Enter twice.
7.2.6 Deleting One of Several Selected Graphics

1. Using the mouse

1. Holding down \( \text{SHIFT} \) on the keyboard, move the cursor onto a line of the figure or text to be deleted, or within a figure to be deleted.

If figures are overlapping each other, move the cursor onto a line of the figure or text to be deleted.

![Diagram of figures and text](image)

2. Holding down \( \text{SHIFT} \) on the keyboard, click at that position.

![Diagram of figures and text](image)

2. Using the keyboard

1. Holding down \( \text{SHIFT} \) on the keyboard, use \( \uparrow \downarrow \leftarrow \rightarrow \) to move the cursor onto a line of the figure or text to be deleted, or within a figure to be deleted.

If figures are overlapping each other, move the cursor onto a line of the figure or text to be deleted.

2. Holding down \( \text{SHIFT} \), press \( \text{DEL} \) twice.
7.3 Correcting Graphics or Characters

7.3.1 Changing the Attributes of a Graphic

There are two ways to change the attributes of a graphic:

- Change the attribute from Tool Bar 2.
- Change the attribute from the "Change Attribute" dialog box.

1 Changing the attribute from Tool Bar 2

1. Change the cursor to the graphic editing cursor.

2. Select the figure whose attribute is to be changed.

   (If the same attribute is to be changed on several figures at the same time, select all of the figures on which the change is to be made.)

3. Open the list box for changing attributes on the tool bar, and change the attribute.

   See Section 6.4, Setting Attributes for Graphics.

2 Changing the attribute from the "Change Attribute" dialog box

1. Change the cursor to the graphic editing cursor.

2. Select the figure whose attribute is to be changed.

   (If the same attribute is to be changed on several figures at the same time, select all of the figures on which the change is to be made.)

3. Move the cursor onto a line of the figure or text, or within the figure (if several figures have been selected, move it onto a line of any selected figure or text, or within any selected figure), and double-click at that position.

4. This displays the [Attribute] dialog box, where the attribute can be changed.

   See Section 6.4, Setting Attributes for Graphics.
7.3.2 Changing the Attributes of a Character

1. Change the cursor to the graphic editing cursor.

2. Select the character string whose attribute is to be changed. (If the same attribute is to be changed on several character strings at the same time, select all of the character strings on which the change is to be made.)

3. Move the cursor onto the character string whose attribute is to be changed (if several strings have been selected, move it onto any selected string), and double-click at that position.

This can also be done by selecting [Edit Text] on the Edit menu.

4. This displays the "Set Text/Graphic" dialog box, where the attribute can be changed.

See Section 6.6.10, Entering Text.

7.3.3 Changing Graphic and Character Attributes Simultaneously

1. Change the cursor to the graphic editing cursor.

2. Select the figure and character string whose attribute is to be changed.

3. Move the cursor onto either the figure or the character string, or within the figure, and double-click at that position.

4. This displays the "Change Attribute" dialog box, where the attribute can be changed for the figure and character string.

See Section 6.4, Setting Attributes for Graphics.
See Section 6.6.10, Entering Text.
7.3.4 Changing the Size of a Straight Line or Circular Arc after Drawing It

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Select the straight line or arc whose size is to be changed.

   ![Diagram of selecting a line or arc]

   3. Move the cursor to a handle on the straight line or arc.

   ![Diagram showing a handle on a line or arc]

   Changing the size in the vertical direction: Use a vertical handle.
   Changing the size in the horizontal direction: Use a horizontal handle.
   Changing the size in both the vertical and horizontal directions: Use a corner handle.

   4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

   ![Diagram of dragging the cursor to change the size]

   5. At the position where the size is to be changed, release the left button of the mouse.

   ![Diagram showing the final size of the line or arc]

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Select the straight line or arc whose size is to be changed.
   3. Using the arrow keys, move the cursor to a handle on the straight line or arc.
   4. The cursor changes to the size changing cursor. Press Enter, and then use the arrow keys to move the cursor to the position at which the size is to be changed.
   5. At the position where the size is to be changed, press Enter.
7.3.5 Changing the Length of a Specified Segment of a Continuous Line or Polygon

1. Using the mouse

1. Change the cursor to the graphic editing cursor.

2. Select the continuous line or polygon whose border line length is to be changed.

   ![Continuous Line and Polygon Examples]


   The handles are displayed as vertex handles.

4. Move the cursor to the position of a handle where the length of the line is to be changed.

   ![Handle Position Examples]

5. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

   ![Size Changing Examples]

6. At the position where the size is to be changed, release the left button of the mouse.

   ![Release Example]

To cancel the vertex editing function, select [Edit Vertex] on the Edit menu once again.

7 - 12
2] Using the keyboard

1. Change the cursor to the graphic editing cursor.

2. Select the continuous line or polygon whose border line length is to be changed.


4. Using ↑ ↓ ← →, move the cursor to a handle on a line whose length is to be changed.

5. The cursor changes to the size changing cursor. Press Enter, and then use ↑ ↓ ← → to move the cursor to the position at which the line length is to be changed.

6. At the position where the length is to be changed, press Enter.
7.3.6 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.

   ![Diagrams for using the mouse]

   3. If changing the size in the vertical direction, move the cursor to a vertical handle, and if changing in the horizontal direction, move the cursor to a horizontal handle.

   ![Diagrams for selecting size handles]

   4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

   ![Diagrams for dragging cursor]

   5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.
   3. Using up, down, left, and right, move the cursor to a vertical handle if the size is to be changed in the vertical direction, and to a horizontal handle if the size is to be changed in the horizontal direction.

   ![Keyboard diagrams]

   4. The cursor changes to the size changing cursor. Press enter, and then use up, down, left, and right to move the cursor to the position at which the size is to be changed.

   ![Keyboard diagrams for moving cursor]

   5. At the position where the size is to be changed, press enter.
7.3.7 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Corner Axis

1. Using the mouse

1. Change the cursor to the graphic editing cursor.

2. Select the figure whose size is to be changed.

3. Move the cursor to a handle at the corner of the figure.

4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the graphic editing cursor.

2. Select the figure whose size is to be changed.

3. Using the keyboard, move the cursor to a handle at the corner of the figure.

4. The cursor changes to the size changing cursor. Press Enter, and then use the arrow keys to move the cursor to the position at which the size is to be changed.

5. At the position where the size is to be changed, press Enter.
7.3.8 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle in the Horizontal or Vertical Direction, Based on a Center Axis

1. Using the mouse
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.
   3. Move the cursor to a handle at the corner of the figure.
   4. The cursor changes to the size changing cursor. Holding down \texttt{CTRL} on the keyboard, press the left button of the mouse and drag the mouse to the position at which the size is to be changed.
   5. At the position where the size is to be changed, release the left button of the mouse.

2. Using the keyboard
   1. Change the cursor to the graphic editing cursor.
   2. Select the figure whose size is to be changed.
   3. Using \texttt{�} \texttt{�} \texttt{�} \texttt{�}, move the cursor to a handle at the corner of the figure.
   4. The cursor changes to the size changing cursor. Holding down \texttt{CTRL} on the keyboard, press \texttt{Enter}, and then use \texttt{�} \texttt{�} \texttt{�} \texttt{�} to move the cursor to the position at which the size is to be changed.
   5. At the position where the size is to be changed, press \texttt{Enter}.
7.3.9 Changing the Size of a Continuous Line, Polygon, Rectangle, or Circle without Changing the Horizontal to Vertical Proportion

1 Using the mouse
1. Change the cursor to the graphic editing cursor.
2. Select the figure whose size is to be changed.

3. Move the cursor to a handle at the corner of the figure.

4. The cursor changes to the size changing cursor. Holding down [CTRL] and [SHIFT] on the keyboard, press the left button of the mouse and drag the mouse to the position at which the size is to be changed.

5. At the position where the size is to be changed, release the left button of the mouse.

2 Using the keyboard
1. Change the cursor to the graphic editing cursor.
2. Select the figure whose size is to be changed.
3. Using [↑↓←→], move the cursor to a handle at the corner of the figure.
4. The cursor changes to the size changing cursor. Holding down [CTRL] and [SHIFT] on the keyboard, press [ESC], and then, still holding down [CTRL] and [SHIFT], use [↑↓←→] to move the cursor to the position at which the size is to be changed.
5. At the position where the size is to be changed, press [Enter].
7.3.10 Deleting Graphics and Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figure or text to be deleted. (If several figures are to be deleted at the same time, select all of the figures to be deleted.)


**TIPS**
The editing procedure described on this page can also be carried out on sprites at the same time.
7.3.11 Cutting Graphics and Characters and Storing Them on the Clipboard

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be cut. (If several figures are to be cut at the same time, select all of the figures to be cut.)

3. Select the scissors icon $\square$ on Tool Bar 1, or the $\text{Cut}$ command on the Edit menu.

The cut figure is stored on the Clipboard and can be pasted back on the screen window later on, if desired.

See Section 7.4.3, Pasting Graphics and Characters Stored on the Clipboard.
7.3.12 Flipping, Reversing, and Rotating Graphics 90°

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be rotated.

3. Select [Rotate/Flip] on the Edit menu, and then select [Flip Vertical], [Flip Horizontal], or [Rotate Left].

7.3.13 Rotating text

1. Select the character string to be rotated.

   [Horizontal direction]        [Vertical direction]
   ● ABCD ●                    ● CDBA ●

2. Select [Rotate/Flip] and then [Rotate Left] on the Edit menu.

   [Horizontal direction]        [Vertical direction]
   ● AB ●                      ● CB ●

3. To turn the character string upside down, select [Rotate/Flip] and then [Rotate Left] on the Edit menu once again.

   [Horizontal direction]        [Vertical direction]
   ● CDBA ●                    ● ABCD ●
7.4 Editing Graphics and Characters

7.4.1 Moving Graphics and Characters

1. Using the mouse

1. Change the cursor to the graphic editing cursor.

2. Select the figure to be moved. (If several figures are to be moved at the same time, select all of
   the figures to be moved.)

   ![Images of figures and cursors]

3. Move the cursor within the figure to be moved (if several figures are to be moved, move the
cursor within any of them).

   ![Images of figures and cursors]

4. The cursor changes to the movement cursor. Press the left button of the mouse and drag the
   mouse to the position to which the figure is to be moved.

   ![Images of figures and cursors]

5. At the position where the figure is to be moved, release the left button of the mouse.

   ![Images of figures and cursors]

**TIPS**
The editing procedure described on this page can also be carried out on sprites at the same
time.
2. Using the keyboard
1. Change the cursor to the graphic editing cursor.
2. Select the figure to be moved. (If several figures are to be moved, select all of them.)
3. Using \(\uparrow\downarrow\leftarrow\rightarrow\), move the cursor within the figure to be moved (if several figures are to be moved, move the cursor within any of them).
4. The cursor changes to the movement cursor. Press \(\text{Enter}\), and then use \(\uparrow\downarrow\leftarrow\rightarrow\) to move the cursor to the position to which the figure is to be moved.
5. At the position where the figure is to be moved, press \(\text{Enter}\).

7.4.2 Copying Graphics and Characters
1. Change the cursor to the graphic editing cursor.
2. Select the figure to be copied. (If several figures are to be copied at the same time, select all of them.)

![Production Quantity Monitor](image)

![Copy](image)

3. Select the \(\text{Copy}\) icon on Tool Bar 1, or select \(\text{Copy}\) on the Edit menu.
4. The selected figure is stored on the Clipboard.

![Clipboard](image)

\(\text{Production Quantity Monitor}\)

![Clipboard](image)

\(\text{Copy}\)

**TIPS**
The editing procedure described on this page can also be carried out on sprites at the same time.
7.4.3 Pasting Graphics and Characters Stored on the Clipboard

1. Select the icon on Tool Bar 1, or select Paste on the Edit menu.

2. The cursor changes to the movement cursor and the image of the figure stored on the Clipboard is displayed. Move the cursor to the position at which the figure is to be pasted.

3. Click at that position.

7.4.4 Changing the Order of Overlapped Graphics or Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figure whose order is to be changed.

3. Select Stacking Order on the Edit menu, and then select Bring to Front or Send to Back.

Bring to Front

Send to Back
7.4.5 Copying and Pasting Figures and Texts as a Group

This editing operation is used to copy and paste figures and text together. Using this function, several figures can be selected and copied at one time.

1. Change the cursor to the figure editing cursor.

2. Select the figure to be copied. (If several figures are to be copied at the same time, select all of the target figures.)

3. Select [Copy and Paste] on the Edit menu. This displays the dialog box shown below.

![Copy and Paste dialog box]

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number&quot;</td>
<td>This specifies the results of copying and pasting the figure or figures in numeric terms. For example, if &quot;2&quot; is specified, one figure is copied, and two figures are pasted on the screen. X direction ...... Specifies the actual number of lines to be copied in the X direction (to the right of the copy source). Y direction ...... Specifies the actual number of lines to be copied in the Y direction (downwards of the copy source). [Example] When &quot;3&quot; is specified for the X direction and &quot;2&quot; for the Y direction</td>
</tr>
</tbody>
</table>

![Example diagram]
<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Interval (dot)&quot;</td>
<td>If a setting of 2 or more has been entered for either the X or Y direction, this is used to specify the interval from the copy source position, in units of dots. X direction ...... Specifies the interval (number of dots) in the X direction (to the right of the copy source). Y direction ...... Specifies the interval (number of dots) in the Y direction (downwards of the copy source).</td>
</tr>
<tr>
<td>[Example] When &quot;0 dots&quot; is specified for the X direction</td>
<td></td>
</tr>
<tr>
<td>&lt;For one figure&gt;</td>
<td><img src="image1" alt="Example Image" /></td>
</tr>
<tr>
<td>&lt;For several figures&gt;</td>
<td><img src="image3" alt="Example Image" /></td>
</tr>
<tr>
<td>When &quot;5 dots&quot; is specified for the X direction</td>
<td></td>
</tr>
<tr>
<td>&lt;For one figure&gt;</td>
<td><img src="image5" alt="Example Image" /></td>
</tr>
<tr>
<td>&lt;For several figures&gt;</td>
<td><img src="image7" alt="Example Image" /></td>
</tr>
<tr>
<td>When &quot;0 dots&quot; is specified for the Y direction</td>
<td></td>
</tr>
<tr>
<td>&lt;For one figure&gt;</td>
<td><img src="image9" alt="Example Image" /></td>
</tr>
<tr>
<td>&lt;For several figures&gt;</td>
<td><img src="image11" alt="Example Image" /></td>
</tr>
<tr>
<td>When &quot;5 dots&quot; is specified for the Y direction</td>
<td></td>
</tr>
<tr>
<td>&lt;For one figure&gt;</td>
<td><img src="image13" alt="Example Image" /></td>
</tr>
<tr>
<td>&lt;For several figures&gt;</td>
<td><img src="image15" alt="Example Image" /></td>
</tr>
</tbody>
</table>

If no sprites have been selected, "Addraw Copymont" cannot be selected.

4. Click on OK.

**TIPS**
The operation described on this page can be done by selecting a sprite or by selecting a figure + sprite.
7.4.6 Undoing the Previous Operation

If a figure or text has been deleted as described in Section 7.3.10, this returns it to the display (this function does not apply to sprites).

To return a figure or text to the original status, select [Undo] on the Edit menu immediately after correcting or editing the figure or text, or editing multiple graphics.

7.5 Editing Several Graphics

7.5.1 Grouping Several Graphics and Characters

- What happens when graphics and text are grouped?

Grouping several graphics and/or characters in one group means that several figures can be treated as a single figure.

There will probably be times when you combine different figures such as a square, a circle, and straight lines, for example, to make a figure. Grouping these various shapes as one figure makes editing much easier.

1. Change the cursor to the graphic editing cursor.
2. Select the figures to be grouped.
3. Select [ ] on Tool Bar 1, or select the [Group] command and then the [Group] command on the Edit menu.

**TIPS**
The editing procedure described on this page can also be carried out on sprites at the same time.
7.5.2 Ungrouping Graphics and Characters

1. Change the cursor to the graphic editing cursor.

2. Select the figures whose group is to be cancelled. (If several groups are to be cancelled at one time, select all of the groups to be cancelled.)

3. Select in Tool Bar 1, or select the Group command and then the Ungroup command on the Edit menu.

**TIPS**
The editing procedure described on this page can also be carried out on sprites at the same time.
7.5.3 Centering Several Graphics

1. Change the cursor to the graphic editing cursor.
2. Select the figures to be centered.

3. Select [Align] and then [Center] on the Edit menu.

TIPS
The editing procedure described on this page can also be carried out on sprites at the same time.

7.5.4 Aligning Several Graphics along the Top or Bottom

1. Change the cursor to the graphic editing cursor.
2. Select the figures to be aligned at the top or bottom.


Aligned at top

Aligned at bottom

The uppermost figure is used as a reference to align the others.

The lowermost figure is used as a reference to align the others.
7.5.5  Aligning Several Graphics along the Left or Right

1. Change the cursor to the graphic editing cursor.
2. Select the figures to be aligned at the left or right.

3. Select [Align] and then [Left] or [Right] on the Edit menu.

   - **Aligned at left**: The figure farthest to the left is used as a reference to align the others.
   - **Aligned at right**: The figure farthest to the right is used as a reference to align the others.

**TIPS**

The editing procedure described on this page can also be carried out on sprites at the same time.
7.5.6 Aligning Several Graphics along the Left or Top at Even Intervals

1. Change the cursor to the graphic editing cursor.

2. Select the figures to be aligned at the left or top, at even intervals.

3. Select [Align] and then [Left evenly] or [Top evenly] on the Edit menu.

- Aligned at left, at even intervals
- Aligned at top, at even intervals

The figures are spaced at even intervals between the top left coordinates of the uppermost figure and the top left coordinates of the lowermost figure.

The figures are spaced at even intervals along the top, between the top left coordinates of the figure furthest to the left and the top left coordinates of the figure farthest to the right.

**TIPS**

The procedure described on this page can also be carried out on sprites at the same time, by selecting the sprite, and then selecting "Figure + Sprite".
7.6 Editing Graphics and Sprites Simultaneously

Sprites set on the screen window and graphics drawn on the same window can be edited at the same time. To do this, change the cursor to the "Figure + Sprite" cursor, and select the figure and sprite to be edited. Then do the editing.

See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.

Sprites to be edited are selected in the same way as figures to be edited.

- What kinds of editing can be done simultaneously?

Editing operations that can be carried out on sprites and figures simultaneously are listed below. Please be aware that there are a few editing operations which cannot be carried out on both sprites and figures at the same time.

- Figures and sprites can be deleted simultaneously.
- Figures and sprites can be cut simultaneously and pasted to the Clipboard. (Sprites can also be stored on the Clipboard.)
- Figures and sprites can be moved simultaneously.
- Figures and sprites can be copied simultaneously.
- Figures and sprites stored on the Clipboard can be pasted simultaneously.
- Figures and sprites can be grouped simultaneously.
- Groups of figures and sprites can be cancelled simultaneously.
- Figures and sprites can be aligned simultaneously.
- Figures and sprites can be deleted simultaneously at even intervals.

- Editing operations which cannot be carried out simultaneously

- The sizes of figures and sprites cannot be changed simultaneously.
- Figures and sprites cannot be flipped, mirror reversed, or rotated 90° simultaneously.
- Overlapped figures and sprites cannot have the order changed simultaneously.
Chapter 8

Before Entering Sprite Settings
# 8. Before Entering Sprite Settings

## 8.1 Types of Sprite Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Numeric display function  | This function displays data stored in word devices as numeric data.  
                           | - Monitor device values undergo data processing, and the processed values can be displayed as numeric values.  
                           | - When the monitor device value has reached a certain value, the display color and attributes can be changed. |
| Data list display function| This function allows the statuses of a number of word devices to be collected at a specified timing and displayed in numeric format.  
                           | - The statuses of target word devices can be displayed in a specified order of preference. |
| ASCII display function    | This function enables data stored in conjunction with a word device to be handled as a character code (ASCII code or shift JIS code) and character strings displayed as such. |
| Clock display function    | This function displays the data for the internal clock of the GOT.  
                           | - The display format can be specified as either time or date. |
| Comment display function  | Bit  
                           | This function enables comments to be displayed as bit devices are turned on or off.  
                           | - Comments can be displayed in multiple lines if necessary, in order to fit into the display range.  
                           | - Comments can be displayed only when a bit device is on, or only when it is off. |
|                           | Word  
                           | This function enables comments to be displayed as word devices are turned on or off.  
                           | - Comments can be displayed in multiple lines if necessary, in order to fit into the display range.  
                           | - Monitor device values undergo data processing, and the processed values can be displayed as comments. |
| Alarm list display function| System alarms  
                           | If an error occurs in the PC CPU, the data link/network, or the GOT, this function displays an error alarm. |
|                           | User alarms  
                           | This function enables comments for several bit devices to be accommodated, with comments displayed in the order that bit devices are turned on.  
                           | - Comments can be displayed in multiple lines if necessary, in order to fit into the display range.  
                           | - The order of preference can be specified as the order of occurrence, or as the numeric order.  
                           | - Comments can be displayed either singly or multiply, in sequential order.  
                           | - The number of bit devices currently turned on can be stored in a word device.  
<pre><code>                       | - When an alarm list display is switched to another screen, the order in which alarms occurred can be stored in memory. |
</code></pre>
<table>
<thead>
<tr>
<th>Function</th>
<th>Contents</th>
</tr>
</thead>
</table>
| Part display function            | **Bit** *(Section 13.2)*  
This function enables parts to be displayed with respect to whether the corresponding bit devices are on or off.  
- Figures in BMP format files can be displayed as parts.  
- Parts for only those bit devices which are on or off can be displayed. |
|                                 | **Word** *(Section 13.3)*  
This function enables parts to be displayed with respect to whether the corresponding word devices are on or off.  
- Figures in BMP format files can be displayed as parts.  
- Monitor device values undergo data processing, and the processed values can be displayed as parts. |
| Part move display function       | *(Section 13.4)*  
This function enables the display positions for the parts display (bit) and parts display (word) functions to be changed (Move/Trajectory Move) based on the value of a 2-point word device. |
| Lamp display                     | **Bit** *(Section 13.5)*  
This turns lamps on and off in conjunction with bit devices being turned on and off. |
|                                 | **Word** *(Section 13.6)*  
This function enables the color in which a lamp lights to be changed based on the word device value.  
- Monitor device values undergo data processing, and the color of the lamp can be changed based on the processed values.  
- Lamp colors can be changed to any of eight colors. |
| Panel meter display function     | *(Section 13.7)*  
This function displays meters as a proportion of the upper and lower limit values of a word device.  
- Monitor device values undergo data processing, and the panel meter can be displayed based on the processed values.  
- When the monitor device value has reached a certain value, the color in which the meter indicator is displayed can be changed. |
| Trend graph display function     | *(Section 14.1)*  
This function allows the data stored in a word device to be collected at a specified timing and displayed as a trend graph. After the data is displayed to the specified range, the display scrolls.  
- Up to eight graphs (data for eight devices) can be displayed.  
- Monitor device values undergo data processing, and a trend graph can be displayed based on the processed values.  
- Data can continue to be collected continuously even if the screen is switched from the trend graph display screen to another screen. |
<table>
<thead>
<tr>
<th>Function</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line graph display function</td>
<td>This function allows the data for multiple word devices to be collected as a group and displayed as a line graph.</td>
</tr>
<tr>
<td>(Section 14.2)</td>
<td>- Data for up to eight devices can be displayed on the graph.</td>
</tr>
<tr>
<td></td>
<td>- Monitor device values undergo data processing, and a line graph can be displayed based on the processed values.</td>
</tr>
<tr>
<td>Bar graph display function</td>
<td>This function displays the data stored in multiple word devices as a bar graph.</td>
</tr>
<tr>
<td>(Section 14.3)</td>
<td>- A standard value can be set, and bar graphs displayed above and below the standard value.</td>
</tr>
<tr>
<td></td>
<td>- Data for up to eight devices can be displayed on one bar graph.</td>
</tr>
<tr>
<td></td>
<td>- Monitor device values undergo data processing, and a bar graph can be displayed based on the processed values.</td>
</tr>
<tr>
<td>Level display function</td>
<td>This function allows a level display showing the proportion of a word device in relation to upper and lower limit values.</td>
</tr>
<tr>
<td>(Section 14.4)</td>
<td>- Level displays can be produced to the top, bottom, right, and left.</td>
</tr>
<tr>
<td></td>
<td>- Monitor device values undergo data processing, and a level display can be produced based on the processed values.</td>
</tr>
<tr>
<td></td>
<td>- When the monitor device value has reached a certain value, the color and pattern of the level display can be changed.</td>
</tr>
<tr>
<td>Touch key</td>
<td>This function turns on a specified bit device when a touch key is touched.</td>
</tr>
<tr>
<td>(Section 15.3)</td>
<td>This function turns off a specified bit device when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function reverses the current status of a specified bit device (ON ↔ OFF) when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function turns on a specified bit device for as long as the key is held down.</td>
</tr>
<tr>
<td>Word</td>
<td>This function writes a specified value to a word device when a touch key is touched.</td>
</tr>
<tr>
<td>(Section 15.4)</td>
<td>This function writes a specified word device value to a word device when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function writes a specified word device value and a fixed value to a word device when a touch key is touched.</td>
</tr>
<tr>
<td>Base switching</td>
<td>This function switches to the previously displayed base screen when a touch key is touched.</td>
</tr>
<tr>
<td>(Section 15.5)</td>
<td>This function switches to a specified base screen when a touch key is touched.</td>
</tr>
<tr>
<td></td>
<td>This function switches to a specified base screen when a specified bit device is turned on or off by touching a touch key.</td>
</tr>
<tr>
<td></td>
<td>This function switches the base screen based on the current value of a specified word device, by touching a touch key.</td>
</tr>
<tr>
<td><strong>Function</strong></td>
<td><strong>Contents</strong></td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Touch key                           | This function switches to a specified window screen when a touch key is touched.  
                                      | This function switches to a specified window screen when a specified bit device is turned on or off by touching a touch key.  
                                      | This function switches the window screen based on the current value of a specified word device, by touching a touch key.          |
| Window switching                    |                                                                             |
| (Section 15.6)                      |                                                                             |
| Expansion                           | This function switches to the screen for an expanded function by touching a touch key. |
| (Section 15.7)                      |                                                                             |
| Key code setting; simultaneous      | This creates a key to be used for numeric or ASCII input.                   |
| pressing inhibited                  | This function inhibits pressing of two touch keys at the same time.         |
| (Section 15.8)                      |                                                                             |
| Numeric input function              | This function writes a desired numeric value to the specified word device.   |
| (Section 16.1)                      | - Touching the input area displays the input cursor.                        |
|                                     | - The numeric input keys display the GOT key window on the screen. (Any keys can be assigned as input keys.) |
|                                     | - Input values undergo data processing, and the processed values can be written to a writing device. |
| ASCII input function                | This function writes any desired key code to the specified word device.     |
| (Section 16.3)                      | - Touching the input area displays the input cursor.                        |
|                                     | - Any keys can be assigned as input keys. (The key window can also be used for input.) |
| Hard copy function                  | This function prints out the currently displayed monitor screen when the bit device is on, or when a touch key is entered.       |
| (Section 22.3)                      |                                                                             |
| Status monitoring function          | This function writes data to the PC CPU when the specified conditions are met |
| (Section 22.4)                      | (the specified bit device is turned on or off).                             |
8.2 Memory Required for Sprites and Maximum Settings

The table below shows the required amount of memory for each of the sprites, and the maximum number of settings that can be entered in one base screen and one window screen. The indicated memory capacity and max. no. of settings are the capacity when all of the setting items for sprites are set to the default values. If settings are being entered for data expression, display methods, and other procedures, the amount of memory required will differ from that shown below (more memory is required).

<table>
<thead>
<tr>
<th>Sprite name</th>
<th>Memory capacity (bytes)</th>
<th>Max. no. of settings (points)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numeric display function</td>
<td>80</td>
<td>200</td>
</tr>
<tr>
<td>Data list display function</td>
<td>400</td>
<td>1 (window screen not possible)</td>
</tr>
<tr>
<td>ASCII display function</td>
<td>68</td>
<td>100 (15) *1</td>
</tr>
<tr>
<td>Clock display function</td>
<td>40</td>
<td>560</td>
</tr>
<tr>
<td>Comment display function</td>
<td>80</td>
<td>200</td>
</tr>
<tr>
<td>Alarm list (system alarms) display function</td>
<td>36</td>
<td>1</td>
</tr>
<tr>
<td>Alarm list (user alarms) display function</td>
<td>64</td>
<td>10 (2) *1</td>
</tr>
<tr>
<td>Comments</td>
<td>12 + 8 x no. of registered comments + (4 + 2 x total no. of characters) x no. of registered comments</td>
<td>Values in parentheses are converted to multiples of 4.</td>
</tr>
<tr>
<td>Parts display function</td>
<td>72</td>
<td>200</td>
</tr>
<tr>
<td>Parts movement display function</td>
<td>108</td>
<td>100</td>
</tr>
<tr>
<td>Parts graphics</td>
<td>Memory capacity for figures drawn as canvas graphics</td>
<td></td>
</tr>
<tr>
<td>Lamp display function</td>
<td>324</td>
<td>315</td>
</tr>
<tr>
<td>Panel meter display function</td>
<td>188</td>
<td>315</td>
</tr>
<tr>
<td>Trend graph display function</td>
<td>76</td>
<td>10 (1) *1</td>
</tr>
<tr>
<td>Line graph display function</td>
<td>184</td>
<td>10 (40) *1</td>
</tr>
<tr>
<td>Bar graph display function</td>
<td>84</td>
<td>200</td>
</tr>
<tr>
<td>Level display function</td>
<td>88</td>
<td>200</td>
</tr>
<tr>
<td>Touch switch functions</td>
<td>Bit</td>
<td>Base screens: 256 (10) *1</td>
</tr>
<tr>
<td></td>
<td>Word</td>
<td>Window screens: 64 (10) *1</td>
</tr>
<tr>
<td></td>
<td>Screen switching</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expansion</td>
<td></td>
</tr>
<tr>
<td>Numeric input function</td>
<td>128</td>
<td></td>
</tr>
<tr>
<td>ASCII input function</td>
<td>84</td>
<td>200</td>
</tr>
<tr>
<td>Window setting</td>
<td>40</td>
<td>100 (15) *1</td>
</tr>
<tr>
<td>Common</td>
<td>Screen title data</td>
<td>2 + 2 / no. of characters</td>
</tr>
<tr>
<td></td>
<td>(unit: 1 screen)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hard copy</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Status monitor</td>
<td>80</td>
</tr>
<tr>
<td></td>
<td>Other than above</td>
<td>128</td>
</tr>
</tbody>
</table>

The data for the various sprite name items listed above are downloaded to the GOT.

*1. Numeric values in parentheses indicate the maximum number than can be set when the maximum is entered for the item being set.
### 8.3 Overlapping Canvas Graphics and Sprites

On base screens and window screens, there may be times when canvas graphics and sprites overlap. There are no special restrictions in displaying overlapped canvas graphics and sprites on the GOT. When these are being displayed on the GOT, sprites are always displayed on top of canvas graphics, regardless of whether the graphics were drawn first or the sprite settings were entered first. The graphics software can be used to check how the display will appear on the GOT.

See Section 20.2, Viewing an Image of the Created Screen Data.

<table>
<thead>
<tr>
<th>Type of sprite</th>
<th>Item set</th>
<th>Default value</th>
<th>Maximum value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII display/ASCII input</td>
<td>No. of digits displayed</td>
<td>6 digits</td>
<td>40 digits</td>
</tr>
<tr>
<td>Alarm list display (user alarms)</td>
<td>No. of monitor device points</td>
<td>1 point</td>
<td>255 points</td>
</tr>
<tr>
<td>Line graph display</td>
<td>No. of graphs/no. of points</td>
<td>1 graph/10 points</td>
<td>8 graphs/100 points</td>
</tr>
<tr>
<td>Bar graph display</td>
<td>No. of graphs</td>
<td>1 graph</td>
<td>8 graphs</td>
</tr>
<tr>
<td>Touch switch function</td>
<td>No. of action setting points</td>
<td>0 point</td>
<td>83 points</td>
</tr>
</tbody>
</table>

Please be aware that if the canvas graphic and the sprite are displayed in the same color, the sprite will not be visible on the screen.

### 8.4 Entering Settings for Overlapped Sprites

With the graphics software, sprite settings can be overlapped. However, overlapped sprite settings cannot be displayed on the GOT. (When displayed on the GOT, the overlapped sections will not be displayed correctly.)

Make sure the settings for the sprite display conditions and other parameters are entered in such a way that sprites are not displayed in an overlapping configuration.

See Section 10.4, Setting Display Conditions.
8.5 Types of Attributes That Can be Set with Sprites

The types of attributes that can be selected are shown below.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Character size</td>
<td>Vertical: 0.5 time (alarm list (system alarm) display only) / 1 time/2 times/4 times/8 times</td>
</tr>
<tr>
<td></td>
<td>Horizontal: 0.5 time (alarm list (system alarm) display only) / 1 time/2 times/4 times/8 times</td>
</tr>
<tr>
<td>Line type</td>
<td>Solid line ––––––, Broken line – – – – –, Dotted line –––––––, Alternate dots and dashes –––––––, Alternate double dots and dashes ––––––</td>
</tr>
<tr>
<td>Line width</td>
<td>1dot –––, 2dots –––––, 3dots –––––, 4dots –––––––</td>
</tr>
<tr>
<td>Selectable display colors</td>
<td>White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple</td>
</tr>
<tr>
<td>How attribute is displayed on GOT</td>
<td>With the A870GOT-EL: All display colors other than black are displayed in the same color (orange).</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-TFT: Selected display colors are displayed.</td>
</tr>
<tr>
<td></td>
<td>With the A85GOT-L: All display colors other than black are displayed in the same color (black).</td>
</tr>
<tr>
<td></td>
<td>With the A85GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td>Painting pattern (bar graph displays and level displays)</td>
<td><img src="image" alt="Painting patterns" /></td>
</tr>
<tr>
<td>Selectable pattern colors (bar graph displays and level displays)</td>
<td>White, black, red, green, blue, blue-green, yellow, purple, beige, dark red, dark green, dark blue, dark blue-green, dark yellow, dark purple</td>
</tr>
<tr>
<td>How attribute is displayed on GOT (bar graph displays and level displays)</td>
<td>With the A870GOT-EL: All display colors other than black and gray are displayed in the same color (orange) (gray is displayed as black).</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-STN: All dark colors are displayed as the original color (gray is displayed as black).</td>
</tr>
<tr>
<td></td>
<td>With the A870GOT-TFT: Data is displayed in the selected color.</td>
</tr>
<tr>
<td></td>
<td>With the A85GOT-L: All display colors other than black are displayed in the same color (black).</td>
</tr>
<tr>
<td></td>
<td>With the A85GOT-STN: All dark colors are displayed as the original color.</td>
</tr>
<tr>
<td>Blinking</td>
<td>Blinking interval: 500 ms (multiple settings per screen possible)</td>
</tr>
</tbody>
</table>
Chapter 9

Devices That Can be Set with Sprites and Their Access Ranges
9. Devices That Can be Set with Sprites and Their Access Ranges

The devices which can be set using sprites, and the access ranges, are the same for the A870GOT and the A85□GOT.

9.1 Names of Devices That Can be Monitored

The devices that can be monitored using the GOT are listed below. There are some devices and device ranges that cannot be monitored with the GOT, depending on how the GOT is connected. For more detailed information on restricted items, please refer to the user's manual for the A870GOT/A850GOT.

(1) With a MELSEC-ACPU

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input (X)</td>
<td>X0 ~ X1FFF</td>
</tr>
<tr>
<td>Output (Y)</td>
<td>Y0 ~ Y1FFF</td>
</tr>
<tr>
<td>Internal relay (M)</td>
<td>M0 ~ M8191</td>
</tr>
<tr>
<td>Annunciator (F)</td>
<td>F0 ~ F2047</td>
</tr>
<tr>
<td>Link relay (B)</td>
<td>B0 ~ B1FFF</td>
</tr>
<tr>
<td>Special internal relay (M)</td>
<td>M9000 ~ M9255</td>
</tr>
<tr>
<td>Timer</td>
<td>Contact point (TT)</td>
</tr>
<tr>
<td></td>
<td>TC0 ~ TC2047</td>
</tr>
<tr>
<td>Timer</td>
<td>Coil (TC)</td>
</tr>
<tr>
<td></td>
<td>TC0 ~ TC2047</td>
</tr>
<tr>
<td>Counter</td>
<td>Contact point (CT)</td>
</tr>
<tr>
<td></td>
<td>CT0 ~ CT1023</td>
</tr>
<tr>
<td>Counter</td>
<td>Coil (CC)</td>
</tr>
<tr>
<td></td>
<td>CC0 ~ CC1023</td>
</tr>
<tr>
<td>Word device bit</td>
<td>Specified bit of word device noted above (except for index register and buffer memories)</td>
</tr>
<tr>
<td>GOT bit register (GB)</td>
<td>GB0 ~ 1023</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0 ~ D8191</td>
</tr>
<tr>
<td>Special data register (D)</td>
<td>D9000 ~ D9255</td>
</tr>
<tr>
<td>Link register (W)</td>
<td>W0 ~ W1FFF</td>
</tr>
<tr>
<td>Timer (current value) (T)</td>
<td>T0 ~ T2047</td>
</tr>
<tr>
<td>Counter (current value) (C)</td>
<td>C0 ~ C1023</td>
</tr>
<tr>
<td>File register (R)</td>
<td>R0 ~ R8191</td>
</tr>
<tr>
<td>Expanded Block</td>
<td>1 ~ 255</td>
</tr>
<tr>
<td>file register (ER)</td>
<td>R0 ~ R8191</td>
</tr>
<tr>
<td>Index register (Z)</td>
<td>Z0 ~ Z6 (Z0 = Z)</td>
</tr>
<tr>
<td></td>
<td>V0 ~ V6 (V0 = V)</td>
</tr>
<tr>
<td>Accumulator (A)</td>
<td>A0 ~ A1</td>
</tr>
<tr>
<td>Buffer memory (special function unit) (BM)</td>
<td>BM0 ~ BMn (*1)</td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD0 ~ GD1023</td>
</tr>
</tbody>
</table>

*1. This can be specified only for the special function unit of a station connected to the A870GOT. It should be specified as a value within the address range of the buffer memory existing in the applicable special function unit.
### (2) With a MELSEC-QnACPU

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input (X)</td>
<td>X0 ~ X1FFF</td>
</tr>
<tr>
<td>Output (Y)</td>
<td>Y0 ~ Y1FFF</td>
</tr>
<tr>
<td>Internal relay (M)</td>
<td>M0 ~ M32767</td>
</tr>
<tr>
<td>Annunciator (F)</td>
<td>F0 ~ F32767</td>
</tr>
<tr>
<td>Link relay (B)</td>
<td>B0 ~ B7FFF</td>
</tr>
<tr>
<td>Timer</td>
<td>Contact point (TT)</td>
</tr>
<tr>
<td></td>
<td>T0 ~ TTT32767</td>
</tr>
<tr>
<td></td>
<td>Coil (TC)</td>
</tr>
<tr>
<td></td>
<td>TC0 ~ TC32767</td>
</tr>
<tr>
<td>Counter</td>
<td>Contact point (CT)</td>
</tr>
<tr>
<td></td>
<td>C0 ~ CTT32767</td>
</tr>
<tr>
<td></td>
<td>Coil (CC)</td>
</tr>
<tr>
<td></td>
<td>CC0 ~ CCC32767</td>
</tr>
<tr>
<td>Special relay (SM)</td>
<td>SM0 ~ SM2047</td>
</tr>
<tr>
<td>Word device bit</td>
<td>Specified bit of word device noted above</td>
</tr>
<tr>
<td></td>
<td>(except for index register and buffer memories)</td>
</tr>
<tr>
<td>GOT bit register (GB)</td>
<td>GB0 ~ GB1023</td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0 ~ D32767</td>
</tr>
<tr>
<td>Special register (D)</td>
<td>SD0 ~ SD2047</td>
</tr>
<tr>
<td>Link register (M)</td>
<td>W0 ~ W7FFF</td>
</tr>
<tr>
<td>Timer (current value) (T)</td>
<td>T0 ~ T32767</td>
</tr>
<tr>
<td>Counter (current value) (C)</td>
<td>C0 ~ C32767</td>
</tr>
<tr>
<td>File register (R)</td>
<td>R0 ~ R32767 ((^1))</td>
</tr>
<tr>
<td>Expanded file register (ER)</td>
<td>Block</td>
</tr>
<tr>
<td></td>
<td>0 ~ 31</td>
</tr>
<tr>
<td>Expanded file register (ZR)</td>
<td>Device</td>
</tr>
<tr>
<td></td>
<td>R0 ~ R32767</td>
</tr>
<tr>
<td>Index register (Z)</td>
<td>ZR0 ~ ZR1042431 ((^2))</td>
</tr>
<tr>
<td>Buffer memory (special function unit) (BM)</td>
<td>BM0 ~ BMn ((^3))</td>
</tr>
<tr>
<td>GOT data register (GD)</td>
<td>GD0 ~ GD1023</td>
</tr>
</tbody>
</table>

\(^1\) This applies to the file registers of blocks switched using the RSET instruction.

\(^2\) This applies to the file registers of blocks switched using the QFRSET instruction.

\(^3\) This can be specified only for the special function unit of a station connected to the A870GOT. It should be specified as a value within the address range of the buffer memory existing in the applicable special function unit.
(3) For the MELSEC-FXCPU

If using the MELSEC-FXCPU, always install the MELSEC-FX communications driver in the GOT.

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
<th>Device no. format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input relay (X)</td>
<td>X0000 ~ X0377</td>
<td>Octal</td>
</tr>
<tr>
<td>Output relay (Y)</td>
<td>Y0000 ~ Y0377</td>
<td></td>
</tr>
<tr>
<td>Auxiliary relay (M)</td>
<td>M0000 ~ M1535</td>
<td></td>
</tr>
<tr>
<td>State (S)</td>
<td>S0000 ~ S0999</td>
<td></td>
</tr>
<tr>
<td>Special auxiliary relay (M)</td>
<td>M8000 ~ M8255</td>
<td>Decimal</td>
</tr>
<tr>
<td>Timer contact point (T)</td>
<td>T0000 ~ T255</td>
<td></td>
</tr>
<tr>
<td>Counter contact point (C)</td>
<td>C0000 ~ C255</td>
<td></td>
</tr>
<tr>
<td>Word device bit (*1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Timer (current value) (T)</td>
<td>T000 ~ T255</td>
<td>Decimal</td>
</tr>
<tr>
<td>Counter (current value) (C)</td>
<td>C000 ~ C255</td>
<td></td>
</tr>
<tr>
<td>Data register (D)</td>
<td>D0000 ~ D0999</td>
<td></td>
</tr>
<tr>
<td>RAM file register (C)</td>
<td>D6000 ~ D7999</td>
<td></td>
</tr>
<tr>
<td>Special data register (D)</td>
<td>D8000 ~ D8255</td>
<td></td>
</tr>
</tbody>
</table>

*1. If running the touch key function in which a word device bit is specified as the monitor device, do not write the word device in the sequence program.

(4) For the OMRON PLC

If using the Omron PLC, always install the SYSMAC C200H communications driver in the GOT.

<table>
<thead>
<tr>
<th>Device name</th>
<th>Range of monitors which can be set</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input relay</td>
<td></td>
</tr>
<tr>
<td>Internal relay</td>
<td></td>
</tr>
<tr>
<td>Data link relay (LR)</td>
<td>LR0000 ~ LR6315</td>
</tr>
<tr>
<td>Auxiliary memory relay (AR)</td>
<td>AR0000 ~ AR2715</td>
</tr>
<tr>
<td>Storage relay (HR)</td>
<td>HR0000 ~ HR9915</td>
</tr>
<tr>
<td>Timer (contact point) (TIM)</td>
<td>TIM000 ~ TIM511</td>
</tr>
<tr>
<td>Counter (contact point) (CNT)</td>
<td>CNT000 ~ CNT511</td>
</tr>
<tr>
<td>Word device bit (*1)</td>
<td></td>
</tr>
<tr>
<td>Data memory (DM)</td>
<td>DM0000 ~ DM9999</td>
</tr>
<tr>
<td>Timer (current value) (TIM)</td>
<td>TIM000 ~ TIM511</td>
</tr>
<tr>
<td>Counter (current value) (CNT)</td>
<td>CNT000 ~ CNT511</td>
</tr>
</tbody>
</table>

*1. If running the touch key function in which a word device bit is specified as the monitor device, do not write the word device in the sequence program.
9. Devices That Can be Set with Sprites and Their Access Ranges

9.2 Monitoring Special Function Units

With special function units, monitoring is possible only with the stations noted below.

1. **With bus connections, CPU direct connections, and calculator link connections**
   Special function units on the base of the connected station

2. **With MELSECNET (II) connections and MELSECNET/B connections**
   Special function units on the base of the master station

3. **With MELSECNET/10 connections**
   Special function units on the base of the control station
9.3 Access Ranges for Data Link Systems That Can be Monitored When Using the MELSEC-ACPU and QnACPU

(1) With bus connections, CPU direct connections, and calculator link connections
   
   (a) When the connected station is the master station
       - Local stations can be monitored.
       If the PC CPU of the local station is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
   
   (b) When the connected station is a local station
       - The master station can be monitored.
       If the PC CPU of the master station is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
       - Other local stations cannot be monitored.

   (c) If the connected station is a tri-layer master station
       - Dual-layer master stations and tri-layer local stations can be monitored.
       If the PC CPU of the station being monitored is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
       - Dual-layer local stations cannot be monitored.

(2) With MELSECNET (II) connections and MELSECNET/B connections
   
   - The GOT acts as a local station, and only the master station can be monitored. If the PC CPU of the master station is the QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the link parameter.
   - Local stations cannot be monitored.

   When settings are entered for the monitor device, the settings for the NW number and station number should be entered as shown below.

   When monitoring the B and W devices assigned with the link parameter:
       - Set NW number to 0 and local station to host station
   When monitoring any device other than the B and W devices assigned with the link parameter:
       - Set NW number to 0 and station number to other station (station number: 0)

(3) When monitoring devices of other stations

   When monitoring devices of other stations on the data link system, the display speed slows considerably. Monitoring should be limited to the link relay (B) and link register (W) assigned with the link parameter.
(4) Setting the monitor device

The following illustration shows an example of how the NW number and station numbers are set when setting a monitor device.

1) When monitoring a connected station (host station) and the B and W devices assigned with the link parameter

Set NW number to 0 and local station to host station

2) When monitoring devices of another station

Set NW number to 0 and local station to (see table below).

Station Number Settings

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>M</th>
<th>L1</th>
<th>L2</th>
<th>L3</th>
<th>L1</th>
<th>L2</th>
<th>L3</th>
</tr>
</thead>
<tbody>
<tr>
<td>M</td>
<td>Host</td>
<td>Other</td>
<td>Other</td>
<td>Other</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>L1</td>
<td>Other</td>
<td>Host</td>
<td></td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>L2 m</td>
<td>Other</td>
<td></td>
<td>Host</td>
<td></td>
<td></td>
<td>L1</td>
<td>L2</td>
</tr>
<tr>
<td>L3</td>
<td>Other</td>
<td></td>
<td></td>
<td>Host</td>
<td></td>
<td></td>
<td>L2</td>
</tr>
<tr>
<td>L1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>L2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>L3 (GOT)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

9 - 6
9.4 Access Ranges for Network Systems That Can be Monitored When Using the MELSEC-ACPU and QnA CPU

(1) For a bus connection (when the A7GT-BUS Version B, the A7GT-BUS2 Version A or each later version is being used)

1) When the connected station is a QnACPU or AnUCPU
   - The control station and all ordinary stations on the network can be monitored.
   - The control station and all ordinary stations on another network can be monitored. (When monitoring another network, always set the routine parameters.)
   - If the connected station is an intermediate station and is mixed with a data link system, the master station and local stations can be monitored.
   - If the connected station is an intermediate station, the data link parameters for the "Unit No. Effective When Accessing Other Stations" (other than the B and W devices assigned with the network parameter) do not need to be set in the PC CPU of the connected station. (If set, the settings will be ignored.)
   - When the devices of another station (other than the B and W devices assigned with the network parameter) are being monitored, there may be times when monitoring cannot be done, depending on the PC CPU of the station being monitored.

   See (7), (Example 1)–(Example 4).

2) When the connected station is an AnA, or AnNCPU
   - The control station on the network can be monitored.
     If the PC CPU of the control station is a QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the network parameter.
   - Ordinary stations on the network cannot be monitored.
   - Other networks cannot be monitored.

(2) For a bus connection (when the A7GT-BUS Version A is being used)

When using the A85□GOT, the A7GT-BUS Version A cannot be used.
When using the A870GOT and the connected station is a QnACPU, the A7GT-BUS Version A cannot be used.

1) When the connected station is an AnUCPU
   - The control station and all ordinary stations on the network can be monitored. When the devices of another station (other than the B and W devices assigned with the network parameter) are being monitored, however, monitoring cannot be done if the PC CPU of the station being monitored is a QnACPU.
   - If the connected station is an intermediate station, the unit number to which the network number being monitored is connected should be set using the data link parameter called "Unit No. Effective When Accessing Other Stations".
2) When the connected station is an AnA or AnNCPU
   • The control station on the network can be monitored.
     If the PC CPU of the control station is a QnACPU, however, the only devices which can be monitored are the B and W devices assigned with the network parameter.
   • Ordinary stations on the network cannot be monitored.
   • Other networks cannot be monitored.

(3) For CPU direct connections or calculator link connections
1) When the connected station is a QnACPU
   • The access range described in (1) 1 applies.
2) When the connected station is an AnUCPU
   • The access range described in (2) 1 applies.
3) When the connected station is an AnA or AnNCPU
   • The access range described in (2) 2 applies.

(4) For MELSECNET/10 connections
   • The GOT acts as an ordinary station, and the control station and all ordinary stations on the network can be monitored.
     If the PC CPU being monitored is the QnACPU, however, monitoring can be done within the AnA device range.
   • Other networks cannot be monitored.
   • When monitoring devices of other stations (other than the B and W devices assigned with the network parameter), there may be times when monitoring cannot be done, depending on the PC CPU of the station being monitored.
     See (Example 6).

(5) Monitoring devices of other stations on the network
When monitoring devices of other stations on the network system, the display speed slows considerably. Monitoring should be limited to the link relay (B) and link register (W) assigned with the link parameter.

(6) Monitoring devices of other networks
   • When monitoring another network, always set the routine parameters in the PC CPU.
   • Monitoring another network causes the display speed to drop considerably.
(7) Monitoring access ranges for other stations, and monitor device settings

(Example 1) For bus connections (A7GT-BUS Version B, A7GT-BUS 2 Version A or all subsequent versions)

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station connected to GOT</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>QnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>O Host station</td>
<td>X</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>O</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>AnU (1-4)</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>QnA (2-1)</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>O</td>
<td>X</td>
</tr>
</tbody>
</table>

O : Can be accessed
X : Can't be accessed
- Setting NW numbers and station numbers when setting monitor devices

1. When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

2. When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>AnU (1-1)</td>
<td>0, host station</td>
<td>2, other station (2)</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>other station (1)</td>
<td>other station (4)</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>0, host station</td>
<td>2, other station (2)</td>
</tr>
<tr>
<td>AnU (1-4)</td>
<td>other station (1)</td>
<td>2, other station (2)</td>
</tr>
<tr>
<td>QnA (2-1)</td>
<td>other station (2)</td>
<td>2, other station (2)</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td>1, other station (4)</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>other station (1)</td>
<td>0, host station</td>
</tr>
</tbody>
</table>

How to read the table: 2, other station (2) NW no. setting Station no. setting

9 - 10
(Example 2) For bus connections (A7GT-BUS Version B, A7GT-BUS 2 Version A or all subsequent versions)

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>AnA (1-3)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>O Hot station</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>X</td>
<td>O Hot station</td>
<td>X</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>O</td>
<td>X</td>
<td>O Hot station</td>
</tr>
<tr>
<td>QnA (2-2) (M)</td>
<td>O</td>
<td>X</td>
<td>O Hot station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

O : Can be accessed
△: Can be accessed within AnA range
(for T/C, the range is 0 ~ 255)
X : Can't be accessed
- Setting NW numbers and station numbers when setting monitor devices

1. When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

   Set the NW number to 0 and the station number to the host station.

2. When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>QnA (1-3)</td>
<td>QnA (2-1)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>0, host station</td>
<td>1, other station (2)</td>
<td>1, other station (3)</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>QnA (2-2) (M)</td>
<td>1, other station (2)</td>
<td>-</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

*1 When monitoring a data link system, set the NW No. to 0.

How to read the table:

\[
\begin{align*}
\uparrow & 2, \ other \ station \ (2) \\
\text{NW no. setting} & \text{Station no. setting}
\end{align*}
\]
(Example 3) For bus connections (when using a QnACPU with A7GT-BUS Version B, A7GT-BUS 2 Version A or each later version, or when using an AnUAAnA or AnNCPU with A7GT-BUS Version A)

*1. The data link parameter called “Unit No. Effective When Accessing Other Station” should be set to the unit number connected to Network No. 1.

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>QnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>O Host station</td>
<td>X</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>O</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>AnU (1-4) (2-2)</td>
<td>O</td>
<td>X</td>
</tr>
<tr>
<td>QnA (2-1)</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnI (2-4)</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
- Setting NW numbers and station numbers when setting monitor devices

1. When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

2. When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AnU (1-1)</td>
<td>QnA (1-2)</td>
</tr>
<tr>
<td>AnU (1-1)</td>
<td>0, host station</td>
<td>-</td>
</tr>
<tr>
<td>QnA (1-2)</td>
<td>1, other station</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>0, other station</td>
<td>-</td>
</tr>
<tr>
<td>AnU (1-4)</td>
<td>0, other station</td>
<td>-</td>
</tr>
<tr>
<td>AnN (2-3)</td>
<td>1, other station</td>
<td>1, other station</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

How to read the table: 

1. NW no. setting  
2. Station no. setting
(Example 4) For bus connections (when using a QnACPU with A7GT-BUS Version B, A7GT-BUS2 Version A or each later version, or when using an AnUAnA or AnNCPU with A7GT-BUS Version A)

- Monitoring access ranges of devices of other networks (other than B and W) and other networks

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>AnA (1-3)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>O Host station</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>X</td>
<td>X</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnA (1-3)</td>
<td>O</td>
<td>X</td>
<td>O Host station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>QnA (L1)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>AnA (L2)</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

- O: Can be accessed
- △: Can be accessed within AnA range (for T/C, the range is 0 ~ 255)
- X: Can't be accessed
- Setting NW numbers and station numbers when setting monitor devices

(1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

(2) When monitoring another station (other than B and W) or another network

<table>
<thead>
<tr>
<th>Station being accessed connected to GOT</th>
<th>Network No. 1</th>
<th>Network No. 2</th>
<th>Data link system</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>QnA (1-1)</td>
<td>AnA (1-2)</td>
<td>QnA (1-3)</td>
</tr>
<tr>
<td>QnA (1-1)</td>
<td>0, host station</td>
<td>1, other station (2)</td>
<td>2, other station (1)</td>
</tr>
<tr>
<td>AnA (1-2)</td>
<td>0, host station</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
<tr>
<td>QnA (1-3)</td>
<td>1, other station (1)</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnU (2-1)</td>
<td>0, host station</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
<tr>
<td>GOT (2-3)</td>
<td>0, host station</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnU (2-4)</td>
<td>0, host station</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
<tr>
<td>QnA (L-1)</td>
<td>0, host station</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
<tr>
<td>AnA (L-2)</td>
<td>0, host station</td>
<td>0, host station</td>
<td>0, host station</td>
</tr>
</tbody>
</table>

*1 When monitoring a data link system, set the NW No. to 0.

How to read the table: 

\[ \uparrow \text{NW no. setting} \quad \uparrow \text{Station no. setting} \]

\[ \frac{2}{1}, \text{other station (2)} \]
(Example 5) For CPU direct connection and calculator link connection

- The monitoring access range for devices of other stations (other than B and W) and other networks is the same as that listed in Example 3 and Example 4.

- Setting the NW number and station number for monitor devices

The settings for the NW number and station number for monitor devices are the same as those listed in Example 3 and Example 4.

(Example 4) For MELSENET/10 connections

- Monitoring access ranges for devices of other stations (other than B and W)

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>QnA (1-1)</th>
<th>QnA (1-2)</th>
<th>GOT (1-3)</th>
<th>AnU (1-4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOT (1-3)</td>
<td>△</td>
<td>△</td>
<td></td>
<td>O</td>
</tr>
</tbody>
</table>

O: Can be accessed  
△: Can be accessed within AnA range (for T/C, the range is 0 - 255)  
X: Can’t be accessed

- Setting NW numbers and station numbers when setting monitor devices

1) When monitoring the B and W devices of the connected station (host station) assigned with the network parameter

Set the NW number to 0 and the station number to the host station.

2) When monitoring another station (other than B and W)

<table>
<thead>
<tr>
<th>Station being accessed</th>
<th>QnA (1-1)</th>
<th>QnA (1-2)</th>
<th>GOT (1-3)</th>
<th>AnU (1-4)</th>
</tr>
</thead>
<tbody>
<tr>
<td>GOT (1-3)</td>
<td>0, other station (1)</td>
<td>0, other station (2)</td>
<td></td>
<td>0, other station (4)</td>
</tr>
</tbody>
</table>

How to read the table:  

\[ \text{NW no. setting, Station no. setting} \]
9.5 Access Ranges Which Can Be Monitored When Using the MELSEC-FXCPU

When using the MELSEC-FXCPU, the only access range which can be monitored is the CPU to which the GOT is connected. Other stations cannot be monitored.

9.6 Access Ranges Which Can Be Monitored When Using the OMRON PLC

When using the Omron PLC, the only access range which can be monitored is the PLC to which the GOT is connected. Other stations cannot be monitored.
Chapter 10

Common Operations Used in Setting Sprites
10. Common Operations Used in Setting Sprites

10.1 Setting Devices for Monitoring

This section describes the device settings used for monitor device and common screen data. Clicking on the “Device” parameter in any of the dialog boxes displays the [Device] dialog box.

When the PC type is set to MELSEC-ACPU or QnACPU

![Device dialog box for MELSEC-ACPU](image)

- **Type**: 16bit/signed
- **Device**: 0
- **Bit position**: 
- **Block**: 
- **Unit top I/O**: 
- **Nw No.**: 
- **Station No.**:
  - [ ] Host
  - [ ] Others

When the PC type is set to MELSEC-FXCPU

![Device dialog box for MELSEC-FXCPU](image)

- **Type**: 16bit/signed
- **Device**: 0
- **Bit position**: 

When the PC type is set to Omron PLC

![Device dialog box for Omron PLC](image)

- **Type**: 16bit/signed
- **Device**: DM 0
- **Bit position**: 
"type" Select the data type for the device being specified, using the list box. The options available for selection in the list box vary depending on the sprite being set.

"Device" Select the name of the device being monitored from the list box. The device names available for selection vary depending on the sprite being set.

"Device No." 
- Set the number of the device being monitored, using the spin box.
- If "BM" (buffer memory) is selected as the device name, specify the address of the buffer memory being monitored, using the spin box.

"Bit position" When a specified bit of a word device is being monitored, specify the bit number being monitored with the spin box.

"Block" When "ER" (expansion file register) is selected as the device name, specify the block number with the spin box.

"Unit top I/O" If "BM" (buffer memory) is selected as the device name, specify the top I/O number, using the spin box.
If the first I/O number specified has not actually been installed, please be aware that the sprite function will be displayed with incorrect data.


- If monitoring is being carried out on the PC CPU connected to the system, regardless of the connected system, the NW number should be set to 0 and the station number to the host station for the B and W devices assigned with the link parameter or network parameter.

10.1.1 Ranges for Device Names and Device Numbers to be Set

The graphics software program does not check to see if the specified device name and device number are usable by the PC CPU that has been connected or is being monitored.

Please refer to the user's manual for the PC CPU that has been connected or is being monitored, and specify a device name and device number that can be used by the PC CPU.
10.2 Setting Data Expressions (Other Than Numeric Input Function)

10.2.1 Items to Know before Setting Data Expressions

(1) What are data expressions?

With this function, the values set for the various monitor devices by the sprites are read out from the PC CPU based on the display conditions, and those values undergo data calculation using specified equations. Monitoring of sprites is then carried out based on the processed values.

(2) Types of sprites for which data expressions can be set

- Numeric display function
- Parts display (word) function
- Lamp display (word) function
- Trend graph display function
- Level display function

* Operations based on equations cannot be carried out with graph displays.

10.2.2 Types of Expression Procedures That Can be Set

The following three types of expression procedures can be specified:

- Mask expression
- Shift expression
- Expression based on equations

<table>
<thead>
<tr>
<th>Expression sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device value</td>
</tr>
</tbody>
</table>

--- indicates that no data expression has been specified.
(1) **What is a mask expression?**

In this operation, a logical AND, logical OR, or an exclusive OR (XOR) is carried out on the mask value which specifies the monitor device value.

- Logical AND expression

  This returns a value of "1" only if both bit numbers are "1", and otherwise returns a value of "0".

  (Example)
  
<table>
<thead>
<tr>
<th>Monitor device value</th>
<th>0:1:0:1:0:1:0:1:0:1:0:1:0:1:0:1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified mask value (set as hexadecimal value)</td>
<td>0:0:0:1:1:1:1:1:1:1:0:0:0:0:0:0</td>
</tr>
<tr>
<td>Expression result</td>
<td>0:0:0:0:0:1:0:1:0:1:0:0:0:0:0:0</td>
</tr>
</tbody>
</table>

- Logical OR expression

  This returns a value of "0" if either bit number is "0", and otherwise returns a value of "0".

  (Example)
  
<table>
<thead>
<tr>
<th>Monitor device value</th>
<th>0:1:1:0:0:0:0:1:1:1:1:0:1:1:1:1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified mask value (set as hexadecimal value)</td>
<td>0:1:0:1:1:1:0:0:1:1:1:1:0:0:0:0</td>
</tr>
</tbody>
</table>

- Exclusive OR expression (XOR)

  This returns a value of "0" if both values are the same, and otherwise returns a value of "1".

  (Example)
  
<table>
<thead>
<tr>
<th>Monitor device value</th>
<th>0:1:0:1:1:0:0:1:0:1:0:1:0:1:0:1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified mask value (set as hexadecimal value)</td>
<td>0:0:0:0:1:1:1:1:1:0:0:0:0:1:1:1</td>
</tr>
<tr>
<td>Expression result</td>
<td>0:1:0:1:1:0:1:0:1:0:1:0:1:0:0:0</td>
</tr>
</tbody>
</table>

(2) **What is a shift expression?**

This expression shifts the monitor device value in the specified direction (left or right) by the specified number of bits.

(Example 1)

<table>
<thead>
<tr>
<th>Monitor device value</th>
<th>1:1:1:1:0:0:0:0:1:1:1:1:0:0:0:0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression result</td>
<td>0:0:0:0:1:1:1:1:0:0:0:0:1:1:1:1</td>
</tr>
</tbody>
</table>

(Example 2)

<table>
<thead>
<tr>
<th>Monitor device value</th>
<th>0:0:0:0:1:0:1:0:1:1:1:1:0:1:1:1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression result</td>
<td>1:0:1:0:1:1:1:1:0:1:1:0:0:0:0:0</td>
</tr>
</tbody>
</table>
(3) **What are expressions based on equations?**

With this function, a monitor device value is added, subtracted, multiplied or divided using a specified equation, and the resulting value is used to display the sprite function.

There are eight types of formats which can be used with equations.

<table>
<thead>
<tr>
<th>Expression</th>
<th>Types of calculation possible</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A \times B$</td>
<td>When adding $\ldots$</td>
<td>$100 \times 3 = 300$</td>
</tr>
<tr>
<td>$A \times (B \times C)$</td>
<td>When multiplying $\ldots$</td>
<td>$10 \times 3 = 30$</td>
</tr>
<tr>
<td>$(A \times B) \times C$</td>
<td>When calculating a percentage $\ldots$</td>
<td>$10 \times 3 = 30 %$</td>
</tr>
<tr>
<td>$A \times (B \times (C \times D))$</td>
<td>When subtracting $\ldots$</td>
<td>$10 \times 3 = 10 - 30$</td>
</tr>
<tr>
<td>$(A \times B \times C) \times (D \times E)$</td>
<td>When dividing $\ldots$</td>
<td>$10 \times 3 = 10 / 3$</td>
</tr>
<tr>
<td>$(A \times B) \times ((C \times D) \times E)$</td>
<td>What is a percentage expression?</td>
<td>$\ldots$</td>
</tr>
<tr>
<td>$((A \times B) \times (C \times D)) \times E$</td>
<td>The left side is divided by the right side, and the remainder is returned as the result.</td>
<td>$100 % 3 = 1 (100 / 3 = 33, with a remainder of 1)$</td>
</tr>
<tr>
<td>$A % B$</td>
<td>The remainder is returned as the result.</td>
<td>$50 % 8 = 2 (50 / 8 = 6, with a remainder of 2)$</td>
</tr>
</tbody>
</table>

**Items that can be specified for A to E:**

- **Numeric value**
  - Numeric values of up to 32 digits including minus signs and decimal points may be specified (in decimal format).

- **$\$$**
  - This is specified if the value of the monitor device is specified from among A to E.
  - This should always be set for at least one position from among A to E. The $\$$ character may not be set at two locations.

- **Device**
  - This is specified if the current value of the specified device is specified from among A to F.
  - The only devices which can be specified are those connected to the GOT. If a MELSECNET connection is being used, only the W assigned using the link parameter or network parameter may be used.
  - The data type for devices which can be specified will be the data type for the monitor device.
  - Up to two types of devices may be specified from among A to E.
### 10.2.3 Setting Data Expressions (Other Than Numeric Input Function)

**Data Expression Procedure**

<table>
<thead>
<tr>
<th>Mask</th>
<th>Shift</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>AND</td>
<td>Left</td>
</tr>
<tr>
<td>OR</td>
<td>Right</td>
</tr>
</tbody>
</table>

Pattern: [HEX]

Expression:

When a mask expression is carried out, the type of mask expression is selected using the radio button.

- **Mask**: When a mask expression is carried out, the type of mask expression is selected using the radio button.
  - None: Select this when no mask expression is to be carried out.
  - AND: Select this for a logical AND.
  - OR: Select this for a logical OR.
  - XOR: Select this for an exclusive OR.

**Pattern**: Specify the mask value to be expressed using the spin box. This setting is entered as a hexadecimal value.

**Shift**: When a shift expression is carried out, select the shift direction using the radio buttons.

- None: Select this when no shift expression is to be carried out.
- Left: Select this to shift to the left.
- Right: Select this to shift to the right.

**No. of shift**: Specify the number of shifts, using the spin box.
"Expression" If the operation is to be carried out based on an equation, click on "Edit", and specify the equation in the "Input Expression" dialog box.

"Expression style" Select the format of the expression from the list box.

"Expression" After specifying the expression style, click on the box for each item and specify numeric values for "Numerical term" and "Variable term", and the monitor device ($$) for the "Device" parameter.

"Select the operands for the left and right sides from the list box.

"Numerical term" When setting the numeric values for the various items, click on the display position of the numeric value and then on [Enter]. Clicking on [Enter] inputs the numeric value. Numeric values are input as decimal values, and up to 32 digits can be input. To clear a numeric value, click on [C].

"Variable term" To specify the "Device" parameter for each item, click on $$ (This can only be set at one location.) To set the current value of a device set for one of the various items, click on [Device] to display the "Set Device" dialog box. Specify the word device in this dialog box. (Up to two devices may be specified.) The only devices which can be specified are those connected to the GOT.

See Section 10.1, Setting Devices for Monitoring.

If a MELSECNET connection is being used, only the W assigned using the link parameter or network parameter may be used.

The data type for devices which can be specified will be the data type for the monitor device.
10.3 Setting Data Expressions (Numeric Input Function)

10.3.1 Types of Expression Procedures That Can be Set with the Numeric Input Function

- Mask expressions
- Shift expressions
- Writing word expressions (expression based on equation)
- Monitor word expressions (expression based on equation)

Expression sequence

--- indicates that no data expression has been specified.

(1) What is a mask expression?
This carries out a logical AND, a logical OR, or an exclusive OR (XOR) on an input value and the specified mask value. After the result is written to the destination device, a mask operation is carried out on the written value and the mask value, and the result is displayed as a numeric value.

See Section 10.2.2, Types of Expressions That Can Be Set Other Than Numeric Input Functions (1).

(2) What is a shift expression?
This carries out a shift of the input value in the specified direction (right/left) by the specified number of bits. After the result is written to the destination device, the written value is shifted in the specified direction by the specified number of bits, and the result is displayed as a numeric value.

See Section 10.2.2, Types of Expressions That Can Be Set Other Than Numeric Input Functions (2).

(3) What is a writing word expression?
The format of the equation is specified, and an equation is created that includes the input value ($W$). The processed value is then written to the destination device.

See Section 10.2.2, Types of Expressions That Can Be Set Other Than Numeric Input Functions (3).

POINT
Avoid specifying an equation that causes the expression result to exceed the allowable range for the specified data type (16-bit or 32-bit).

(4) What is a monitor word expression?
The format of the equation is specified, and an equation is created that includes the written value ($S$). The processed value is then written to the destination device.

See Section 10.2.2, Types of Expressions That Can Be Set Other Than Numeric Input Functions (3).
(5) Restrictions on data operations with the numeric input function

When a numeric value containing a decimal point is converted to an integer through a write word operation (when real numbers are being set) and is stored in the PC CPU, there may be times when the value stored in the PC CPU is different from the actual value, based on the input value.

<Example>

No. of decimal places: 2  
Write word equation: $W \times 100$

Input value: 9.95  
Internal GOT processing:

9.9499999 ---
(Handled as a real number with a floating decimal point)

↓

9.9499999 --- \times 100 = 994.99999.....
(6 decimal places are discarded)

↓

Value written to PC CPU: 994

- With the GOT, when real-number data with a floating decimal point is converted to an integer by means of a write word operation, the digits to the right of the decimal point will be discarded when the value is stored in the CPU, as in the above example.

- Specify a write word operation like the following:

$(SW + 0.001) \times 100$

If the input value is a negative value (carried to two decimal places):

$(SW - 0.001) \times 100$

When carried to three decimal places:

$(SW + 0.0001) \times 1000$

- When both positive and negative values are entered, the write word operation varies, as shown above. The numeric input function should be specified independently for positive value input and negative value input. (This is because there is only one type of write word operation equation for one numeric input function.)
### Setting Data Expressions (Numeric Input Function)

#### Data Expression Procedure

![Numerical Input Interface]

- **Mask**
  - When a mask expression is carried out, the type of mask expression is selected using the radio button.
  - None ......... Select this when no mask expression is to be carried out.
  - AND ............ Select this for a logical AND.
  - OR ............ Select this for a logical OR.
  - XOR .......... Select this for an exclusive OR.

- **Pattern**
  - Specify the mask value to be expressed using the spin box. This setting is entered as a hexadecimal value.

- **Shift**
  - When a shift expression is carried out, select the shift direction using the radio buttons.
  - None .......... Select this when no shift expression is to be carried out.
  - Left .......... Select this to shift to the left.
  - Right .......... Select this to shift to the right.

- **No. of shift**
  - Specify the number of shifts, using the spin box.

- **Monitor word expression**
  - If the operation is to be carried out based on an equation created using the value after being written to the writing destination, click on **Edit**, and specify the equation in the "Input Expression" dialog box.
"Write word expression"  If the operation is to be carried out based on an equation created using the input value, click on Edit, and specify the equation in the "Input Expression" dialog box.

"Expression style"  Select the format of the expression from the list box.

"Expression"  After specifying the expression style, click on the box for each item and specify numeric values for "Numerical term" and "Variable term", and the monitor device (SS) for the "Device" parameter.

"Numerical term"  When setting the numeric values for the various items, click on the display position of the numeric value and then on [Enter]. Clicking on [Enter] inputs the numeric value. Numeric values are input as decimal values, and up to 32 digits can be input. To clear a numeric value, click on [C].

"Variable term"  When specifying the "Monitor word expression" parameter, to specify the "Device" parameter for each item, click on [SS]. (This can only be set at one location.) When specifying the "Write word expression" parameter, to specify the "Device" parameter for each item, click on [SW]. (This can only be set at one location.) When setting "Monitor Word Expression" and "Write Word Expression", to set the current value of a device set for one of the various items, click on [Device] to display the "Set Device" dialog box. Specify the word device in this dialog box. (Up to two devices may be specified.)

See Section 10.1, Setting Devices for Monitoring.

The only devices which can be specified are those connected to the GOT. If a MELSECNET connection is being used, only the W assigned using the link parameter or network parameter may be used.

The data type for devices which can be specified will be the data type for the monitor device.
10.4 Setting Display Conditions

This section explains how to enter the settings for the display conditions specified for the various sprites.

10.4.1 Items to Know before Setting Display Conditions

(1) Types of display conditions that can be set

- Ordinary
- While ON/while OFF
- Rising/falling
- Sampling

(2) Ordinary displays that can be set

With this method, monitor device data is read out from the PC CPU once during the scan time of the sequence program (END processing) or once per link scan time, and the data is displayed.

(3) Displays that can be set while on or off

With this method, monitor device data can be read out from the PC CPU once during the scan time of the sequence program (END processing) or once per link scan time, while the specified bit device is ON/OFF, and the data displayed. The sprite display can be deleted or saved if the condition is never satisfied.

(4) Displays set during rise or fall

With this method, monitor device data can be read out from the PC CPU once during the scan time of the sequence program (END processing) or once per link scan time, when the specified bit device is detected to have gone ON (rise time) or OFF (fall time), and the data displayed.

Monitor device data can be read and displayed even if conditions in effect only the first time that the screen is switched have not been fulfilled.

(5) Displays set based on sampling

Monitor device data is read out from PC CPU and displayed at the specified timing (in units of one second).
10.4.2 Setting Up Displays When Setting Several Sprites on One Screen

With the GOT, there is a limit to the number of sprites that can be read from the PC CPU during one scan time of the sequencer program (END processing) or one link scan time. The number of sprites that can be read depends on the GOT connection configuration and the device being monitored.

<table>
<thead>
<tr>
<th>Connection configuration</th>
<th>Device being monitored</th>
<th>Max. no. readable at one time *1</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bus connection</td>
<td>Monitoring of B and W assigned with host station/link parameter or network parameter</td>
<td>40 points</td>
</tr>
<tr>
<td>• CPU direct connection (other than OnACPU)</td>
<td>Monitoring of devices other than B and W for other station</td>
<td></td>
</tr>
<tr>
<td>• Calculator link connection (other than AJ71QC24)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• CPU direct connection ([RACPU])</td>
<td>Monitoring of B and W assigned with host station/link parameter or network parameter</td>
<td>96 points</td>
</tr>
<tr>
<td>• Calculator link connection (AJ71QC24)</td>
<td>Monitoring of devices other than B and W for other station</td>
<td></td>
</tr>
<tr>
<td>• MELSECNET (II) connection</td>
<td>Monitoring of B and W assigned with link parameter</td>
<td>Total no. of points set for 1 screen</td>
</tr>
<tr>
<td>• MELSECNET/B connection</td>
<td>Monitoring of other station</td>
<td>40 points</td>
</tr>
<tr>
<td>• MELSECNET/10 connection</td>
<td>Monitoring of B and W assigned with network parameter</td>
<td>Total no. of points set for 1 screen</td>
</tr>
<tr>
<td></td>
<td>Monitoring of other station</td>
<td>40 points</td>
</tr>
</tbody>
</table>

*1. Calculating the number of sprite points

- The value obtained by adding the total number of points indicated below is the total number of sprites that can be set on one screen.

Total no. of display conditions for sprites set on one screen + Total no. of sprites for devices being monitored set on one screen = Total no. of points

<table>
<thead>
<tr>
<th>Display condition</th>
<th>Calculated as 0 points</th>
<th>Calculated as 1 point</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordinary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sampling</td>
<td></td>
<td></td>
</tr>
<tr>
<td>While on/off</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At rise/fall</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Device monitored</th>
<th>Calculated as 1 point</th>
<th>Calculated as 2 points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Data type: 16-bit)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Data type: 32-bit)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If the sprites specified for one screen exceed the maximum number of points that can be read based on the above table, the display conditions (ON/OFF status of the bit device) for all of the sprites and the device being monitored cannot be read in one scan time (END processing) or one link scan time. The amount of time required for all of the sprites to be displayed will be longer.

In order to make sure all of the display conditions (ON/OFF status of the bit device) for all of the sprites and the device being monitored can be read, set the GOT in the actual monitoring mode, and check whether the ON/OFF time of the bit device for the display conditions and the device being monitored has to be maintained for more than a given number of milliseconds. Then adjust the sequence program accordingly.

Even if the number of sprites specified on one screen is less than the maximum number that can be read at one time, and the scan time (END processing/ link scan time of the sequence program is 100 ms or less, the GOT is still unable to finish reading the display conditions (ON/OFF status of the bit device) and the data of the device being monitored, in less than 100 ms.

Always adjust the sequence program is adjusted so that the on/off time of the bit device and the data of the device being monitored are maintained for 100 ms or longer.
10.4.3 Setting Display Conditions

(Display Conditions) Procedure

We will use an example of a dialog box from the numeric display function.

![Numerical Display Dialog Box]

"Trigger type" Using the radio buttons, select the display conditions under which the sprite is to be displayed. If "Sampling" is selected, select the sampling time with the spin box. Settings can be entered in units of 1 second, starting from a minimum of 1 second.

"Trigger device" If "ON", "OFF", "Rise", or "Fall" is selected for the "Trigger type" parameter, click on [Dev.], and specify the bit device in the "Device Setting" dialog box. See Section 10.1, Setting the Device Being Monitored.

"Initial display" If "Rise" or "Fall" is selected for the "Trigger type" parameter, place an "X" in the check box if the data for the device being monitored is to be read and displayed even if only the first condition when the screen is switched has not been satisfied.

"Hold display" If "ON" or "OFF" is selected for the "Trigger type" parameter, place an "X" in the check box if the sprite display is to be retained after the condition is no longer satisfied. If there is no "X" in the check box, the sprite display will disappear as soon as the condition is no longer satisfied.
10.5 Setting Display Ranges (Comparative Equations)

This section explains how display methods are switched based on the values of the device being monitored for each of the sprites, and on the values of the data expression results, and how to specify comparative equations to change the display color and attributes.

This function can also be used to specify the input range for numeric input functions.

When entering settings for the display method, the “Edit Display Format” dialog box is displayed.

```
Edit Display Format

Attribute

Color: [ ] [ ] [ ] [ ] [ ] [ ] Reverse

Blink: No [ ]

OK Cancel

Display range

<

Left < [ ] Middle No [ ] Right [ ]
```

For items other than “Display range”, the items to be set are described under the respective sprite.

“Display range”
- **Left**
- **Middle**
- **Right**

Clicking on “Left”, “Middle”, or “Right” displays the “Input Expression” dialog box, where values can be specified for the pertinent items.

```
“<”

Select the operands used for left and center items, using the list box.

< ........ The value of the left item is smaller than that of the center item.

<= .......... The value of the left item is the same as that of the center item, or smaller.

== .......... The value of the left item is the same as that of the center item.

!= .......... The value of the left item is different from that of the center item.
```

```
“No”

Select the operands used for center and right items, using the list box.

No ......... Select this if the equation does not contain three elements.

< ........ The value of the center item is smaller than that of the right item.

<= .......... The value of the center item is the same as that of the right item, or smaller.
```
Setting the “Input Expression” Dialog Box

“Numerical term”  To enter numeric values for the left, center, and right items, click on the position where the numeric value is displayed, and then click on [Enter].
Clicking on [Enter] enters the numeric value. Numeric values are input as decimal values, and up to 32 digits can be entered.
To clear a numeric value, click on [C].

“Variable term”  Click on this to enter the values listed below for the left, center, and right items.
$V  ....... "Monitor device value"/Select this when specifying the value resulting from the data expression when a data expression is specified.
$W  ....... Select this to specify an input value.
( $W can be selected only if the numeric input function has been specified.)
Chapter 11

Setting Data Display Functions
11. Setting Data Display Functions

11.1 Setting the Numeric Value Display Function

When does this function do?

This function displays data stored in the word device as a numeric value.

---

Example of Settings

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display size</strong></td>
<td>Vertical: 2 x ; Horizontal: 2 x</td>
</tr>
<tr>
<td><strong>Monitor device</strong></td>
<td>16 bits/with sign 0-FF-D100</td>
</tr>
<tr>
<td><strong>Display style</strong></td>
<td>Decimal, with sign</td>
</tr>
<tr>
<td>&quot;Digits&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Left alignment/Right alignment&quot;</td>
<td>Aligned right</td>
</tr>
<tr>
<td>&quot;Zero suppress&quot;</td>
<td>No</td>
</tr>
<tr>
<td><strong>Display method</strong></td>
<td><strong>Display color</strong></td>
</tr>
<tr>
<td>Ordinary</td>
<td>&quot;Blink&quot;</td>
</tr>
<tr>
<td></td>
<td>&quot;Reverse display&quot;</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Trigger type</strong></td>
<td>Default</td>
</tr>
</tbody>
</table>
Procedure Outline

Basic Settings
- Display size setting
- Monitor device setting
- Display style setting
- Display color setting

See 1

Change display color when monitor device reaches a certain value?

NO

Display Method
- Setting of comparative equation to change display method

See 5

YES

Set data expression?

NO

Data Expression
- Setting of calculation equation for data expression

See 2

YES

Trigger
- Setting of display conditions

See 3

When settings have been completed, click on "OK" on any tab.

Setting of display position

See 4

End
**Description of Settings**

**1. Setting the Basic settings**

<table>
<thead>
<tr>
<th>Basic</th>
<th>Display Format</th>
<th>Expression($)</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Position**
- X: 0
- Y: 0

**Size**
- V: 1
- H: 1

**Monitor device($$)**
- 0:FF D0

**Display style**
- Signed decimal
- Digits: 6
- Decimal point: 0
- Left alignment
- Right alignment
- Disp. all digits

**Default**
- Color: [ ]
- Norm.: [ ]
- Blink: [ ]

**Display size**
Select the size in which numeric values are to be displayed, using the list box. Characters displayed at the x 1 size in both directions are displayed at 16 x 18 dots.

**Monitor device**
Click on [Dev.] and then use the "Device Settings" dialog box to specify the word device to be monitored.

**Device type**
Select the data type for the word device to be monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
</tr>
</tbody>
</table>

**NW No.**

**Station No.**

**Device Name**

**Device No.**

**Display style**
Select the style in which monitor device values or data expression results are to be displayed, using the list box.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>Select this to display monitor device values or data expression results as decimal values.</td>
<td>Select this to display monitor device values or data expression results as real numbers with floating decimal points.</td>
<td>Select this to display monitor device values or data expression results as binary values.</td>
</tr>
</tbody>
</table>

See Section 10.1, Setting the Monitor Device.
"Digits" Specify the number of digits used to express the numeric value, using the spin box. The number of digits that can be displayed using the "Display style" parameter is as shown below.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>1 - 13 digits (including minus sign)</td>
<td>1 - 32 digits (including decimal points and digits to right of decimal point)</td>
<td>1 - 32 digits</td>
</tr>
</tbody>
</table>

"Decimal point" When real numbers are selected using the "Display style" parameter, use the spin box to specify how many digits to the right of the decimal point are to be displayed.

(Example) No. of digits displayed: 5, No. of digits to right of decimal point: 3
Contents of monitor device: 324.5321 (real number with floating decimal point)

*Image of display showing 4.532 and 324.5321*

"Left alignment" Using the radio buttons, select whether the display is to be aligned to the left or right in relation to "Right alignment" the display position.

(Example) No. of digits displayed: 6, contents of monitor device: 150

*Image of display showing left and right alignment with display range*

When "Right alignment" is selected above, place an "X" in the check box if zeros are to be displayed in front of the numeric value.

"Zero suppress" (Example) No. of digits displayed: 6, contents of monitor device: 150

*Image of display showing zero suppress with display range*
"Normal"  Click on [Edit] and specify the display color in the "Edit Display Format" dialog box.

"Attribute"  If a comparative equation is being specified using [Display Format], these settings for the display color and attribute are effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

"Color"  Select the color in which numeric values are to be displayed, using the list box.

"Blink"  If a blinking display is to be used, select "Yes" using the list box.

"Reverse"  If a reversed display is to be used, place an "X" in the check box.

2. Setting the Data Expression
   → See Section 10.2, Setting Data Expressions.

3. Setting the Trigger
   → See Section 10.4, Setting Display Conditions.

4. Setting the display position
   (1) When the settings for the various tabs have been entered, click on [OK] in any tab.
   (2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified numeric values.

   (3) Move the cursor to the display position, and click at that position.
5 Setting the Display Format

This is specified if the display color and attributes are to be changed when the value of the monitor device or the value resulting from the data expression reaches a certain value.

Click on Edit to display the “Edit Display Format” dialog box, and specify the display color, attribute, and comparison equation. Up to seven types of comparison equations can be specified.

To delete a comparison equation that has been specified, click on Delete. To change the order of the specified comparison equations, click on Up or Down.

“Attribute” Specify the display color and attribute to be used once the monitor device value or the value resulting from the data expression corresponds to the comparison equation specified by the “Display Range” parameter.

“Color” Select the display color, using the list box.

“Reverse” If a reversed display is to be used, place an “X” in the check box.

“Blink” If a blinking display is to be used, select “Yes” using the list box.

“Display range” Specify the comparison equation or equations.

See Section 10.5, Setting the Display Range (Comparative Equations).
(Examples)
Case 1: Monitor device value is -100 or less ($$ \leq -100$$): Blinking display in yellow
Case 2: Monitor device value is 100 ~ 500 (100 \leq $$ \leq 500$$): Displayed in blue
Case 3: Monitor device value is 1000 or higher (1000 \leq $$): Reversed blinking display in red
Normal: When the monitor device value does not correspond to any of the above: Display color specified with the "Normal" parameter

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Color</th>
<th>Normal/ reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$$ \leq -100$$</td>
<td>Yellow</td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>100 \leq $$ \leq 500$$</td>
<td>Blue</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>1000 \leq $$</td>
<td>Red</td>
<td>Reversed</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Normal</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
</tbody>
</table>

The "Normal" parameter is specified using the (Basic) tab.

Outline of Operation Procedure

In the "Edit Display Format" dialog box, specify the display color, attributes, and comparison equations.
The values for "Left", "Middle", and "Right" are specified using the "Input Expression" dialog box.
Specify the for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
11.2 Setting the ASCII Display Function

**When does this function do?**

With this function, stored data following the word device is viewed as character codes (ASCII codes or shift JIS codes), and is displayed as a character string.

---

**Example of Settings**

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x, horizontal: 2 times</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0 - FF - D0</td>
</tr>
<tr>
<td>&quot;Digits&quot;</td>
<td>9</td>
</tr>
<tr>
<td>&quot;Display format&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; No</td>
</tr>
<tr>
<td></td>
<td>&quot;Reverse&quot; No</td>
</tr>
</tbody>
</table>

**Tigger**

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Procedure Outline

- Basic
  - Display size setting
  - Monitor device setting
  - Display style setting
  - Display format setting

- Trigger
  - Setting of display conditions

When settings have been completed, click on "OK" on any tab.

Setting of display position

See 1

See 2

See 3

End
Description of Settings

1 Setting the Basic settings

![Screen capture of Basic settings](image)

"Display size" Select the size in which character strings are to be displayed, using the list box.
(Example) Vertical: 2 x Horizontal: 2 x

![Diagram of display sizes](image)

"Monitor device" Click on [Dev.] and then use the "Device Settings" dialog box to specify the initial word device in which the character code to be displayed is stored.

See Section 10.1, Setting the Device to be Monitored.

"Display style"

"No. of digits displayed" Select the number of characters to be displayed, using the spin box.
(Example) No. of digits displayed: 4

![Example of digit display](image)

"Display format"

"Color" Select the color in which character strings are to be displayed, using the list box.

"Blink" If a blinking display is to be used, select "Yes" using the list box.

"Reverse" If a reversed display is to be used, place an "X" in the check box.
2 Setting the Trigger

See Section 10.4, Setting Display Conditions.

3 Setting the display position

(1) When the settings for the various tabs have been entered, click on [OK] in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified ASCII display.

(3) Move the cursor to the display position, and click at that position.

Special Cases

- What happens if the character code being displayed contains a space (20H)?

  The space (20H) will be displayed as a blank.

The space (20H) is treated as one digit and displayed.
11.3 Setting the Clock Display Function

When does this function do?

This function displays the internal clock data in the GOT.

When the power supply is turned on, the GOT reads the PC CPU clock data and verifies the PC CPU clock data once every hour.

POINT

If there is no clock data in the PC CPU which is connected to the GOT, the clock display function cannot be used.

--- Example of Settings ---

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Contents of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Item&quot;</td>
<td>Time</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
</tbody>
</table>

--- Example of Settings ---

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Contents of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Item&quot;</td>
<td>Date</td>
</tr>
<tr>
<td>&quot;Date&quot;</td>
<td>Year/month/day</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
</tbody>
</table>
### Procedure Outline

Clock display settings
- Setting of item to be displayed
- Setting of date
- Setting of display size
- Setting of display color

When settings have been completed, click on "OK".

Setting of display position

End

See 1

See 2

### Description of Settings

1. Setting the "Clock display settings" dialog box

![Clock display settings dialog box](image)
"Item" Using the radio buttons, select whether the date or time is to be displayed. The format in which the date and time are displayed is fixed and cannot be changed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Contents of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>The display format is determined by the &quot;Date format&quot; parameter. The number of digits displayed is fixed at 8. The year is displayed in the four-digit style of the Western calendar. (Example) Date format: Year/month/day</td>
<td>The number of digits displayed is fixed at 5. The time is displayed using the 24-hour system. (Example)</td>
</tr>
<tr>
<td><img src="image" alt="95/07/07" /></td>
<td><img src="image" alt="23:05" /></td>
</tr>
</tbody>
</table>

"Date format" If "Date" is selected for the "Item" parameter, use the radio buttons to select the format in which the date is displayed.

"Size" Using the list box, select the size in which the characters of the date/time are displayed. Characters displayed at the x1 size consist of 16 x 18 dots.

"Color" Select the color in which the date/time is to be displayed, using the list box.

2 Setting the display position

1. When the settings have been entered, click on [OK].

2. A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified clock display.

3. Move the cursor to the display position, and click at that position.
**Special Cases**

- If there is a clock function in the PC CPU to which the GOT is connected, this function can be run.

- Which PC CPU is used to read clock data when the power to the GOT is turned on?
  
The clock data of the PC CPU stated below is read, depending on how the GOT is connected.
  
  - For a bus connection, CPU direct connection, and calculator link connection
    
    ............... the PC CPU connected to the GOT

  - For a MELSECNET connection
    
    ............... the PC CPU of the master station/control station

- Precautions when using the clock display function

  While using the clock display function, the devices noted below should not be turned on or off.

  If the GOT is connected to a MELSEC-ACPU: M9025, M9028

  If the GOT is connected to a MELSEC-QnACPU: SM210, SM213
Chapter 12

Setting the Message Display Function
12. Setting the Message Display Function

12.1 Registering Comments to Display with the Comment Display Function

This section explains the procedure for registering comments to be displayed on the GOT using the comment display function and alarm list function (user alarms).

12.1.1 Registering Comments

When is this function used?

This function is used when you want to register comments to be displayed using the comment display function and alarm list function (user alarms).

- Useful information before registering comments
  - Up to 32,767 types of comments can be registered.
  - One comment can consist of 1 ~ 512 characters, regardless of whether half-width or full-width characters are used.
  - Comments consisting of several lines can be created.
  - To enter a line return, press Enter at the end of the comment line.
  - A line return takes up two characters.

Line 1 is currently in operation. ← Input Enter.

- To enter an empty line, with nothing on it, press Enter at that line. This takes up two characters.

Line 1 is currently in operation. ← Input Enter.

- The Enter command accounts for one character.

Line 1 is currently in operation. ← Input Enter.

The overall message consists of 13 characters: 12 for the message "Line 1 is currently in operation", and one for the Enter command.

- If a comment is created which consists of several lines, it will be displayed on the GOT as follows.

Currently in operation
Y70 is ON

Display range
- The character display size is specified using the dialog box where sprite settings are entered.

- The characters for various languages can be registered as comments and displayed using the comment display function and the alarm list display (user alarms) function. When such comments are input, however, the character input system corresponding to that language (excluding Japanese and English) is required.

With the comment display (bit) function, comments to be displayed when the sprite settings are entered can be specified and displayed, without having to register comments corresponding to the on/off status.

- With the comment display (word) function, when comments corresponding to the value of the word device are displayed (indirect command), a comment should be registered for the corresponding comment number.

(Example) If the value of D100 is “0”, the comment “Line 1 is not currently in operation” will be displayed.

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>The comment is registered as Comment No. 1.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current production quantity is 1</td>
<td></td>
</tr>
</tbody>
</table>

(Example) If the value of D100 is “100”, the comment “Current production quantity is 100” will be displayed.

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>The comment is registered as Comment No. 100.</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Current production quantity is 100</td>
<td></td>
</tr>
</tbody>
</table>
1. Select **Comment** on the Draw Settings menu.

2. The "Comment List" dialog box is displayed. Click on the comment column for the comment number about to be registered. Then click on **Edit**.

   If the comment number to be registered is not displayed, use the "Comment No." spin box to specify the comment number to be registered, and then click on **Jump**.

3. The "Edit Comment" dialog box is displayed. Enter the comment in the "Comment" text box. Using the "Color" list box under the "Attribute" parameter, select the color in which the comment is to be displayed.

   If the comment is to be displayed in a reverse display, place an "X" in the check box next to "Reverse".

   If the comment is to be displayed in a blinking display, select "Yes" for "Blink".

   Click on **OK**.

4. The "Comment List" dialog box is displayed. To correct the comment which has been registered, click on the comment column for the number of the comment to be corrected, and use the same procedure as that for registering comments to make the correction.

   When all of the comments have been registered, click on **OK**.
12.1.2 Deleting Registered Comments

- When is this function used?
  - This function is used when you want to delete a comment that has been registered.

   (If the "Comment List" dialog box is already open, this step can be skipped.)

2. The "Comment List" dialog box is displayed. Click on [Delete].

3. The "Delete Comment" dialog box is displayed.
   Using the spin box, specify the number of the comment to be deleted.

   If consecutive comments following the one specified by the "Delete No." parameter are also to be deleted, specify the number of lines to be deleted using the "No. of delete" spin box.

   Then click on [OK].

4. The comments for the specified comment number or numbers are deleted. After the comment or comments have been deleted, click on [OK].
12.1.3 Copying a Registered Comment to Another Comment Number

When is this function used?
- This function is used when you want to take a comment that has been registered and copy it to another comment number.

   (If the "Comment List" dialog box is already open, this step can be skipped.)

2. The "Comment List" dialog box is displayed. Click on [Copy].

3. The "Copy Comments" dialog box is displayed.
   Using the “Source No.” spin box, specify the number of the comment to be copied.
   If consecutive comments following the one specified by the “Source No.” parameter are also to be copied, specify the number of lines to be copied using the “No. of copy” spin box.
   Then click on [OK].

4. The comments for the specified comment number or numbers are copied. After the comment or comments have been copied, click on [OK].
12.1.4 Using Data in Text File Format as Comment Data

Text file data created using commercial text editor programs (files with the .TXT extension) can be used as comment data.

Also, registered comment data can be written to a specified file as text file data, enabling it to be edited using a text editor.

- Useful information before creating comment data with a text editor
  - Before inputting a comment, always enter /*, */, the comment number, and Enter.

```
/ / 1
```

- One comment can consist of 1 ~ 512 characters, regardless of whether half-width or full-width characters are used. Comments consisting of several lines can be created. To enter a line return, press Enter at the end of the comment line.

To enter an empty line, with nothing on it, press Enter at that line. This takes up two characters.

```
/ / 1
Currently in operation

Y70 is ON
```

- The Enter command is treated as a character.

- All of the data entered up to the next /*, */, comment number, and Enter sequence is handled as one comment.

```
/ / 1
Currently in operation

Y70 is ON

X30 is ON
/ / 2
Not currently in operation
/ / 3
Currently in operation
```

Comment for Comment No. 1

Comment for Comment No. 2

Comment for Comment No. 3

2. The "Comment List" dialog box is displayed. Click on [File].

3. The "Text File" dialog box is displayed. Using the "Write/Read" radio buttons, specify whether comment data is to be read or written. Then click on [Browse] after the "File name" parameter.

4. The "Browse" dialog box is displayed. If comment data is being read, specify the name of the file containing the data in text file format which is to be read. If comment data is to be written, specify the file name (.TXT) to which the data is to be written. Then click on [OK].

5. The "Text File" dialog box is displayed. Click on [OK].

The comment data is read or written as specified. When comment data is being written, only data which is in the text file format can be written. The display color and attributes cannot be written to the file along with the data.
6. The "Comment List" dialog box is displayed. When the reading or writing of the comment data has been completed, click on **OK**.
12.2 Setting the Comment Display (Bit) Function

**What does this function do?**
- This function is used to display comments corresponding to the ON/OFF status of the bit device.

**Example of settings**

### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Preview Comment No.&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; Horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>Bit device: 0 - FF - X0000</td>
</tr>
</tbody>
</table>

### Display Format

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ON&quot;</td>
<td>Display comment&quot; Direct</td>
</tr>
<tr>
<td>&quot;Attribute&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td></td>
<td>&quot;Reverse&quot; Yes</td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; No</td>
</tr>
<tr>
<td>&quot;Comment&quot;</td>
<td>X0 is ON</td>
</tr>
<tr>
<td>&quot;OFF&quot;</td>
<td>Display comment&quot; Direct</td>
</tr>
<tr>
<td>&quot;Attribute&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td></td>
<td>&quot;Reverse&quot; No</td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; No</td>
</tr>
<tr>
<td>&quot;Comment&quot;</td>
<td>X0 is OFF</td>
</tr>
</tbody>
</table>

### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Setting of preview comment number
- Setting of display size
- Setting of monitor device

See 1

Display Format
- Setting of display comment
- Setting of display color and attributes
- Registration of comments

See 2

Trigger
- Setting of display conditions

See 3

After entering settings, click on "OK" on any tab

Setting of display position (display range)

See 4

End
Description of settings

1. Setting the Basic settings

"Preview comment" Using the spin box, specify the number of the comment to be displayed when an image is displayed. Please be aware that the comment corresponding to the specified preview comment number will be displayed as an image even if the comment has been input directly, rather than specifying a comment number.

See Section 20.2, Viewing an Image of the Created Screen Data.

"Display size" Select the size in which the comment is to be displayed, using the list box.
(Example) Vertical: 2 x Horizontal: 2 x

8 dots 16 dots 10 dots 32 dots

8 dots 16 dots 32 dots

Half-width character

Full-width character

"Monitor device" Click on [Dev.] and then use the "Device Settings" dialog box to specify the bit device to be monitored.

"Dev." If the comment is to be displayed when a bit device is turned ON/OFF, select the bit device using the spin box. If the comment is to be displayed when the bit number of a word device is turned ON/OFF, select the word bit using the spin box.

"NW No." "Station No." "Device Name" "Device No." See Section 10.1, Setting the Device to be Monitored.
2 Setting the Display Format

"Comment (ON)" Using the radio buttons, select whether a registered comment is to be displayed, or the comment "Comment (OFF)" about to be entered in the "Comment" box is to be displayed.

No. ............ This is used to display a comment that has already been registered. When "No." is selected, use the spin box to specify the number of the comment to be displayed. Clicking on [Browse] under "Comment indication" displays the "Comment List" dialog box, where the number of the comment to be displayed can be confirmed.

Direct ........ Select this to display the comment entered in the "Comment" box.

Clicking on [Copy from ON] enables the contents specified with the ON comment to be copied. To select this directly, enter a comment in the Comment column

See Section 12.1, Registering Comments to Display With the Message Display Function.

"Attribute" When a number has been selected using the above setting, place an "X" in the check box if you do not want to display the comment in the color and with the attributes entered when the comment was entered.

"Change attribute" If an "X" is placed in the box, enter the desired settings for the color and attributes under "Color", "Blink", and "Reverse".

"Color" Using the list box, select the color in which the comment is to be displayed.

"Blink" If a blinking display is to be used, select "Yes" in the list box.

"Rev." If a reversed display is to be used, select "Yes" in the list box.
3 Setting the display conditions

See Section 10.4, Setting Display Conditions.

4 Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on [OK] in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window.

(3) Move the cursor to the position where the first letter of the comment is to be displayed (the upper left of the first letter), and click at that position.

(4) Move the cursor to a handle on the sprite setting frame, and press the left button of the mouse. Holding down the button, drag the mouse to the position marking the comment display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.

(5) When the display range has been determined, release the left button of the mouse.
Special Cases

- How do I display a comment only when the bit device is ON or OFF?
  Use the Display Format tab to specify the conditions under which the comment is to be displayed (when ON or OFF).
  (Example) To display the comment only when the bit device is ON:
  Comment to be displayed: X0 is currently ON.

- What happens if the comment is longer than the specified display range?
  If the comment is longer than the display range in the horizontal direction, it will be displayed in a wrap-around display.
  Comment to be displayed: Line 1 is currently in operation

If the comment is longer than the display range in the vertical direction, only the part of the comment which fits in the display range is shown.
Comment to be displayed: Line is currently stopped
  Press START button
  X1 is ON

The sentence "X1 is ON" will not be displayed.
12.3 Setting the Comment Display (Word) Function

- What does this function do?
  - This function is used to display comments corresponding to the value of the word device.

![Image of a device and comments]

---

**Example of Settings**

Comment registered in "Comment List" dialog box

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Display color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current production quantity is 1.</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td>Current production quantity is 10.</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>100</td>
<td>Today's production has been completed.</td>
<td>White</td>
<td>Reversed</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Preview comment no. &quot;</td>
<td>Specify either 1, 5, or 100</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 2 x; horizontal: 2 x</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>Word device: 0-FF-D100</td>
</tr>
<tr>
<td>Normal &quot;display format&quot;</td>
<td>Indirect</td>
</tr>
</tbody>
</table>

### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

- **Basic**
  - Setting of preview comment number
  - Setting of display size
  - Setting of monitor device
  - Setting of display format

- **Is comment display format to be switched when monitor device value reaches a certain value?**
  - **YES**
    - Setting of comparative equation used to switch display format
  - **NO**
    - Specify data expression?
      - **YES**
        - Setting of equation for data expression
      - **NO**
        - Data Expression
          - Setting of display conditions

- After entering settings, click on "OK" on any tab

- Setting of display position (display range)

See 1

See 2

See 3

See 4

See 5

End
**Description of settings**

1. **Setting the Basic settings**

   ![Screenshot of Basic settings dialog box]

   **Position**
   - X1: 0
   - Y1: 0
   - X2: 15
   - Y2: 15

   **Preview comment size**
   - V: 1
   - H: 1

   **Monitor device (D, H)**
   - D: 0~FF
   - Dev.

   **Default**
   - No.: [ ]
   - Edit [ ]

   “Preview comment no.”
   - Using the spin box, specify the number of the comment to be displayed when an image is displayed.
   - See Section 20.2, Viewing an Image of the Created Screen Data.

   **Size**
   - Select the size in which the comment is to be displayed, using the list box.
     - (Example) Vertical: 2 x 16 dots
     - Horizontal: 2 x 16 dots
     - 8 dots
     - 16 dots
     - 32 dots
     - 64 dots

   **Monitor device**
   - Click on [Dev.] and then use the “Device Settings” dialog box to specify the bit device to be monitored.
   - The “Device type” parameter for word devices is fixed at 16-bit with a sign.
   - See Section 10.1, Setting the Device to be Monitored.

   **Default**
   - Click on [EDIT] and select “Indirect” using the radio button in the Edit Display Format dialog box.
   - Using the radio button, select “Indirect”. When “Indirect” is specified, nothing is displayed if the value of the word device is 0 or less. If a comparative equation is specified under (Display Format), the comment display format specified when the monitor device value or data expression result does not correspond to the comparative equation will be used.

   ![Diagram of device states]
   - When monitor device value is “1”
   - When monitor device value is “0”
2 Setting “Data Expression”

See Section 10.2, Setting Data Expressions.

3 Setting “Trigger”

See Section 10.4, Setting the Display Conditions.

4 Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on [OK] in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window.

(3) Move the cursor to the position where the first letter of the comment is to be displayed (the upper left of the first letter), and click at that position.

(4) The cursor changes to the size changing cursor. Press the left button of the mouse, and, holding down the button, drag the mouse to the position marking the comment display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.

(5) When the display range has been determined, release the left button of the mouse.
5 Setting the Display Format

This is specified if the comment display format is to be switched when the monitor device value or the value resulting from the data expression reaches a certain value.

(1) Comments can be displayed in the following display formats, based on the comparative equation specified by "Display Range" and the monitor device value or the value resulting from the data expression.

No. ...................... If the monitor device value or the value resulting from the data expression fits the comparative equation, the comment corresponding to the specified comment number is displayed.
Indirect ................. If the monitor device value or the value resulting from the data expression fits the comparative equation, the comment corresponding to the value is displayed.
No Processing ......... If the monitor device value or the value resulting from the data expression fits the comparative equation, the currently displayed comment continues to be displayed.

(2) The comparative equation for the display range is specified as follows.

<table>
<thead>
<tr>
<th>Type of comparative equation</th>
<th>Left</th>
<th>Operand</th>
<th>Middle</th>
<th>Operand</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>n1</td>
<td>&lt;=</td>
<td>$V</td>
<td>&lt;=</td>
<td>m1</td>
</tr>
<tr>
<td>Above</td>
<td>n2</td>
<td>&lt;=</td>
<td>$V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>$V</td>
<td>&lt;=</td>
<td>$3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify numeric values for n1, m1, n2, and $3.

"$V" indicates the monitor device value or the value resulting from the data expression.
Click on "Edit" and specify the display format and comparative equation in the "Edit Display Format" dialog box. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

“Comment indication” Using the radio buttons, select the display format in which the comment is to be displayed when the monitor device value or the value resulting from the data expression fits the comparative equation specified with the "Display Range" parameter.

No. .................... This is used to display the comment corresponding to the specified comment number. Clicking on [Browse] under "Comment indication" displays the "Comment List" dialog box, where the number of the comment to be displayed can be confirmed.

Indirect................. Select this to display the comment for the comment number corresponding to the value.

No Processing ........ The currently displayed comment continues to be displayed.

“Change attribute” When a number has been selected with the “Comment indication” parameter, or “Indirect” has been selected, place an “X” in the check box if the comment is not to be displayed in the color and with the attributes specified when the comment was registered. Use the “Attribute” parameter to specify the display color and attributes of the comment.

“Attribute”

“Color” Using the list box, select the color in which the comment is to be displayed.

“Blink” If a blinking display is to be used, select “Yes” in the list box.

“Reverse” If a reversed display is to be used, place an “X” in the check box.

“Display range” Specify a comparative equation.

See Section 10.5, Setting the Display Range (Comparative Equation).
(Example)

Case 1: No comment is displayed if the monitor device value is 0 or less ($V \leq 0$).
(Comment no.: Specify 0.)

Case 2: If the value of the monitor device is between 1 and 100 (1 \leq $V \leq 100$), the comment for the comment number corresponding to the monitor device value is displayed.

Case 3: If the value of the monitor device is between 101 and 199 (101 \leq $V \leq 199$), the currently displayed comment continues to be displayed.

Delft: If the monitor device value does not fit any of the above cases (the monitor device is 200 or above), the comment for comment number 101 is displayed.
Comment being registered

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Display color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Current production quantity is 1.</td>
<td>White</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Current production quantity is 2.</td>
<td>White</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>Production quantity has exceeded 100.</td>
<td>White</td>
<td>Normal</td>
<td>Yes</td>
</tr>
<tr>
<td>101</td>
<td>Today's production has been completed.</td>
<td>White</td>
<td>Reversed</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Displayed comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$V&lt;0$</td>
<td>No. 0</td>
</tr>
<tr>
<td>2</td>
<td>$1\leq V \leq 100$</td>
<td>Indirect</td>
</tr>
<tr>
<td>3</td>
<td>$101&lt; V \leq 199$</td>
<td>No processing</td>
</tr>
</tbody>
</table>

Normal  ○ No. 100  ○ Indirect  ○ No processing

Operation Procedure Outline

Specify the display format to be used if the value does not fit any of the specified comparative equations.

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box. The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
12.4 Setting the Alarm List Display (System Alarms) Function

What does this function do?

If an error occurs in the GOT, the PC CPU, or the data link or network, this function displays an error message.

Example of settings

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Object&quot;</td>
<td>System alarm</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 1 x; horizontal: 1 x</td>
</tr>
</tbody>
</table>

Useful Information Before Setting the Alarm List (System Alarms) Function

- If the Y axis of the display range is set to 3 lines (which is different from the "Size" setting), separate error messages can be displayed if an error occurs in the PC CPU, the data link or network, or the GOT.

<table>
<thead>
<tr>
<th>Display range is set to 3 lines</th>
<th>Error message displayed if error occurs in PC CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error message displayed if error occurs in data link/network</td>
<td></td>
</tr>
<tr>
<td>Error message displayed if error occurs in GOT</td>
<td></td>
</tr>
</tbody>
</table>
**Outline of Procedure**

- **Basic**
  - Selection of display contents for system alarm
  - Setting of display size

See [1]

- After entering settings, click on "OK"

See [2]

- Setting of display position (display range)

End

The display condition for the alarm list display (system alarms) function is fixed at "___" (3 seconds). (Trigger) does not need to be specified.

**Description of settings**

1. Setting the **Basic** settings

![Setting the Basic settings](image)
"Object" Select the system alarm, using the radio button. The format in which system alarms are displayed is fixed.

<table>
<thead>
<tr>
<th>Error code</th>
<th>Warning message</th>
<th>If an error occurs in the GOT, the time at which the error occurred is also displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequencer CPU error</td>
<td>4 characters</td>
<td>48 characters</td>
</tr>
<tr>
<td>Data link/network error</td>
<td>Error code</td>
<td>Warning message</td>
</tr>
<tr>
<td>GOT error</td>
<td>Error code</td>
<td>Warning message</td>
</tr>
</tbody>
</table>

"Size" Select the size in which characters are to be displayed, using the list box.

<table>
<thead>
<tr>
<th>4 characters (32 dots)</th>
<th>46 characters (384 dots)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error code</td>
<td>Warning message</td>
</tr>
<tr>
<td>Time of occurrence</td>
<td>8 characters (64 dots)</td>
</tr>
</tbody>
</table>

2 Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on "OK" in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window.

(3) Move the cursor to the position where the first letter of the warning message (error code) is to be displayed (the upper left of the first letter), and click at that position.

(4) The cursor changes to the size changing cursor. Press the left button of the mouse, and holding down the button, drag the mouse to the position marking the display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.
(5) When the display range has been determined, release the left button of the mouse.

---

Special Cases

- Causes of error messages and reference manuals

Errors occur in the following cases:

1. The GOT detects an error pertaining to error code No. 300 or higher.
2. An error code is stored in D9008 of the ACPU.
3. An error code is stored in SDO of the QnACPU.
4. A special relay (M9200) for the data link has gone on.
   (The effective special relays are different for master stations and local stations.)
5. A special relay (SB0000) for the network has gone on.

(6) Error codes and reference manuals

<table>
<thead>
<tr>
<th>Location where error occurs</th>
<th>Error code</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACPU</td>
<td>0 ~ 199</td>
<td>User's manual for the ACPU connected to the GOT</td>
</tr>
<tr>
<td></td>
<td>(value of D9008)</td>
<td></td>
</tr>
<tr>
<td>MNET/B, MNET (II)</td>
<td>200 ~ 299</td>
<td>Data link system reference manual for the MNET (II) or MNET/B (see explanation of special relays for links) *1</td>
</tr>
<tr>
<td>MNET/10</td>
<td>500 ~ 799</td>
<td>Network system reference manual for the MNET/10 (see explanation of special relays for links) *2</td>
</tr>
<tr>
<td>QCPU</td>
<td>1000 ~</td>
<td>User's manual for the QnACPU connected to the GOT</td>
</tr>
<tr>
<td></td>
<td>(value of SD)</td>
<td></td>
</tr>
</tbody>
</table>

*1. See the section explaining the special link relay for (error code) + 9000 and handle the error accordingly. For example, if the error for error code (210) occurs, 210 + 9000 = 9210, so handle the error as described under M9210.

*2. See the section explaining the special link relay for (error code) - 500 and handle the error accordingly. For example, if the error for error code (510) occurs, 510 - 500 = 10, so handle the error as described under SB000A.
(Special link relays are hexadecimal values, so decimal values should be converted to hexadecimal values.)
12.5 Setting the Alarm List Display (User Alarms) Function

- What does this function do?
  - This function is used to set up a correspondence between comments and several bit devices, and display the comments for bit devices which are on, in sequential order.

Above screen is displayed again

Screen switches to another screen

Order of occurrence is stored in memory
### Example of settings

Comments registered using the "Comment List" dialog box

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Display color</th>
<th>Normal/reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>X1 Check processed product</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
<tr>
<td>11</td>
<td>X2 Conveyor error</td>
<td>White</td>
<td>Reversed</td>
<td>No</td>
</tr>
<tr>
<td>12</td>
<td>X3 Inspect conveyor</td>
<td>White</td>
<td>Normal</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Type&quot;</td>
<td>User</td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>V: 2 x; H: 2 x</td>
</tr>
<tr>
<td>&quot;Comment No.&quot;</td>
<td>10</td>
</tr>
<tr>
<td>&quot;Monitor device ($$)&quot;</td>
<td>No. of points: 3/Bit device: 0-FF-X1</td>
</tr>
<tr>
<td>&quot;Storing device&quot;</td>
<td></td>
</tr>
</tbody>
</table>

#### Display Style

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number&quot;</td>
<td>Plural</td>
</tr>
<tr>
<td>&quot;Sort&quot;</td>
<td>Address</td>
</tr>
<tr>
<td>&quot;Option&quot;</td>
<td>&quot;Save&quot; Yes</td>
</tr>
<tr>
<td></td>
<td>&quot;Scroll&quot; No</td>
</tr>
<tr>
<td></td>
<td>&quot;Date display&quot; Yes</td>
</tr>
</tbody>
</table>

#### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Ordinary</td>
</tr>
</tbody>
</table>
**Outline of Procedure**

**Basic**
- Setting of display contents
- Setting of character size
- Setting of number of head comment
- Setting of monitor device
- Setting of device where error occurrence is stored

See [1]

**Display Style**
- Setting of number to be displayed
- Setting of display order
- Setting of options

See [2]

**Trigger**
- Setting of display conditions

See [3]

After entering settings, click on "OK" on any tab

See [4]

Setting of display position (display range)

End
Description of settings

1 Setting the Basic settings

"Type" Select the system alarm, using the radio button.

"Size" Select the size in which the comment is to be displayed, using the list box.
(Example) Vertical: 2 x  Horizontal: 2 x

"Comment No." Using the spin box, specify the number of the comment corresponding to the first bit device. With the alarm list display, blinking displays are not used even if "Yes" has been specified for "Blink" for the comment pertaining to that number.

See Section 20.2, Viewing an Image of the Created Screen Data.
"Monitor device" Using the spin box, specify the number of bit devices (up to 255 may be specified). Then click on "points" [Device] and specify the bit device. If "1" is set as the number of devices, the "Set Device" dialog box will be displayed at this point. Specify the bit device.

If a value of 2 or more has been entered, the "Set Multiple Devices" dialog box will be displayed.

"Device Type" Using the list box, specify the data type (the specified bit of the bit or word device).

"Continuous" Using the radio button, select how the monitor device to be specified at this point is to be set.

"Random" Continuous ...... Starting with the specified device, devices will be specified continuously, up to the number of points specified.
Random ............ This enables the desired points to be specified individually.

Click on [Edit] to display the "Set Device" dialog box, and specify the word device to be monitored.
If "Random" is selected, click on the column for the specified number, and then click on [Edit].

See Section 10.1, Setting Devices for Monitoring.
"Storing device" Click on [Dev.], and in the "Device Setting" dialog box, specify the word device which identifies the number of bit devices that are currently on. The number of occurrences can be confirmed by displaying the specified device using the numeric display function.

![Diagram of numeric display of specified word device.]

### Setting the Trigger settings

**Number**

Using the radio buttons, specify whether several comments are to be displayed when on, in priority order, within the specified display range, or whether one comment is to be displayed.

- Plural ....... Several comments are displayed in priority order.
- Single ....... Only one comment is displayed, in priority order.
"Sort" Using the radio buttons, select whether comments which are ON are to be displayed in the order in which they went ON, or whether comments are to be displayed in the order of the bit devices which are ON, starting with the lowest number.

(Example)

<table>
<thead>
<tr>
<th>&quot;On&quot; order</th>
<th>Corresponding comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1: ON</td>
<td>2</td>
</tr>
<tr>
<td>X2: ON</td>
<td>3</td>
</tr>
<tr>
<td>X3: ON</td>
<td>1</td>
</tr>
<tr>
<td>X1: Check Line 1</td>
<td></td>
</tr>
<tr>
<td>X2: Check conveyor</td>
<td></td>
</tr>
<tr>
<td>X3: Please inspect</td>
<td></td>
</tr>
</tbody>
</table>

If "Plural" is selected for "Number":

If "Single" is selected for "Number":
"option" If the screen is switched from the alarm list display screen to another screen and then back again, "Store memory" placing an "X" in the check box records the order of occurrences up until the previous display in the memory, and displays them.

(Example) When the display screen shows the order of occurrence

![Diagram showing the order of occurrence and the option to store memory]

Switch to another screen

- Store memory
- Store memory

Previous order of occurrence is saved

Previous order of occurrence is not saved. The GOT decides that all of the previous occurrences were simultaneous, and displays the bit devices in numeric order.

When an "X" is placed in the "Store memory" check box

- If an "X" is placed in the "Store memory" check box, the Alarm List (User Alarms) function can only be specified once in one project.
- If an "X" is placed in the "Store memory" check box, the setting for the display condition should be set to "Cycle".
- If the GOT has been reset, the power has been turned off, or the GOT has been connected to a computer and communications carried out, the data saved in the memory will be deleted.
"Scroll on" In order to specify the touch switches for scrolling upward (00F2H) and scrolling downward (00F3H) on the screen window and switch the comment display, place an "X" in the check box.

If the above touch switches have been specified, please be aware that multiple Alarm List (User Alarms) functions cannot be specified on one screen.

If an "X" has been placed in the "Scroll" check box, the data list display function cannot be set for that screen.

(Example) Corresponding comment
X1: ON X1: Check Line 1
X2: ON X2: Check conveyor
X3: ON X3: Please inspect

Number: Plural; Sort: Number order

"Display date" To display this when the specified bit device is on, place an "X" in the check box. The date/time display appears at the left of the Comment column.

The date is shown at the left, followed by the time (this format is fixed and cannot be changed). Up to 20 characters can be displayed.

(Example)

\[
\begin{array}{c}
96/07/07 \quad 09:30:40 \quad \text{Check Line 1} \\
\text{Space} \quad \text{Space} \quad \text{Space} \quad \text{Space} \quad \text{Space} \quad \text{Space} \quad \text{Space} \quad \text{Space} \quad \text{Space} \\
20 \text{ characters} \\
\end{array}
\]

If "Size" is set to Vertical: 1, Horizontal: 1, the size of a single character will be 16 x 8 dots (160 dots for 20 characters).

Years are displayed based on the Western calendar, and times are displayed using the 24-hour format.
3 Setting the Trigger
See Section 10.4, Setting the Display Conditions.

4 Setting the display position (display range)
(1) When the settings for the various tabs have been entered, click on OK in any tab.
(2) A dotted-line box is displayed at the upper left of the screen window.

(3) Move the cursor to the position where the first letter of the comment is to be displayed (the upper left of the first letter), and click at that position.

(4) The cursor changes to the size changing cursor. Press the left button of the mouse, and, holding down the button, drag the mouse to the position marking the comment display range. At this point, the cursor moves in units of 16 dots in both directions (vertical and horizontal), regardless of the amount of movement allowed by the automatic cursor positioning function.

(5) When the display range has been determined, release the left button of the mouse.

When multiple displays have been selected, please be aware that comments cannot be wrapped at the ends of lines if the comment is longer than the display range. The display range should be taken into consideration when specifying comments.
Chapter 13

Setting Moving Screen Display Functions
13. Setting Moving Screen Display Functions

13.1 Registering Parts (Graphics) Displayed in the Parts Display and Parts Movement Display

This section explains how to register parts (graphics) displayed on the GOT in the parts display and parts movement display functions.

13.1.1 Useful Information When Utilizing and Registering Parts

- Of the 32,767 part numbers, up to 15,000 types of parts can be registered.
- Graphic data in the BMP format can be registered as a part.
- The memory capacity for registered parts is the same as that when the graphic is drawn.
- Parts graphics should be drawn using a line width of 1 dot. If graphics are drawn using a line width of 2 or more dots, there may be times when the graphics are not displayed on the GOT using the specified line width.
  If graphics with a line width of 2 or more dots are to be displayed as parts, they should be registered by combining graphics drawn with a line width of 1 dot.
- To display parts for part numbers corresponding to the values of word devices (indirectly specified parts) with the parts display and parts movement display functions, register the part for the part number corresponding to the value.

(Example) Displaying ☐ when the value of D100 is “1”

(Example) Displaying the solid black part when the value of D100 is “100”
13.1.2 Registering Parts

When is this function used?

- This function is used when you want to register parts to be displayed in the parts display and parts movement display functions.

1. Draw the figure to be registered, and add handles.


3. The "Parts" dialog box is displayed. Click at the position where the part number to be registered is displayed. Then click on [Write].

   If the part number to be registered is not displayed, use the "Part No." spin box to specify the part number to be registered, and click on [Jump].

4. The "Name" dialog box is displayed. Enter the name of the part in the text box.

   Click on [OK]. The part is registered for the specified part number.

5. The display returns to the screen window, where registered graphics can be deleted. To change a part that has been registered, register the part following the change once again, for the part number that has been changed.
13.1.3 Reading Out Registered Parts

When is this function used?

- This function is used when you want to read out a registered part in the screen window and check it.


   The “Parts” dialog box is displayed.

2. Click at the position where the part number to be read is displayed. You can also click on [Image], and when the “Select Image” dialog box is displayed, click on the position at which the part number being read out is to be displayed.

   Click on [Read].

   Clicking on “Select” in the “Select Image” dialog box returns the display to the “Parts” dialog box.

3. The image of the part is displayed at the upper left of the screen window.

4. Move the cursor and click at the position where the image is to be placed.
13.1.4 Deleting Registered Parts

When is this function used?

- This function is used when you want to delete a part that has been registered.


2. The "Parts" dialog box is displayed. Click at the position where the part number to be deleted is displayed. Then click on [Delete].

   To check what type of part is being deleted, click on [Image].
   This displays the "Select Image" dialog box, where the part can be confirmed.

   Clicking on [Select] in the "Select Image" dialog box returns the display to the "Parts" dialog box.

3. The specified part is deleted.

   After the part has been deleted, click on [Close].
13.1.5 Changing a Part Name Assigned When a Part was Registered

When is this function used?

- This function is used to change the name which has been assigned to a part.


2. The "Parts" dialog box is displayed. Click at the position where the part number to be changed is displayed. Then click on [Rename].

3. The "Name" dialog box is displayed. Enter the new part name in the text box, and click on [OK].

4. The "Parts" dialog box is displayed, showing the changed name.
   When the name change has been completed, click on [Close].
13.2 Setting the Parts Display (Bit) Function

What does this function do?
- This function is used to display a part in accordance with the ON/OFF status of a bit device.

---

Example of settings

Part registration

<table>
<thead>
<tr>
<th>Part No. 1</th>
<th>Part No. 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Part 1" /></td>
<td><img src="image2.png" alt="Part 2" /></td>
</tr>
</tbody>
</table>

Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Preview part&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Center</td>
</tr>
<tr>
<td>&quot;Display mode&quot;</td>
<td>Replace</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-X0</td>
</tr>
</tbody>
</table>
### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;ON&quot;</td>
<td>&quot;No.&quot; 1</td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; Yes</td>
</tr>
<tr>
<td>&quot;OFF&quot;</td>
<td>&quot;No.&quot; 2</td>
</tr>
<tr>
<td></td>
<td>&quot;Blink&quot; No</td>
</tr>
</tbody>
</table>

### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

---

**Tool Bar 1**

- Selected icon: [SP] → Part Disp

**Menu Bar**

- Selected command
  - On Draw menu:
    - Animation Display → Part Display

---

### Outline of Procedure

1. **Basic**
   - Setting of preview comment number
   - Setting of positioning
   - Setting of display mode
   - Setting of monitor device

2. **Display Format**
   - Setting of number of part to be displayed
   - Setting of attribute (blinking)

3. **Trigger**
   - Setting of display conditions

4. After entering settings, click on "OK" on any tab

5. Setting of display position (display range)

See 1

See 2

See 3

See 4

End
"Preview part no." Using the spin box, specify the number of the part to be displayed when an image is displayed.

See Section 20.2, Viewing an Image of the Created Screen Data.

"Positioning" Using the radio buttons, specify how the part is to be displayed in relation to the specified display position.

(Example) Positioning: Left - Top

The part is displayed with its top left corner at the specified display position.
(Example) Positioning: Center
The part is displayed with its center at the specified display position.

"Display mode" Using the radio buttons, select how the part is to be displayed if there is a canvas graphic at the display position, and how it is to be displayed based on the on/off status of the bit device. Replace ....... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead. When parts are changed, the currently displayed part is deleted, and a new one is displayed in its place.

Overwrite .... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead. When parts are changed, the new part is superimposed on top of the one currently displayed.
XOR .......... If there is a canvas graphic at the display position, the canvas graphic and the part are superimposed in an XOR reversed display.
When parts are changed, the currently displayed part is deleted, and the new part is displayed in its place.

- XOR color combinations when using single colors

<table>
<thead>
<tr>
<th>black</th>
<th>blue</th>
<th>red</th>
<th>purple</th>
<th>green</th>
<th>blue-green</th>
<th>yellow</th>
<th>white</th>
<th>dark blue</th>
<th>dark red</th>
<th>dark purple</th>
<th>dark green</th>
<th>dark blue-green</th>
<th>dark yellow</th>
<th>beige</th>
</tr>
</thead>
<tbody>
<tr>
<td>black</td>
<td>blue</td>
<td>red</td>
<td>purple</td>
<td>green</td>
<td>blue-green</td>
<td>yellow</td>
<td>white</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>blue</td>
<td>blue</td>
<td>red</td>
<td>purple</td>
<td>green</td>
<td>blue-green</td>
<td>yellow</td>
<td>white</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>red</td>
<td>red</td>
<td>purple</td>
<td>black</td>
<td>blue</td>
<td>yellow</td>
<td>white</td>
<td>green</td>
<td>blue-purple</td>
<td>dark purple</td>
<td>dark blue</td>
<td>dark yellow</td>
<td>blue-beige</td>
<td>dark yellow</td>
<td>dark blue</td>
</tr>
<tr>
<td>purple</td>
<td>purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>blue-green</td>
<td>dark green</td>
<td>dark red</td>
<td>black</td>
<td>beige</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
</tr>
<tr>
<td>green</td>
<td>blue-green</td>
<td>yellow</td>
<td>white</td>
<td>blue</td>
<td>black</td>
<td>purple</td>
<td>red</td>
<td>dark green</td>
<td>blue</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>blue-green</td>
<td>green</td>
<td>white</td>
<td>yellow</td>
<td>blue</td>
<td>black</td>
<td>purple</td>
<td>red</td>
<td>dark green</td>
<td>blue</td>
<td>dark purple</td>
<td>dark green</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>yellow</td>
<td>white</td>
<td>green</td>
<td>blue-green</td>
<td>red</td>
<td>purple</td>
<td>black</td>
<td>blue</td>
<td>dark green</td>
<td>blue</td>
<td>dark red</td>
<td>dark purple</td>
<td>dark blue</td>
<td>dark red</td>
<td>dark purple</td>
</tr>
<tr>
<td>white</td>
<td>yellow</td>
<td>blue-green</td>
<td>green</td>
<td>purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>dark blue</td>
<td>black</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark blue-green</td>
</tr>
<tr>
<td>dark red</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark blue-green</td>
</tr>
<tr>
<td>dark purple</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark blue-green</td>
</tr>
<tr>
<td>dark green</td>
<td>dark blue-green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>dark yellow</td>
<td>dark blue-green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark yellow</td>
<td>beige</td>
</tr>
<tr>
<td>beige</td>
<td>dark yellow</td>
<td>dark blue-green</td>
<td>dark purple</td>
<td>red</td>
<td>blue</td>
<td>black</td>
<td>white</td>
<td>yellow</td>
<td>dark blue-green</td>
<td>dark green</td>
<td>dark purple</td>
<td>dark red</td>
<td>dark blue-green</td>
<td>dark yellow</td>
</tr>
</tbody>
</table>

13 - 10
"Monitor device" Click on [Dev.], and specify the bit device to be monitored in the "Device Setting" dialog box.

"Dev." When parts are being displayed in accordance with the on/off status of the bit device, select the bit device with the list box, and when parts are being displayed in accordance with the on/off status of the word device bit number, select the bit of the word with the list box.

"NW No."
"Station No."
"Device name"
"Device number"

See Section 10.1, Setting the Device to be Monitored.

Setting the [Display Format]

[Diagram of Display Format screen]

"ON" "OFF"

"No." Using the spin box, select the part number to be displayed.

"Blink" Using the list box, select "Yes" to specify a blinking display.
3. Setting the display conditions

See Section 10.4, Setting the Display Conditions.

4. Setting the display position

(1) When the settings for the various tabs have been entered, click on OK in any tab.

(2) The image of the part specified with the "Preview part" parameter is displayed at the upper left of the screen window.

(3) Move the cursor to the position at which the part is to be displayed, and click at that position. Specify a display position which enables all of the part specified with the "Preview part" parameter and one other part to be displayed.
**Special Cases**

- How do I display a part only when the bit device is ON/OFF?

  Use the [Display Format] tab to specify the conditions under which the part specification No. 0 is to be displayed (when ON/OFF).

  (Example) To display the part only when the bit device is ON:
  
  Comment to be displayed: X0 is currently ON.

<table>
<thead>
<tr>
<th></th>
<th>Part specification</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>No. 1</td>
<td>No</td>
</tr>
<tr>
<td>OFF</td>
<td>No. 0</td>
<td>No</td>
</tr>
</tbody>
</table>

![Diagram]

Nothing is displayed when the bit device is off.

Canvas graphic text

When the bit device is on, the specified part is displayed.

Part (When "OFF" is set for display mode)
13.3 Setting the Parts Display (Word) Function

- What does this function do?
  - This function is used to display a part in accordance with the on/off status of a word device.

---

**Example of settings**

Part registration

<table>
<thead>
<tr>
<th>Part No. 1</th>
<th>Part No. 10</th>
<th>Part No. 100</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Preview part&quot;</td>
<td>100</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Center</td>
</tr>
<tr>
<td>&quot;Display mode&quot;</td>
<td>Replace</td>
</tr>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td>&quot;Normal&quot;</td>
<td>&quot;Part&quot; Indirect</td>
</tr>
<tr>
<td></td>
<td>&quot;Attribute&quot; Blink No</td>
</tr>
</tbody>
</table>

**Trigger**

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Setting of preview comment number
- Setting of positioning
- Setting of display mode
- Setting of monitor device
- Setting of parts display format

Change display color when monitor device reaches a certain value?

Display Format
- Setting of comparative equation to be used to switch parts display format

Data Expression
- Setting of equation for data expression

Trigger
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position

End

See 1
See 2
See 3
See 4
See 5
Description of settings

1 Setting the **Basic** settings

**Display settings**

- **Position**
  - X: 0
  - Y: 0
- **Positioning**
  - ○ Left-Top
  - ○ Center
- **Preview part**
- **Display mode**
  - ○ Replace
  - ○ XOR
  - ○ Overwrite
- **Monitor device($$)**
  - 0-FF
- **Default Indicate:**
  - Blink:
  - Edit

“**Preview part**” Using the spin box, specify the number of the part to be displayed when an image is displayed.

See Section 20.2, Viewing an Image of the Created Screen Data.

When setting the display position, the part for the part number specified by the “Preview part” parameter can be displayed as an image while positioning is being carried out.

“**Positioning**” Using the radio buttons, specify how the part is to be displayed in relation to the specified display position.

(Example) Positioning: Left - Top

The part is displayed with its top left corner at the specified display position.
(Example) Positioning: Center
The part is displayed with its center at the specified display position.

"Display mode" Using the radio buttons, select how the part is to be displayed if there is a canvas graphic at the display position, and how it is to be displayed based on changes in the value of the word device. Replace ...... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead.
When parts are changed, the currently displayed part is deleted, and a new one is displayed in its place.

Overwrite .... If there is a canvas graphic at the display position, the part overwrites the canvas graphic and is displayed instead.
When parts are changed, the new part is superimposed on top of the one currently displayed.
XOR......... If there is a canvas graphic at the display position, the canvas graphic and the part are superimposed in an XOR reversed display.

See Section 13.2, Setting the Parts Display (Bit) Function.

"Monitor device" Click on [Dev.], and specify the word device to be monitored in the "Device Setting" dialog box.

See Section 10.1, Setting the Device to be Monitored.

"Default" Click on [Edit], and specify the parts display format in the "Edit Display Format" dialog box.

"Display format" Using the radio button, select "Indirect".

If a comparative equation is being specified using [Display Format], this setting is effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

"Attribute" "Blink" If the part is to be shown in a blinking display, select "Yes" in the list box.
2 Setting the **Data Expression**

See Section 10.2, Setting Data Expressions.

3 Setting the **Trigger**

See Section 10.4, Setting Display Conditions.

4 Setting the display position

(1) When the settings for the various tabs have been entered, click on **OK** in any tab.

(2) The image of the part specified with the “Preview part” parameter is displayed at the upper left of the screen window.

(3) Move the cursor to the position at which the part is to be displayed, and click at that position. Specify a display position which enables all of the parts other than those specified with the “Preview part” parameter to be displayed.

If “Center” is specified for the “Positioning” parameter, the coordinates of this position (the center of the sprite setting frame) will be set.

If “Left - Top” is specified for the “Positioning” parameter, the coordinates of this position will be set.
5. Setting the Display Format

This is specified if the part display format is to be switched when the monitor device value or the value resulting from the data expression reaches a certain value.

1) Parts can be displayed in the following display formats, based on the comparative equation specified by "Display Range" and the monitor device value or the value resulting from the data expression.

No. ..................... If the monitor device value or the value resulting from the data expression fits the comparative equation, the part corresponding to the specified part number is displayed.

Indirect .................. If the monitor device value or the value resulting from the data expression fits the comparative equation, the part corresponding to the value is displayed.

No Processing ........ If the monitor device value or the value resulting from the data expression fits the comparative equation, the currently displayed part continues to be displayed.

2) The comparative equation for the display range is specified as follows.

<table>
<thead>
<tr>
<th>Type of comparative equation</th>
<th>Left</th>
<th>Operand</th>
<th>Middle</th>
<th>Operand</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>n1</td>
<td>&lt;=</td>
<td>$V</td>
<td>&lt;=</td>
<td>m1</td>
</tr>
<tr>
<td>Above</td>
<td>n2</td>
<td>&lt;=</td>
<td>$V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>$V</td>
<td>&lt;=</td>
<td>&lt;= 3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify numeric values for n1, m1, n2, and <=3. "$V" indicates the monitor device value or the value resulting from the data expression.
Click on [Edit] and specify the parts display format and comparative equation in the "Edit Display Format" dialog box. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

"Parts indication" Using the radio buttons, select the display format in which the part is to be displayed when the monitor device value or the value resulting from the data expression fits the comparative equation specified with the "Display Range" parameter.
- No. This is used to display the part corresponding to the specified part number.
- Indirect. Select this to display the part for the part number corresponding to the value.
- No Processing. The currently displayed part continues to be displayed.

"Attribute"

"Blink" If the part is to be shown in a blinking display, select "Yes" in the list box.

"Display range" Specify a comparative equation.

See Section 10.5, Setting the Display Range (Comparative Equation).
(Example)

Case 1: No part is displayed if the monitor device value is 0 or less ($V \leq 0$).

(Part no.: Specify 0.)

Case 2: If the value of the monitor device $i$ between 1 and 100 ($1 \leq V \leq 100$), the part for the part number corresponding to the monitor device value is displayed.

Case 3: If the value of the monitor device is between 101 and 199 ($101 \leq V \leq 199$), the currently displayed part continues to be displayed.

Default: If the monitor device value doesn’t fit any of the above cases (the monitor device is 200 or above), the part for part number 101 is displayed.
Part being registered

<table>
<thead>
<tr>
<th>Part No. 1</th>
<th>Part No. 10</th>
<th>Part No. 100</th>
<th>Part No. 101</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 unit</td>
<td>10 units</td>
<td>Over 100 units!</td>
<td>Finish</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Parts indication</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$V &lt;= 0</td>
<td>No. 0</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>1 &lt;= $V &lt;= 100</td>
<td>indirect</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>101 &lt;= $V &lt;= 199</td>
<td>No processing</td>
<td>No</td>
</tr>
</tbody>
</table>

When monitor device value does not fit the above cases

The "Default" value is set under the (Basic) tab settings.

---

**Operation Procedure Outline**

1. **Display Format**
   - Edit
   - OK

2. **Edit Display Format**
   - Left / Middle / Right
   - OK

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box.

The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

3. **Input Expression**
   - OK

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
13.4 Setting the Parts Movement Display Function

What does this function do?

- This function is used to change the display position of the parts display function described in Sections 13.2 and 13.3, based on the values of two word devices.
- It can also be used to change (movement display) a specified (fixed) part based on the values of two word devices.

Examples of settings

Registration of part

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Position device&quot;</td>
<td>D100, D101</td>
</tr>
<tr>
<td>&quot;Parts switching&quot;</td>
<td>Fixed</td>
</tr>
<tr>
<td>&quot;Positioning&quot;</td>
<td>Center</td>
</tr>
<tr>
<td>&quot;Display mode&quot;</td>
<td>Shift</td>
</tr>
<tr>
<td>&quot;Default&quot;</td>
<td>&quot;Parts indication&quot; No.: 10</td>
</tr>
<tr>
<td>&quot;Attribute&quot; &quot;Blink&quot;</td>
<td>No</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>
Outline of Procedure

Basic
- Setting of position device
- Setting of parts switching format

Select "Word" for "Parts switching"

Basic
- Setting of positioning
- Setting of display mode
- Setting of monitor device
- Setting of parts display format

Should parts display format be switched when monitor device value reaches a certain value?

NO

Display Format
- Set comparative equation to be used for parts display format

YES

Is data expression to be set?

NO

Data Expression
- Set equation for data expression

YES

Trigger
- Set display conditions

When settings have been completed, click on "OK" on any tab

End

Select "Bit" for "Parts switching"

Basic
- Setting of positioning
- Setting of display mode
- Setting of monitor device

Select "Fixed" for "Parts switching"

Basic
- Setting of positioning
- Setting of display mode

On Draw menu:
- Animation Display
- Part movement

See 1
Description of settings

1. Setting the (Basic) settings

```
<table>
<thead>
<tr>
<th>Basic</th>
<th>Display Format</th>
<th>Display Format</th>
<th>Data Expression($Y)</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position device</td>
<td>0-FF</td>
<td>Dev.</td>
<td>OK</td>
<td>Cancel</td>
</tr>
<tr>
<td>Parts switching</td>
<td></td>
<td></td>
<td></td>
<td>Prev</td>
</tr>
<tr>
<td></td>
<td>Word dev.</td>
<td>Bit dev.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Positioning</td>
<td></td>
<td></td>
<td></td>
<td>Next</td>
</tr>
<tr>
<td></td>
<td>Left-Top</td>
<td>Center</td>
<td>Movement</td>
<td>Locus</td>
</tr>
<tr>
<td>Monitor device($$)</td>
<td>0-FF</td>
<td>Dev.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td>Indicate:</td>
<td>Blink:</td>
<td>Edit</td>
<td></td>
</tr>
</tbody>
</table>
```

“Position device” Click on Dev., and in the “Device Settings” dialog box, specify the word device to be used to change the position at which the part is displayed.

[See Section 10.1, Setting the Device to be Monitored.]

(Example) If the specified device is D100:

- Device which determines the X coordinate ....... D100
- Device which determines the Y coordinate ....... D101

The specified device +1 serves as the device which determines the Y coordinate.

“Parts switching” Using the radio buttons, select the parts display where the parts movement display is to be carried out.

- Word .... Select this if the movement display is to be carried out with the parts display (word) function described in Section 13.2.
- Bit ........ Select this if the movement display is to be carried out with the parts display (bit) function described in Section 13.3.
- Fixed ...... Select this if the movement display is to be carried out using only one type of part.
"Positioning" Use the radio buttons to select how the part is to be displayed in relation to the coordinate position corresponding to the values of the word device specified with the “Position device” parameter.

(Example) Positioning: Top - Left

Positioning: Center

X coordinate: (Word device value 280)
Y coordinate: (Word device value 260)

The part is displayed so that its upper left is at the coordinate position corresponding to the values of the position device.

X coordinate: (Word device value 280)
Y coordinate: (Word device value 260)

The part is displayed so that its center is at the coordinate position corresponding to the values of the position device.

Using the radio button, select whether the trace pattern is to be retained each time the part figure is moved, or whether the previously displayed figure is to be deleted each time the part figure is moved.
"Monitor device" If the movement is being carried out with the parts display (word) function, specify the word device. If it is being carried out with the parts display (bit) function, specify the bit device. See Section 10.1, Setting the Device to be Monitored.

"Normal"

Under “Change Display Format”, click on (EDIT) to specify “Word” or “Fixed”, and then, in the Edit Display Format dialog box, specify the method by which parts are to be displayed.

"Part display format" If “Fixed” is selected under “Change Display Format”, use the radio button to select the number, and specify the number of the part to be displayed, using the spin box. If “Word” is selected under “Change Display Format”, the operation is the same as specifying the parts display (word) function. See Section 13.3, Setting the Parts Display (Word) Function.

"Attribute"

"Blink" if the part is to be shown in a blinking display, select “Yes” in the list box. Setting (Display Format), (Data Expression), and (Trigger)

If “Word” has been selected with the “Parts switching” parameter, the setting procedure is the same as that for the parts display (word) function. If “Bit” has been selected, the setting procedure is the same as that for the parts display (bit) function. See Section 13.2, Setting the Parts Display (Word) Function. See Section 13.3, Setting the Parts Display (Bit) Function.

Setting the display position

- The device for the display position is specified using the “Position device” parameter, so there is no setting for the display position, as there is with other sprites.
- No sprite setting box is displayed in the screen window after the parts movement display has been specified. If data is to be edited, use the “Edit Sprite” dialog box to make the changes.
- Please be aware that the parts movement display will not be displayed even if an image display is used.
Special Cases

- What happens if a value is stored for the position device which cannot be displayed on the GOT?

If none of the values stored in the position device can be used to display parts, the previous parts display will continue to be displayed.

(Example) A870GOT

- X coordinate: (Word device value 40)
  Y coordinate: (Word device value 40)
- X coordinate: (Word device value 1000)
  Y coordinate: (Word device value 50)
- X coordinate: (Word device value 240)
  Y coordinate: (Word device value 200)
- X coordinate: (Word device value 10)
  Y coordinate: (Word device value 50)
- X coordinate: (Word device value 560)
  Y coordinate: (Word device value 50)
- X coordinate: (Word device value 240)
  Y coordinate: (Word device value 50)

Previous parts display is continued

No parts can be displayed
13.5 Setting the Lamp Display (Bit) Function

- What does this function do?
  - This function turns lamps on and off, based on whether the bit device is ON/OFF.

---

Example of settings

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-Y70</td>
</tr>
<tr>
<td>&quot;Shape&quot;</td>
<td>&quot;Type&quot;</td>
</tr>
<tr>
<td>&quot;On&quot;</td>
<td>&quot;OFF&quot;</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Set text&quot;</td>
<td>Bottom</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Lamp 1</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Vertical alignment&quot;</td>
<td>5 dots</td>
</tr>
<tr>
<td>&quot;OFF&quot;</td>
<td>&quot;Color&quot;</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Set text&quot;</td>
<td>Top</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>&quot;Horizontal alignment&quot;</td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
</tbody>
</table>

---

---
### Outline of Procedure

<table>
<thead>
<tr>
<th>Basic</th>
<th>Display Format</th>
<th>Setting of display position</th>
<th>End</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Setting of monitor device</td>
<td>• Setting of color in which lighted lamp graphic is to be displayed</td>
<td>See 1</td>
</tr>
<tr>
<td></td>
<td>• Setting of lamp graphic</td>
<td>• Setting of attributes for lamp graphic</td>
<td>See 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Setting of text display color</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Setting of text display position</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Input of text to be displayed</td>
<td></td>
</tr>
</tbody>
</table>

The display conditions for the lamp display function are fixed at the default values. When specifying data, there are no settings to be entered under Trigger.
Description of settings

1. Setting the (Basic) settings

"Monitor device" Click on Dev., and specify the bit device to be monitored in the "Device Setting" dialog box.

"Dev." When the lamp is being turned on and off in accordance with the ON/OFF status of the bit device, select the bit device with the list box, and when the lamp is being turned on and off in accordance with the ON/OFF status of the word device bit number, select the word with the list box.

"NW No."
"Station No."
"Device name"
"Device number"

See Section 10.1, Setting the Device to be Monitored.

"Shape" Click on Select to display the "Shape Select" dialog box.

Click on the lamp figure to be displayed.
2. Setting the **Display Format**

- **ON**
  - **Text**
    - Select the color in which the lamp is to be displayed, using the list box.
  - **Lamp**
  - **Text**
    - If text is to be displayed on the lamp, select the color in which the text is to be displayed, using the list box.
  - **Blink**
    - If a blinking display is to be used for the lamp graphic and text, select "Yes" in the list box.
  - **Text**
    - If text is to be displayed on the lamp, select the position at which the text is to be displayed.

<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
<th>Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Text]</td>
<td></td>
<td>[Text]</td>
<td></td>
<td>[Text]</td>
</tr>
</tbody>
</table>

After the display position for the text has been selected, specify the positioning for the text. Click on [Edit], and when the "Text" dialog box is displayed, specify the text to be displayed and the positioning.

With lamp graphics, text can be displayed at the left, right, top, bottom, or center of the lamp. To delete the specified contents, click on [Delete].

Clicking on [Copy from ON] enables the specified contents to be copied when on.
"Text"  
Input the text to be displayed. If text is to be displayed in several lines, input \n after each line. The size at which text is displayed is fixed at 1 x in both the vertical and horizontal directions.

"Horizontal alignment"  
Select the horizontal positioning of the text, using the command button.

"Vertical alignment"  
Select the vertical positioning of the text, using the command button.

"Offset"  
Using the spin box, specify the number of dots by which the lamp graphic and the text are to be separated. A maximum of 100 dots can be specified.

Example 1) Text setting: Top / Horizontal alignment: / Offset: 5 dots

Example 2) Text setting: Right / Vertical alignment: / Offset: 5 dots

Example 3) Text setting: Center / Horizontal alignment: / Vertical alignment:

*** indicates the input text.
Setting the display position

1. When the settings for the various tabs have been entered, click on "OK" in any tab.
2. A dotted-line box is displayed at the upper left of the screen window, indicating the size of the lamp graphic.

(3) Move the cursor to the position where the lamp is to be displayed, and click at that position.

(4) Specify the lamp display size.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

See Section 19.3.4, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis).

See Section 19.3.5, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction without Changing the Proportion.
13.6 Setting the Lamp Display (Word) Function

What does this function do?

- This function changes the color in which the lamp lights, based on the value of the word device.

Example of settings

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Monitor device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td>&quot;Shape&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Size&quot;</td>
<td>48 dots</td>
</tr>
<tr>
<td>&quot;Type&quot;</td>
<td>Round lamp</td>
</tr>
<tr>
<td>&quot;Default&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Lamp color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Text color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Bottom</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Warning lamp lighted</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
</tbody>
</table>
### Trigger

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Case 1&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>$V = 0$</td>
</tr>
<tr>
<td>&quot;Lamp color&quot;</td>
<td>Black</td>
</tr>
<tr>
<td>&quot;Text color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Bottom</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Not lighted</td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
<tr>
<td>&quot;Case 2&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>$1 &lt;= V &lt;= 100$</td>
</tr>
<tr>
<td>&quot;Lamp color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Text color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Blink&quot;</td>
<td>No</td>
</tr>
<tr>
<td>&quot;Text&quot;</td>
<td>Top</td>
</tr>
<tr>
<td>&quot;Horizontal alignment&quot;</td>
<td>Lighted</td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>5 dots</td>
</tr>
</tbody>
</table>

---

### Tool Bar 1

- Selected icon

  ![P] → [Lamp]

### Menu Bar

- Selected command

  On Draw menu:

  ![Animation Display] → [Lamp]

---

### Outline of Procedure

- Basic
  - Setting of monitor device
  - Setting of lamp graphic
  - Setting of default lamp graphic display format

- Display Format
  - Setting of display range
    - Comparative equation
  - Setting of color in which lighted lamp graphic is to be displayed
  - Setting of attributes for lamp graphic
  - Setting of text display color
  - Setting of text display position
  - Input of text to be displayed

(continued on next page)
Is data expression to be specified?

NO

Data Expression

YES

• Setting of equation for data expression

See 3

After entering settings, click on "OK" on any tab

See 4

Setting of display position

End

The display conditions for the lamp display function are fixed at the default values. When specifying data, there are no settings to be entered under (Trigger).

---

**Description of settings**

1. Setting the (Basic) settings

![Basic settings](image)
"Monitor device" Click on [Dev], and specify the word device to be monitored in the "Device Setting" dialog box.

"Dev." Select the word device with the list box.

"NW No."
"Station No."
"Device name"
"Device number"

See Section 10.1, Setting the Device to be Monitored.

"Shape"
Click on [Select] to display the "Select Figure" dialog box.
Click on the lamp figure to be displayed.

See Section 13.5, Setting the Lamp Display (Bit) Function.

"Default" The "Default" setting is the same setting as that for the lamp graphic display format used when the monitor device value or the value resulting from the data expression does not fit the comparative equation specified in the [Display Format] tab settings.
Click on [Edit], and in the "Edit Display Format" dialog box, specify the format in which the lamp graphic is to be displayed when the monitor device value or the value resulting from the data expression does not fit the comparative equation.
“Attribute”
“Lamp” Select the color in which the lighted lamp is to be displayed, using the list box.

“Text” If text is to be displayed on the lamp, select the color in which the text is to be displayed, using the list box.

“Text” If text is to be displayed on the lamp, select the position at which the text is to be displayed.

<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
<th>Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Text</td>
<td>Text</td>
<td>Text</td>
<td>Text</td>
</tr>
</tbody>
</table>

After the display position for the text has been selected, specify the positioning for the text. Click on Edit, and when the “Text” dialog box is displayed, specify the text to be displayed and the positioning.

With lamp graphics, text can be displayed at the left, right, top, bottom, or center of the lamp. To delete the specified contents, click on Delete.

“Text” Input the text to be displayed. If text is to be displayed in several lines, input Enter after each line. The size at which text is displayed is fixed at 1 x in both the vertical and horizontal directions.

“Horizontal alignment”
“Vertical alignment”
“Offset”

See Section 13.5, Setting the Lamp Display (Bit) Function.
2 Setting the display Format

This is used to switch the lamp graphic display when the monitor device value or the value resulting from the data expression reaches a certain value.

Click on [Edit]. When the "Edit Display Format" dialog box is displayed, specify the display color, the attributes, and the comparative equation. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

"Attribute" Specify the display color and the attributes to be used for the lamp graphic display if the monitor device value or the value resulting from the data expression fits the comparative equation.

For instructions on the procedure, please refer to the previous page.
“Display range” Specify a comparative equation.
See Section 10.5, Setting the Display Range (Comparative Equation).

---

**Operation Procedure Outline**

```
Display Format

Edit       OK

Edit Display Format

Left   Middle   Right

Input Expression

3  Setting **Data Expression**
See Section 10.2, Setting Data Expressions.

4  Setting the display position
See Section 13.5, Setting the Lamp Display (Bit) Function.
```

---
13.7 Setting the Panel Meter Display Function

What does this function do?
- This function produces a meter display showing the proportion between the upper and lower limit values for the word device value.

Example of settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Monitor device</strong></td>
</tr>
<tr>
<td></td>
<td>16-bit, with sign 0-FF-D100</td>
</tr>
<tr>
<td><strong>Monitor device</strong></td>
<td>Top 1/2</td>
</tr>
<tr>
<td><strong>Meter style</strong></td>
<td>Clockwise</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Scale points</strong></td>
<td>7</td>
</tr>
<tr>
<td><strong>Edit text</strong></td>
<td>Bottom</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>White</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Meter 1</td>
</tr>
<tr>
<td><strong>Horizontal alignment</strong></td>
<td>Meter 1</td>
</tr>
<tr>
<td><strong>Offset</strong></td>
<td>5 dots</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td><strong>Meter color</strong></td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Range</strong></td>
</tr>
<tr>
<td><strong>Min.</strong></td>
<td>0</td>
</tr>
<tr>
<td><strong>Max.</strong></td>
<td>300</td>
</tr>
</tbody>
</table>
The display conditions for the panel meter display function are fixed at the default values. When specifying data, there are no settings to be entered under Trigger.
Description of settings

1 Setting the (Basic) settings

Monitor device

“Monitor device” Click on [Dev.], and specify the word device to be monitored in the “Device Setting” dialog box.

“Dev.” Select the data type with the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>32-bit with no sign</td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.

Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.

See Section 10.1, Setting the Monitor Device.
"Type" Select the type of meter to be displayed, using the list box.

<table>
<thead>
<tr>
<th>Top 1/4</th>
<th>Bottom 1/4</th>
<th>Left 1/4</th>
<th>Right 1/4</th>
<th>Top right 1/4</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Diagram" /></td>
<td><img src="image2" alt="Diagram" /></td>
<td><img src="image3" alt="Diagram" /></td>
<td><img src="image4" alt="Diagram" /></td>
<td><img src="image5" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Top left 1/4</th>
<th>Bottom left 1/4</th>
<th>Bottom right 1/4</th>
<th>Top 1/2</th>
<th>Bottom 1/2</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image6" alt="Diagram" /></td>
<td><img src="image7" alt="Diagram" /></td>
<td><img src="image8" alt="Diagram" /></td>
<td><img src="image9" alt="Diagram" /></td>
<td><img src="image10" alt="Diagram" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Left 1/2</th>
<th>Right 1/2</th>
<th>Circle</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image11" alt="Diagram" /></td>
<td><img src="image12" alt="Diagram" /></td>
<td><img src="image13" alt="Diagram" /></td>
</tr>
</tbody>
</table>

The various squares and boxes indicate the specified frame. To display text, specify the position at which the text is to be displayed in relation to this specified frame.

If the "Type" parameter specified in the screen window for the panel meter display function has been changed (corrected), the display size must also be changed. Be sure to change the size to match the new type.

"Org." Specify the origin if "Circle" has been selected for the meter type. If the monitor device value or the value resulting from the data expression is outside of the minimum/maximum values specified on the [Display Format] tab, use the list box to select the position at which the indicator of the meter is to be located.

<table>
<thead>
<tr>
<th>0°</th>
<th>90°</th>
<th>180°</th>
<th>270°</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image14" alt="Diagram" /></td>
<td><img src="image15" alt="Diagram" /></td>
<td><img src="image16" alt="Diagram" /></td>
<td><img src="image17" alt="Diagram" /></td>
</tr>
</tbody>
</table>

"Direction" Specify whether, as the monitor device value or the value resulting from the data expression increases, the meter indicator is to rotate in the clockwise direction, or in the counterclockwise direction.

If "Clockwise" is specified, the circle shown on the illustration under "Type" will serve as the origin.

If "Counterclockwise" is specified, the triangle shown on the illustration under "Type" will serve as the origin.
"Frame"  Place an "X" in the check box if a frame is to be displayed around the panel meter. The width of the line used to draw the frame is 1 dot, and the display color is white. These are fixed and cannot be changed.

"Scale"  Place an "X" in the check box if a scale is to be displayed on the panel meter. The display color is white and cannot be changed.

"Scale points"  Specify this if a scale is being displayed. Use the spin box to specify how many points will be displayed on the scale. The number of scale points can be between 2 and 11.

(Example)

<table>
<thead>
<tr>
<th>Type: Top 1/2</th>
<th>Type: Top 1/2</th>
<th>Type: Top 1/2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame: Yes</td>
<td>Frame: No</td>
<td>Frame: No</td>
</tr>
<tr>
<td>Scale: Yes</td>
<td>Scale: Yes</td>
<td>Scale: No</td>
</tr>
<tr>
<td>Scale points: 3</td>
<td>Scale points: 3</td>
<td>Scale points: —</td>
</tr>
</tbody>
</table>

If no frame or scale is displayed, only the indicator will be displayed on the meter.

If text is to be displayed on the panel meter, click on [Edit Text]. The "Text" dialog box is displayed.
“Text”
Select the position at which the text is to be displayed.

<table>
<thead>
<tr>
<th>Left</th>
<th>Right</th>
<th>Top</th>
<th>Bottom</th>
<th>Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Text</td>
<td>Text</td>
<td>Text</td>
<td>Text</td>
</tr>
</tbody>
</table>

“Color”
Select the color in which the text is to be displayed, using the list box.
After the display position for the text has been selected, specify the positioning for the text. Click on [Edit], and when the “Text” dialog box is displayed, specify the text to be displayed and the positioning.
With panel meters, text can be displayed at the left, right, top, bottom, or center of the lamp. To delete the specified contents, click on [Delete].

“Text”
Input the text to be displayed. If text is to be displayed in several lines, input [Enter] after each line. The size at which text is displayed is fixed at 1 x in both the vertical and horizontal directions.
“Horizontal alignment” Select the horizontal positioning of the text, using the command button.

“Vertical alignment” Select the vertical positioning of the text, using the command button.

“Offset” Using the spin box, specify the number of dots by which the panel meter frame and the text are to be separated. A maximum of 100 dots can be specified.

(Example 1) Text setting: Top / Horizontal alignment: □□□ / Offset: 5 dots

(Example 2) Text setting: Right / Vertical alignment: □□□ / Offset: 5 dots

*** indicates the input text.

“Default” Click on [Edit], and when the “Edit Display Format” dialog box is displayed, specify the color of the panel meter indicator.

“Attribute” “color” Select the display color for the meter indicator, using the list box.

The width of meter indicator is fixed at 3 dots.

The line width of the meter indicator may be either 1 dot or 2 dots, depending on whether the indicator is slanted, and by how much.

If a comparative equation is being specified using [Display Format], this setting is effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.
2 Setting the **Display Format** (data display range)

- **Panelmeter**
  - **Basic**
  - **Display Format**
  - **Expression**

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Color</th>
<th>Edit</th>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Range**

If a data expression has been specified, this serves as the setting for the minimum and maximum values for the result of the data expression.

**"Lower/Upper"** Specify the minimum and maximum values for the panel meter display.

See Section 14.4, Setting the Level Display Function.

The range which can be specified varies depending on the "Data Type" parameter under the "Monitor Device" parameter.

3 Setting the **Data Expression**

See Section 10.2, Setting Data Expressions.

4 Setting the display position (display size)

If "Yes" has been specified for "Scale", the display position must always be specified at a point 2 dots away from the end of the screen window.

1. When the settings for the various tabs have been entered, click on **OK** in any tab.
2. A dotted-line box is displayed at the upper left of the screen window.
(3) Move the cursor to the position where the panel meter is to be displayed, and click at that position.

![Meter 1](image)

(4) Change the size in which the panel meter is displayed to the display size.

- See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).
- See Section 19.3.4, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis).
- See Section 19.3.5, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction Without Changing the Proportion.

![Meter 1](image)

5 Setting the Display Format (comparative equation)

Specify this if the color in which the panel meter is displayed is to be changed when the monitor device value or the value resulting from the data expression reaches a certain value.

![Panel meter editor](image)
Click on [Edit] and specify the meter indicator color and comparative equation in the "Edit Display Format" dialog box. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].

"Attribute" Specify the color in which the meter indicator is to be displayed when the monitor device value or the value resulting from the data expression fits the comparative equation specified by the "Display range" parameter.

"Meter color" Select the display color for the meter indicator, using the list box.

"Display range" Specify a comparative equation.

See Section 10.5, Procedure for Setting the Display Range (Comparative Equation).

(Example) Type: 16-bit, with sign

Min.: 0
Max.: 300

Case 1: When monitor device value is 200 or higher: Indicator is displayed in red.
Case 2: When monitor device value is 50 or lower: Indicator is displayed in blue.
Default: If monitor device value does not correspond to the above cases: Indicator is displayed in white.

<table>
<thead>
<tr>
<th>Blue</th>
<th>White</th>
<th>Red</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ~ 50</td>
<td>51</td>
<td>199</td>
</tr>
<tr>
<td>200</td>
<td></td>
<td>200</td>
</tr>
<tr>
<td>300</td>
<td></td>
<td>300</td>
</tr>
</tbody>
</table>
The default value is specified under the (Basic) settings.

--- Operation Procedure Outline ---

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box. The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
Chapter 14

Setting Graph Display Functions
14. Setting Graph Display Functions

14.1 Setting the Trend Graph Display Function

*What does this function do?*

- This function collects data stored in the word device at a specified timing, and displays it as a trend graph. When the data has been displayed to the end of the display range, it scrolls the display.

![Diagram](image)

- When using the Save function:
  - Switch to another screen (data acquisition can also be carried out after the screen is switched)
  - The trend graph screen is displayed once again.
  - Data continues to be acquired, and the screen shows the ongoing accumulation of data.

- When not using the Save function:
  - Switch to another screen (data acquisition ends after the screen is switched)
  - The trend graph screen is displayed once again.
  - Data acquisition begins after the trend graph screen is displayed, and the results are displayed.
### Example of settings

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Display style&quot;</td>
<td>&quot;Direction&quot;</td>
</tr>
<tr>
<td></td>
<td>To right</td>
</tr>
<tr>
<td>&quot;No. of lines&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;No. of pts.&quot;</td>
<td>5</td>
</tr>
<tr>
<td>&quot;Sampling&quot;</td>
<td>2000ms</td>
</tr>
<tr>
<td>&quot;Memory store&quot;</td>
<td>Yes</td>
</tr>
<tr>
<td>&quot;Memory clear trigger&quot;</td>
<td></td>
</tr>
</tbody>
</table>

### Monitor Device

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;No.1&quot;</td>
<td>&quot;Color&quot;</td>
</tr>
<tr>
<td></td>
<td>White</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>&quot;Width&quot;</td>
</tr>
<tr>
<td></td>
<td>1 dot</td>
</tr>
<tr>
<td>&quot;Device&quot;</td>
<td>0-FF-D100</td>
</tr>
<tr>
<td>&quot;Device type&quot;</td>
<td>16-bit, with sign</td>
</tr>
<tr>
<td>&quot;Continuous/Random&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>&quot;Lower&quot;</td>
</tr>
<tr>
<td></td>
<td>0</td>
</tr>
<tr>
<td>&quot;Upper&quot;</td>
<td>400</td>
</tr>
</tbody>
</table>

The values for the graph display frame, the scale, and the number of scale points should be entered after the sprite settings have been entered.
Outline of Procedure

Basic
- Setting of display style
- Setting of display timing
- Setting of whether or not data is to be saved

See 1

Monitor Device
- Setting of device type
- Setting of upper/lower limit values
- Setting of graph line attributes
- Setting of monitor device

See 2

Is data expression to be specified?

YES
- Setting of equation for data expression

See 3

NO
After entering settings, click on "OK" on any tab

Setting of display position (display range)

See 4

End
Description of settings

1 Setting the [Basic] settings

```

<table>
<thead>
<tr>
<th>Basic</th>
<th>Monitor Device</th>
<th>Expression(Expression)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>X1: 0</td>
<td>Y1: 0</td>
<td>X2: 32</td>
</tr>
<tr>
<td>Display style:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Direction: Left</td>
<td>Lines: 1</td>
<td></td>
</tr>
<tr>
<td>Points: 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sampling:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>Previous</td>
<td>Next</td>
</tr>
<tr>
<td>Memory store:</td>
<td>Store</td>
<td>Not store</td>
</tr>
<tr>
<td>Memory clear trigger:</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>
```

"Display style"
"Direction" Using the list box, select the direction in which the graph is to be displayed.

```

<table>
<thead>
<tr>
<th>To right</th>
<th>To left</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device</td>
<td>Monitor device</td>
</tr>
<tr>
<td>Display timing</td>
<td>Display timing</td>
</tr>
</tbody>
</table>
```

"No. of lines" Specify the number of lines (the number of monitor device points) to be displayed on the graph, using the spin box. A maximum of eight lines (eight points) can be specified.

"No. of pts." Specify the number of points to be displayed on one graph for each sampling. Up to 100 points can be specified. The spacing between points is determined automatically by the specified number of points and the display range in the X axis direction.

(Example) No. of points: 5

```

Spacing between points = 20 dots
X axis: 100 dots
```
"Sampling"  Using the spin box, specify the timing at which monitor device values are read from the PC CPU and graphs are displayed. The minimum timing that can be specified is 100 ms, and the timing can be specified in units of 100 ms.

However, if specify the setting to continue the data acquisition when the screen is switched from the trend graph screen to another screen, the timing can be specified from minimum 2 seconds (2000 ms) in units of 100 ms.

The following precautions should be observed regarding the sampling:

- If the monitor device values cannot be read from the PC CPU at the specified timing, the graphs cannot be displayed at the specified timing, depending on the configuration of the GOT connections and the number of sprites set for the screen on which the trend graph is specified.
- If the monitor device values cannot be read from the PC CPU at the specified timing, the graphs cannot be displayed at the specified timing because multiple sprite settings have been entered for the screen on which the trend graph has been specified, trend graphs like those described below can be displayed on the GOT.

The GOT will always display graphs at the specified timing, regardless of whether or not the monitor device values can be read from the PC CPU at the specified timing.

If monitor device values cannot be read at the right timing, graphs will be displayed using the previously displayed values. (The same values will be displayed at several points.)

- If trend graphs cannot be displayed at the specified timing because multiple sprite settings have been entered on the screen.

As long as displays can still be produced, the GOT detects how many samplings have been displayed up to that point, and always processes the necessary number of points to display a graph.

Graphs will be displayed by drawing a line from the previous point to the current point, so that the correct values will not be displayed for the interim points.

"Memory store"  Using the radio button, specify whether data acquisition is to continue when the screen is switched from the trend graph screen to another screen, or whether data acquisition is to end.

YES ...... Data continues to be acquired after the screen has been switched. The acquired data is stored in the internal memory of the GOT.

- Up to two trend graph display functions using the "Save" function can be specified for one project.
- Data stored in the internal memory of the GOT will be lost if the GOT is reset, the power supply is turned off, or the GOT is connected to a computer and communications are carried out.
NO ....... Data acquisition ends when the screen is switched.

"Memory clear" This can be selected only if "Save" has been specified.

"Trigger" If the data stored in the internal memory of the GOT is to be deleted when a bit device is turned on or off, use the list box to select this option.

After the selection has been made using the list box, click on [Device] to display the "Set Device" dialog box, and specify the bit device.

See Section 10.1, Setting Device for Monitoring.

- On/Off times for specified bit devices

The on and off times for the bit device should always be specified in such a way that the time is longer than the timing specified with the "Sampling" parameter.
"Device type" Select the type of data for the word device being monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign 32-bit with sign</th>
<th>16-bit with no sign 32-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

Clicking on Edit displays the “Set Range” dialog box.
"Display range"

"Lower"/ "Upper"

Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values. Fixed .... Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device .... Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the "Set Device" dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768</td>
<td>0</td>
<td>-2147483648</td>
<td>0</td>
<td>-999999999999.0</td>
</tr>
<tr>
<td>32767</td>
<td>-65535</td>
<td>-2147483647</td>
<td>-4294967295</td>
<td>-999999999999.0</td>
</tr>
</tbody>
</table>

If "Device" is selected, the "Type" parameter in the "Set Device" dialog box is fixed as the data type specified for the "Type" parameter on the previous page.

"Continuous"/ "Random"

Select this if a value of 2 or more has been entered for "No. of lines".

Using the radio button, specify the monitor device and the attributes for the graph lines.

Continuous ...... Starting with the specified device, devices are specified continuously and automatically, for the number of lines of the graph. The same line attributes will be used for all of the graphs.

Random .......... Any desired device and attribute can be specified for each point.

Click on [Edit], and when the "Attribute" dialog box is displayed, specify the attributes for the graph lines.

If "Random" is selected, click on the number to be specified, and specify the monitor device and graph line attributes for each individual point.

"Attribute"

"Color"

Select the color in which the graph lines are to be displayed, using the list box.

"Style"

Select the style of the graph lines, using the list box.

"Width"

Select the width of the graph lines, using the list box.

"Device"

Click on [Dev], and when the "Device" dialog box is displayed, specify the word device to be monitored.

See Section 10.1, Setting the Device to be Monitored.
3 Setting the Data Expression
   See Section 10.2, Setting Data Expressions.

4 Setting the display position (display range)
   (1) When the settings for the various tabs have been entered, click on “OK” in any tab.
   (2) A square consisting of dotted lines is displayed at the upper left of the screen window.

   (3) Move the cursor to the position where the graph is to be displayed, and click at that position.

   (4) Move the cursor to a handle on the sprite setting frame, and determine the range within which
       the graph is to be displayed.

   See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

   See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

   If “Style” has been set to anything other than a solid line, the display range of the X axis should
   be set so that the spacing between points is at least 16 dots.
14.2 Setting the Line Graph Display Function

What does this function do?
- This function collects data stored in the word device at a specified timing, and displays it as a line graph. When the data has been displayed to the end of the display range, it scrolls the display.

Example of settings

<table>
<thead>
<tr>
<th>Basic</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Description of Setting</strong></td>
</tr>
<tr>
<td>&quot;Display style&quot;</td>
<td>To right</td>
</tr>
<tr>
<td>&quot;No. of lines&quot;</td>
<td>1</td>
</tr>
<tr>
<td>&quot;No. of pts.&quot;</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Monitor Device</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Description of Setting</strong></td>
</tr>
<tr>
<td>&quot;No.1&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>Solid line</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>1 dot</td>
</tr>
<tr>
<td>&quot;Continuous(Random)&quot;</td>
<td>Continuous</td>
</tr>
<tr>
<td>&quot;Device&quot;</td>
<td>0-FF-D100-D104</td>
</tr>
<tr>
<td>&quot;Device type&quot;</td>
<td>16-bit, with sign</td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td>&quot;Lower&quot; 0</td>
</tr>
<tr>
<td>&quot;Upper&quot;</td>
<td>400</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Trigger</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Description of Setting</strong></td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

The values for the graph display frame, the scale, and the number of scale points should be entered after the sprite settings have been entered.
Outline of Procedure

Basic
- Setting of display style

Monitor Device
- Setting of device type
- Setting of upper/lower limit values
- Setting of graph line attributes
- Setting of monitor device

Is data expression to be specified?

NO

Data Expression
- Setting of equation for data expression

YES

Trigger
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position (display range)

End

See 1

See 2

See 3

See 4

See 5
Description of settings

1. Setting the (Basic) settings

"Display style"
"Direction" Using the list box, select the direction in which the graph is to be displayed.

<table>
<thead>
<tr>
<th>To right</th>
<th>To left</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device</td>
<td>Monitor device</td>
</tr>
<tr>
<td>Display timing</td>
<td>Display timing</td>
</tr>
</tbody>
</table>

"Lines" Specify the number of lines (the number of monitor device points) to be displayed on the graph, using the spin box. A maximum of eight lines (eight points) can be specified.

"Points" Specify the number of monitor devices to be displayed on the graph, using the spin box. Up to 100 points can be specified.

The spacing between points is determined automatically by the specified number of points and the display range in the X axis direction.

A monitor device setting for the number of points x the number of graphs is necessary.

Example) No. of points: 5

Spacing between points = 20 dots
X axis: 100 dots
2 Setting the Monitor Device

```
<table>
<thead>
<tr>
<th>No.</th>
<th>Head device</th>
<th>Color Style</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0-FF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Device type: 16bit/signed

Display range
Lower: -32768
Upper: 32767

"Device type" Select the type of data for the word device being monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

Clicking on Edit displays the "Set Range" dialog box.

```
<table>
<thead>
<tr>
<th>Lower</th>
<th>Upper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
```

Device
Lower
-32768
Device
Upper
32767
Device
"Display range"
"Lower"/
"Upper"

Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values. Fixed......Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device......Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the "Set Device" dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768</td>
<td>0</td>
<td>-2147483648</td>
<td>0</td>
<td>-999999999999.0</td>
</tr>
<tr>
<td>-32767</td>
<td>-65535</td>
<td>-2147483647</td>
<td>-999999999999.0</td>
<td></td>
</tr>
</tbody>
</table>

If "Device" is selected, the "Type" parameter in the "Set Device" dialog box is fixed as the data type specified for the "Type" parameter on the previous page.

Click on the number to be specified, and then on Edit. The "Attribute" dialog box will be displayed.

"Attribute"

Select the color in which the graph lines are to be displayed, using the list box.

"Style"

Select the style of the graph lines, using the list box.

"Width"

Select the width of the graph lines, using the list box.

"Continuous"/
"Random"

Using the radio button, select how the monitor devices to be used for the graph are to be specified.

Continuous ...... Starting with the specified device, devices are specified continuously and automatically.

Random ........... Any desired device can be specified for the number of points used for the graph.

Click on [Edit], and when the "Device" dialog box is displayed, specify the word device to be monitored.

If "Random" is selected, click on the number to be specified, and then click on [Edit].

See Section 10.1, Setting Monitor Device.
3 Setting the (Data Expression)
See Section 10.2, Setting Data Expressions.

4 Setting the (Trigger)
See Section 10.4, Setting Display Conditions.

5 Setting the display position (display range)
(1) When the settings for the various tabs have been entered, click on [OK] in any tab.
(2) A square consisting of dotted lines is displayed at the upper left of the screen window.

(3) Move the cursor to the position where the graph is to be displayed, and click at that position.

(4) Move the cursor to a handle on the sprite setting frame, and determine the range within which the graph is to be displayed.
See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.
See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

If "Style" has been set to anything other than a solid line, the display range of the X axis should be set so that the spacing between points is at least 16 dots.
If a spacing of less than 16 dots is specified, dotted lines will be displayed as solid lines.
### 14.3 Setting the Bar Graph Display Function

**What does this function do?**
- This function collects data stored in several word devices and displays it as a bar graph.

#### Example of settings

<table>
<thead>
<tr>
<th><strong>Basic</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Description of Setting</strong></td>
</tr>
<tr>
<td>&quot;Display style&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;No. of bars&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Vertical/horizontal&quot;</td>
<td>Vertical</td>
</tr>
<tr>
<td>&quot;Offset&quot;</td>
<td>20</td>
</tr>
<tr>
<td>&quot;Width&quot;</td>
<td>20</td>
</tr>
<tr>
<td>&quot;Space&quot;</td>
<td>40</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Monitor Device</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Description of Setting</strong></td>
</tr>
<tr>
<td>&quot;Device type&quot;</td>
<td>16-bit, with sign</td>
</tr>
<tr>
<td>&quot;Display range&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Base&quot;</td>
<td>0</td>
</tr>
<tr>
<td>&quot;Lower&quot;</td>
<td>-400</td>
</tr>
<tr>
<td>&quot;Upper&quot;</td>
<td>400</td>
</tr>
<tr>
<td>&quot;Continuous&quot;/&quot;Random&quot;</td>
<td>Continuous</td>
</tr>
<tr>
<td>&quot;No.1&quot;/&quot;No.3&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
<tr>
<td>&quot;No.2&quot;/&quot;No.4&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Pattern&quot;</td>
<td>Fill paint</td>
</tr>
<tr>
<td>&quot;Device&quot;</td>
<td>0-FF-D100-D103</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Trigger</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Item to Set</strong></td>
<td><strong>Description of Setting</strong></td>
</tr>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

The values for the graph display frame, the scale, and the number of scale points should be entered after the sprite settings have been entered.
Outline of Procedure

**Basic**
- Setting of display style

**Monitor Device**
- Setting of device type
- Setting of base and upper/lower limit values
- Setting of graph line attributes
- Setting of monitor device

Is data expression to be specified?

**Data Expression**
- Setting of equation for data expression

**Trigger**
- Setting of display conditions

After entering settings, click on "OK" on any tab

Setting of display position (display range)

End

See 1
See 2
See 3
See 4
See 5
Description of settings

1. Setting the [Basic] settings

<table>
<thead>
<tr>
<th>Basic</th>
<th>Monitor Device</th>
<th>Expression(V)</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>X1: 0</td>
<td>Y1: 0</td>
<td>X2: 32</td>
<td>Y2: 16</td>
</tr>
</tbody>
</table>

Display style
- Bars: [Select using spin box]
- Vertical
- Horizontal
- Offset: [Select using spin box]
- Width: [Select using spin box]
- Space: [Select using spin box]

"Display style"
- "Bars" Using the spin box, select the number of bars (the number of monitor device points) to be displayed. A maximum of eight lines (eight points) can be specified.
- "Vertical/Horizontal" Using the radio buttons, select the direction in which the graph is to be displayed.

<table>
<thead>
<tr>
<th>Vertical direction</th>
<th>Horizontal direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitor device values</td>
<td>Sequence of specified devices</td>
</tr>
<tr>
<td>Sequence of specified devices</td>
<td>Monitor device values</td>
</tr>
</tbody>
</table>

"Offset" Using the spin box, specify the number of dots comprising the distance from the origin point to the bar graph display position. A maximum of 100 dots can be specified.
"Width" Specify the width of the bar graph to be displayed, using the spin box. A maximum of 500 dots can be specified.

"Space" Specify the spacing between bars (not including the bar width), using the spin box. A maximum of 500 dots can be specified.

2 Setting the Monitor Device

![Setting the Monitor Device](image)

Device type: 16bit/signed
Display range
Base: 0
Lower: -32768
Upper: 32767

Color Pattern

Edit
OK
Cancel
Previous
Next

Pattern

Pattern

Pattern

Pattern
“Device type” Select the type of data for the word device being monitored, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
</tr>
<tr>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Clicking on [Edit] displays the “Set Range” dialog box.

**Base**

**“Base”**

**“Lower”/ “Upper”**

Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values. Fixed......Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.

Device......Select this if the values stored in the specified device are to be set as the upper and lower limit values.

Click on [Device] to display the “Set Device” dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768</td>
<td>0</td>
<td>-2147483648</td>
<td>0</td>
<td>-999999999999.0</td>
</tr>
<tr>
<td>-32767</td>
<td>-65535</td>
<td>-2147483647</td>
<td>-4294967295</td>
<td>-999999999999.00</td>
</tr>
</tbody>
</table>

If “Device” is selected, the “Type” parameter in the “Set Device” dialog box is fixed as the data type specified for the “Type” parameter on the previous page.
14. Setting Graph Display Functions

"Base"
Specify the value which will serve as the origin point of the bar graph, using the spin box. The base value should be between the upper and lower limit values.

(Example) Lower limit: 0  Upper limit: 300  Base: 100

1) Monitor device value: 300  2) Monitor device value: 0  3) Monitor device value: 200

"Continuous"/
Select a value of 2 or more for "No. of bars".

"Random"
Using the radio buttons, select how to monitor devices used to draw the graph are to be specified, and how the bar graph attributes are to be specified.

Continuous ...... Starting with the specified device, devices are specified continuously and automatically, for the number of bars on the graph. The same attributes will be used for all of the graphs.

Random......... Any desired device and attributes can be specified for each individual point.

Click on "Edit", and when the "Attribute" dialog box is displayed, specify the monitor device and the graph attributes.

If "Random" is selected, click on the number to be specified, and then specify the monitor device and bar graph attributes for each individual point.

"Attribute"

"Color"
Select the color in which the graph lines are to be displayed, using the list box.

"Pattern"
Select the painting pattern for the graph, using the list box.

"Device"
Click on [Dev.], and when the "Device" dialog box is displayed, specify the word device to be monitored.

See Section 10.1, Setting the Device to be Monitored.

3 Setting the [Data Expression]

See Section 10.2, Setting Data Expressions.

4 Setting the [Trigger]

See Section 10.4, Setting Display Conditions.
5 Setting the display position (display range)

(1) When the settings for the various tabs have been entered, click on "OK" in any tab.

(2) A square consisting of dotted lines is displayed at the upper left of the screen window.

A line frame is displayed at the minimum size for the contents specified by the "Display style" parameter.

(3) Move the cursor to the position where the graph is to be displayed, and click at that position.

(4) Move the cursor to a handle on the sprite setting frame, and determine the range within which the graph is to be displayed.

The display range cannot be smaller than the size displayed by the dotted-line box.

See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).
14.4 Setting the Level Display Function

What does this function do?
- This function displays a level display showing the value of the word device in relation to the upper and lower limit values.

Example of settings

Drawing the figure to be used for the level graph

(X = 200, Y = 25)

Drawn with white solid lines

(X = 500, Y = 350)

<table>
<thead>
<tr>
<th>Basic</th>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display style</td>
<td>&quot;Direction&quot;</td>
<td>Up</td>
</tr>
<tr>
<td></td>
<td>&quot;Boundary&quot;</td>
<td>White</td>
</tr>
<tr>
<td>Internal pos.</td>
<td></td>
<td>X: 350     Y: 200</td>
</tr>
<tr>
<td>Monitor Device</td>
<td>&quot;Color&quot;</td>
<td>White</td>
</tr>
<tr>
<td></td>
<td>&quot;Pattern&quot;</td>
<td>Fill paint</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Display Format</th>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>&quot;Min.&quot;</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>&quot;Max.&quot;</td>
<td>400</td>
</tr>
</tbody>
</table>
### Display Conditions

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Trigger type&quot;</td>
<td>Default</td>
</tr>
</tbody>
</table>

---

### Tool Bar 1

Selected icon

```
  (Level)
```

### Menu Bar

Selected command

On Draw menu:

```
Graph → Level
```

---

### Outline of Procedure

- Drawing of figure to use for level display
  
  See 1

- Setting of display style
  - Setting of internal position
  - Setting of monitor device
  - Setting of level display attributes

  See 2

- Setting of minimum/maximum values for level display

  See 3

- Change attribute if monitor device reaches a given value?

- Setting of comparative equation used to change attributes of level display

  See 7

- Is data expression to be specified?

  See 4

- Setting of equation for data expression

(continued on next page)
Drawing the figure to be used for the level display

A level display can be drawn if the graphic is a closed figure.

- Always use solid lines to draw the graphic used for the level display.
- The level display cannot be produced correctly if the figure is open even slightly. Make sure it is completely closed.

Setting the **Basic** settings

![Basic Settings](image)
"Display style"
"Direction" Using the list box, select the direction in which the level is to be displayed each time the value of the monitor device increases.

<table>
<thead>
<tr>
<th>Up</th>
<th>Down</th>
<th>Right</th>
<th>Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚩</td>
<td>🚩</td>
<td>🚩</td>
<td>🚩</td>
</tr>
</tbody>
</table>

"Boundary" Select the color in which the lines of the figure used for the level display are to be displayed.

"Internal pos." When the display position (display range) is set, the position inside the figure used for the level display will automatically be specified as the internal position, so no setting needs to be entered here.

If the position inside the figure is already known, the internal position should be specified using the spin box.

The internal position may be specified at any position, as long as it is within the figure being used for the level display.

"Monitor Device" Click on [Dev.], and when the "Device" dialog box is displayed, specify the word device to be monitored.

"Device type" Select the type of data, using the list box.

<table>
<thead>
<tr>
<th>16-bit with sign</th>
<th>16-bit with no sign</th>
<th>32-bit real numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>32-bit with sign</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is not used to evaluate plus and minus signs.</td>
</tr>
<tr>
<td>32-bit with no sign</td>
<td></td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

"NW No."  
"Station No."  
"Device name"  
"Device number"  

See Section 10.1, Setting the Device to be Monitored.
"Default" Click on [Edit], and specify the painting color and the pattern for the level display, using the list boxes in the "Edit Display Format" dialog box.

If a comparative equation is being specified using [Display Format], these settings for the painting color and pattern are effective when the monitor device value or the value resulting from the data expression does not fit the comparative equation.

3 Setting the [Display Format] (display range)

"Display range" Clicking on [Edit] displays the "Set Range" dialog box.
"Display range"
"Min.*/Max.*" Using the radio button, select whether the upper and lower limit values are to be input directly, or whether the values stored in the specified device are to be set as the upper and lower limit values. Fixed ...... Select this if the upper and lower limit values are to be input directly. Then use the spin box to input the upper and lower limit values.
Device .... Select this if the values stored in the specified device are to be set as the upper and lower limit values.
Click on [Device] to display the "Set Device" dialog box, and specify the word device.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768</td>
<td>0</td>
<td>-2147483648</td>
<td>0</td>
<td>-999999999999.0</td>
</tr>
<tr>
<td>-32767</td>
<td>-66636</td>
<td>-2147483647</td>
<td>-4204967206</td>
<td>-000000000000.00</td>
</tr>
</tbody>
</table>

If "Device" is selected, the "Type" parameter in the "Set Device" dialog box is fixed as the data type specified for the "Type" parameter on the previous page.

4 Setting the [Data Expression]
See Section 10.2, Setting Data Expressions.

5 Setting the [Trigger]
See Section 10.4, Setting Display Conditions.

6 Setting the display position (display range)
(1) When the settings for the various tabs have been entered, click on "OK" in any tab.
(2) A square consisting of dotted lines is displayed at the upper left of the screen window.
   A cross-shaped marker which indicates the internal position is displayed inside the dotted-line square.

(3) Move the cursor to the position where the level is to be displayed, and click at that position.

(4) Move the cursor to a handle on the sprite setting frame, and change the sprite setting frame to a size in which the entire figure used for the level display can be enclosed.
See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).
• After setting the display position (display range), the following procedure should be carried out if the + marker used for the internal position is not positioned within the figure used for the level display.

(1) Move the cursor to the handle at the upper left corner of the sprite setting frame, and double-click at that position.

(2) Handles will appear on the + marker for the internal position. Move the + marker inside the figure used for the level display.

7 Setting the (Display Format) (Comparative Equation)
Specify this if the attributes of the level display are to be changed when the monitor device value or the value resulting from the data expression reaches a certain value.

Click on [Edit], and when the “Edit Display Format” dialog box is displayed, specify the painting color, the pattern, and the comparative equation. Up to seven types of comparative equations can be specified.

To delete a comparative equation that has been specified, click on [Delete]. To change the order of the comparative equations, click on [Up] or [Down].
"Attribute" Specify the painting color and pattern to be used when the monitor device value or the value resulting from the data expression fits the comparative expression specified with the "Display range" parameter.

"Color" Select the painting color, using the list box.

"Pattern" Select the painting pattern, using the list box.

"Display range" Specify a comparative equation.

See Section 10.5, Setting the Display Range (Comparative Equation).

(Example) Type: 16-bit, with sign
Min.: 0
Max.: 300
Case 1: When monitor device value is 200 or higher: Level displayed in red, with fill painting.
Case 2: When monitor device value is 50 or lower: Level displayed in blue, with fill painting.
Default: if monitor device value does not correspond to the above cases: Displayed in white, with fill painting.

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Displayed comment</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>200&lt;=$V</td>
<td>Red</td>
<td>Fill</td>
</tr>
<tr>
<td>2</td>
<td>$V&lt;=$50</td>
<td>Blue</td>
<td>Fill</td>
</tr>
<tr>
<td>Default</td>
<td>White</td>
<td>White</td>
<td>Fill</td>
</tr>
</tbody>
</table>

The default value is specified under the Basic settings.

Operation Procedure Outline

Specify the comment display format and comparative equation in the "Edit Display Format" dialog box.
The values for "Left", "Middle", and "Right" are specified in the "Input Expression" dialog box.

Specify the values for "Left", "Middle", and "Right" in the "Input Expression" dialog box.
Chapter 15

Setting the Touch Key Functions
15. Setting the Touch Key Functions

15.1 Items to Know before Setting the Touch Key Functions

Before setting the touch key functions, there are a few useful items of information we will look at.

(1) Up to 256 touch keys can be specified on base screens. With the A870GOT, a maximum of 209 touch keys can be specified on window screens, and with the A850GOT, up to 77 touch keys can be specified on window screens.

(2) The minimum size for one touch key is 16 x 16 dots.

(3) When setting the display positions for touch keys, there are two sizes which can be specified: the size of the touch key graphic, and the effective size of the key when it is actually touched and operated (the touch key size). Touch key graphics can be specified in units of 1 dot, while the effective area can be specified in units of 16 dots.

- : Effective area of touch key when actually touched (size can be changed in units of 16 dots horizontally/vertically)
- : Key graphic size (size can be changed in units of 1 dot horizontally/vertically)
- : Minimum unit for touch key (effective area)

Nothing happens if the shaded area is touched.

(4) Several functions can be assigned to one touch key.

<table>
<thead>
<tr>
<th>Function</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word SET</td>
<td>20</td>
</tr>
<tr>
<td>Bit SET</td>
<td>20</td>
</tr>
<tr>
<td>Bit RST</td>
<td>20</td>
</tr>
<tr>
<td>Bit ALT</td>
<td>20</td>
</tr>
<tr>
<td>Bit momentary</td>
<td>1</td>
</tr>
<tr>
<td>Base screen switching</td>
<td>1</td>
</tr>
<tr>
<td>Window screen switching</td>
<td>1</td>
</tr>
</tbody>
</table>

If expanded functions screen switching has been specified, please be aware that the above functions cannot be set.
(5) Several functions can be assigned to one touch key, but please be aware that there are some functions which may not run properly, depending on the combination of functions specified.

\[
\begin{array}{|c|c|c|c|c|}
\hline
\text{Key Type} & \text{Function} & \text{Expansion} & \text{Key code setting} & \text{Operation} & \text{Priority order when multiple functions are set} & \text{Word SET, Bit SET, Bit RST, Bit ALT, Bit Momentary, Base Screen Switching, Window Screen Switching} \\
\hline
\text{Expanded function} & \bigcirc & x & x & \times \ \\
\text{Key code setting} & x & \bigcirc & x & x \ \\
\text{Key code setting (numeric/ASCII input Enter key)} & x & x & \bigcirc & \bigcirc \ \\
\hline
\end{array}
\]

(6) While one touch key is being pressed, it is possible to specify that the other touch keys are invalid (simultaneous pressing inhibited).

If simultaneous pressing is to be inhibited, the key code `FFFEH` should be set for the touch keys.

- **See Section 15.8, Inhibiting Simultaneous Pressing of Touch Keys When Creating Keys for Numeric and ASCII Input.**

(7) When the touch key functions are specified, the user can specify the type of key graphic to be displayed, so there is no need to draw graphics for touch keys.

There are two ways to specify key graphics, as shown below. Key graphics can be switched between off and on in response to a change in the status of the device when touched.

1. Setting from the basic figures provided by the graphic settings software
2. Setting from a panel kit

(If the user is using any desired figure, the figure must first be registered in the panel kit.)
(8) If the touch keys marked with circles below are pressed simultaneously, please be aware that the touch keys indicated by the shaded sections will be activated.

A square indicates one touch key.

- Whether or not keys are adjacent to each other, if three touch key positions marked with circles form a triangle, the vertex of the fourth key, which forms a rectangle (square) and is indicated by the shaded section, will be activated.
15.2 Common Settings for Touch Key Functions

This section explains setting operations which are common to all of the functions described starting in Section 15.3.

15.2.1 Setting Key Graphics

Key graphics are set using the Basic settings tab.

“Display trigger” Using the radio buttons, select the conditions under which the OFF and ON graphics about to be set are to be switched.

Key ......... The figure is switched from OFF to ON when touched.
Device ......... The figure is switched from OFF to ON when the specified bit device goes ON or when the value of the specified word device reaches the value specified by the “Fixed” parameter.

To select a device, click on [Dev.] and use the “Device Setting” dialog box to specify the bit device or word device.

See Section 10.1, Setting the Device to be Monitored.

“Fixed” When a word device has been specified using the above setting, use the spin box to specify the value of the word device at which the key is to be turned on.

“Shape” Select the type of graphic to be displayed, using the list box.

User .......... The basic graphic supplied by the graphics software is displayed.
Computer .... A graphic registered in the panel kit is displayed.
None .......... Select this if no graphic is to be displayed.
• If a free figure is selected
  Clicking on [ON] or [OFF] displays the "Panel Kit" dialog box. Select the figure to be displayed.
  Please be aware that panel kit figures with sprites cannot be used.
  See Section 18.3, Reading a Registered Panel Kit.

• If a basic figure is selected
  Click on either [ON] or [OFF].
  The "Select Figure" dialog box is displayed.
  (When [OFF] is selected)

Click on the switch figure to be displayed.
Clicking on [ON] displays the switch figure when on, and clicking on [OFF] displays the switch figure when off.
If a basic figure has been selected, select the switch figure using either [ON] or [OFF].
Please be aware that when a figure is on, a figure like SWITCH1 cannot be selected, and when off, a figure like SWITCH3 cannot be selected.

"Edit"
Specify the characters, display position, and color for the switch figure.
Then click on [Edit].
This displays the "Set Attribute" dialog box.
"ON"/"OFF"

"Key" Using the list box, select the color in which the switch figure is to be displayed.

"Text" if characters are to be displayed on the switch figure, select the direction in which the text is to be displayed.

Characters can be displayed at the left, right, top, bottom, or center of the figure.

"Text color" Using the list box, select the color in which characters are to be displayed.

After the display direction of the text has been specified, click on [Edit] to display the "Set Text" dialog box. Specify the characters and alignment of the text to be displayed.

To delete any contents that have been specified, click on [Delete].

Clicking on [Copy from ON] enables characters and display positions specified when the switch is on to be copied.

"Text" Input the text to be displayed. If text is to be displayed in several lines, input [Enter] after each line.

The size at which text is displayed is fixed at 1 x in both the vertical and horizontal directions.
"Horizontal alignment" Select the horizontal positioning of the text, using the command button.

"Vertical alignment" Select the vertical positioning of the text, using the command button.

"Offset" Using the spin box, specify the number of dots by which the key graphic and the text are to be separated. A maximum of 100 dots can be specified.

(Example 1) Text setting: Top / Horizontal alignment: ← / Offset: 5 dots

(Example 2) Text setting: Right / Vertical alignment: ↑ / Offset: 5 dots

*** indicates the input text.

--- Special Cases ---

- Using specified touch key functions as hidden keys
  Key graphics can be used as hidden keys if no settings are entered for them.
15.2.2 Setting the Run Timing for Specified Movements

The timing at which specified movements are executed can be specified on the Trigger tab.

"Trigger type" Using the radio buttons, select whether the specified action is to be executed immediately when the key is touched, or if it is to be executed only when a specified bit device is ON/OFF. Ordinary ...... The action is executed when the key is touched. ON .......... The action is executed only when the bit device specified with the "Trigger device" parameter is ON.

Specified bit is OFF

Specified action is not executed

Specified bit is ON

Specified action is executed

POINT

When a touch key function is executed, this is the interlock device which either enables or inhibits that action to be executed.

OFF ......... The action is executed only when the bit device specified with the "Trigger device" parameter is OFF.

Specified bit is ON

Specified action is not executed

Specified bit is OFF

Specified action is executed
"Range" This can be run only if the word device specified with "Trigger device" corresponds to the comparative equation specified with the "Range" parameter.

Comparative equation

\[
0 < D10 < 100 \\
\text{When } D10 \text{ is 1000}
\]

Specified action is not carried out

Comparative equation

\[
0 < D10 \\
\text{When } D10 \text{ is 50}
\]

Specified action is carried out

"Trigger device" This is specified after either "ON" or "OFF" has been selected for the "Trigger type" parameter. Click on [Dev.] and specify the bit device in the "Device Setting" dialog box.

See Section 10.1, Setting the Device to be Monitored.

"Range" When the range is selected using the "Trigger type" parameter, a comparative equation can be specified.

See Section 10.5, Setting Display Ranges (Comparative Equations) for instructions on entering settings.

"Key code" This is not specified in the run timing settings.

See Section 15.8, Inhibiting Simultaneous Pressing of Touch Keys When Creating Keys for Numeric and ASCII Input.

"Edit key group" When the "Touch Key" dialog box is displayed in order to edit touch keys which have already been specified, place an "X" in this check box if the effective area is also to be changed. After the editing has been completed, the sprite setting box is displayed in the area outlined by dotted lines, for effective area settings.

---

**Special Cases**

- Timing at which the bit device specified with "Trigger device" is checked

This function checks the status of a specified bit device immediately after a key is touched and determines whether or not the action can be executed. For example, with a touch key in the touch key (momentary) function, this checks the status of the bit device immediately after the key has been touched, and determines whether or not the action can be executed. This means that the action will not change even if the status of the bit device changes while the key is being touched.
15.2.3 Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics

1] Positioning

(1) When the settings for the various tabs have been entered, click on “OK” in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window. The smaller dotted box inside the larger one is for specifying the effective area. The effective area is displayed at a position which is a multiple of 16 dots in both the horizontal and vertical directions.

(3) Move the cursor to the display position, and click at that position.

When the position is determined, the graphic and text in the OFF status are displayed (only when a key graphic has been specified).

2] Adjusting the key graphic size

(1) Move the cursor to a handle on the sprite setting frame, and determine the size of the key graphic.

See Section 19.3.2, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction.

See Section 19.3.3, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis).

See Section 19.3.4, Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis).
3 Adjusting the size of the effective area

(1) Move the cursor to the top left corner of the sprite setting frame and double-click at that position.

(2) The box for specifying the effective area is displayed in the sprite setting frame.

(3) Move the cursor to a handle on the sprite setting frame, and use the same procedure as that in step (4) to determine the effective area. When doing this, the cursor moves in units of 16 dots in the horizontal and vertical directions, regardless of the amount of movement used in automatic positioning.

The effective area must be smaller than the display size of the key graphic.

If the key graphic and the effective area are the same size, the key graphic should be specified in units of 16 dots in the horizontal and vertical directions.
15.3 Setting Touch Key (Bit) Functions

What does this function do?

- This function turns on the specified bit device by touching it. (Bit SET)
- This function turns off the specified bit device by touching it. (Bit RST)
- This function reverses the status (ON ↔ OFF) of the specified bit device by touching it. (Bit ALT)
- This function keeps the specified bit device on as long as it is touched. (Bit Momentary)

![Diagram of Bit SET](image)
Touching the specified bit turns it ON

![Diagram of Bit RST](image)
Touching the specified bit turns it OFF

![Diagram of Bit ALT](image)
Touching the currently specified bit reverses its status (ON → OFF) (OFF → ON)

![Diagram of Bit Momentary](image)
The specified bit is ON only while touched
Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1
- No key graphic specified

Action
- Clicking on "Bit"
- Setting of type of action
- Setting of storing device

See 2

Trigger
- Setting of action conditions

See 3

After entering settings, click on "OK" on any tab

Setting of display position, display size, and effective area

See 4

End
Description of settings

1. Setting the Basic settings

See Section 15.2.1, Setting Key Graphics.

2. Setting the Action settings

Click on [Bit].

To correct the specified contents after the action settings have been entered, click on [Edit]. To delete the specified contents, click on [Delete].

The "Key Action (Bit)" dialog box is displayed.
“Action” Using the radio buttons, select the type of function to be carried out for the bit device to which the data is written when the device is touched.

<table>
<thead>
<tr>
<th>Bit SET</th>
<th>Bit RST</th>
<th>Bit ALT</th>
<th>Bit Momentary</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON</td>
<td>OFF</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Bit is turned ON when touched</td>
<td>Bit is turned OFF when touched</td>
<td>Bit switches between ON and OFF when touched</td>
<td>Bit is ON while touched</td>
</tr>
</tbody>
</table>

“Storing device” Click on [Dev.], and in the “Device Setting” dialog box, specify the bit device to which the data is to be written.

See Section 10.1, Setting the Device to be Monitored.

3 Setting the (Trigger) settings

See Section 15.2.2, Setting the Run Timing for Specified Movements.

4 Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.

---

**Special Cases**

- Making sure the specified action was actually executed

The status of the target device can be confirmed by specifying a key graphic and then specifying the device set with the “Storing device” parameter for the “Display Key” parameter.
• What happens if the power supply is turned OFF while a touch key for which "Bit Momentary" was specified is being touched?

The bit device remains on even if the power supply to the GOT is turned off.

• What happens if a request is issued to switch the base screen while a touch key for which "Bit Momentary" was specified is being touched?

The screen will be switched after the key is released. Switching of base and windows screens is carried out when the key is no longer being touched.

• What happens if a hardware problem occurs with the GOT and monitoring is interrupted while a touch key for which "Bit Momentary" was specified is being touched?

The bit device remains ON, so it should be turned OFF using the procedure outlined below.

(1) Specify a time-out for the pertinent device which is continually on, and when the time-out occurs, initiate a forced RST on the sequencer CPU side.

(2) When using the A870GOT, use the I/O signal from the RUN terminal as an interlock.

• Setting other touch switches invalid while a touch switch for which bit momentary has been specified is being touched

Using the "Action" tab, set the key code FFFE$.

See Section 15.8, Inhibiting Simultaneous Pressing of Touch Keys When Creating Keys for Numeric and ASCII Input.
15.4 Setting Touch Key (Word) Functions

What does this function do?

- This function writes the value of the specified word device by touching it. (Fixed value)
- This function writes the value of the specified word device to a word device by touching it. (Indirect)
- This function writes the value of the specified word device + the fixed value to a word device by touching it. (Fixed value + Indirect)
**Outline of Procedure**

**Basic**
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1

No key graphic specified

**Action**
- Clicking on "Word"
- Setting of storing device
- Setting of type of action

See 2

**Trigger**
- Setting of action conditions

See 3

After entering settings, click on "OK" on any tab

Setting of display position, display size, and effective area

See 4

End
Description of settings

1 Setting the (Basic) settings

See Section 15.2.1, Setting Key Graphics.

2 Setting the (Action) settings

Click on [Word].

To correct the specified contents after the action settings have been entered, click on [Edit]. To delete the specified contents, click on [Delete].

The "Key Action (Word)" dialog box is displayed.
"Storing device"  Click on [Dev.] and use the "Device Setting" dialog box to specify the word device to which the data is to be written.

"type"  Select the type of data to be written, using the list box. The range of values which can be written varies depending on the selected data type.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>-32768</td>
<td>0</td>
<td>-2147483648</td>
<td>0</td>
<td>-999999999999.0</td>
</tr>
<tr>
<td>~32767</td>
<td>~65535</td>
<td>~2147483647</td>
<td>~4294967295</td>
<td>~999999999999.00</td>
</tr>
</tbody>
</table>

"NW No."  
"Station No."  
"Device name"  
"Device number"

See Section 10.1, Setting the Device to be Monitored.

"Fixed"  Select the check box for the method by which data is to be written to the storing word device when touched.

"Device"

<table>
<thead>
<tr>
<th>☒ Fixed Device</th>
<th>☐ Fixed Device</th>
<th>☒ Fixed Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storing word device 100 → 10</td>
<td>Storing word device 200 → 100</td>
<td>Storing word device 50 → 101</td>
</tr>
<tr>
<td>Fixed value: 10</td>
<td>Current value of specified word device: 100</td>
<td>Current value of specified word device + fixed value 100 + 1 = 101</td>
</tr>
<tr>
<td>When touched, the specified fixed value is written. Specify the value using the spin box to the right of &quot;Fixed&quot;.</td>
<td>When touched, the current value of the specified word device is written. Specify the word device by clicking on [Dev.] to display the &quot;Device Setting&quot; dialog box.</td>
<td>When touched, the current value of the specified word device + the fixed value is written.</td>
</tr>
</tbody>
</table>

The range of values which can be specified as fixed values changes depending on the setting entered for "Device".
3 Setting the **Trigger** settings

See Section 15.2.2, Setting the Run Timing for Specified Movements.

4 Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.

**Special Cases**

- Adding or subtracting the current word device value by touching it

If you set the same value for the storing word device and the specified word device, and then specify the value to be added or subtracted (using the "Fixed" parameter), values can be added to and subtracted from the current word device value.

(Example) Each time **+** is touched, the value of D100 increases by 1, and each time **-** is touched, the value decreases by 1.
15.5 Setting Touch Key (Base Switching) Functions

15.5.1 Switching to the Screen of the Previously Displayed Base Screen Number

- What does this function do?
  - This function switches to the screen of the previously displayed base screen number when touched.

**POINT**
- Base screens are switched when the touch key is released.
- Base screens can also be switched through the PC program.

- This function can be used to switch base screens as shown below.

The screen numbers of up to ten previously displayed base screens can be stored in the memory of the GOT, so base screens can be switched all the way back to the first one displayed, in reverse order.
**Outline of Procedure**

**Basic**
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

*See 1* No key graphic specified

---

**Action**
- Clicking on "Base"

*See 2* This is the "Touch Key" dialog box.

---

**Basic**
- Selection of "Previous monitored" for "Next screen"

*See 3* This is the "Set action (Base switching)" dialog box.

---

**Trigger**
- Setting of action conditions

*See 4* This is the "Touch Key" dialog box.

---

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

*See 5*

End
Description of settings

1. Setting the **Basic** settings in the “Touch Key” dialog box

   See Section 15.2.1, Setting Key Graphics.

2. Setting the **Action** settings in the “Touch Key” dialog box

   Click on **Edit**. After the action settings have been entered, to correct the specified contents, click on **Delete**. To delete the specified contents, click on **Delete**.

   The “Set Action (Base switching)” dialog box is displayed.

   ![Set Action (Base switching) dialog box]

   There are three tabs in the “Set Action (Base switching)” dialog box: **Basic**, **Action** (for word settings), and **Action** (for bit settings).

3. Setting the **Basic** settings (in the “Set Action (Base switching)” dialog box)

   “Next screen” Select “Previous monitored, with the radio button.”
4. Setting the **Trigger** settings in the “Touch Key” dialog box
   
   See Section 15.2.2, Setting the Run Timing for Specified Movements.

5. Setting the display position, display size, and effective area for key graphics
   
   See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.

---

**Special Cases**

- Example of switching screens using this function

```
Case 1: 1 → 2 → 6 → 10 → 6 → 2 → 5 → 9 → 5 → 2 → 1
Case 2: 1 → 3 → 7 → 11 → 7 → 3 → 1
Case 3: 1 → 4 → 8 → 12 → 8 → 4 → 1
```

The values in the boxes indicate the base screen number.

→ indicates a screen switching action not initiated using this function.

→ indicates a screen switching action initiated using this function.
15.5.2 Switching to the Screen of the Specified Base Screen Number

What does this function do?

- This function switches to the screen of a specified base screen number by touching the screen.

**POINT**

- Base screens are switched when the touch key is released.
- Base screens can also be switched through the sequence program.

![Base screen switching device diagram](image)
Outline of Procedure

1. Basic
   - Setting of display switching
   - Setting of type of graphic
   - Setting of key graphic and text
   See 1

2. Action
   - Clicking on "Base"
   See 2

3. Basic
   - Selection of "Fixed" with "Next screen", and specifying of destination base screen number
   See 3

4. Trigger
   - Setting of action conditions
   See 4

5. Setting of display position, display size, and effective area
   See 5

End
Description of settings

1. Setting the (Basic) settings in the “Touch Key” dialog box
   - See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings in the “Touch Key” dialog box
   - Click on [Basic]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].
   - The “Set Action (Base switching)” dialog box is displayed.

   ![Set Action (Base switching) dialog box]

   There are three tabs in the “Set Action (Base switching)” dialog box: [Basic], [Action] (for word settings), and [Action] (for bit settings).

3. Setting the (Basic) settings (in the “Set Action (Base switching)” dialog box)
   - (1) Next screen
     - Select “Fixed”, with the radio button.
     - Using the spin box to the right of the “Fixed” parameter, specify the screen number of the next base screen to be displayed.

4. Setting the (Trigger) settings in the “Touch Key” dialog box
   - See Section 15.2.2, Setting the Run Timing for Specified Movements.

5. Setting the display position, display size, and effective area for key graphics
   - See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
15.5.3 Switching to the Screen of a Base Screen Number by Turning the Specified Bit Device ON/OFF

What does this function do?
- This function switches to the specified base screen by touching a specified bit device to turn it ON and OFF.

POINT
- Base screens are switched when the touch key is released.
- Base screens can also be switched through the sequence program.

[Diagram showing the process of switching screens based on bit device ON/OFF status.]
15. Setting the Touch Key Functions

--- Tool Bar 1 ---
Selected icon

--- Menu Bar ---
Selected command
On Draw menu:

Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1
No key graphic specified
This is the
"Touch Key" dialog box.

Action
- Clicking on "Base"

See 2
This is the
"Touch Key" dialog box.

Basic
- Selection of "Device" with "Next screen"
- Specifying of bit device

See 3
This is the "Set action (Base switching)"
dialog box.

Set action
- Setting of number of base screen to be displayed

See 4
This is the "Set action (Base switching)"
dialog box.

Trigger
- Setting of action conditions

See 5
This is the "Touch Key" dialog box.

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

See 6

End
Description of settings

1 Setting the (Basic) settings in the "Touch Key" dialog box

See Section 15.2.1, Setting Key Graphics.

2 Setting the (Action) settings in the "Touch Key" dialog box

Click on [Base]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].

The "Set Action (Base switching)" dialog box is displayed.

There are three tabs in the "Set Action (Base switching)" dialog box: [Basic], [Action] (for word settings), and [Action] (for bit settings).

3 Setting the (Basic) settings in the "Set Action (Base switching)" dialog box

"Next screen" Select "Device", with the radio button.

Click on [Dev.], and in the "Device Setting" dialog box, specify the bit device.

See Section 10.1, Setting the Device to be Monitored.
4 Setting the (Trigger) settings (in the “Set Action (Base switching)” dialog box)

To specify the number of the base screen to which the display is to be switched when the specified bit device is on, click on the “ON” column, and then on [Edit].

To specify the number of the base screen to which the display is to be switched when the specified bit device is off, click on the “OFF” column, and then on [Edit].

The “Edit Display Format” dialog box is displayed.

“Switching type” Select the method by which the base screen is to be switched, using the radio buttons.

No. ............ Select this if the screen is to be switched to the specified base screen number when the specified bit device is turned on or off.

Hold ............ Select this if the screen is not to be switched when the specified bit device is turned on or off.
Setting the **Trigger** settings in the "Touch Key" dialog box

See Section 15.2.2, Setting the Run Timing for Specified Movements.

Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
15.5.4 Switching to the Screen of a Base Screen Number Using the Current Value of the Specified Word Device

What does this function do?
- This function switches the base screen based on the current value of a specified word device, by touching it.

POINT
- Base screens are switched when the touch key is released.
- Base screens can also be switched through the sequence program.

When touched, if the value of the specified word device fits a specified comparison equation, the screen of the specified base screen number is displayed.

Up to 8 comparison equations can be specified.
Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1
No key graphic specified
This is the "Touch Key" dialog box.

Action
- Clicking on "Base"

See 2
This is the "Touch Key" dialog box.

Basic
- Selection of "Device" with "Next screen"
- Specifying of word device

See 3
This is the "Set action (Base switching)" dialog box.

Set action
- Setting of comparative equation and number of next base screen to be displayed

See 4
This is the "Set action (Base switching)" dialog box.

Trigger
- Setting of action conditions

See 5
This is the "Touch Key" dialog box.

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

See 6

Setting of display position, display size, and effective area
Description of settings

1. Setting the (Basic) settings in the “Touch Key” dialog box
   See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings in the “Touch Key” dialog box
   Click on [Base]. After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].
   The “Set Action (Base switching)” dialog box is displayed.

   ![Set Action (Base switching) dialog box]

   There are three tabs in the “Set Action (Base switching)” dialog box: [Basic], [Action] (for word settings), and [Action] (for bit settings).

3. Setting the (Basic) settings in the “Set Action (Base switching)” dialog box
   “Next screen” Select “Device”, with the radio button.
   Click on [Dev.], and in the “Device Setting” dialog box, specify the bit device.
   See Section 10.1, Setting the Device to be Monitored.
4. Setting the **Trigger** settings (in the "Set Action (Base switching)" dialog box)

This is specified if the base screen is to be switched when touched, based on the value stored in the specified word device.

(1) Base screens can be switched as described below, based on the value stored in the specified word device and the comparative equation.

- No. ............ If the value of the specified word device fits the comparative equation, the screen is switched to the specified base screen.
- Indirect ........ If the value of the specified word device fits the comparative equation, the screen is switched to the base screen corresponding to the value.
- Hold............ If the value of the specified word device fits the comparative equation, the screen is not switched even if touched.

(2) The comparative equation for the display range is specified as follows.

<table>
<thead>
<tr>
<th>Type of comparative equation</th>
<th>Left</th>
<th>Operand</th>
<th>Middle</th>
<th>Operand</th>
<th>Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range</td>
<td>n1</td>
<td>&lt;=</td>
<td>$V</td>
<td>&lt;=</td>
<td>m1</td>
</tr>
<tr>
<td>Above</td>
<td>n2</td>
<td>&lt;=</td>
<td>$V</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Below</td>
<td>$V</td>
<td>&lt;=</td>
<td>2 3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specify numeric values for n1, m1, n2, and 2 3. "$V" indicates the value stored in the specified word device.

Click on **Edit** and specify the method by which the screen is to be switched and the comparative equation in the "Edit Display Format" dialog box. Up to eight types of comparative equations can be specified.
"Switching type" Using the radio buttons, specify the method by which the base screen is to be switched if the value of the specified word device fits the comparative equation specified with the "Display range" parameter.

No. ............ Select this if the screen is to be switched to the specified base screen number. Use the spin box to specify the number of the next base screen to be displayed.

Indirect........ Select this if the base screen is to be switched to the screen whose number corresponds to the value of the specified word device.

Hold............ Select this if the screen is not to be switched even if touched.

"Display range" Specify a comparative equation.

See Section 10.5, Setting the Display Range (Comparative Equation).
(Example)
Case 1: The screen is switched to Base Screen No. 10 if the current value of the specified word device is 0 or less ($V \leq 0$) when touched.

![Diagram](image)

Current value of specified word device $\leq 0$

Case 2: If the current value of the specified word device is between 1 and 20 ($1 \leq V \leq 20$) when touched, the screen is switched to the base screen number corresponding to the value.

- If the current value of the specified word device is 5, the screen is switched to Base Screen No. 5.
- If the current value of the specified word device is 10, the screen is switched to Base Screen No. 10.

![Diagram](image)

$1 \leq$ Current value of specified word device $\leq 20$

Case 3: If the current value of the specified word device does not fit the above cases when touched (the current value of the specified word device is 21 or higher), the currently displayed base screen continues to be displayed.

![Diagram](image)

$21 \leq$ Current value of specified word device

<table>
<thead>
<tr>
<th>Case</th>
<th>Display range</th>
<th>Screen No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>$V \leq 0$</td>
<td>No. 10</td>
</tr>
<tr>
<td>2</td>
<td>$1 \leq V \leq 20$</td>
<td>Indirect</td>
</tr>
<tr>
<td>Default</td>
<td>$21 \leq V$</td>
<td>Hold</td>
</tr>
</tbody>
</table>
15.5.5 Switching the Base Screen Using a Sequence Program

Base screens can be switched without using the touch key (base switching) function, by creating a sequence program in which the value of the base screen switching device is written to the value of the base screen number to be displayed next.

If "GD" is specified as the device name for the base screen switching device, however, the base screen cannot be switched using the sequence program.

(Example) Base screen switching device: D100

The display switches to base screen No. 10 when M10 goes on.

![Switching instruction diagram]

Switching instruction
M0

|M | [MOVP K10 D100 |

If "GD" is specified as the device name for the base screen switching device, the base screen cannot be switched using the sequence program.
15.6 Setting the Touch Key (Window Switching) Functions

15.6.1 Changing to the Screen of the Specified Window Number

What does this function do?

- This function switches to a specified window screen number by touching the screen.

**POINT**

- Only one window screen can be displayed on a base screen.
- Window screens are displayed and switched when the touch key is released.
- Window screens can also be switched through the sequence program.

- This function can also be used to switch from the currently displayed window screen to a specified window screen.
Outline of Procedure

**Basic**
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

- No key graphic specified

**Action**
- Clicking on "Window"

- This is the "Touch Key" dialog box.

**Trigger**
- Setting of action conditions

- This is the "Touch Key" dialog box.

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

End

- Settings for this function are entered using the same procedures as those for switching base screens. (The same approach is used.)

See Section 15.5.2, Changing to the Screen of the Specified Base Screen Number.
15.6.2 Changing to the Screen of a Window Screen Number by Turning the Specified Bit Device ON/OFF

What does this function do?
- This function switches to the specified window screen by touching a specified bit device to turn it on and off.

**POINT**
- Only one window screen can be displayed on a base screen.
- Window screens are displayed and switched when the touch key is released.
- Window screens can also be switched through the sequence program.

• The window screen can be switched by using this function to specify another window screen.
Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

Action
- Clicking on "Window"

Basic
- Selection of "Device" with "Next screen", and specifying of bit device

Action settings
- Specifying the number of the window screen to be displayed or switched

Trigger
- Setting of action conditions

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

End

- Settings for this function are entered using the same procedures as those for switching base screens by turning the specified bit device on or off. (The same approach is used.)

See Section 15.5.3, Changing to the Screen of the Specified Base Screen Number by Turning the Specified Bit Device On/Off.
15.6.3 Changing to the Screen of a Window Screen Number Using the Current Value of the Specified Word Device

What does this function do?

- This function switches the window screen based on the current value of a specified word device, by touching it.

POINT

- Only one window screen can be displayed on a base screen.
- Window screens are displayed and switched when the touch key is released.
- Window screens can also be switched through the sequence program.

When touched, if the value of the specified word device fits a specified comparison equation, the screen of the specified window screen number is displayed.

- This function can be used to switch the window screen by specifying another window screen.
15. Setting the Touch Key Functions

Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

Action
- Clicking on "Window"

Action settings
- Selection of "Device" with "Next screen", and specifying of word device

Trigger
- Setting of action conditions

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

End

- Settings for this function are entered using the same procedures as those for switching base screens by turning the specified word device on or off. (The same approach is used.)

See Section 15.5.4, Changing to the Screen of the Specified Base Screen Number by Turning the Specified Word Device On/Off.
15.6.4 Changing the Window Screen Using a Sequence Program

Window screens can be switched without using the touch key (base switching) function, by creating a sequence program in which the value of the window screen switching device is written to the value of the window screen number to be displayed next.

If "GD" is specified as the device name for the window screen switching device, however, the window screen cannot be switched using the sequence program.

(Example) Window screen switching device: D100

The display switches to window screen No. 10 when M10 goes ON.

If a window screen is already displayed:

Switching instruction M10

\[ \text{MOVP} \ K10 \ D100 \]

\[ \text{MOVP} \ K10 \ D100 \]

\[ \text{MOVP} \ K10 \ D100 \]

\[ \text{MOVP} \ K10 \ D100 \]
15.7 Setting the Touch Key (Expansion) Functions

What does this function do?
- This function switches from the screen being monitored to the next screen. The following can be switched to and displayed:
  - Utility screens (utility menu screens)
  - Key windows (for numeric input function)
  - System monitor (basic screen for system monitor)
  - Circuit monitor screens (circuit monitor screens/PC readout screens) .... A85□GOT can’t be set.
  - Special unit monitors (system configuration) ....................................... A85□GOT can’t be set.
  - Start Hard Copy ............................................................................ A85□GOT can’t be set.
  - Cancel Hard Copy .......................................................................... A85□GOT can’t be set.

--- Tool Bar 1 ---
Selected icon

![SP] → Touch key

--- Menu Bar ---
Selected command
On Draw menu:
Touch key

Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1 No key graphic specified

Action
- Clicking on "Expanded"
- Specifying the screen to be switched

See 2

Trigger
- Setting of action conditions (Set only when key window is selected)

See 3

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

See 4

End
Description of settings

1. Setting the (Basic) settings in the “Touch Key” dialog box

   See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings

Click on [Extended].

After the action settings have been entered, to correct the specified contents, click on [Edit]. To delete the specified contents, click on [Delete].

The “Action (Expanded Key)” dialog box is displayed.
"Expanded action" Select the screen to be displayed, using the radio buttons.

3 Setting the (Trigger) settings
   See Section 15.2.2, Setting the Run Timing for Specified Movements.

4 Setting the display position, display size, and effective area for key graphics
   See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
15.8 Inhibiting Simultaneous Pressing of Touch Keys When Creating Keys for Numeric and ASCII Input

This function can be specified on a window screen and touch keys used as the keys for inputting numeric values to base screens and for input in the ASCII input function.

When is this function used?
- This function is used when you want to create keys to use with the numeric input function or the ASCII input function, and when simultaneous pressing of touch keys is inhibited.

Description of settings

Selected icon

SP! → Touch key

Selected command

On Draw menu:

Touch key

Outline of Procedure

Basic
- Setting of display switching
- Setting of type of graphic
- Setting of key graphic and text

See 1

No key graphic specified

Action
- Specifying the key code
- Specifying the action conditions

See 2

After entering settings, click on "OK" on any tab in the "Touch Key" dialog box.

Setting of display position, display size, and effective area

See 3

End
15. Setting the Touch Key Functions

1. Setting the (Basic) settings in the “Touch Key” dialog box
   See Section 15.2.1, Setting Key Graphics.

2. Setting the (Action) settings

   ![Touch Key Settings Diagram]

   Inhibiting simultaneous pressing of keys
   - Set the key code $FFFF_{16}$

   Using the spin box, specify the key codes for the keys to be used for numeric input or ASCII input.
   ASCII codes and shift JIS codes may be specified.

   **Numeric Input Functions**
   - Delete all numeric values being displayed only at the beginning ....................... $002E_{16}$
   - Numeric values input .................................................. $002D, 002E, 0030_{16} \text{ to } 0046_{16}$
   - Delete all input numeric values ........................................ $0088_{16}$
   - Delete numeric value being input and reverse sign ..................................... $002D_{16}$
   - Delete last digit of input numeric value and shift all one digit to the right ........ $0008_{16}$
   - Write input numeric value to storing device (execute) / shift cursor ............. $000D_{16}$
   - Interrupt input and shift cursor To right ........................................ $0080_{16}$
   - Interrupt input and shift cursor To left ........................................... $0081_{16}$
   - Up .............................................................................. $0082_{16}$
   - Down ........................................................................ $0083_{16}$
   - Interrupt input and delete cursor ......................................................... $001B_{16}$
ASCII Input Functions

- Delete all numeric values being displayed only at the beginning .................................. 002E\text{H}
- For ASCII input .............................................................................................................. ASCII codes
- Delete all characters being input .................................................................................... 0088\text{H}
- Write input characters to storing device (execute) /shift cursor .................................... 000D\text{H}
- Shift cursor
  - To right .................................................................................................................... 0080\text{H}
  - To left ....................................................................................................................... 0081\text{H}
  - Up ......................................................................................................................... 0082\text{H}
  - Down .................................................................................................................... 0083\text{H}
- Delete cursor .................................................................................................................. 001B\text{H}

Setting the display position, display size, and effective area for key graphics

See Section 15.2.3, Setting Display Positions, Display Sizes, and Effective Areas for Key Graphics.
Chapter 16

Setting Data Input Functions
16. Setting Data Input Functions

16.1 Setting the Numeric Input Function

What does this function do?

- This function allows any desired numeric value to be written to a specified word device.
- Keys for numeric input are displayed on the GOT key window screen (keys for input can be freely created by the user).
- If the value is not to be input (the input cursor is not displayed), the value is displayed as a numeric value.

Useful Information About the Numeric Input Function

- Touching the area to be input displays the input cursor. (When specifying the display position, the X and Y axes should be specified in values that are multiples of 16 dots.)
- When a window is displayed, if the numeric input function is specified in the displayed window screen, the input cursor is displayed only in the window screen. It will not be displayed in the base screen, even if the numeric input function is on in the base screen.
Outline of Procedure

- **Basic**
  - Setting of display size
  - Setting of monitor device
  - Setting of display format

- **Display Format**
  - Setting of input range
  - Setting of display color

- Is layered conversion to be used for input data?
- Is value to be stored in device to be added and displayed?

- **Expression**
  - Specify equations for layered conversion and addition

- **Trigger**
  - Setting of display conditions

After entering settings, click on "OK" on any tab

- Setting of display position

- Setting of cursor position following writing of numeric value

End

See 1

See 2

See 3

See 4

See 5

See 6
**Description of settings**

1. Setting the **Basic** settings

![Numerical Input](image)

- **Position**
  - X: 0
  - Y: 0

- **Size**
  - V: 1
  - H: 1

- **Monitor device**
  - 0–FF

- **Display style**
  - Signed decimal: 1
  - Digits: 6
  - Decimal point: 0
  - Left alignment
  - Right alignment
  - Disp. all digits

"Display size" Using the list box, select the size in which text is to be input following input of numeric values. The size of one character at a horizontal and vertical size of 1 x is 16 x 18 dots.

"Monitor device" Click on [Dev.], and specify the word device to which the data is to be written in the "Device Setting" dialog box.

"Dev." Using the list box, select the data type for the input numeric value or the value resulting from the written word calculation.

The range of values that can be stored varies depending on the data type setting.

<table>
<thead>
<tr>
<th>16-bit, with sign</th>
<th>16-bit, without sign</th>
<th>32-bit, with sign</th>
<th>32-bit, without sign</th>
<th>32-bit real number</th>
</tr>
</thead>
<tbody>
<tr>
<td>−32768</td>
<td>0</td>
<td>−2147483648</td>
<td>0</td>
<td>−999999999999.0</td>
</tr>
<tr>
<td>−32767</td>
<td>−65535</td>
<td>−2147483647</td>
<td>−4294967395</td>
<td>−999999999999.00</td>
</tr>
</tbody>
</table>

If "32-bit real number" is specified, the input value is written to the sequencer CPU with the precision of a single-precision integer with seven significant digits.

If "32-bit real number" is specified, the input value is written in real number format.

"NW No."   "Station No."   "Device name"   "Device number"

See Section 10.1, Setting the Device to be Monitored.
"Display style" Using the list box, select the numeric format in which the value of the storing device or the value resulting from the monitor word calculation is to be displayed.

Numeric values can be displayed in any format, but are input as decimal/hexadecimal values.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>Select this to display monitor device values as decimal values.</td>
<td>Select this to display monitor device values as real numbers with floating decimal points.</td>
<td>Select this to display monitor device values as binary values.</td>
</tr>
</tbody>
</table>

"Digits" Specify the number of digits used to express the numeric area, using the spin box. The number of digits that can be displayed using the "Display style" parameter is as shown below.

<table>
<thead>
<tr>
<th>Decimal with sign</th>
<th>Real numbers</th>
<th>Binary</th>
<th>Hexadecimal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal without sign</td>
<td>1 - 13 digits</td>
<td>1 - 32 digits</td>
<td>1 - 8 digits</td>
</tr>
</tbody>
</table>

"Decimal point" When real numbers are selected using the "Display style" parameter, use the spin box to specify how many digits are to be displayed to the right of the decimal point.

"Left alignment" Using the radio buttons, select whether the display is to be aligned to the left or right in relation to "Right alignment" the display position.

(Example) 6 digits, with a monitor device of 150

"Zero suppress" When "Right alignment" is selected for the above parameter, place an "X" in the check box if zeroes are to be displayed in front of the numeric value.
2. Setting the Display Format

Click on “Case” and then [Edit] to display the “Edit Display Format” dialog box, and specify the numeric input range and the numeric display attributes. The “Edit Display Format” dialog box is displayed.

“Attribute”

“Color” If the value of the storing device is within the range specified by the “Display range” parameter, select the color in which the numeric value is to be displayed, using the list box.

“Reverse” If the value of the storing device is within the range specified by the “Display range” parameter and a reversed display is to be used, place an “X” in the check box.

“Blink” If the value of the storing device is within the range specified by the “Display range” parameter and a blinking display is to be used, select “Yes” using the list box.
"Display range" Specify the range of values that can be input. If a numeric value is input which is not within this range, it will not be written to the storing device. Up to eight types of comparative equations can be specified.

See Section 10.5, Setting the Display Range (Comparative Equations).

### Setting the Expression

See Section 10.3, Setting Data Expressions.

Please keep the following in mind when setting the data expression:

- "Monitor word expression" is specified if the value of the storing device is to be added and displayed.
- "Storing word expression" is specified if the input value is to be written to the storing device.
- The equation specified for the "Storing word expression" parameter should enable values to be stored in the data type specified with the "Device type" parameter.
- Input values are written to the device in the sequence shown below, and displayed as numeric values.

![Diagram](image)

--- indicates that no data expression has been specified.
"Trigger type" Using the radio buttons, select whether the value is to be written to the storing device immediately when [2] is touched, or if it is to be written only when a specified bit device is on or off. Ordinary...... The numeric value is written to the storing device when the key is touched. ON .............. The numeric value is written to the storing device only when the bit device specified with the “Trigger device” parameter is on.

<table>
<thead>
<tr>
<th>Specified bit is off</th>
<th>Specified bit is on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input value is not written</td>
<td>Input value is written</td>
</tr>
</tbody>
</table>

OFF .......... The numeric value is written to the storing device only when the bit device specified with the “Trigger device” parameter is off.

<table>
<thead>
<tr>
<th>Specified bit is on</th>
<th>Specified bit is off</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input value is not written</td>
<td>Input value is written</td>
</tr>
</tbody>
</table>

"Range" This can be run only if the word device specified with “Trigger device” corresponds to the comparative equation specified with the “Range” parameter.

<table>
<thead>
<tr>
<th>Comparative equation</th>
<th>Comparative equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 &lt; D10 &lt; 100 When D10 is 1000</td>
<td>0 &lt; D10 When D10 is 50</td>
</tr>
</tbody>
</table>

Specified action is not carried out Specified action is carried out

"Trigger device" This is specified after either “ON” or “OFF” has been selected for the “Trigger type” parameter. Click on [Dev.] and specify the bit device in the “Device Setting” dialog box.

See Section 10.1, Setting the Device to be Monitored.
5 Setting the display position

(1) When the settings for the various tabs have been entered, click on OK in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the input numeric value function.

(3) Move the cursor to the display position, and click at that position.

POINT
To touch the input area and display the input cursor, the X and Y axes of the display position should be specified so that they are multiples of 16 dots.

6 Setting the input cursor movement direction following writing of a numeric value

This should be specified if several numeric input functions have been specified on one screen.

(1) With the sprite setting frame displayed, select Data input and then Cursor info on the Draw Settings menu.

The “Cursor Movement” dialog box is displayed.
"Mode" Using the radio buttons, select the position at which the input cursor is to be displayed after the numeric value is written.

- Auto (use right arrow key to confirm input) ...... This shifts the input cursor as shown in the illustration below.
  (The ①, ②, and ③ markers show the display positions specified by the numeric and ASCII input functions.)

  (This has the same effect as touching ➡.)

- Auto (use down arrow key to confirm input) ...... This shifts the input cursor as shown in the illustration below. (The ①, ②, and ③ markers show the display positions specified by the numeric and ASCII input functions.)

  (This has the same effect as touching ➩.)

(3) Click on Set.

- To correct the setting for the cursor position, select [Data Input] and then Cursor Info on the Draw Settings menu once again, and enter the correction.

---

**Special Cases**

- What is the target area for the input?

  There is only one area targeted for input, even if several numeric input functions have been specified for one screen.

- Is all monitoring interrupted during numeric input?

  Monitoring of the input area where the input cursor is displayed will be interrupted, but other sprites can be monitored during numeric input.

- What happens if the display positions for the numeric input function aren't set to a multiple of 16 dots?

  In this case, the input cursor cannot be displayed by touching the input area. The input cursor can be displayed using the following procedure in this case:

  (1) Display the key window.

  (2) Touch any arrow key.

  The input cursor is displayed.
16.2 Key Window Operations

This section describes how to display and operate the key windows used with the numeric input function.

(1) Displaying a key window

Key windows can be displayed by specifying the touch key (expanded) function, and touching the touch keys.

**POINT**

Key windows can also be used in the ASCII input function.

See Section 15.7, Setting the Touch Keys (Expanded) Function.

1. Touch the input area to display the input cursor.
2. Touch a touch key used for the touch keys (expanded) function.
3. A key window is displayed.

(2) Key window display size

A870GOT .... The display size for key windows is fixed at 174 (vertical) \times 314 (horizontal) dots.
A850GOT .... The display size for key windows is fixed at 118 (vertical) \times 190 (horizontal) dots.

(3) Key window type

A870GOT .... Decimal/hexadecimal input key window.
A850GOT .... Decimal input key window.
(4) Moving the key window display position

① Touch the top of the key window.

The key window enters the movement status and all monitoring is interrupted.

② Touch the position to which the window is to be moved within three seconds.

If the key window is not touched within three seconds, the movement status is cancelled, and monitoring is resumed. If the key window is touched within three seconds, the touch keys will not function even if touched at the specified positions.

③ The position at which the key window is displayed moves.
(5) Applications of the various keys

<table>
<thead>
<tr>
<th>Key</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 0</td>
<td>Touch to input numeric values</td>
</tr>
<tr>
<td>A - F</td>
<td>Touch to input a decimal point</td>
</tr>
<tr>
<td></td>
<td>Touch to input a negative value</td>
</tr>
<tr>
<td></td>
<td>Touch to move the input cursor</td>
</tr>
<tr>
<td></td>
<td>Touch to delete the last digit of the numeric value being input and shift</td>
</tr>
<tr>
<td></td>
<td>all of the digits one digit to the right</td>
</tr>
<tr>
<td></td>
<td>Touch to write the input numeric value to the storing device (execute)</td>
</tr>
</tbody>
</table>

(6) Movements of the input cursor using ▼ ▼ ▼ ▼
Touching these keys moves the input cursor in the sequence indicated by ①, ②, and ③.
(①, ②, and ③ are the display positions specified for the numeric input and ASCII input functions.)
(7) Closing a key window

1. Touch the box on the key window.
2. The key window is closed.

Closing a key window causes the input cursor to disappear.

(8) Creating the desired keys for input

With the touch key function, the user can create keys for input by specifying the key codes for keys to be used for input when touch keys are pressed.

See Section 15.8. Inhibiting Simultaneous Pressing of Touch keys When Creating Keys for Numeric and ASCII Input
16.3 Setting the ASCII Input Function

What does this function do?

- This function writes any desired numeric value to a specified word device.
- The user can create keys to be used for input. (Numeric values can also be input using key windows.)
- If the value is not targeted for input (the input cursor is not displayed), it will be displayed as an ASCII value.

Useful Information About the ASCII Input Function

- Touching the area to be input displays the input cursor. (When specifying the display position, the X and Y axes should be specified in values that are multiples of 16 dots.)
- When a window screen is displayed, if the ASCII input function is specified in the displayed window screen, the input cursor is displayed only in the window screen. It will not be displayed in the base screen, even if the ASCII input function is on in the base screen.
### Outline of Procedure

**Basic**
- Setting of display size
- Setting of monitor device
- Setting of display style
- Setting of display format

See 1

**Trigger**
- Setting of display conditions

See 2

After entering settings, click on "OK" on any tab

Setting of display position

See 3

Setting of cursor position following writing of ASCII value

See 4

End
1. Setting the Basic settings

- **Position**
  - X: [ ]
  - Y: [ ]

- **Size**
  - V: [ ]
  - H: [ ]

- **Monitor device (H)**
  - 0-FF

- **Display style**
  - Digits: [ ]

- **Display format**
  - Color: [ ]
  - Blink: [ ]
  - Reverse: [ ]

---

(1) "Display size" Using the list box, select the size in which character strings are to be displayed.

  (Example) Vertical: 2 x  Horizontal: 2 x

(2) "Monitor device" Click on [Dev] and then use the "Device Settings" dialog box to specify the first word device in which the data is to be stored.

   ➤ See Section 10.1, Setting the Device to be Monitored.

(3) "Display style"

  "Digits" Using the spin box, specify the number of digits in which the text is to be input.

(4) "Display format"

  "Color" Select the color to be used for ASCII displays, using the list box.

  "Blink" If a blinking display is to be used for ASCII displays, select "Yes" using the list box.

  "Reverse" If a reversed display is to be used for ASCII displays, place an "X" in the check box.
“Trigger type” Using the radio buttons, select whether the character code is to be written to the storing device immediately when $\Box$ is touched, or if it is to be written only when a specified bit device is on or off.

Ordinary ...... The character code is written to the storing device when the key is touched.
ON .............. The character code is written to the storing device only when the bit device specified with the “Trigger device” parameter is on.

Specified bit is off                     Specified bit is on
Character code for input character is not written  Character code for input character is written

OFF .............. The character code is written to the storing device only when the bit device specified with the “Trigger device” parameter is off.

Specified bit is on                     Specified bit is off
Character code for input character is not written  Character code for input character is written

“Trigger device” This is specified after either “ON” or “OFF” has been selected for the “Trigger type” parameter. Click on [Dev.] and specify the bit device in the “Device Setting” dialog box.

See Section 10.1, Setting the Device to be Monitored.
3 Setting the display position

(1) When the settings for the various tabs have been entered, click on [OK] in any tab.

(2) A dotted-line box is displayed at the upper left of the screen window, showing the display range for the ASCII input function.

(3) Move the cursor to the display position, and click at that position.

**POINT**
To touch the input area and display the input cursor, the X and Y axes of the display position should be specified so that they are multiples of 16 dots.

4 Setting the input cursor movement direction following writing of a numeric value

This should be specified if several numeric input functions have been specified on one screen.

(1) With the sprite setting frame displayed, select [Data Input] and then [Cursor Info] on the Draw Settings menu.

The "Cursor Movement" dialog box is displayed.
"Mode" Using the radio buttons, select the position at which the input cursor is to be displayed after the text is written.

- Auto (use right arrow key to confirm input)...... This shifts the input cursor as shown in the illustration below.

(The ①, ②, and ③ markers show the display positions specified by the numeric and ASCII input functions.)

(This has the same effect as touching ➤.)

- Auto (use down arrow key to confirm input) This shifts the input cursor as shown in the illustration below. (The ①, ②, and ③ markers show the display positions specified by the numeric and ASCII input functions.)

(This has the same effect as touching ▼.)

(3) Click on Set.
- To correct the setting for the cursor position, select [Data input] and then [Cursor Info] on the Draw Settings menu once again, and enter the correction.

Special Cases

- What is the target area for the input?

There is only one area targeted for input, even if several ASCII input functions have been specified for one screen.

- Is all monitoring interrupted during text input?

Monitoring of the input area where the input cursor is displayed will be interrupted, but other sprites can be monitored during text input.

- What happens if the display positions for the ASCII input function aren't set to a multiple of 16 dots?

In this case, the input cursor cannot be displayed by touching the input area. The input cursor can be displayed using the following procedure in this case:

(1) Display the key window.
(2) Touch any arrow key.

The input cursor is displayed.
16.4 Creating Keys to be Input

The user can create keys to be used for input in the touch key function, by specifying a key code for the touch key to be used for input.

See Section 15.8, Inhibiting Simultaneous Pressing of Touch Keys When Creating Keys for Numeric and ASCII Input.
Chapter 17

Displaying Window Screens
17. Displaying Window Screens

17.1 Window Screen Operations

This section describes how to display and operate window screens.

(1) Displaying a key window

Key windows can be displayed by specifying the touch key (window switching) function, and touching the touch keys. The touch key (window switching) function can also be specified to switch from the currently displayed window screen to another window screen.

See Section 15.6, Setting the Touch Keys (Window Switching) Function.

(Sequence programs can also be used to switch window screens.)

(2) Window screen display size

A870GOT ---- The display size for key windows is fixed at 195 (vertical) x 319 (horizontal) dots.

(The range for drawing graphics and setting sprites in the graphics software is 176 x 316 dots.)

A850GOT ---- The display size for key windows is fixed at 128 (vertical) x 192 (horizontal) dots.

(The range for drawing graphics and setting sprites in the graphics software is 127 x 191 dots.)

(3) Status of base screens in which a window screen is displayed

Monitoring of the base screen can be carried out even if a window screen is displayed on the base screen.

(4) When a key window is displayed on the base screen

Window screens can be displayed even if a key window is displayed on the base screen.

(5) In the graphics software, a line with a one-dot width at the upper left of the window screen overlaps the window frame. Please be aware that, because of this, if a graphic is drawn which includes this line, that line of the graphic will not be displayed on the GOT.
(6) Setting the first position at which a window screen is displayed

The first position at which a window screen is displayed is specified by setting the position at which the window is to be displayed on the base screen window.

See Section 17.2, Setting the Initial Display Position for the Window Screen.

If a window screen is displayed on a base screen without entering the above setting, the window screen will be displayed in the center of the base screen.

(7) Moving the window screen display position

1. Touch the top of the window screen.
   The window screen enters the movement status and all monitoring is interrupted.

2. Touch the position to which the window is to be moved within three seconds.
   If the window is not touched within three seconds, the movement status is cancelled, and monitoring is resumed. If the window is touched within three seconds, the touch keys will not function even if touched at the specified positions.

3. The position at which the window screen is displayed moves.

(8) Closing the window screen

1. Touch the [ ] on the window screen.
   2. The window screen closes.
17.2 Setting the Initial Display Position for the Window Screen

1. Make the base screen window on which the window screen is to be displayed the active window.


3. The "Window Position" dialog box is displayed.

4. Click on [Edit].

5. A dotted square indicating the window screen appears on the base screen window.

6. Move the cursor to the first position at which the window is to be displayed, and click at that position.

   - To correct a position after it has been specified, enter this setting once again.
17.3 Precautions When Base Screen Touch Keys, and Window Screens are Overlapped

This section explains precautions which should be observed if the touch keys on a base screen overlap a window screen.

(1) A870GOT

A 32-dot area around the periphery of the window screen is reserved and cannot be used for base screen touch keys.

- The touch key will not function even if touched.

- If the section marked ① is touched, the key functions.
- If the section marked ② is touched, the key does not function.
(2) A85□GOT

A 16-dot area around the periphery of the window screen is reserved and cannot be used for base screen touch keys.

- The touch key will not function even if touched.

- If the section marked ① is touched, the key functions.
- If the section marked ② is touched, the key does not function.
Chapter 18

Operations Using the Panel Kit
18. Operations Using the Panel Kit

18.1 Items to Know When Using the Panel Kit

1  Panel kit configuration

- The panel kit provided with the graphics software is registered.
- Library No. 1
- Library No. 2
- Library No. 50
- User library

2  Panel kit provided by the graphics software

Library No. 1 contains graph display boxes and three-dimensional switch graphics (with sprites). These can be easily drawn by reading out the panel kit, pasting the graphics on the screen window, and then editing them.

Graphics drawn by the user and sprites set by the user cannot be registered in Library No. 1.

3  Registering user-drawn graphics and set sprites in a panel kit

Graphics drawn by the user, as well as text and sprites which have been set, can be registered in panel kits. Several graphics and sprites can also be grouped and registered in the panel kit as a single figure.

The user can also group all of the graphics and sprites on a screen and registered them in a panel kit. The registered graphics and sprites can then be read out from the panel kit.

4  The number of panel kits that can be registered

Up to 49 panel kits can be registered in the user library, and up to 50 types of data can be registered in one library.

POINT
To check what kind of graphic is registered, click on [Image] in the "Panelkit" dialog box.
18.2 Registering Drawn Graphics and Sprite Settings in a Panel Kit

When is this function used?

- This function is used when you want to register graphics that you have drawn, or sprites for which you have entered settings, in a panel kit, so that they can be used on other screens and with other project data.

1. Affix handles to the graphic or sprite to be registered.
   
   If you are registering several graphics and/or sprites in one panel kit, group them first.


3. The “Panelkit” dialog box is displayed. Click on [Create] under “Standard Library”.

4. The “Number” dialog box is displayed. Using the spin box, enter the number of the library in which the graphics or sprites are to be registered, and then click on [OK].

5. The “Name” dialog box is displayed. Enter the library name in the text box, and click on [OK].
6. Under "Panelkit name" in the "Panelkit" dialog box, click on the display position for the number being registered. Then click on [Write].

7. The "Name" dialog box is displayed. Enter the panelkit name in the text box, and click on [OK]. The specified graphics and/or sprites are registered.

8. The screen returns to the screen window display.
18.3 Reading a Registered Panel Kit

When is this function used?

- This function is used when you want to paste graphics or sprites that have been registered in a panel kit on a screen window.
- It is also used to paste a panel kit provided by the graphics software on a screen window.


2. The "Panelkit" dialog box is displayed. Using the "Library name" list box, select the number of the library to be read.

   Click on the display position for the panel kit to be read out, in the "Panelkit name" list box.

   This can also be done by clicking on [Image] and then clicking on the display position for the panel kit to be read out, in the "Select Image" dialog box.

   With a panel kit with a sprite function, clicking on [–> ON] enables the user to confirm the switch figure when the switch is on, and clicking on [–> OFF] enables the user to confirm the switch figure when the switch is off.

   Click on [Read]. Clicking on [Select] in the "Select Image" dialog box returns the display to the "Panelkit" dialog box.

3. An image of the selected panel kit appears at the upper left of the screen window.

4. Move the cursor to the position where the panel kit is to be pasted, and click at that position.

   - If the panel kit being read contains sprites, the following dialog box is displayed.

     If the panel kit being read out contains a single sprite, the dialog box for that sprite is displayed, so the sprite can be edited.

     If the panel kit being read out contains several sprites, the "Edit Sprites" dialog box is displayed, so the sprites can be edited.

See Section 19.4, Selecting Several Sprites and Correcting Sprites From a List.
18.4 Deleting a Registered Panel Kit

When is this function used?

- This function is used when you want to delete a panel kit that has been registered.
- Panel kits in Library No. 1 cannot be deleted.


2. The “Panelkit” dialog box is displayed. Using the “Library name” list box, select the number of the library to be deleted. If all of the panel kits in the library are to be deleted, click on [Delete].

   Click on the display position for the panel kit to be deleted, in the “Panelkit name” list box.

   To check the type of panel kit, click on [Image] and confirm the panel kit in the “Select Image” dialog box.

   Then click on [Delete].

3. The selected panel kit is deleted. When it has been deleted, click on [Close].
18.5 Changing the Registered Library Name or Panel Kit Name

When is this function used?

- This function is used when you want to change the name of the library in a panel kit, or the name of a panel kit itself.
- Library names and panel kit names in Library No. 1 cannot be changed.


2. The “Panelkit” dialog box is displayed. To change the name of a library, select the number of the library in the “Library name” list box, and click on [Rename].

To change the name of a panel kit, select the library name to be changed. Then use the “Panelkit name” list box to click on the display position for the panel kit whose name is to be changed, and click on [Rename].

3. The “Nome” dialog box is displayed. Enter the name of the library or panel kit to be changed in the text box, and click on [OK].

4. The “Panelkit” dialog box is displayed, showing the new library or panel kit name.

When the change has been made, click on [Close].
Chapter 19

Editing Set Sprites
19. Editing Set Sprites

19.1 Changing the Cursor to the Sprite Editing Cursor

To edit a sprite, the cursor first has to be changed to the sprite editing cursor, and then the sprite to be edited has to be selected.

1. On the Edit menu, select [Object of Selection] and then [Sprite].

- Select [Object of Selection] and then [Figure] to edit a graphic or text.

   See Section 7.1, Changing the Cursor to the Graphic Editing Cursor.

- To edit sprites and user-drawn graphics at the same time, select [Object of Selection] and then [Figure and Sprite].

2. The cursor changes to the sprite editing cursor. Select the sprite to be edited.

- What happens if [X] is selected on Tool Bar 1?

  Selecting [X] on Tool Bar 1 returns the cursor to the status it was in the last time that [Object of Selection] was selected on the Edit menu (the graphic editing cursor, sprite editing cursor, or graphic + sprite editing cursor).

(Examples)

- If [Object of Selection] and then [Figure and Sprite] were selected previously, selecting [X] changes the cursor to the graphic + sprite editing cursor.

- If [Object of Selection] and then [Figure] were selected previously, selecting [X] changes the cursor to the graphic editing cursor.
19.2 Selecting the Sprite to Edit

When editing sprites, handles are first attached to the sprite to be edited.

After the sprite setting has been entered (the display position for the sprite has been specified), handles are attached to the sprite.

**POINT**

The sprite setting frame shows the display range for the specified sprite on the screen window, in order to let the user see the display range and confirm that the sprite has been specified correctly.

The sprite setting frame is displayed in green, with an asterisk (*) displayed at the left or at the upper left of the specified position.

19.2.1 Selecting a Single Sprite

1. **Using the mouse**
   1. Change the cursor to the sprite editing cursor.
   2. Move the cursor onto a line of the sprite frame containing the sprite to be edited, or within the frame.
   3. Click at that point.

2. **Using the keyboard**
   1. Change the cursor to the sprite editing cursor.
   2. Using , move the cursor onto a line of the sprite frame containing the sprite to be edited, or within the frame.
   3. Press Enter twice.
19.2.2 Selecting Several Overlapped Sprites in a Screen Window

1. Using the mouse

1. Change the cursor to the sprite editing cursor.
2. Move the cursor to the position which serves as the starting point.

3. Click the left button of the mouse at the starting point, and then drag the mouse to a position which encloses all of the sprite setting frames to be selected.

4. Release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.
2. Using ← → ↑ ↓, move the cursor to the starting point.
3. Press [Enter] at the starting point, and using ← → ↑ ↓, move the cursor to a position which encloses all of the sprite setting frames to be selected.
4. Press [Enter].
• What happens if there is a graphic within the enclosed area?
   If the cursor has changed to the sprite editing cursor, handles will not be attached to any graphics within the selected area.

• All of the sprites on the screen window can be selected using this procedure.
  - Drawing a square that extends from the upper left corner of the screen window to the lower right corner will display handles on all of the sprites on the screen.
  - If no graphics have been drawn in the screen window, the [Select All] command on the Edit menu can be used to display handles on all of the figures and text.
  - The [Select All] command on the Edit menu can be used to display handles on all of the graphics and sprites in the screen window.
19.2.3 Selecting Disparate Several Sprites in a Screen Window

1  Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Move the cursor onto a line of the sprite setting frame to be selected first, or within the frame.

3. Click at that position.

4. Move the cursor onto a line of the sprite setting frame containing the sprite to be selected next, and hold down \texttt{SFT} on the keyboard while clicking at that position.

   Repeat this procedure to display handles on all of the sprites to be edited.

2  Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Using \texttt{[Cancel] \rightarrow \rightarrow \rightarrow \rightarrow}, move the cursor onto a line of the sprite setting frame containing the sprite to be selected first, or within the frame.

3. Press \texttt{En}.  

4. Using \texttt{[Cancel] \rightarrow \rightarrow \rightarrow \rightarrow}, move the cursor onto a line of the sprite setting frame containing the sprite to be selected next, or within the frame, and press \texttt{En} while holding down \texttt{SFT}. Repeat this procedure to display handles on all of the sprites to be edited.
19.2.4 Deleting One or More Selected Sprites

1. **Using the mouse**
   1. Move the cursor to a position on the screen window where there is no sprite setting frame, and no graphic.

   ![Sprite Setting Frame](image1)

   ![No Graphic](image2)

   2. Click at that position.

   ![Cursor Position](image3)

   ![Click Result](image4)

2. **Using the keyboard**
   1. Using [← → ↑ ↓], move the cursor to a position on the screen window where there is no sprite setting frame and no graphic.

   ![Keyboard Direction](image5)

   2. Press Enter twice.
19.2.5 Deleting One of Several Selected Sprites

1. Using the mouse

1. Move the cursor onto a line of the sprite setting frame containing the sprite to be deleted, or within the frame.

If figures are overlapping each other, move the cursor onto a line of the figure or text to be deleted.

2. Holding down \text{[Shift]} on the keyboard, click at that position.

2. Using the keyboard

1. Use \text{[Left]} \text{[Right]} \text{[Up]} \text{[Down]} to move the cursor onto a line of the sprite setting frame containing the sprite to be deleted, or within the frame.

2. Holding down \text{[Shift]}, press \text{[Enter]} twice.
19.3 Editing a Sprite Using the Same Procedures as Graphic Editing

19.3.1 Correcting the Data of a Set Sprite

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be corrected.

3. Move the cursor onto a line of the sprite setting frame containing the sprite to be corrected, or within the frame, and double-click at that position. This can also be done by selecting [Edit Sprite] on the Edit menu.

4. When the dialog box for the selected sprite is displayed, correct the data.

- What happens if I click on [Previous Setting] or [Next Setting] after correcting the data?

[Previous Setting] or [Next Setting] can be selected if several sprites of the same type as that currently being corrected have been specified on the screen window. Selecting these can be very convenient if you want to continue correcting similar sprites.

Clicking on [Previous Setting] or [Next Setting] initiates the following:

(Example) If the sprite currently being corrected is displayed in Numeric Display 2:

[Previous Setting] : Displays the Numeric Display 1 dialog box
[Next Setting] : Displays the Numeric Display 3 dialog box

(Example) If the sprite currently being corrected is displayed in Numeric Display 1:

[Previous Setting] : Cannot be selected
[Next Setting] : Displays the Numeric Display 2 dialog box

(Example) If the sprite currently being corrected is displayed in Numeric Display 3:

[Previous Setting] : Displays the Numeric Display 2 dialog box
[Next Setting] : Cannot be selected
19.3.2 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction

This editing procedure can be used only with the sprites listed below:

- Comment display
- Trend graph display
- Level display
- Alarm list display
- Line graph display
- Touch key display
- Panel motor display
- Bar graph display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1. Using the mouse

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display range is to be changed.
3. If changing the display range in the vertical direction, move the cursor to a vertical handle, and if changing it in the horizontal direction, move the cursor to a horizontal handle.

![Changing in the vertical direction](image1)
![Changing in the horizontal direction](image2)

4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the display range is to be changed.
5. At the position where the change is to be made, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display range is to be changed.
3. Using 
   ①, move the cursor to a vertical handle if the display range is to be changed in the vertical direction, and to a horizontal handle if the display range is to be changed in the horizontal direction.
4. The cursor changes to the size changing cursor. Press [Enter], and then use 
   ① to move the cursor to the position at which the change is to be made.
5. At the position where the change is to be made, press [Enter].
19.3.3 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Corner Axis)

This editing procedure can be used only with the sprites listed below:

- Comment display
- Trend graph display
- Level display
- Alarm list display
- Line graph display
- Touch key display
- Panel meter display
- Bar graph display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1. Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Press the left button of the mouse and drag the mouse to the position at which the change is to be made.

5. At the position where the change is to be made, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Using `→` or `←`, move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Press `Enter`, and then use `→` or `←` to move the cursor to the position at which the change is to be made.

5. At the position where the change is to be made, press `Enter`. 
19.3.4 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction (on a Center Axis)

This editing procedure can be used only with the sprites listed below:

- Comment display
- Alarm list display
- Trend graph display
- Line graph display
- Level display
- Touch key display
- Panel meter display
- Bar graph display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1. Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Holding down Ctrl on the keyboard, press the left button of the mouse and drag the mouse to the position at which the change is to be made.

5. At the position where the change is to be made, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display range is to be changed.

3. Using ←→↑↓, move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Holding down Ctrl on the keyboard, press Enter, and then use ←→↑↓ to move the cursor to the position at which the change is to be made.

5. At the position where the change is to be made, press Enter.
19.3.5 Changing the Display Range of the Set Sprite in the Vertical or Horizontal Direction without Changing the Proportion

This editing procedure can be used only with the sprites listed below.

- Comment display
- Alarm list display
- Trend graph display
- Line graph display
- Level display
- Bar graph display
- Touch key display

With comment displays and alarm list displays, changes can be made in units of 16 dots in the horizontal and vertical directions. With other functions, changes can be made in units of 1 dot.

1. Using the mouse

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display range is to be changed.
3. Move the cursor to a handle at the corner of the sprite.

4. The cursor changes to the size changing cursor. Holding down Shift and on the keyboard, press the left button of the mouse and drag the mouse to the position at which the change is to be made.
5. At the position where the change is to be made, release the left button of the mouse.

2. Using the keyboard

1. Change the cursor to the sprite editing cursor.
2. Select the sprite whose display range is to be changed.
3. Using , move the cursor to a handle at the corner of the sprite.
4. The cursor changes to the size changing cursor. Press , and, holding down the Ctrl and Shift, use this movement to move the cursor to the position at which the change is to be made.
5. At the position where the change is to be made, press Enter.
19.3.6 Deleting a Set Sprite

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be deleted. (If several sprites are to be deleted at the same time, select all of the sprites to be deleted.)

3. Press **DEL** on the keyboard.

**TIPS**
The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.7 Cutting the Set Sprite and Storing it on the Clipboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be cut. (If several sprites are to be cut at the same time, select all of the sprites to be cut.)

3. Select the scissors [X] on Tool Bar 1, or the [Cut] command on the Edit menu.

The cut sprite is stored on the Clipboard and can be pasted back on the screen window later on, if desired.

See Section 19.3.10, Pasting Sprites Stored on the Clipboard.

**TIPS**

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.8 Changing (Moving) the Display Position of the Set Sprite

1] Using the mouse

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display position is to be changed. (If the display positions of several sprites are to be changed at the same time, select all of the target sprites.)

3. Move the cursor to a position within the sprite setting frame (if several sprites have been selected, move the cursor within the frame of any selected sprite).

4. The cursor changes to the movement cursor. Press the left button of the mouse and drag the mouse to the position at which the display position is to be changed.

5. At the position where the change is to be made, release the left button of the mouse.

2] Using the keyboard

1. Change the cursor to the sprite editing cursor.

2. Select the sprite whose display position is to be changed. (If the display positions of several sprites are to be changed at the same time, select all of the target sprites.)

3. Using ←→↑↓, move the cursor to a position within the sprite setting frame (if several sprites have been selected, move the cursor within the frame of any selected sprite).

4. The cursor changes to the movement cursor. Press Enter, and then use ←→↑↓ to move the cursor to the display position to be changed.

5. At the position where the change is to be made, press Enter.

TIPS
The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.9 Copying a Set Sprite

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be copied. (If several sprites are to be copied at the same time, select all of the sprites to be copied.)

3. Select \( \text{Copy} \) on Tool Bar 1, or select \( \text{Copy} \) on the Edit menu.

4. The selected sprite is stored on the Clipboard.

| Clipboard | Clipboard |

**TIPS**

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.10 Pasting a Sprite Stored on the Clipboard

1. Select † on Tool Bar 1, or select Paste on the Edit menu.

2. The cursor changes to the movement cursor and the setting frame for the sprite stored on the Clipboard is displayed as a dotted-line square. Move the cursor to the position at which the sprite is to be pasted.

3. Click at that position.
19.3.11 Copying and Pasting Sprites as a Batch

This editing operation enables a group of sprites to be copied and pasted at one time. Using this function, several sprites can be selected and copied at one time.

1. Change the cursor to the sprite editing cursor.

2. Select the sprite to be copied. (If several sprites are to be copied at the same time, select all of the target sprites.)

3. Select [Copy and Paste] on the Edit menu. This displays the dialog box shown below.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Number&quot;</td>
<td>This specifies the results of copying and pasting the sprite or sprites in numeric terms. For example, if &quot;2&quot; is specified, one sprite is copied, and two sprites are pasted on the screen. X ................. Specifies the actual number of sprites to be copied in the X direction (to the right of the copy source). Y ................. Specifies the actual number of sprites to be copied in the Y direction (downwards of the copy source). [Example] When &quot;3&quot; is specified for the X direction and &quot;2&quot; for the Y direction</td>
</tr>
<tr>
<td>Item to be Set</td>
<td>Description of Setting</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
</tr>
</tbody>
</table>
| "Interval (dot)" | If a setting of 2 or more has been entered for either the X or Y direction, this is used to specify the interval from the copy source position, in units of dots. X .............. Specifies the interval (number of dots) in the X direction (to the right of the copy source). Y .............. Specifies the interval (number of dots) in the Y direction (downwards of the copy source). [Example] When "0 dots" is specified for the X direction  
<For one figure>  
|[Diagram]|  |
|For several figures>  
|[Diagram]|  |
|When "5 dots" is specified for the X direction  
<For one figure>  
|[Diagram]| 5 dots |
|<For several figures>  
|[Diagram]|  |
|When "0 dots" is specified for the Y direction  
<For one figure>  
|[Diagram]|  |
|<For several figures>  
|[Diagram]|  |
|When "5 dots" is specified for the Y direction  
<For one figure>  
|[Diagram]| 5 dots |
|<For several figures>  
|[Diagram]|  |
|When "5 dots" is specified for the Y direction  
<For one figure>  
<p>|[Diagram]| 5 dots |</p>
<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Address increment&quot;</td>
<td>This specifies the number of times that the device number is to be incremented. Incrementing is applied to the monitor device of the selected sprite. (For touch switches only, incrementing targets the writing device of the bit and word operations.)</td>
</tr>
<tr>
<td></td>
<td>Not ......................................................................... The number is not incremented.</td>
</tr>
<tr>
<td></td>
<td>X priority ............................................. Numbers are incremented in the X direction (to the right).</td>
</tr>
<tr>
<td></td>
<td>Y priority ............................................. Numbers are incremented in the Y direction (downwards).</td>
</tr>
</tbody>
</table>

If “32 bits” has been specified for “Device type”, incrementing is done in units of two addresses, and if a word bit has been specified, incrementing is done 1 bit at a time.

4. Click on [OK].

**TIPS**

The procedure described on this page can also be carried out on graphics at the same time.
19.3.12 Grouping Several Sprites in One Group

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be grouped.

3. Select on Tool Bar 1, or select the Group command and then the Group command on the Edit menu.

19.3.13 Ungrouping Sprites

1. Change the cursor to the sprite editing cursor.

2. Select the sprites whose group is to be cancelled. (If several groups are to be cancelled at one time, select all of the groups to be cancelled.)

3. Select on Tool Bar 1, or select the Group command and then the Ungroup command on the Edit menu.

**TIPS**
The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.14 Aligning Several Sprites along the Top or Bottom

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be aligned at the top or bottom.


   - **Aligned at top**
     - The uppermost sprite is used as a reference to align the others.
   - **Aligned at bottom**
     - The lowermost sprite is used as a reference to align the others.

19.3.15 Aligning Several Sprites along the Left or Right

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be aligned at the left or right.

3. Select [Align] and then [Left] or [Right] on the Edit menu.

   - **Aligned at left**
     - The sprite farthest to the left is used as a reference to align the others.
   - **Aligned at right**
     - The sprite farthest to the right is used as a reference to align the others.

**TIPS**

The editing procedure described on this page can also be carried out on graphics at the same time.
19.3.16 Aligning Several Sprites along the Left or Top at Even Intervals

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be aligned at the left or top, at even intervals.

3. Select [Align] and then [Left evenly] or [Top evenly] on the Edit menu.

   The sprites are spaced at even intervals between the top left coordinates of the uppermost sprite and the top left coordinates of the lowermost sprite.

   The sprites are spaced at even intervals along the top, between the top left coordinates of the sprite farthest to the left and the top left coordinates of the sprite farthest to the right.

19.3.17 Displaying Numeric or ASCII Displays in Block Format

The alignment operations described above can be used to show several numeric displays or ASCII displays as a block display.

TIPS

The procedure described on this page can also be carried out on graphics at the same time.
19.4 Selecting Several Sprites and Correcting Sprites from a List

With this editing function, if several sprites are being corrected, only those sprites which have been selected are displayed in list format, allowing editing to be done on a limited number of sprites.

1. Change the cursor to the sprite editing cursor.

2. Select the sprites to be corrected.


4. The “Edit Sprites” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Description of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Sprite name”</td>
<td>The names of the selected sprites and the device being monitored are displayed. Names are displayed in the order in which they are to be specified in the screen window. Click on the position at which the name of the sprite to be corrected is displayed, and then click on [Modify]. The dialog box for the selected sprite is displayed, so that the data can be corrected. After the data has been corrected, the “Edit Sprites” dialog box is displayed, with an asterisk (*) next to the name of the sprite which has been corrected.</td>
</tr>
<tr>
<td>“Device change to”</td>
<td>Click on [Dev.]. When the “Device Setting” dialog box is displayed, specify the NW number, station number, device name, and device number to be effective after the change is made. See Section 10.1, Setting Devices for Monitoring. Click on [Change dev.] after setting the changed device.</td>
</tr>
<tr>
<td>Close</td>
<td>Click on this when all of the sprite corrections have been made.</td>
</tr>
</tbody>
</table>
19.5 Correcting, Utilizing, and Deleting Set Sprites from a List

This editing procedure is used to correct, utilize, and delete all of the sprites which have been specified on one screen.

1. Check to make sure handlers have been affixed to the sprites, and then select [Edit Sprites] on the Edit menu.

2. The “Edit Sprites” dialog box is displayed.

![Edit Sprites dialog box]

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Description of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Sprite name”</td>
<td>The names of the sprites specified on one screen are displayed. Names are displayed in the order in which they are to be specified in the screen window. Click on the position at which the name of the sprite to be corrected, allocated, or deleted is displayed, and then click on [Modify], [Utilize], or [Delete]. If you have clicked on [Modify], [Utilize], the dialog box for the selected sprite is displayed, so that the data can be corrected. After the data has been corrected, the “Edit Sprites” dialog box is displayed, with an asterisk (*) next to the name of the sprite which has been edited.</td>
</tr>
<tr>
<td>Close</td>
<td>Click on this when all of the sprite editing has been completed.</td>
</tr>
</tbody>
</table>
19.6 Batch Changes to Monitor Devices Set Using Sprites


2. The "Batch Device Change" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be Set</th>
<th>Description of Setting</th>
</tr>
</thead>
</table>
| "Objects"      | Using the radio buttons, select the object of the monitor device to be changed.  
In Edit Screen: Select this if a monitor device in the screen window opened in the current application window is to be changed.  
All Screens: Select this if the monitor devices in all of the created screen windows are to be changed. |
| "Points"       | Using the spin box, set the number of points to be changed.  
Setting the number of points to be changed also changes the device numbers subsequent to the device number of the monitor device to be changed. |
| "Device"       | Select [Device], and specify the NW numbers, station numbers, device names, and device numbers both before and after the change, in the "Set Device" dialog box.  
See 10.1, Setting the Monitor Device. |
| Replace         | After setting the devices prior to and after the change, click on this. |

**POINT**

The bits of the bit device ↔ word device can also be switched.
Chapter 20

Operations Subsequent to Screen Creation
20. Operations Subsequent to Screen Creation

20.1 Assigning a Title to the Screen Data

What purpose does this function serve?

This function is used to assign titles to base screens and window screens that have been created, to make it easy to recognize the type of screen. Titles and detailed information about the screens can also be printed out.

1. On the Common menu, select [Title] and then [Screen].

2. The “Screen Title” dialog box is displayed. Select whether a base screen or window screen title is to be specified.

   In the “Title list” text box, click at the position where the number of the screen to which a title is to be assigned is displayed.

   Then click on [Edit].

3. Enter the title in the “Title” text box. (Up to 32 full-width characters can be input.)

   If necessary, enter any explanations of the screen in the “Detailed explanation” text box. (Up to 512 full-width characters can be input.)

   Then click on [OK].

4. The “Set Title” dialog box is displayed. To correct a title which has been specified, click on the screen number for the title to be corrected, and then follow the same procedure as when the title is first specified to correct the title. When the title has been specified, click on [Close].
20.2 Viewing an Image of the Created Screen Data

When is this function used?

- This function is used when you want to confirm how screen data which you have created will actually look when it is displayed on the GOT.

1. Make the screen window containing the image to be viewed the active window.
2. Select [Preview] and then [Image] on the Screen menu, or select [F].
3. The contents of the screen window are displayed as an image display.
• Operations that can be used after an image is displayed

To enlarge an image display to its maximum size: Select the "Max. Size" button.

To close an image display: Select [Close] in the control menu box.

To switch to a device display: Select [Device] on the Display Format menu.

To switch to an image and device display: Select [Image and Device] on the Display Format menu.

To switch to a canvas display: Select [Canvas] on the Display Format menu.

To switch to a sprite ID display: Select [Sprite ID] on the Display Format menu.

To print out an image display: Select [Print] on the File menu.

To output an image display to a file: Select [Save] on the File menu.
20.3 Viewing the Monitor Device Specified by a Sprite

- When is this function used?
  - This function is used when you want to check the device for a monitor device specified with a sprite.

1. Make the screen window containing the device to be viewed the active window.
2. Select [Preview] and then [Device] on the Screen menu.
3. The device name and device number specified for the monitor device are displayed.
• Operations that can be used after the device is displayed

To enlarge a display to its maximum size : Select the "Max. Size" button.

To close a device display : Select [Close] in the control menu box.

To switch to an image display : Select [Image] on the Display Format menu.

To switch to an image and device display : Select [Image and Device] on the Display Format menu.

To switch to a sprite ID display : Select [Sprite ID] on the Display Format menu.

To switch to a canvas display : Select [Canvas] on the Display Format menu.

To print out a device display : Select [Print] on the File menu.

To output a device display to a file : Select [Save] on the File menu.

• Displaying overlapping sprites at the same position

If several sprites have been specified so that they overlap each other at the same position, the monitor device for the last sprite to have been specified will be displayed. To display the monitor devices of all of the overlapping sprites, select "Display Several Devices/IDs" on the Display Format menu.

• If multiple actions have been specified in the touch switch function, this function can be used to display multiple devices for actions which have been specified.
20.4 Viewing the Image and Device for the Created Screen Data

- When is this function used?

  - This function is used when you want to check devices for monitor devices specified by both images and sprites in the screen data.

1. Make the screen window containing the image and device screen data to be viewed the active window.

2. Select [Preview] and then [Image and Device] on the Screen menu.

3. The contents of the screen window are displayed as an image display, and the device name and device number for the monitor device specified by the sprite are displayed.
• Operations that can be used after an image and device display
  
  To enlarge a display to its maximum size : Select the "Max. Size" button.
  
  To close an image and device display : Select [Close] in the control menu box.
  
  To switch to an image display : Select [Image] on the Display Format menu.
  
  To switch to a device display : Select [Device] on the Display Format menu.
  
  To switch to a canvas display : Select [Canvas] on the Display Format menu.
  
  To switch to a sprite ID display : Select [Sprite ID] on the Display Format menu.
  
  To print out an image and device display : Select [Print] on the File menu.
  
  To output an image and device display to a file : Select [Save] on the File menu.

• Displaying overlapping sprites at the same position

  If several sprites have been specified so that they overlap each other at the same position, the
  monitor device for the last sprite to have been specified will be displayed. To display the moni-
  tor devices of all of the overlapping sprites, select "Display Several Devices/IDs" on the Display
  Format menu.

• If multiple actions have been specified in the touch switch function, this function can be used to
  display multiple devices for actions which have been specified.
20.5 Viewing an Image for a Still Screen (Canvas Screen)

- When is this function used?
  - This function is used when you want to confirm how the still image (canvas graphic) section of the screen data will actually look when it is displayed on the GOT.

1. Make the screen window containing the screen data for the still image (canvas graphic) to be viewed the active window.

2. Select [Preview] and then [Canvas] on the Screen menu.

3. An image of the still image (canvas graphic) is displayed, with the sprite setting screen deleted.

The "OFF" graphics for the touch key function and lamp display function are displayed, along with the panel meter graphic for the panel meter function.
• Operations that can be used after a canvas display

To enlarge the display to its maximum size: Select the "Max. Size" button.

To close a canvas display: Select [Close] in the control menu box.

To switch to an image display: Select [Image] on the Display Format menu.

To switch to a device display: Select [Device] on the Display Format menu.

To switch to an image and device display: Select [Image and Device] on the Display Format menu.

To switch to a sprite ID display: Select [Sprite ID] on the Display Format menu.

To print out a canvas display: Select [Print] on the File menu.

To output a canvas display to a file: Select [Save] on the File menu.
20.6 Viewing Sprite ID Numbers Set Using Sprites

- When is this function used?
  - This function is used to check sprite ID numbers which were assigned automatically by the graphics software.

- What is a sprite ID number?
  This is an ID number assigned to each sprite specified in a screen window. The graphics software automatically assigns an ID number to sprites for each screen window.
  An ID number of 10000 is assigned to the first sprite specified in a screen window, followed by 10001, 10002, 10003, and so on.
  When a sprite which has been specified is deleted, sprite ID numbers specified after the deleted one will be moved up to fill in the gap.

1. Make the window in which the sprite ID number is to be confirmed the active window.
2. Select [Preview] and then [Sprite ID] on the Screen menu.
3. The sprite ID numbers are displayed.
• Operations that can be used after a sprite ID display

To enlarge the display to its maximum size: Select the “Max. Size” button.

To close a sprite ID display: Select [Close] in the control menu box.

To switch to an image display: Select [Image] on the Display Format menu.

To switch to a device display: Select [Device] on the Display Format menu.

To switch to an image and device display: Select [Image and Device] on the Display Format menu.

To switch to a canvas display: Select [Canvas] on the Display Format menu.

To print out a sprite ID display: Select [Print] on the File menu.

To output a sprite ID display to a file: Select [Save] on the File menu.

• Displaying overlapping sprites at the same position

If several sprites have been specified so that they overlap each other at the same position, the sprite ID No. for the last sprite to have been specified will be displayed. To display the sprite ID No. of all of the overlapping sprites, select “Display Several Devices/IDs” on the Display Format menu.
Chapter 21

Editing in Screen Units / Single-Project Units
21. Editing in Screen Units/Single-Project Units

21.1 Copying Other Screen Data to the Project Data being Edited

When is this function used?

- This function is used when you want to copy screen data, parts data, or comment data created as separate project data into the project data currently being edited.

Because parts data and comment data cannot be copied in number units, if there is parts data or comment data among the project data being edited, please be aware that the existing data will be deleted when the other project data is copied to the data currently being edited.

1. On the Project menu, select [Import File] and then [Project].

2. The "Import From Project" dialog box is displayed.
   - Click on [Browse] under "Source".

3. The "Browse" dialog box is displayed.
   - Specify the directory containing the project data to be copied, and then click on [OK].

4. The "Import From Project" dialog box is displayed again. Click on [Select] under the "Object" parameter.
5. The “Select Copy Objects” dialog box is displayed. Using the “Objects” parameter under the [Select objects] tab, place an X in the check box for the data to be copied. If a base screen or window screen is to be copied, specify the screen number to be copied, and the screen number to which it is to be copied.

If a base screen is to be copied, select the [Base] tab, and if a window screen is to be copied, select the [Window] tab.

6. Under “Source Screen”, click on the position where the title of the screen to be copied is displayed. More than one screen number can be selected for copying. To cancel a screen number which has been selected, click on the title display position once again.

Using the “Destination head screen no.” parameter, specify the screen number to which the screen is to be copied, and then click on [Browse].

7. The “Browse Title” dialog box is displayed.

If the data is being copied to more than one screen number, or more than one screen is being copied, click on the position where the destination screen number is displayed, and then click on [OK].

The “Destination head screen no.” spin box can also be used to specify the screen number to which the data is to be copied.

8. When the source screen numbers and destination screen numbers for base screens and window screens have been specified, click on [OK].
9. The "Import From Project" dialog box is displayed.

Click on [Import]. This initiates the copying procedure. If a base screen or window screen is being copied, the title data for that screen number is also copied.

When the data has been copied from the other project, click on [Close].
21.2 Combining Data Created by More Than One Person

This section explains how to take several different elements of project data which have been created by more than one person, and combine them as one project data element. It also explains useful information to know before beginning this procedure.

21.2.1 Items to Know Before Creating Data as a Team

- The persons involved in creating the data should discuss the project beforehand, and decide items such as base screen numbers, window screen numbers, part numbers, and comment numbers.
- If there are sections of the data which are common to all of the screens being created individually (such as screen frames and screen title boxes), these can be created ahead of time by one person, and registered in a panel kit.

1. Create the common data items to be used on all of the screens.

2. Register the data which has been created in a panel kit.

☞ See Section 18.2, Registering Drawn Graphics and Sprite Settings in a Panel Kit.

After the data has been registered in a panel kit, store it in the drive containing the graphics software, under the following file name:

```
a8gotppkitpkit nn . A8
```

nn is the library number

3. Using the Windows File Manager and DOS commands, copy the above data to a floppy disk.
4. Copy the data to the required number of floppy disks.

To change the library number, change the (nn) of the destination file name and then copy the data.

5. Those persons receiving the data should then copy it under “aBgtppkit” in the drive in which the graphics software has been installed.

6. Read the common data elements from the panel kit.
21.2.2 Combining Data Created by More Than One Person

Open any of the project data to be combined in the application window, and following the procedure described in Section 21.1, copy several project data elements and combine them in one.

Base screens and window screens can be copied in number units, but parts data and comment data cannot. To combine these data elements, follow the procedures described in Sections 21.2.3 and 21.2.4.

21.2.3 Combining Parts Data

Because parts data cannot be copied in number units, the procedure outlined below must be used.

1. Read the individually registered parts into the screen window. (A screen number which is not in actual use should be used as the screen window into which the parts data is read.)

See Section 13.1.2, Reading Registered Parts.
2. Open one of the project data in the application window, and following the procedure described in Section 21.1, combine the data created by Persons A and B. (Make sure the parts data is not copied.)

3. Register the parts from base screen numbers 100 and 101, and then delete the data of base screen numbers 100 and 101.

See Section 13.1.1, Registering Parts.
21.2.4 Combining Comment Data

Because comment data cannot be copied in number units, the procedure outlined below must be used. However, this procedure requires a commercial text editor. Please be aware that comment data cannot be combined without a text editor.

The only comment data which can be combined using this procedure is the comment itself (the text section). Attributes for the comments must be specified after the comment data has been combined.

1. Write the individually registered comment data to a text file.

   See Section 12.1.4, Using Text File Data as Comment Data.

   ![Diagram](image)

2. Using the text editor, combine the text data file created by Persons A and B.

   ![Diagram](image)
3. Open one of the project data in the application window, and following the procedure described in Section 21.1, combine the data created by Persons A and B. (Make sure the comment data is not copied.)

4. Read the comment data in text file format combined using the text editor, and then specify the attributes for each comment.
21.3 Copying the Created Screen Data to Another Screen Number

When is this function used?

- This function is used when you want to copy screen data you have created to another screen number.

2. The “Screen Utilize/Delete” dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Description of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Base</strong></td>
<td>Using the tab, select the type of screen to be copied. Copying cannot be done between base screens and window screens.</td>
</tr>
<tr>
<td><strong>Window</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td>Using the radio buttons, select “Utilize”.</td>
</tr>
<tr>
<td>**Source/Delete No.”</td>
<td>Click on the position where the title of the screen number to be copied is displayed. More than one screen number can be selected for copying. To cancel a screen number which has been selected, click on the title display position again.</td>
</tr>
<tr>
<td><strong>Utilize number</strong></td>
<td>Using the spin box, specify the number to be utilized. When the number to be utilized has been specified, the function is applied to screens subsequent to that of the destination screen number.</td>
</tr>
<tr>
<td>**Destination No.”</td>
<td>Click on the position where the title of the destination screen number is displayed. When the source and destination screen numbers have been specified, click on [Execute]. This initiates the copying procedure. The title data for the screen numbers is also copied.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Select this when all of the data has been copied.</td>
</tr>
</tbody>
</table>
21.4 Deleting the Created Screen Data in Screen Number Units

When is this function used?

- This function is used when you want to delete several units of screen data in number units, as a batch.

2. The "Screen Utilize/Delete" dialog box is displayed.

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Description of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Base, Window</td>
<td>Using the tab, select the type of screen to be deleted.</td>
</tr>
<tr>
<td>&quot;Action&quot;</td>
<td>Using the radio buttons, select &quot;Delete&quot;.</td>
</tr>
<tr>
<td>&quot;Source/Delete No.&quot;</td>
<td>Click on the position where the title of the screen number to be deleted is displayed. More than one screen number can be selected for deletion. To cancel a screen number which has been selected, click on the title display position again. When the screen numbers to be deleted have been specified, click on [Execute]. This initiates the deletion procedure. The title data for the screen numbers is also deleted.</td>
</tr>
<tr>
<td>Close</td>
<td>Select this when all of the specified data has been deleted.</td>
</tr>
</tbody>
</table>
21.5 Changing the Screen Number of the Created Screen Data

- When is this function used?
  - This function is used when you want to change the screen number for screen data you have created to another screen number.

1. Make the screen window containing the screen number to be changed the active window.
2. Select [Store As] on the Screen menu.
3. The “Store As” dialog box is displayed.

- Old No.: 1  Type: Base
  - New No.: 1

Old screen:
- Undelete  Delete

Title list:
- Initial screen
- Demo menu
- Operator panel
- Multi-language
- High speed monitor

<table>
<thead>
<tr>
<th>Item to be set</th>
<th>Description of settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>“New No.”</td>
<td>Using the spin box, specify the screen number to which the screen data in the active screen window is to be changed. This can also be done by clicking on the position at which the screen number to be changed using the “Screen title” parameter is displayed.</td>
</tr>
<tr>
<td>“Old No.”</td>
<td>Using the radio buttons, specify whether or not the screen data for the current screen number is to be deleted after the change is made. When the setting for the screen number to be changed has been entered, click on [OK]. The screen data is moved to the specified screen number, and that screen window becomes active.</td>
</tr>
<tr>
<td>Title list</td>
<td>Click on this to specify a title. The “Set Title” dialog box is displayed. See Section 20.1, Assigning a Title to the Screen Data.</td>
</tr>
</tbody>
</table>
Chapter 22

Setting Sprite Functions Added to the SW2 and Subsequent Versions
22. Setting Sprite Functions Added to the SW2 and Subsequent Versions

22.1 Precautions When Using Functions Described in This Chapter

When using the functions described in this chapter, make sure the SW2NIW-A8SYSP has been installed in the GOT.
22.2 Specifying the Data List Display Function

The data list display function cannot be specified on window screens.

Only one data list display can be specified on one screen window.

If a data list display has been specified for a screen window, the "Scroll" parameter for the alarm list (user alarms) function cannot be specified for that window.

**What does this function do?**

This function gathers data on the statuses of a number of word devices at a specified timing, and displays the results as numeric data, in the form of a table.

The priority order of items in the table can be changed based on the statuses of the applicable word devices.

**GOT display**

The order of the display is switched at the specified timing.

---

**Data List Display Format**

- Lines and numbers do not need to be drawn in data list displays. These are displayed automatically, based on the columns and rows displayed.

```
<table>
<thead>
<tr>
<th>No</th>
<th>1</th>
<th>1</th>
<th>1</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
<tr>
<td>2</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
<tr>
<td>3</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
<tr>
<td>4</td>
<td>*2</td>
<td>*3</td>
<td>*3</td>
<td>*3</td>
</tr>
</tbody>
</table>
```

*1. Specify names for the items in each row.
*2. Specify comment numbers that correspond to the numbers in each row.
*3. Specify the device to be displayed in numeric format in each row.

Only one device name needs to be specified; the rest are specified automatically in consecutive order, based on the number of rows.

Example: To specify D100

<table>
<thead>
<tr>
<th>D100</th>
<th>D101</th>
<th>D102</th>
</tr>
</thead>
</table>
### Example of settings

#### Basic

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Size&quot;</td>
<td>Vertical: 1 x Horizontal: 1 x</td>
</tr>
<tr>
<td>&quot;List style&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Rows&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Disp. rows&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Columns&quot;</td>
<td>4</td>
</tr>
<tr>
<td>&quot;Sort&quot;</td>
<td>Ascending order</td>
</tr>
<tr>
<td>&quot;Sort/Attr. column&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Interval&quot;</td>
<td>Vertical: 3 x Horizontal: 3</td>
</tr>
<tr>
<td>&quot;Cycle&quot;</td>
<td>10 seconds</td>
</tr>
</tbody>
</table>

#### List

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Device&quot;</td>
<td>Random</td>
</tr>
<tr>
<td>&quot;Comment&quot;</td>
<td>Cont</td>
</tr>
<tr>
<td>&quot;Row 1&quot;</td>
<td>&quot;Comment no.&quot; 100</td>
</tr>
<tr>
<td>&quot;Device no.&quot;</td>
<td>D10, D11, D12</td>
</tr>
<tr>
<td>&quot;Row 2&quot;</td>
<td>&quot;Comment no.&quot; 101</td>
</tr>
<tr>
<td>&quot;Device no.&quot;</td>
<td>D20, D21, D22</td>
</tr>
<tr>
<td>&quot;Row 3&quot;</td>
<td>&quot;Comment no.&quot; 102</td>
</tr>
<tr>
<td>&quot;Device no.&quot;</td>
<td>D30, D31, D32</td>
</tr>
<tr>
<td>&quot;Row 4&quot;</td>
<td>&quot;Comment no.&quot; 103</td>
</tr>
<tr>
<td>&quot;Device no.&quot;</td>
<td>D40, D41, D42</td>
</tr>
<tr>
<td>&quot;Col. 1&quot;</td>
<td>&quot;Digits&quot; 12 characters</td>
</tr>
<tr>
<td>&quot;Title&quot;</td>
<td>Display of processing results</td>
</tr>
<tr>
<td>&quot;Col. 2&quot;</td>
<td>&quot;Device type&quot; 16 bit/signed</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>Signed decimal;Digits: 3; Right alignment</td>
</tr>
<tr>
<td>&quot;Title&quot;</td>
<td>Planned no.</td>
</tr>
<tr>
<td>&quot;Col. 3&quot;</td>
<td>&quot;Device type&quot; 16 bit/signed</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>Signed decimal;Digits: 3; Right alignment</td>
</tr>
<tr>
<td>&quot;Title&quot;</td>
<td>No. produced</td>
</tr>
<tr>
<td>&quot;Col. 4&quot;</td>
<td>&quot;Device type&quot; 16 bit/signed</td>
</tr>
<tr>
<td>&quot;Style&quot;</td>
<td>Signed decimal;Digits: 3; Right alignment</td>
</tr>
<tr>
<td>&quot;Title&quot;</td>
<td>No. of defects</td>
</tr>
</tbody>
</table>

#### Display Format

<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description of Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Default&quot;</td>
<td>&quot;Color&quot; White</td>
</tr>
<tr>
<td>&quot;Reverse&quot;</td>
<td>NO</td>
</tr>
</tbody>
</table>

Entering comments in the "Comment Chart" dialog box

<table>
<thead>
<tr>
<th>Comment No.</th>
<th>Comment</th>
<th>Text Color</th>
<th>Normal/Reversed</th>
<th>Blinking</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>Machine 1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>Machine 2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>Machine 3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>Machine 4</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The display color and attributes become effective when the display method is specified.
Outline of Procedure

**Basic**
- Setting of display size
- Setting of list format
- Setting of sorting order
- Setting of display spacing
- Setting of display timing
- Setting of default display attribute

**List**
- Setting of line comment and monitor device
- Setting of row title, monitor device data type, and number of rows to display

Is data expression to be specified?

**Expression**
- Setting of equation for data expression

**Display Format**
- Setting of comparative equation used to change display method

**After entering settings, click on "OK" on any tab**

**Setting of display position**

End

See 1

See 2

See 2

See 4

See 3
Description of Settings

1. Setting the (Basic) settings

“Size”
Using the list box, select the title to be displayed and the text size for numeric values. If “Vertical: 1, Horizontal: 1” is selected, the size of one character will be 16 x 8 dots.

“List style”
“Rows”
Using the spin box, specify the total number of lines to be monitored. Up to 128 lines can be specified.

“Disp. rows”
Using the spin box, specify the actual number of lines to be displayed.

“Columns”
Using the spin box, specify the number of rows to be displayed. Up to 6 rows can be specified.

“Sort”
Using the radio button, select the method by which the display is to be sorted.
Ascending ....... Sorting is carried out beginning with the device that has the smallest value among the rows specified by the “Sort/attribute row” parameter.
Descending ....... Sorting is carried out beginning with the device that has the largest value among the rows specified by the “Sort/attribute row” parameter.
Numeric order . Items are displayed in order of the specified line numbers.

“Sort/Attr. column”
Using the spin box, specify the rows to be targeted when the display is sorted.
(Example) Total lines: 5 lines, No. of lines displayed: 3 lines,
No. of rows: 3 rows, Sort/ascending row: 2 rows

When “Sort” is specified in ascending order

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. of defects</th>
<th>No. of defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Machine 4</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Machine 3</td>
<td>20</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>Machine 5</td>
<td>1</td>
<td>0</td>
</tr>
</tbody>
</table>

Row 1  Row 2  Row 3
Sorting is carried out in order starting with the smallest value in the , in line units.

Since the number of lines to be displayed is 3, these are not displayed on the GUT.

When “Sort” is specified in descending order

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. of defects</th>
<th>No. of defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Machine 5</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>Machine 1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>50</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Machine 1</td>
<td>10</td>
<td>0</td>
</tr>
</tbody>
</table>

Row 1  Row 2  Row 3
Sorting is carried out in order starting with the largest value in the , in line units.

Since the number of lines to be displayed is 3, these are not displayed on the GUT.
When "Sort" is specified in numeric order

<table>
<thead>
<tr>
<th>No.</th>
<th>Processing results</th>
<th>No. produced</th>
<th>No. of defects</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Machine 1</td>
<td>500</td>
<td>5</td>
</tr>
<tr>
<td>2</td>
<td>Machine 2</td>
<td>600</td>
<td>50</td>
</tr>
<tr>
<td>3</td>
<td>Machine 3</td>
<td>700</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Machine 4</td>
<td>400</td>
<td>10</td>
</tr>
<tr>
<td>5</td>
<td>Machine 5</td>
<td>800</td>
<td>1</td>
</tr>
</tbody>
</table>

Since the number of lines to be displayed is 3, these are not displayed on the GOT.

The results are displayed in the order of the line numbers specified with the [List] parameter.

**Displaying the 4th and 5th Lines on the GOT**

*Scroll Up* (00F2H) and *Scroll Down* (00F3H) touch keys should be specified on the screen window.

"Interval"

Using the spin box, specify the amount of spacing to be provided between the title, comments, and numeric values displayed in the chart.
Up to 32 dots can be specified in each direction (vertical and horizontal).

```
No. | Processing results | No. produced | No. of defects |
1   | Machine 1          | 100          | 001           |
```

Vertical display spacing

Horizontal display spacing

"Cycle"

Using the spin box, specify the timing at which the monitor devices in the PC CPU are checked and the display is sorted.
A value between 1 second and 80 seconds can be specified, in 1-second units.

"Default"

Click on [Edit] to display the "Edit Display Method" dialog box, and specify the attributes and display color.
Comments will also be displayed in the color and with the attributes specified here. (Attributes specified when the comment is created will be ignored.)

"Attribute"

If a comparative equation has been specified with the "Display method" parameter, this setting will revert to the display color and attributes effective when the monitor device value or data expression result does not correspond to the comparative equation.

"Color"

Using the list box, specify the color in which numeric values are to be displayed.

"Reverse"

Place an "X" in the check box if the data is to be shown in a reversed display.
Setting the (List) settings

(1) Line settings

"Device" Using the radio button, select how devices to be displayed using numeric values are to be specified. Cont. ......... Devices are specified automatically, in successive order, starting from the device set with the (Row 1) parameter and continuing for the number of devices to be displayed using numeric values.

Random ..... The desired number of devices can be set, in line units.

"Comment" Using the radio button, select how comment numbers to be displayed are to be specified. Cont. ......... Comment numbers are specified automatically, in successive order, starting from the comment number set with the [Row 1] parameter and continuing for the number of lines.

Random ..... The desired comment numbers can be set, in line units.

" (Row 1) " Clicking on (Row 1) displays the "Edit Line" dialog box.

Specify the comment number to be displayed on the selected line, and the device of the numeric value display.

See 10.1, "Setting Devices for Monitoring".
If "Continuous" has been specified for "Device" or "Comment", settings will be made automatically, starting with the device and comment number displayed in numeric format as specified by the (Row 1) parameter.

(Example) Device: D10, Comment No.: 1, No. of Rows: 4, No. of Columns: 5

<table>
<thead>
<tr>
<th>Row 1</th>
<th>Col. 1</th>
<th>Col. 2</th>
<th>Col. 3</th>
<th>Col. 4</th>
<th>Col. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>D10</td>
<td>D11</td>
<td>D12</td>
<td>D13</td>
<td></td>
</tr>
</tbody>
</table>

Devices are set continuously starting from D10, for the number of devices to be displayed in numeric format.

Comment No. 1 is displayed first, and the remaining comment numbers are set continuously.

If "Random" is selected for "Device" or "Comment", the user can specify as many devices and comment numbers as desired, to be displayed in numeric format, in line units.

(Example) Device: D10, Comment No.: 1, No. of Rows: 4, No. of Columns: 5

Set the devices and comment numbers to be displayed in numeric format, for each individual line.

<table>
<thead>
<tr>
<th>Row 1</th>
<th>Col. 1</th>
<th>Col. 2</th>
<th>Col. 3</th>
<th>Col. 4</th>
<th>Col. 5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>D10</td>
<td>D11</td>
<td>D12</td>
<td>D13</td>
<td></td>
</tr>
</tbody>
</table>

Devices are set continuously for the number of rows specified to be displayed in numeric format, starting with the specified device. Device settings cannot be entered in row units.

* (Row 2) - (Row n)*

If "Random" is selected for "Device" or "Comment", click on (Row n) (n being whatever number of lines is to be displayed), to display the "Edit Line" dialog box. Here, specify the devices and comment numbers.

- The display format (type of device, number of lines to be displayed, and other information) for numeric displays is set using the row setting.

The specified devices and comment numbers are displayed under the (List) tab display.

Please be aware that, because only six lines of data can be displayed at one time, there may be times when it is not possible to display all of the characters on the screen, depending on the specified devices and device numbers.
(2) Setting columns

Clicking on **Col. 1** displays the "Edit Columns" dialog box.

**Title**

Enter the item name for Col. 1.

<table>
<thead>
<tr>
<th>No.</th>
<th>Item name specified for Columns 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

**Digits**

Use the spin box to specify the number of characters to be displayed in Column 1, taking into consideration any comments and titles to be displayed.

After entering the setting, click on **OK** under "Title" or "Digits". The specified title is displayed on the screen display.

Because only six half-width characters can be displayed, please be aware that there may be times when the full title cannot be displayed, depending on the length of the title that has been set.

Clicking on **Col. 2 ~ Col. n** displays the "Edit Columns" dialog box.
Setting the Display Style settings

**Title**
Enter the item name for the column.

**Device type**
Using the list box, select the data type for the word device to be used to monitor the column.

<table>
<thead>
<tr>
<th><strong>16 bit/signed</strong></th>
<th><strong>16 bit/unsigned</strong></th>
<th><strong>32 bit/real</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>32 bit/signed</strong></td>
<td>Select this to display data as a 16- or 32-bit word device. The MSB of the bit configuration is used to evaluate plus and minus signs.</td>
<td>Select this to display data as a 32-bit word device with a floating decimal point.</td>
</tr>
</tbody>
</table>

**style**
Using the list box, select the style in which the column monitor device values or data expression results are to be displayed.

<table>
<thead>
<tr>
<th><strong>Signed decimal</strong></th>
<th><strong>Real</strong></th>
<th><strong>Binary</strong></th>
<th><strong>Hexadecimal</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unsigned decimal</strong></td>
<td>Select this to display monitor device values or data expression results as real numbers with floating decimal points.</td>
<td>Select this to display monitor device values or data expression results as binary values.</td>
<td>Select this to display monitor device values or data expression results as hexadecimal values.</td>
</tr>
</tbody>
</table>

**Digits**
Specify the number of digits used to express the numeric value of the column, using the spin box. The number of digits that can be displayed using the "Display style" parameter is as shown below.

<table>
<thead>
<tr>
<th><strong>Signed decimal</strong></th>
<th><strong>Real</strong></th>
<th><strong>Binary</strong></th>
<th><strong>Hexadecimal</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unsigned decimal</strong></td>
<td>1 ~ 13 digits (including minus sign)</td>
<td>1 ~ 32 digits (including decimal points and digits to right of decimal point)</td>
<td>1 ~ 8 digits</td>
</tr>
</tbody>
</table>

**Decimal point**
When real numbers are selected using the "Display style" parameter, use the spin box to specify how many digits to the right of the decimal point are to be displayed.

**Left alignment**
**Right alignment**
Using the radio buttons, select whether the display is to be aligned to the left or right in relation to the display position.
If "Right alignment" is selected above, place an "X" in the check box if zeros are to be displayed in front of the numeric value.
Setting **Expression** settings

These settings should be entered if data expressions are to be used in relation to the monitor device for a column.

"Mask"  
"Shift"  
"Expression"

See 10.2, "Setting Data Expressions".

3 Setting the display position

1. When the settings for the various tabs have been entered, click on **OK** in any tab.

2. A dotted-line box is displayed at the upper left of the screen window, showing the display range for the specified data list display:

3. Move the cursor to the display position, and click at that position.

4 Setting the **Display Format** settings

These settings should be entered if the display color and attributes for the numeric display of the line are to be changed when the monitor device value or the data expression results for the row specified by the "Sort/Attr. column" under **1. Basic** reach a certain value.

11.1, "Setting the Numeric Value Display Function", **5**.
22.3 Setting the Hard Copy Function

If the hard copy function is to be used, always make sure the option driver (printer) has been installed in the A870GOT.

Using the hard copy function requires the A8GT-70 PRF printer interface.

The hard copy function cannot be used when the A850GOT is being used.

What does this function do?

This function enables the monitor screen currently displayed on the GOT to be printed out by turning a bit device on or off, or by using the touch key (expanded) function.

If the monitor screen is printed out using a touch key, the hard copy function should be initiated by specifying the touch key (expansion) function.

15.7. “Setting the Touch Key (Expanded) Function”.

1. Select [Hardcopy] on the Common menu.

2. The “Hardcopy” dialog box is displayed.
<table>
<thead>
<tr>
<th>Item to Set</th>
<th>Description</th>
</tr>
</thead>
</table>
| "Start trigger"      | Click on [Device], and specify the device which is to initiate the hard copy function.  
|                       | See 10.1, "Setting Devices for Monitoring".                                                                                                 |
| "Abort trigger"      | Click on [Device], and specify the device which is to terminate the printout.  
|                       | See 10.1, "Setting Devices for Monitoring".                                                                                                 |
|                       | Printing can also be terminated using the touch key (expanded) function.                                                                        |
| "Print mode"         | Using the radio buttons, select whether printing is to be done in color, or black and white.                                                |
| "Reverse/Normal"     | Using the radio buttons, specify whether or not the black and white areas of the screen are to be reversed when printing is done.          |
| "Trigger watch cycle"| Specify the timing at which the PC CPU is to be checked for the status of the bit devices used to initiate and stop printing.  
|                       | The value should be specified in 1-second units, with a minimum value of 2 seconds.                                                           |
|                       | The bit devices for the start and stop triggers should always be set so that they are on for at least two seconds.                          |

- Internal processing of the GOT after printing starts

The monitor screen currently displayed on the GOT is temporarily stored in the GOT internal memory when the specified bit device goes on, or when the touch key (expanded) function is activated. (The screen is retained in the internal memory of the GOT for up to 5 seconds.)

After the monitor screen has been stored in the internal memory, it is printed out. (The time required to print out the monitor screen depends on the performance of the printer being used.)

![Diagram](Image)
Monitor screens when printing is carried out

During printing, we recommend displaying monitor screens that have a small number of sprite functions. If monitor screens that have sprite functions with a large number of changes (such as numeric display functions) are displayed on the GOT, the GOT assigns priority to the sprite functions, which results in more time being required for printing. (Using a bus connection with the GOT especially slows printing.)

The table below shows the printing time for a displayed monitor screen for which a numeric display (25, 50, 75, or 100 points) has been specified. (These are reference values based on a sequence program scanning time of 10 ms.)

(1) For black-and-white printing

<table>
<thead>
<tr>
<th>No. of numeric display set</th>
<th>Type of connection</th>
<th>CPU direct connection</th>
<th>Calculator link connection (C24)</th>
<th>NET (l)</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>5:01 minutes</td>
<td>2:03 minutes</td>
<td>1:56 minutes</td>
<td>2:03 minutes</td>
</tr>
<tr>
<td>50</td>
<td>6:50 minutes</td>
<td>2:08 minutes</td>
<td>2:02 minutes</td>
<td>2:12 minutes</td>
</tr>
<tr>
<td>75</td>
<td>6:45 minutes</td>
<td>2:08 minutes</td>
<td>2:01 minutes</td>
<td>2:18 minutes</td>
</tr>
<tr>
<td>100</td>
<td>6:53 minutes</td>
<td>2:10 minutes</td>
<td>2:02 minutes</td>
<td>2:21 minutes</td>
</tr>
</tbody>
</table>

(2) For color printing

<table>
<thead>
<tr>
<th>No. of numeric display set</th>
<th>Type of connection</th>
<th>CPU direct connection</th>
<th>Calculator link connection (C24)</th>
<th>NET (l)</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>14:43 minutes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100</td>
<td>20:25 minutes</td>
<td>6:21 minutes</td>
<td>5:51 minutes</td>
<td>6:49 minutes</td>
</tr>
</tbody>
</table>

What happens if the printer power supply is off when the hard copy function is started?

If the power to the printer is off when the hard copy function is started, the monitor screen cannot be printed out. Make sure the power supply is on before using the function.

What happens if the hard copy function is begun while printing is in progress, or data is being stored in the internal memory of the GOT?

If the hard copy function is run while a monitor screen is being printed out, or while data is being stored to the internal memory, the monitor screen will not be saved to the internal memory. (The instruction to begin the hard copy function will be ignored.)

Which printers can be used?

Any printer which accommodates ESC/P24-J84 can be used with this function. For more detailed information, please refer to the user's manual for the A8GT-70PRF Interface Unit.
22.4 Setting the Status Monitor Function

What does this function do?

This function writes data to the PC CPU when the specified conditions have been met (the specified bit device is turned on or off).

Regardless of the monitor screen currently displayed, the following types of data can be written to the PC CPU when the specified conditions have been met (the specified bit device is turned on or off).

- Bit devices can be turned on only while the conditions are satisfied, and are turned off as soon as the conditions are no longer satisfied (momentary).
- Bit devices can be turned on (Bit SET).
- Bit devices can be turned off (Bit RST).
- The current status of a bit device can be reversed (Bit ALT).
- Values can be written to a word device (Word SET).

Two bit devices can be set as conditions.
Only one of the above can be specified for writing in relation to the specified conditions.
A maximum of 40 points (condition + data writing) can be specified.

(Example) A value of 100 is written to D100 when the specified bit device is turned on.

1. The GOT acknowledges that the specified bit device has been turned on (the status of the specified bit is monitored at the specified timing).

2. The specified PC CPU writing is carried out when the conditions have been met.

2. The “Observe Status” dialog box is displayed.

Clicking on [Add] displays the “Trigger/Action” dialog box.
1. Setting the **Trigger** settings

"Condition 1" Click on [Device] to display the "Set Device" dialog box, and specify the bit device to be set as a condition.

10. 1. "Setting Devices for Monitoring".
After specifying the device, use the radio buttons to select whether the specified bit device is to be turned on or off when the conditions are satisfied.

"Condition 2" If a second bit device is to be set as a condition, specify it here, using the same operation as that for "Condition 1".

2. Setting the **Action** settings.

- **Action**
Using the list box, select the actions to be written to the PC CPU when the specified bit device conditions are satisfied.

- Bit Momentary ........ A bit device is turned on only while the conditions are satisfied, and is turned off as soon as the conditions are no longer satisfied.
- Bit set .................. The bit devices is turned on when the conditions are satisfied.
- Bit reset .................. The bit device is turned off when the conditions are satisfied.
- Bit alternate ............ The current status of the bit device is reversed (OFF ↔ ON) when the conditions are satisfied.
- Word set (16-bit) .... The specified value (16-bit data) is written to a word device when the conditions are satisfied.
- Word set (32-bit) .... The specified value (32-bit data) is written to a word device when the conditions are satisfied.
Using the spin box, specify the number of devices to be set using the "Writing device" parameter when the conditions are satisfied.

<table>
<thead>
<tr>
<th>action</th>
<th>Bit Momentary, Bit set, Bit reset, Bit alternate</th>
<th>Word set (16-bit)</th>
<th>Word set (32-bit)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. no. of points</td>
<td>40</td>
<td>20</td>
<td>10</td>
</tr>
</tbody>
</table>

"Storing device" Click on [Device] to display the "Device" dialog box, and in the "Set Multiple Devices" dialog box, specify the device to which the data is to be written.

10.1, "Setting Devices for Monitoring".

"Fixed" "Indirect"

If "Data SET (16-bit)" or "Data SET (32-bit)" is selected for the "Writing device" parameter, specify the value to be written.

1 When writing the specified value to a word device when the conditions have been met

Place an "X" in the check box by "Fixed", and use the spin box to specify the value to be written.

(Example) Trigger 1: M0 is on, points: 3, Storing devices: D10, D11, D12

Fixed: 1000

2 If the current value of the word device is to be written when the conditions have been satisfied, or the current value of a specified word device + a specified value are to be written (when there is one writing destination specified)

Place an "X" in the check box by "Indirect", and click on [Device] to display the "Device" dialog box. Specify the word device in this dialog box.

If the current value of a word device and a specified value are to be written, place an "X" in the check box by "Fixed", and use the spin box to specify the value to be written.

(Example 1) Trigger 1: M0 is on, points: 1, Storing device: D10

Indirect: D100
(Example 2) Trigger 1: M0 is on, points: 1, Storing device: D10
Indirect: D100, Fixed: 100

If the current value of the word device is to be written when the conditions have been satisfied, or the current value of a specified word device + a specified value are to be written (when there is more than one writing destination specified)
Place an "X" in the check box by "Indirect", and click on [Device] to display the *Device* dialog box. Specify the word device in this dialog box.
If the current value of a word device and a specified value are to be written, place an "X" in the check box by "Fixed", and use the spin box to specify the value to be written.
After the above settings have been entered, use the radio buttons to select whether the data is to be written to the writing destination in a single transmission, or whether similar data items are to be sent to the destination together, in a batch.

FMOV..... The current value of the specified device is written to multiple destination devices when the conditions have been satisfied (batch transmission of similar data).

(Example 1) Trigger 1: M0 is on, points: 3, Storing devices: D10, D20, D30
Indirect: D100

(Example 2) Trigger 1: M0 is on, points: 3, Storing devices: D10, D20, D30
Indirect: D100, Fixed: 100
BMOV .... The current values of the specified devices are written to multiple destination devices when the conditions have been satisfied (batch transmission).

(Example 1) Trigger 1: M0 is on, points: 3, Storing devices: D10, D11, D12
Indirect: D100

(Example 2) Trigger 1: M0 is on, points: 3, Storing devices: D10, D11, D12
Indirect: D100 Fixed: 100

When the conditions and actions have been set, click on OK.
The "Observe Status" dialog box is displayed once again.
If any of the settings are to be changed after the conditions and actions have been specified, click on [Edit]. To delete any setting which has been entered, click on [Delete].

To set multiple conditions and actions, click on [Add] and specify the conditions and actions. (Up to 40 settings can be entered.)

When all of the settings have been entered, specify a value for the "Observe Status" parameter.

"Observe cycle"
This specifies the timing at which the GOT monitors statuses of bit devices for conditions which have been specified.
Values can be entered in 1-second units, with the smallest setting being 1 second.
If the time interval during which the bit device specified by the condition is on or off cannot be maintained for longer than the timing specified for condition monitoring, the data is not written to the PC CPU.

- Precautions if multiple conditions and actions have been specified
  Always make sure the same NW numbers and station numbers are set for all of the bit devices to which conditions apply.

- Precautions if data is being written to several devices within one point which has been specified
  If "Bit alternate", "Word set (16-bit)", or "Word set (32-bit)" has been specified as the writing action, and an error (link error) occurs with the PC CPU of the device to which the data is being written, no data will be written to any of the writing destination devices.
### Appendices

#### Appendix 1. Key Code Table

<table>
<thead>
<tr>
<th>Key</th>
<th>Key Code (H)</th>
<th>Key</th>
<th>Key Code (H)</th>
<th>Key</th>
<th>Key Code (H)</th>
<th>Key</th>
<th>Key Code (H)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP</td>
<td>20</td>
<td>@</td>
<td>40</td>
<td></td>
<td>60</td>
<td>→</td>
<td>80</td>
</tr>
<tr>
<td>!</td>
<td>21</td>
<td>A</td>
<td>41</td>
<td>a</td>
<td>61</td>
<td>←</td>
<td>81</td>
</tr>
<tr>
<td>&quot;</td>
<td>22</td>
<td>B</td>
<td>42</td>
<td>b</td>
<td>62</td>
<td>↑</td>
<td>82</td>
</tr>
<tr>
<td>#</td>
<td>23</td>
<td>C</td>
<td>43</td>
<td>c</td>
<td>63</td>
<td>↓</td>
<td>83</td>
</tr>
<tr>
<td>$</td>
<td>24</td>
<td>D</td>
<td>44</td>
<td>d</td>
<td>64</td>
<td>(Clear)</td>
<td>88</td>
</tr>
<tr>
<td>%</td>
<td>25</td>
<td>E</td>
<td>45</td>
<td>e</td>
<td>65</td>
<td>(Scroll up)</td>
<td>F2</td>
</tr>
<tr>
<td>&amp;</td>
<td>26</td>
<td>F</td>
<td>46</td>
<td>f</td>
<td>66</td>
<td>(Scroll down)</td>
<td>F3</td>
</tr>
<tr>
<td>,</td>
<td>27</td>
<td>G</td>
<td>47</td>
<td>g</td>
<td>67</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(</td>
<td>28</td>
<td>H</td>
<td>48</td>
<td>h</td>
<td>68</td>
<td></td>
<td></td>
</tr>
<tr>
<td>)</td>
<td>29</td>
<td>I</td>
<td>49</td>
<td>i</td>
<td>69</td>
<td></td>
<td></td>
</tr>
<tr>
<td>*</td>
<td>2A</td>
<td>J</td>
<td>4A</td>
<td>j</td>
<td>6A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+</td>
<td>2B</td>
<td>K</td>
<td>4B</td>
<td>k</td>
<td>6B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>,</td>
<td>2C</td>
<td>L</td>
<td>4C</td>
<td>l</td>
<td>6C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-</td>
<td>2D</td>
<td>M</td>
<td>4D</td>
<td>m</td>
<td>6D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>.</td>
<td>2E</td>
<td>N</td>
<td>4E</td>
<td>n</td>
<td>6E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/</td>
<td>2F</td>
<td>O</td>
<td>4F</td>
<td>o</td>
<td>6F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>30</td>
<td>P</td>
<td>50</td>
<td>p</td>
<td>70</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>31</td>
<td>Q</td>
<td>51</td>
<td>q</td>
<td>71</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>32</td>
<td>R</td>
<td>52</td>
<td>r</td>
<td>72</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>33</td>
<td>S</td>
<td>53</td>
<td>s</td>
<td>73</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>34</td>
<td>T</td>
<td>54</td>
<td>t</td>
<td>74</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>35</td>
<td>U</td>
<td>55</td>
<td>u</td>
<td>75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>36</td>
<td>V</td>
<td>56</td>
<td>v</td>
<td>76</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>37</td>
<td>W</td>
<td>57</td>
<td>w</td>
<td>77</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>38</td>
<td>X</td>
<td>58</td>
<td>x</td>
<td>78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>39</td>
<td>Y</td>
<td>59</td>
<td>y</td>
<td>79</td>
<td></td>
<td></td>
</tr>
<tr>
<td>:</td>
<td>3A</td>
<td>Z</td>
<td>5A</td>
<td>z</td>
<td>7A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>;</td>
<td>3B</td>
<td>[</td>
<td>5B</td>
<td>{</td>
<td>7B</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;</td>
<td>3C</td>
<td>V</td>
<td>5C</td>
<td>l</td>
<td>7C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>=</td>
<td>3D</td>
<td>]</td>
<td>5D</td>
<td>}</td>
<td>7D</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&gt;</td>
<td>3E</td>
<td>^</td>
<td>5E</td>
<td>~</td>
<td>7E</td>
<td></td>
<td></td>
</tr>
<tr>
<td>?</td>
<td>3F</td>
<td>_</td>
<td>5F</td>
<td>i</td>
<td>7F</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix 2. Screen Creation Form
For A670/GOT-EL models

<table>
<thead>
<tr>
<th>0</th>
<th>16</th>
<th>32</th>
<th>48</th>
<th>64</th>
<th>80</th>
<th>96</th>
<th>112</th>
<th>128</th>
<th>144</th>
<th>160</th>
<th>176</th>
<th>192</th>
</tr>
</thead>
<tbody>
<tr>
<td>30</td>
<td>256</td>
<td>288</td>
<td>300</td>
<td>320</td>
<td>336</td>
<td>360</td>
<td>396</td>
<td>400</td>
<td>420</td>
<td>440</td>
<td>460</td>
<td>480</td>
</tr>
<tr>
<td>60</td>
<td>512</td>
<td>536</td>
<td>552</td>
<td>576</td>
<td>600</td>
<td>624</td>
<td>648</td>
<td>696</td>
<td>720</td>
<td>768</td>
<td>800</td>
<td>840</td>
</tr>
</tbody>
</table>

A - 3
For AE50GOT-STNL models
### Appendix 3. Display Speeds for Sprites

The table below shows the speeds at which the various sprites are displayed.

The actual display speed depends on the number of sprites specified on one screen and the canvas graphics drawn on the screen.

The measured values were calculated by specifying only the sprites on one screen and the default display conditions.

<table>
<thead>
<tr>
<th>Sprite name</th>
<th>Setting conditions</th>
<th>No. set</th>
<th>Bus connection</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>16 bits</td>
</tr>
<tr>
<td>Numeric display</td>
<td>No. of digits: 6</td>
<td>18 points</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
<td>0.20</td>
</tr>
<tr>
<td>ASCII display</td>
<td>No. of digits: 6</td>
<td>6 points</td>
<td>Momentary</td>
</tr>
<tr>
<td>Comment (bit) display</td>
<td>No. of comment characters: 10</td>
<td>18 points</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
<td>0.30</td>
</tr>
<tr>
<td>Comment (word) display</td>
<td>No. of comment characters: 10</td>
<td>18 points</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
<td>0.40</td>
</tr>
<tr>
<td>Par (bit) display</td>
<td>Part size: 48 x 48 dots</td>
<td>32 points</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td>Time until all dots are displayed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Part (word) display</td>
<td>Part size: 48 x 48 dots</td>
<td>32 points</td>
<td>0.40</td>
</tr>
<tr>
<td></td>
<td>Time until all dots are displayed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lemp (bit) display</td>
<td>Lemp size: 48 x 48 dots</td>
<td>18 points</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
<td>0.30</td>
</tr>
<tr>
<td>Panel meter display</td>
<td>Meter size: 64 x 64 dots, upper</td>
<td>18 points</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td>quarter circle</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>32 points</td>
<td>0.30</td>
</tr>
<tr>
<td>Trend graph display</td>
<td>Graph sprite bar: 240 x 120 dots</td>
<td>1 point</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td>No. of graphs: 8</td>
<td></td>
<td>0.30</td>
</tr>
<tr>
<td>Line graph display</td>
<td>Graph sprite bar: 240 x 120 dots</td>
<td>1 point</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td>No. of graphs: 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No. of points: 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bar graph display</td>
<td>No. of bars: 10</td>
<td>1 point</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td>Continuous device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Level display</td>
<td>Painting size: 160 x 160 dots</td>
<td>6 points</td>
<td>Momentary</td>
</tr>
<tr>
<td></td>
<td>Painting pattern: Fill</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Datalist display</td>
<td>No. of all lines: 128</td>
<td>1 point</td>
<td>2.97</td>
</tr>
<tr>
<td></td>
<td>No. of digits: 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No. of rows: 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(Numeric display is 32 bit data)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display speed (unit: S)</td>
<td>CPU direct connection</td>
<td>Calculator link (C24)</td>
<td>MELSECNET/10 connection</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------</td>
<td>-----------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>16 bits</td>
<td>32 bits</td>
<td>16 bits</td>
</tr>
<tr>
<td></td>
<td>0.30</td>
<td>0.46</td>
<td>0.40</td>
</tr>
<tr>
<td></td>
<td>0.51</td>
<td>0.60</td>
<td>0.51</td>
</tr>
<tr>
<td></td>
<td>0.32</td>
<td>0.40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.57</td>
<td>0.44</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.60</td>
<td>0.50</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.64</td>
<td>0.71</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td>1.20</td>
<td>1.20</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td>1.20</td>
<td>1.20</td>
<td>0.40</td>
</tr>
<tr>
<td></td>
<td>0.30</td>
<td>0.42</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.42</td>
<td>0.42</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.30</td>
<td>0.40</td>
<td>0.46</td>
</tr>
<tr>
<td></td>
<td>0.40</td>
<td>0.45</td>
<td>0.50</td>
</tr>
<tr>
<td></td>
<td>0.30</td>
<td>0.57</td>
<td>0.82</td>
</tr>
<tr>
<td></td>
<td>2.16</td>
<td>3.00</td>
<td>2.30</td>
</tr>
<tr>
<td></td>
<td>0.30</td>
<td>0.30</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td>0.30</td>
<td>0.30</td>
<td>0.30</td>
</tr>
<tr>
<td></td>
<td>17.67</td>
<td>20.65</td>
<td>1.41</td>
</tr>
</tbody>
</table>

A - 7
When exported from Japan, this manual does not require application to the Ministry of International Trade and Industry for service transaction permission.